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INTRODUCTION

The Fiery XF product family is the perfect tool for anyone wanting to achieve high-quality 
and consistent color reproduction. 

Fiery XF targets the proofing, production, and photo markets as well as the sign-and-display, 
and print-for-pay markets. It is an ICC-compliant client/server application that runs on both 
Windows and Macintosh operating systems. Its modular design makes it suitable for any size 
of operation and means that it can be flexibly configured to meet your individual 
requirements. 

Fiery XF enables you to:

• Achieve the maximum gamut from the printer, media and ink combination — essential 
requirements for production-heavy environments, for which Fiery XF’s intelligent clean 
color technologies, tiling, advanced step and repeat, color adjustments for last-minute 
edits, and professional finishing are also a must.

• Simulate the colors achieved on a professional printing press or any other printer, thereby 
making it possible to reproduce genuine ISO 12467-7/8-compliant validation prints and 
contract proofs on a conventional printer.

Program architecture
Fiery XF is based on a server/client architecture of modular design. It provides maximum 
flexibility in customizing the software to suit your own particular workflow requirements. 
One server version can be accessed from an unlimited number of client versions. A Fiery XF 
client does not have to be installed on the same computer as the Fiery XF server.

The minimum version of the software comprises:

• Fiery XF (includes one server version and an unlimited number of client versions)

– The server is the software’s nerve center. It runs as a service and is responsible for job 
processing. When you restart your computer after installing the software, the server 
software starts automatically.

– The client software simply provides an intuitive user interface. All settings and actions 
that are initiated on the client computer are sent to the server for processing.

• One Output M Option (for one printer up to 18 inches)

A wide range of additional options is available to supplement the standard version. With the 
use of the appropriate options, you can set up your ideal workflows and completely do away 
with the need for third-party products.
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System requirements
The following recommended system requirements are necessary to install and run Fiery XF 
successfully.

Operating systems

Hardware
For details of current hardware requirements, visit our website at 
http://w3.efi.com/fiery-wide-format/product-overview/marketing-materials.

Server • Windows 7 (64 bit)

• Windows 8 (64 bit)

• Windows 8.1 (64 bit)

• Windows 2008 R2

• Windows 2012 Servers

• Macintosh OS X 10.7, 10.8, 10.9

Client • Windows 7 (64 bit and 32 bit)

• Windows 8 (64 bit and 32 bit)

• Windows 8.1 (64 bit and 32 bit)

• Windows 2012 Servers

• Macintosh OS X 10.7, 10.8, 10.9

http://w3.efi.com/fiery-wide-format/product-overview/marketing-materials
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Online help
Fiery XF includes a comprehensive help system:

• The online help (HTML and PDF format) provides detailed information on how to set up 
and use each feature of Fiery XF. You can open the help from the Help menu.

• The context-sensitive help gives a brief description of the settings on each pane. You can 
access the context-sensitive help via the menu buttons in property inspector. Right-click a 
menu button and click Help.

Conventions
The screen captures in this manual have been created from a mixture of the Windows 7 and 
Macintosh OS X 10.8.2 platforms. Depending on which platform and version of operating 
system you are using, the images on your screen may look slightly different from the images 
that you see in this documentation.

Property inspector
1 Menu button

1
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FIERY XF CONTROL

Fiery XF Control is used to:

• Control the Fiery XF server status

• License the Fiery XF software

• Download and install software updates and media profiles

• Define new locations for profile folders and system folders

Fiery XF Control is located in the status area of the taskbar (Windows) or in the Dock 
(Macintosh) of the computer that is running the server software.

If you cannot see the Fiery XF Control icon, follow the steps below to display the taskbar 
(Windows only) and to display the Fiery XF Control icon.

TO DISPLAY THE WINDOWS TASKBAR AT ALL TIMES

The Windows taskbar is not displayed by default.

1 Move the pointer to the bottom of the screen.

2 Right-click the taskbar and then click Properties.

3 In the Taskbar and Start Menu Properties dialog box, click the Taskbar tab.

4 Under “Taskbar appearance”, select “Lock the taskbar” and clear “Auto-hide the taskbar”. 

5 Click OK.
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TO DISPLAY THE FIERY XF CONTROL ICON

If the Fiery XF Control icon is not visible in the taskbar (Windows) or in the Dock 
(Macintosh) try the following:

• In Windows 7 or Windows 8, make sure that Fiery XF Control is not a hidden icon. In 
the status area of the taskbar, move the pointer to the bottom of the screen. In the status 
area of the taskbar, click the up arrow, and click “Customize”. The Notification Area 
Icons” dialog box appears. For EFI_XF_Control.exe, select the behavior “Show icon and 
notifications”, and click OK.

• In Windows, click Start, point to All Programs, click EFI, click Fiery XF, and then click 
Fiery XF Control.

• On Macintosh, go to /Applications/Fiery XF/Server and drag the Fiery XF Control 
application to the Dock.

TO START A PROCESS FROM FIERY XF CONTROL

1 Right-click the Fiery XF Control icon, and click an item.

You can use Fiery XF Control for the following tasks:

Windows taskbar
1 Up arrow to show hidden 

icons
2 Customize settings to show 

hidden icons

1

2

Shortcut menu command Description

Fiery XF Online Update Downloads and install Fiery XF updates from a 
computer with Internet access.

Fiery XF Profiles Online Update Downloads and installs new or updated media profiles 
from a computer with Internet access.
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Fiery XF Server Stop Stops the Fiery XF server. You must stop the Fiery XF 
server to activate Server File Maintenance. If you are 
currently not working with Fiery XF, you can free up 
additional RAM by stopping the Fiery XF server 
temporarily.

The Fiery XF Control icon turns red when the 
Fiery XF server is not running.

Fiery XF Server Start Starts the Fiery XF server if the Fiery XF server is not 
running.

The Fiery XF server is not running if the 
Fiery XF Control icon is red.

Fiery XF Server Restart Stops and then restarts the Fiery XF server. Some 
processes can be accelerated by restarting the Fiery XF 
server. For example, new profiles are often detected 
quicker if you restart the server.

Fiery XF Client Start Starts the Fiery XF client. This command is available 
only if the server and the client are installed on the 
same computer.

Fiery XF Server Configuration 
(Windows only)

The Fiery XF server runs as a service. Use this 
command to start or stop the service. You can also use 
this command to assign network access rights to the 
server. Network access rights are required for printing 
via a hotfolder.

Activate Fiery XF Generates and installs a new license file.

Show Dongle ID Displays the dongle ID of the dongle that is plugged 
into the computer. The dongle ID is required to 
license the software.

Show License Information Displays details of which licenses are currently 
installed and their expiration dates.

Autostart Fiery XF Control 
(Windows)

Options > Open at Login 
(Macintosh)

Starts Fiery XF Control automatically every time the 
computer is started. If you do not want to start 
Fiery XF Control automatically, click the command 
to clear the check mark.

Shortcut menu command Description
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See also:

“Licensing the software” on page 42

“Updating Fiery XF” on page 172

“Updating media profiles” on page 174

“Changing the profile folders and system folders” on page 381

“Printing problems” on page 389

Server File Maintenance Moves the profile folders and system folders from the 
default location to a different location. As an example, 
you can move media profiles to a different partition to 
free up disk space on the C drive.

Exit (Windows)

Quit (Macintosh)

Exits Fiery XF Control. In Windows, the 
Fiery XF Control icon disappears from the status area. 
On Macintosh, the Fiery XF Control icon turns blue.

To make Fiery XF Control available again:

• In Windows, click Start, point to All Programs, 
click EFI, click Fiery XF, and then click 
Fiery XF Control. For Windows 7 or Windows 8, 
make sure that you have administrator rights.

• On Macintosh, click the Fiery XF Control icon. 
The icon turns green (if the server is running), or 
red (if the server is not running). If necessary, start 
the Fiery XF server.

Shortcut menu command Description
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STARTING FIERY XF
Fiery XF is a server/client program. The server is responsible for processing requests that are 
submitted by the clients. An unlimited number of Fiery XF clients can log on to a Fiery XF 
server.

Starting the Fiery XF server
The Fiery XF Control icon is located in the status area of the taskbar (Windows) or in the 
Dock (Macintosh) of the computer that is running the server software.

Normally, the Fiery XF server starts automatically when the computer is started. If the 
Fiery XF Control icon is green, it indicates that the Fiery XF server is running and clients can 
log on.

If the Fiery XF Control icon is red, the Fiery XF is not running. Start the Fiery XF server.

TO START THE FIERY XF SERVER

1 Right-click the Fiery XF Control icon, and click Fiery XF Server Start.

The Fiery XF Control icon turns green to indicate that the Fiery XF server is running.

See also:

“Fiery XF Control” on page 18
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Starting the Fiery XF client
Make sure that the Fiery XF server is running. The Fiery XF client does not work if the 
Fiery XF server is not running.

TO START THE FIERY XF CLIENT

1 Do one of the following:

• In Windows, double-click the program icon on the desktop. 
On Macintosh, click the program icon in the Dock. 

• Right-click the Fiery XF Control icon, and click Fiery XF Client Start.

• In Windows, click the Start button, point to All Programs, click EFI, click Fiery XF, and 
then click Fiery XF Client.

If an error message appears, make sure that a valid license is installed.

See also:

“Licensing” on page 42

Logging on to a Fiery XF server
If a Fiery XF server and client are installed on the same computer, the Fiery XF client 
automatically logs on to that server as the default administrator when you start the software 
for the first time. If the Fiery XF server and client are installed on different computer, the 
Login dialog box appears.



STARTING FIERY XF 24

The Login dialog box appears also if any of the following apply:

• The Fiery XF server is not running. 

• The dongle is not correctly inserted.

• The software license cannot be detected. 

• The previous user logged off when exiting Fiery XF.

• The firewall settings are not correctly configured.

If a firewall is in use in your network, make sure that it is configured to enable 
communication between server and client. The following ports must be available on the 
server and client computers:

Port Used for

50005 to 50026 General communication between the Fiery XF server and 
Fiery XF client

8010 JDF Connector service

4108 Epson Spectroproofer

8051, 8052, 8053, 8054, 
8061, 8062, 8063, 8064

Communication between Fiery XF server and APPE 
processes (up to four instances)

27000 to 27009, 60000 License management/Cut Server

8020, 8022 JDF integration and connectivity between Fiery XF server 
and VUTEk printers

20020 to 20021 
(UDP only)

Fiery XF discovery
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Furthermore, make sure that the following applications can communicate through the 
firewall:

* Only if installed

For the Windows firewall, the port and application settings are created automatically by 
the installer.

TO LOG ON TO A FIERY XF SERVER

Fiery XF is installed with two default users.

• The user “admin” (password “admin”) is permitted to create, set up and manage system 
configurations in System Manager. A minimum system configuration consists of one user, 
one workflow and one output device.

• The user “guest” (password “guest”) is permitted to print and manage his or her own jobs, 
but does not have access to System Manager.

1 In the Login dialog box, enter a user name and a password.

If you are starting Fiery XF for the first time, log on as the default administrator. Logging on 
as the default administrator enables you to create and set up system configurations.

If you have previously been set up as a user in Fiery XF, you can log on with your own login 
credentials.

Fiery XF Windows applications Macintosh applications

Server EFI_XF_Server 
EFI Activation Wizard 
EFI_XF_Control 
ProfileUpdater 
Updater 
plink 
pscp

EFI XF Server 
EFI Activation Wizard 
EFI XF Control 
Profilupdater 
Updater

Client EFI_XF_Client 
EFI_ClientPtchr 
EFI_ClientPatcher 
ColorEditor 
Color Tools 
EFIDotCreator 
EFI_Fiery XF HelpU 
EFIColorVerifier 
Fiery Device Linker. 
Fiery Printer Profiler 
RGB_Profile_Connector* 
App2* (Cut Server)

Fiery XF Client 
EFI_ClientPtchr 
ColorEditor 
Color Tools 
EFI Dot Creator 
Fiery XF Help 
EFIColorVerifier 
Fiery Device Linker. 
Fiery Printer Profiler 
EFI RGB Profile Connector*
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2 Select or type the IP address of the Fiery XF server computer.

A list of all available Fiery XF servers in the sub-network is displayed with their IP address in 
the drop-down list box.

The Login dialog box appears also if the previous user logged off at the end of the last session. 
If the Fiery XF server and client are installed on the same computer, you can enter “localhost” 
instead of an IP address. Entering “localhost” is the same as using the IP address 127.0.0.1.

3 Click OK.

The Fiery XF client starts. The connected server is displayed at the bottom of the program 
window.

Each time you start Fiery XF, the client logs on to the server that was last connected.

TO LOG ON TO A DIFFERENT FIERY XF SERVER

You can log on to a different Fiery XF server from a current session.

1 On the File menu, click Login.

The Login dialog box appears.

2 Enter a user name and password.

3 Select or type the IP address of the Fiery XF server computer.

4 Click OK.

See also:

“Starting the Fiery XF server” on page 22

“Licensing” on page 42

“License problems” on page 386

“To log on to a Fiery XF server” on page 25
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GETTING TO KNOW FIERY XF

User interface
Fiery XF has two program windows: Job Explorer and System Manager.

• Job Explorer is where you load, organize and preview jobs, and make job settings.

• System Manager is where you create and configure system configurations.

You can display each window by clicking the appropriate tab.

Job Explorer
Job Explorer is where you load, organize and preview jobs, and make job settings.

1

2

3

4
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TO CUSTOMIZE THE JOB EXPLORER WINDOW

Job Explorer is divided into four areas:

• Job list

• Preview window

• Property inspector

• Selector

You can hide the preview window, property inspector, and selector. The job list cannot be 
hidden.

Legend Description

1 The job list provides an overview of loaded jobs. It contains job-specific 
information, such as job status and file name. You can customize the 
information that is displayed in the job list.

2 A selected job is previewed in the preview window.

3 In property inspector, you can make job settings for a job that is selected in the 
job list.

4 The selector acts as filter. It lists jobs according to workflow, printer or job status. 
The “All Jobs” button lets you view the jobs from all workflows. By default, the 
selector is hidden.
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1 Do one of the following:

• On the Workspace menu, click Hide Preview, Hide Selector, or Hide Property Inspector.

• Rest the pointer on the edge of an area until it changes into a double-headed arrow, and 
click.

To hide the preview window, the pointer must rest exactly on the sash bar in the middle.

You can also show or hide property inspector by right-clicking a job in the job list, and 
clicking the appropriate command.

See also:

“Customizing the job list” on page 76

Job Explorer
1 Click to show/hide
2 Drag to change the size

1 1

12
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System Manager
System Manager is where you create and configure system configurations. System Manager is 
accessible to users with administrative rights only.

See also:

“Creating a system configuration in System Manager” on page 57

“To set a system configuration offline” on page 66

1 2

Legend Description

1 The layout area is used for creating, configuring and managing system 
configurations.

The layout area shows which users can print to which workflows, and which 
workflow is printing to which output device.

In the layout area, you can halt jobs at certain stages of the workflow. This may 
be desirable if you need to make alterations to a system configuration — for 
example, to divert a workflow to a different output device if one printer needs 
servicing.

2 In property inspector you can configure the user, workflow or printer that is 
selected in the layout area.
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Property inspector
Job and workflow settings are arranged on tabs. Each tab is subdivided into panes. For 
example, the Workflow tab consists of the panes Basic Information, Preview, and Speed.

Panes must be expanded to view the available settings. To expand a pane, click the pane bar.

Using the menu buttons, you can customize property inspector to show only the tabs and 
panes that you require for your everyday work. The menu buttons provide also access to the 
context-sensitive help. The context-sensitive help gives a brief description of the settings on 
each pane.

Property inspector
1 Tab bar
2 Pane bar (with collapsed 

pane)
3 Expanded pane
4 Menu button
5 Presets menu

4
1

2

4

3

5
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Global settings
The following are settings that affect the appearance of the user interface.

TO CHANGE THE DISPLAY LANGUAGE

By default, Fiery XF is displayed in the language of the operating system. Follow the steps 
below to change the display language in Windows. On Macintosh, you can change the 
language via the international settings in “System Preferences”.

To display one of the supported Asian languages on a PC, Fiery XF must be running on an 
operating system that supports double-byte fonts.

1 Go to System Manager. On the Edit menu, click Languages, and click a language.

2 Restart Fiery XF for the new language to take effect.

If you change the display language, make sure that the help set for that language is installed. 
Otherwise, no help will be available. You can install help sets in additional languages from the 
software DVD.

TO CHANGE THE SYSTEM OF MEASUREMENT

By default, the system of measurement that is set up for the operating system is used.

1 On the Edit menu, point to Measurement System, and click a system of measurement.

You can choose between millimeter, centimeter, meter, inch and foot.

General Fiery XF operations

Job processing
The following are operations that you require in your everyday work with Fiery XF. 

TO LOAD A JOB

The following file formats are supported: PostScript, PDF, TIFF, JPEG, JPEG2000, RAW, 
EPS, Delta Lists, Scitex CT/LW, TIFF/IT, DCS1/DCS2, RPF, and PSD. One-bit files are also 
supported if the OneBit Option is installed. Files in all other formats may be loaded but 
cannot be processed.

1 Do one of the following:

• On the toolbar, click Import Job.

• On the File menu, click Import Job.

• Right-click anywhere in the job list, and click Import Job.

• Drag a file directly into the job list — for example, from the desktop or from a network 
folder.
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Small jobs are loaded immediately in Fiery XF. Larger jobs and multiple jobs can take longer 
to load. In this case, a progress bar in the Fiery XF status bar shows you the current status. To 
cancel jobs that are being loaded, click the gray down arrow to the right of the progress bar. 
Clicking the arrow displays the progress of each individual job that is currently being loaded.

Click the Cancel button to the left of a job to stop loading that job.

TO SAVE CHANGES

1 In the job list, click the job.

2 Do one of the following:

• On the toolbar, click Save.

• On the File menu, click Save.

• In the job list, right-click the job, and click Save.

If you do not save your changes, you are prompted to do so when you switch to a different 
program view.

TO PRINT A JOB

If you load jobs as “hold” job, or if the workflow is set offline at workflow exit, you can submit 
the job to the printer manually when you are ready — for example, after applying job settings.

1 Make sure that the printer is switched on and that media is loaded in the printer.

2 In the job list, click the job.

Job loading
1 Progress bar
2 Canceling job loading

1

2
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3 Do one of the following:

• On the toolbar, click Print.

• On the File menu, click Print.

• In the job list, right-click the job, and click Print.

TO RESET A JOB

If you are not satisfied with your job changes, you can return the page to its original state.

1 In the job list, click the job.

2 Do one of the following:

• On the Edit menu, click Reset Page.

• On the toolbar, click Reset.

• In the job list, right-click the job, and click Reset Page.

TO DELETE A JOB

1 In the job list, click the job.

2 Do one of the following:

• On the toolbar, click Delete Job.

• In the job list, right-click the job, and click Delete.

The job is deleted from the job list.

TO CANCEL JOB PROCESSING

By canceling job processing you can prevent a job from being printed unnecessarily if 
additional job settings are required.

1 In the job list, click the job.

2 Do one of the following:

• On the toolbar, click Cancel Printing.

• On the File menu, click Cancel.

• In the job list, right-click the job, and click Cancel.

Job processing stops. The job remains in the job list. You can restart job processing by 
selecting the print command.
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TO SET UP A VIRTUAL SHEET SIZE

By default, jobs are arranged on the media size that is set up for the output device. You can set 
up a virtual sheet size that overrides the default setting, if required. It can be useful to set up a 
virtual sheet size to process the following types of jobs:

• Nestings

Nestings can be difficult to manage if the output device is set up for oversize media or roll 
media. Defining a more convenient sheet size gives you better control over the layout of 
nested pages.

• Print-to-file jobs

If you have an appropriate license, you can create a print file for an output device that 
supports different media sizes.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Layout tab, open 
the Virtual Sheet Size pane.

• Go to Job Explorer. In the job list, click the job. On the Layout tab, open the Virtual Sheet 
Size pane.

2 Under “Sheet size”, select a sheet size.

Alternatively, select “Custom Size”, and enter the required width and height in the boxes.

3 Save your changes.

TO CREATE A CUSTOM WORKFLOW TEMPLATE

Fiery XF provides many default workflow templates. Each has been set up with color 
management settings for a particular workflow scenario, such as pre-press, print production, 
photo printing or contour cutting.

You can modify the settings from a default template to suit your exact requirements, and save 
them as a custom template. Saving workflow settings as a custom template makes it easy to 
create multiple workflows with the same settings. You have to set up identical workflows to 
print to multiple printers. This is necessary, since each workflow can be connected to only one 
printer.

When you have set up your workflow, do the following:

1 Go to System Manager. In the Layout area, click the workflow.

2 On the File menu, click Save as Template.

The Save as Template dialog box appears.

3 Define a unique name, and click Save.
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The next time you create a workflow, the new template is available for selection under 
“Custom”. 

See also:

“Loading and printing a job” on page 186

Logging off and exiting Fiery XF

TO EXIT FIERY XF 

1 Do one of the following:

• In Windows, on the File menu, click Exit.

• In Windows, click the Close button in the top, right-hand corner of the program window.

• On Macintosh, on the Fiery XF Client menu, click Quit Fiery XF Client.

• On Macintosh, click the Close button in the top, left-hand corner of the program window.

If you have made changes, you are prompted to save them before Fiery XF closes. The next 
time Fiery XF is started, the program logs on automatically with the same user credentials.

If multiple users are using the same computer, you can prevent subsequent users from logging 
on to your workflows by logging off before you exit Fiery XF..

TO LOG OFF AND EXIT FIERY XF 

Each time you start Fiery XF, the client automatically logs on to the server that was last 
selected. If multiple users are using the same computer, you can log off from the Fiery XF 
server when you exit the Fiery XF client. This causes the Login window to open the next time 
the client is started, thus ensuring that each user logs on to his own workflows.

1 On the File menu, click Logoff and Exit.

If you have made changes, you are prompted to save them before Fiery XF closes.

See also:

“Logging on to a Fiery XF server” on page 23

Keyboard shortcuts
Keyboard shortcuts are available for many operations. In the main, they correspond to the 
shortcuts that you will already be familiar with from popular graphics programs.

In the case of key combinations, many of the shortcuts that can be applied to individual 
images can also be applied to multiple job selections on a nesting.
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• Activating options

• Activating toolbars

• General

Function Function key

Start Color Tools <F2> 

<Alt>+<Apple><F2>

Start Verifier <F3>

<Alt>+<Apple>+<F3>

Start Color Editor <F4>

<Alt>+<Apple>+<F4>

Start Dot Creator <F5>

<Alt>+<Apple>+<F5>

Start EFI XF Uploader <F7>

<Alt>+<Apple>+<F7>

Start Media Mapper <F9>

<Alt>+<Apple>+<F9>

Function Function key

Transform toolbar <T>

Crop toolbar <C>

Edit tiling toolbar <E>

Zoom toolbar <Z>

Function Key combination

Switch between Job Explorer and 
System Manager

<F6>

<Alt>+<Apple>+<F6>

Show system information <F10>

<Alt>+<Apple>+<F10>

Show shortcut menu for a selected 
page (“Edit” menu)

Right-mouse click on a page

Show shortcut menu for a selected 
sheet (“Nesting” menu)

Right-mouse click on a sheet



GETTING TO KNOW FIERY XF 38

• Page position

Show shortcut menu (“View” 
menu)

<Shift>+right-mouse click on a sheet

Select page Click on page

Scale page(s) 
(Crop tool selected)

Click on page handle. Then press <Alt> and drag 
cursor.

Crop page(s) 
(Transform tool selected)

Click on page handle. Then press <Alt> and drag 
cursor.

Rotate page(s) Click on page edge and drag image. Rotations snap 
automatically to 90, 180, 270 or 360 degrees.

Invert • <Ctrl>+<I>

• <Apple>+<I>

Reset page • <Ctrl>+<Shift>+<R>

• <Apple>+<Shift>+<R>

Maximize preview window • <Ctrl>+<Shift>+<M>

• <Apple>+<Shift>+<M>

Next page <Ctrl>+<Page down>

Previous page <Ctrl>+<Page up>

Go to first page • <Ctrl>+<Home>

• <Apple>+<Alt>+<Page down>

Go to last page • <Ctrl>+<End>

• <Apple>+<Alt>+<Page up>

Show/hide crosshairs for more 
precise page layout

<Tab>

Function Key combination

Move page 0.5 mm on sheet Arrow keys

Move page 10 mm on the sheet <Shift>+arrow keys

Move sheet randomly <Space bar>+drag mouse

Scroll sheet up/down • <Page up>/<Page down>

• Scroll wheel up/down

Function Key combination
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• Nesting jobs

Scroll sheet left/right • <Shift>+<Page up>/<Page down>

• <Ctrl>+Scroll wheel up/down

Scroll to top/bottom of sheet <Home>/<End>

Scroll to left/right edge of sheet <Shift>+<Home>/<End>

Function Key combination

Select all jobs • <Ctrl>+<A>

• <Apple+<A>

Add page to selection <Shift>+click on page

Select jobs in a cropped area Mouse click and drag lasso

Remove page from selection <Shift>+click on page

Move selected pages Drag cursor

Remove selected page(s) and copy 
to clipboard (cut page)

• <Ctrl>+<X>

• Apple+<X>

Delete selected page(s) <Ctrl>+<Backspace>

Copy selected page(s) • <Ctrl>+<C>

• <Apple>+<C>

Paste selected page(s) from the 
clipboard

• <Ctrl>+<V>

• <Apple>+<V>

Refresh nesting • <Ctrl>+<Alt>+<R>

• <Apple><Alt>+<R>

Add sheet • <Ctrl>+<Alt>+<+>

• <Apple><Alt>+<+>

Lock page • <Ctrl>+<L>

• <Apple>+<L>

Unlock page • <Ctrl>+<Alt>+<L>

• <Apple>+<Alt>+<L>

Function Key combination
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• Zoom

• Rulers, guides and grid

Function Key combination

Zoom in/out • <Ctrl>+<+>/<>

• <Apple>+<+>/<>

• <Alt>+Scroll wheel

Fit sheet to window • <Ctrl>+<0>

• <Apple>+<0>

Fit to actual size • <Ctrl>+<Alt>+<0>

• <Apple>+<Alt>+<0>

Fit selection to window • <Ctrl>+<F>

• <Apple>+<F>

Fit selection to window and zoom 
out one step

• <Ctrl>+<Alt>+<F>

• <Apple>+<Alt>+<F>

Zoom in two steps • <Ctrl>+<Space bar>+mouse click

• <Apple>+<Space bar>+mouse click

Zoom out two steps • <Alt>+<Space bar>+mouse click

Zoom into selected area • <Ctrl>+drag lasso

• <Apple>+drag lasso

Function Key combination

Show/hide ruler • <Ctrl>+<R>

• <Apple>+<R>

Set ruler to new zero coordinates Drag cursor from top left corner of preview 
window (where vertical and horizontal rulers 
intersect)

Return ruler to default zero 
coordinates

Double-click in top left corner of preview window 
(where vertical and horizontal rulers intersect)

Create guide Drag cursor from ruler

Re-position guide Select and drag guide to new position

Delete guide Drag guide and release in ruler (unlocked guides 
only)
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Show/hide guides • <Ctrl>+<;>

• <Apple>+<;>

Lock/unlock guides • <Ctrl>+<Alt>+<;>

• <Apple>+<Alt>+<;>

Show/hide grid • <Ctrl>+<“>

• <Apple>+<“>

Override snap to <Shift>+drag cursor

Function Key combination
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LICENSING

Fiery XF is a modular-based software, designed to guarantee that you receive a product 
tailored to meet your individual workflow needs. The license management system ensures that 
only those options that make up your chosen configuration are visible in the software.

A so-called “EAC” (Entitlement Access Code) is provided when you purchase Fiery XF or an 
additional option. The EAC contains information about the product and output options that 
you have purchased. The EAC is printed on the Product Activation Certificate. If the Product 
Activation Certificate is missing from the scope of delivery, contact your dealer for assistance.

A dongle is also shipped with the software. Each dongle is unique and can be identified by its 
electronically integrated ID. The licensing procedure uses the dongle ID to create a fixed link 
between the software and the dongle.

The number of license files you require depends on the particular software configuration you 
have purchased. If a license file is not detected when you launch Fiery XF, that part of the 
software will not be available. If no license files are detected, Fiery XF will not start and an 
error message will appear.

A license file is generated during product registration. To generate a license file, you require a 
computer with Internet access.

Licensing the software
Normally, you will already have generated and installed a license file as part of the software 
installation procedure. However, there may be occasions when you need to generate a new 
license file for a newly purchased Fiery XF option.

To generate a license file, you require the following:

• You require a computer with Internet access. If you do not have a computer with Internet 
access, you can ask your authorized dealer to generate a license file for you.

• You require the EAC that is printed on the Product Activation Certificate inside the 
product packaging

• You require the dongle ID. If the Fiery XF server is installed on a computer that has access 
to the Internet, the dongle ID is detected automatically. If the Fiery XF server is installed 
on a computer that does not have Internet access, make a note of the dongle ID before you 
start the licensing procedure.
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TO DETERMINE THE DONGLE ID

You can find the dongle ID in Fiery XF Control. Fiery XF Control is located in the status area 
of the taskbar (Windows) or in the Dock (Macintosh) of the computer that is running the 
server software.

If the Fiery XF Control icon is not visible or is displayed in a different color, do the following:

• Make sure that Fiery XF Control is started.

• Make sure that the Windows taskbar is displayed.

• In Windows, make sure that Fiery XF Control is not a hidden icon.

1 Plug the dongle into a USB port on the computer that is running the Fiery XF server software.

Ensure that only the Fiery XF dongle is plugged into your computer. It can lead to problems if 
multiple dongles are plugged in. The dongle can take up to one minute to be detected, so wait 
before performing the next step.

2 Right-click the Fiery XF Control icon, and click Show dongle ID.

TO GENERATE AND INSTALL A NEW LICENSE FILE AUTOMATICALLY (REQUIRES INTERNET ACCESS)

Use this method if the computer that is running the Fiery XF server software has Internet 
access.

If you are upgrading from an earlier version of the software, make sure that you do NOT 
delete the existing license files from the FlexLM folder. They are required in addition to the 
new license file(s).

If you are extending an existing configuration of Fiery XF with additional options, make sure 
to exit all client versions of the software before starting the following procedure.

1 Make sure that the dongle is correctly plugged into a USB port on the computer.

2 Start the Activation Wizard/Assistant. Do one of the following:

• Right-click the Fiery XF Control icon, and click Activate Fiery XF.

• Go to System Manager. On the System menu, click Activation Wizard.

3 Read carefully the License Agreement. Then click Accept to accept the terms of the license 
agreement.

If you do not accept the terms of the License Agreement, the licensing procedure is aborted.
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4 Click the Automatically tab.

5 Select “Generate and activate new license”.

6 Enter the EAC code in the appropriate boxes and click Continue with user details.

The EAC code is case-sensitive.

7 Read carefully the information about product registration. Then click Next Step.

8 Fill out the online form with your user registration details.

If you are a returning customer, the form is filled out automatically if you type your e-mail 
address and click Retrieve.

9 Click Install License.

A license file is created and downloaded to the FlexLM folder on your computer.

10 Click Finish to exit the Activation Wizard/Assistant.

If problems arise when trying to download a license file using this method, you can generate a 
license file from the activation website instead.

You may need to restart the Fiery XF server if the license is not automatically detected..
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TO GENERATE A NEW LICENSE FILE THROUGH THE ACTIVATION WEBSITE

Use this method if the computer that is running the Fiery XF server does not have Internet 
access.

1 On a computer with Internet access, go to the website http://activation.efi.com.

The Login dialog box appears.

2 Click a language button.

3 Enter the EAC code in the box, and click Submit.

The EAC code is case-sensitive.

4 Select the check box to the left of a listed product to indicate the items that you want to 
license. Then click Next.

5 Type your dongle ID. Then click Next.

6 Type an e-mail address. Then click Next.

The e-mail address will be used to notify you of product innovations, etc.

7 Fill out the online form with your user registration details. Then click Next.

8 Check the order information and the dongle ID. Then click Next.

If you need to make any changes, click Previous to return to an earlier dialog box.

9 Specify how you want to receive your license file.

Select one of the following methods:

• Click Save to File to save the generated license file to a defined location on your computer. 
The license file is saved as a text file with the file extension *.lic.

• Click Send Email to send the license file to any valid e-mail address. A dialog box appears 
to confirm that the license file has been sent to the specified e-mail address. 

10 Click Logout to exit the website.

11 Follow the instructions to install the license file manually.

TO INSTALL A LICENSE FILE MANUALLY VIA THE ACTIVATION WIZARD/ASSISTANT

Use this method to install a previously generated a license file.

If you are upgrading from an earlier version of the software, make sure that you do NOT 
delete the existing license files from the FlexLM folder. These are required in addition to the 
new license file(s).

If you are extending an existing configuration of Fiery XF with additional options, make sure 
to exit all client versions of the software before starting the following procedure.
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1 Copy the license file to the computer that is running the Fiery XF server software (for 
example, the desktop).

2 Start the Activation Wizard/Assistant.

Use one of the following methods:

• Right-click the Fiery XF Control icon, and click Activate Fiery XF.

• Go to System Manager. On the System menu, click Activation Wizard.

3 Read carefully the License Agreement. Then click Accept to accept the terms of the license 
agreement.

If you do not accept the terms of the License Agreement, the licensing procedure is aborted.

4 Click the Manually tab.

5 Click Install License and browse to the license file.

6 Select the license file and click Open.

The license file is copied to the FlexLM folder on your computer.

7 Click Finish.

You may need to restart the Fiery XF server if the license is not automatically detected..
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See also:

“Fiery XF Control” on page 18

“Fiery XF Server Restart” on page 20

“To determine the dongle ID” on page 43

“To generate a new license file through the activation website” on page 45

Regenerating a license file
There may be occasions when you need to regenerate a license — for example, after 
reinstalling Fiery XF on a different computer. The only prerequisite is that you must use the 
same dongle.

TO REGENERATE A LICENSE FILE

1 Make sure that the dongle is correctly plugged into a USB port on the computer.

2 Start the Activation Wizard/Assistant. Do one of the following:

• Right-click the Fiery XF Control icon, and click Activate Fiery XF.

• Go to System Manager. On the System menu, click Activation Wizard.

3 Read carefully the License Agreement. Then click Accept to accept the terms of the license 
agreement.

If you do not accept the terms of the License Agreement, the licensing process is aborted.
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4 Click the Automatically tab.

5 Select “Download previously created license”, and click Download Activated Licenses.

A license file is created and downloaded to the FlexLM folder on your computer.

6 Click Finish to exit the Activation Wizard/Assistant.

If problems arise when trying to download a license file using this method, you can regenerate 
a license file from the activation website instead.

You may need to restart the Fiery XF server if the license is not automatically detected.

See also:

“Fiery XF Server Restart” on page 20

“To generate a new license file through the activation website” on page 45
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Viewing license information
You can display details of currently installed licenses and their expiration dates.

TO VIEW LICENSE INFORMATION

1 Do one of the following:

• Right-click the Fiery XF Control icon, and click Show License Information.

• On the Help menu, click Fiery XF Server Information.
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CREATING A SYSTEM CONFIGURATION

Fiery XF is installed with one default system configuration that consists of two users, one 
workflow and one output device. You can view system configurations in System Manager.

The user "admin" (password "admin") is permitted to create, set up and manage system 
configurations in System Manager.

The user "guest" (password "guest") is permitted to print and manage his or her own jobs in 
Job Explorer but does not have access to System Manager. ”Guest” enables infrequent users of 
Fiery XF to log on quickly and easily, without first having to be defined as a user. 

The workflow “EFI Linearization” and the output device “Linearization device” are used 
primarily in conjunction with Color Tools and Color Profiler Suite for printer linearization 
and profile creation. Only users with administrator rights can print jobs through this system 
configuration.

You can set up a system configuration:

• In the Setup Wizard/Assistant

The Setup Wizard/Assistant leads you logically through the minimum of steps that are 
necessary to set up a basic system configuration for the default users. You can finetune 
your workflow settings later in System Manager, if required. Normally, you will already 
have created a system configuration in this way when you started Fiery XF for the first 
time.

• In System Manager

In System Manager, you have access to all the available settings and can create additional 
users, workflows and output devices. You can also make changes to existing system 
configurations.

To set up an output device, you must have media profiles for that output device installed on 
the computer. If you did not install the media profiles during installation, you can install 
them now. To install media profiles use one of the following methods:

• Download the latest media profiles from the EFI website.

• Install media profiles from the media profiles DVD. For more information, see the Quick 
Start Guide.
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See also:

“Updating media profiles” on page 174

Creating a system configuration in Setup Wizard/Assistant
System configurations that are created in Setup Wizard/Assistant enable users to output jobs 
in their original size and with color management applied.

TO SET UP A SYSTEM CONFIGURATION IN SETUP WIZARD/ASSISTANT

You can click Finish Now at any time to exit the setup procedure. Any settings that you have 
already made are saved.

1 Go to System Manager. On the System menu, click Setup Wizard (Windows) or Setup Assistant 
(Macintosh).
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2 Click Continue.

3 Under “Workflow”, select a workflow environment: Proof, Photo or Production.

Alternatively, select “Custom” to create a workflow with no predefined industry-specific 
settings.

4 Under “Template”, select the template that best suits your workflow requirements.

Fiery XF provides many default workflow templates. Each has been set up with color 
management settings for a particular workflow scenario, such as pre-press, print production, 
photo printing or contour cutting.



CREATING A SYSTEM CONFIGURATION 53

5 Click Continue.

6 Under “Select a device”, select “Create a new output device”.

Alternatively, select “None” if you prefer to set up an output device in System Manager.

7 Select the manufacturer of your output device.

Select “EFI” as the manufacturer to set up an output device for one of the following options: 
File Output Option, Fiery Option, Softproof Output Option.

8 Select your device type.

When you make a selection, the Setup Wizard/Assistant displays the number of media profiles 
that are installed for the output device.

If no media profiles are installed, an error message appears. In this case, you must cancel the 
setup and install the appropriate media profiles.

You can download the latest media profiles from the EFI website. Alternatively, you can install 
media profiles from the media profiles DVD. For more information, see the Quick Start 
Guide.
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9 Click Continue.

The dialog box varies depending on the type of output device you selected.

10 Select one of the following connection types:

• Select “Print to system printer” to print to a Windows printer that has already been set up 
as a system printer on the computer that is running the Fiery XF server software. Then, 
select the printer from the drop-down list box.

This setting is available for Windows only, and the system printer must be a printer that is 
supported by Fiery XF.

• Select “Print via IP network” to print to a network printer.

Type the IP address of the network printer. Then, do one of the following:

– For all output devices except Fiery Command WorkStation: Select the type of TCP/IP 
protocol that your printer uses for data transfer. Most printers support the RAW 
protocol and print to port 9100. The LPR protocol is normally reserved for Unix 
systems or print servers with multiple interfaces. In most cases, you can leave the box 
empty. Refer to your printer manual or ask your system administrator if you are unsure.

– For Fiery Command WorkStation: Select a queue name (“Print”, “Hold” or “Direct”).

• Select “Print via port” to print to a printer that is connected via USB to the server 
computer. The printer must be switched on when you start Fiery XF. Otherwise, the 
printer cannot be detected.

• Select “Print to file” to print to PDF/TIFF format, to create a softproof on a Caddon 
can:view output device, or to output to a Fiery output device.

Check the export path. Click Choose and browse to a different folder, if required. 
Complete the rest of your settings. The available settings depend on the type of file output. 

• Select “Print via JDF port” to set up a JDF connection to a VUTEk printer.



CREATING A SYSTEM CONFIGURATION 55

11 Click Continue.

12 Select the type of ink that is inserted in the printer.

13 Select the name of the media that you are going to use.

Fiery XF provides media profiles that have been created for specific combinations of media, 
ink and resolution. Furthermore, you can implement your own custom media profiles that 
have been created for your exact printer.

14 Select a calibration set.

The calibration set defines a set of print conditions, and ensures that the printer’s behavior is 
adjusted optimally to the media.
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15 Click Continue.

16 Make media-specific settings.

Select the source of the media: roll or sheet. Then select the media format. Alternatively, 
define a custom size by entering the required dimensions.

17 Click Finish.

Your workflow and output device are now set up. You can finetune the system configuration 
in System Manager, if required.

See also:

“Connection” on page 474

“Updating media profiles” on page 174

“Printing to file” on page 220

“Printing to a Fiery output device” on page 221

“Printing to a VUTEk printer” on page 223

“Printing to a Caddon can:view cabinet” on page 226
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Creating a system configuration in System Manager 
In System Manager, you can create system configurations that are configured to your exact 
needs.

TO CREATE A NEW USER

You can create new users in Fiery XF. Each user is given a unique password and receives access 
to selected areas of the software.

1 Do one of the following:

• On the toolbar, click New User.

• In the layout area, right-click an existing user, and click New User.

• On the File menu, point to New, and click User.

A user with the name “New User 1” is created.

2 Define a unique user name. Do one of the following:

• In the layout area, double-click “New User 1”, overwrite the default name, and press 
<Enter>.

• On the Profile tab, open the User Account pane, and overwrite “New User 1”.

3 On the Profile tab, open the User Account pane.

• Define a password. Then confirm it by re-typing it in the appropriate box.

You can also change existing user passwords in this way.

However, be aware that if you change the default password of the user “admin” and if the 
user “admin” is the only user with administrator rights, you will no longer be able to access 
System Manager if the password is misplaced.

• Select a user role.

Administrators are permitted to create, set up and manage system configurations in 
System Manager, and to load jobs and make job-specific settings in Job Explorer.

Users are permitted only to load jobs and make job-specific settings in Job Explorer.
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4 On the Profile tab, open the Workspace pane, and assign a workspace.

A workspace is a custom view of Fiery XF. It defines the basic areas of Fiery XF that each user 
can see. The predefined workspaces provide access to a specific range of Fiery XF features:

• FULL provides access to Fiery XF’s full range of licensed features.

• PRODUCTION provides access to all settings that are required in a production workflow, 
but hides those settings that are specifically aimed at a proofing environment.

• PROOFING provides access to all settings that are required in a proofing workflow, but 
hides those settings that are specifically aimed at a production environment.

You can also create and assign custom workspaces.

5 Assign a color to the user (optional).

Assigning a color can help you to identify users more easily. For example, you can assign a 
specific color to all users of one group. Do one of the following:

• In the layout area, right-click the user, click Color Indicator, and click a color.

• In the layout area, click the white stripe to the left of the user name, and click a color.

You can select one of the available basic colors, or you can define a custom color. To define a 
custom color, click Define Custom Colors. Custom colors must be defined in the RGB color 
space. When you have defined a color, click Add to Custom Colors.

Click OK to close the dialog box.

6 Save your changes.

TO CREATE A WORKFLOW

You can create new workflows in Fiery XF. Workflow templates are available for different 
workflow scenarios. 
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1 Do one of the following:

• On the toolbar, click New Workflow.

• In the layout area, right-click an existing workflow, and click New Workflow.

• On the File menu, point to New, and click Workflow.

The New Workflow from Template dialog box appears.

2 Select a type of workflow environment: Proof, Photo, or Production.

3 Select the name of the template that best suits your workflow requirements.

Fiery XF provides many default workflow templates. Each has been set up with color 
management settings for a particular workflow scenario, such as pre-press, print production, 
photo printing or contour cutting.

Initially, only the default templates are available. However, you can modify the settings from a 
default template to suit your exact requirements, and save them as a custom template.

4 Click Load.

A new workflow is created. The workflow has the same name as the workflow template, with 
a consecutive number added.

5 Define a unique name for the workflow. Do one of the following:

• In the layout area, double-click the new workflow, overwrite the default name, and press 
<Enter>.

• On the Workflow tab, open the Basic Information pane, and overwrite the default name.

6 Make your required workflow settings.

For example, you can apply special color profiles, output jobs collectively as nestings, or scale 
all jobs to a uniform size. The settings you make for the workflow are applied to all the jobs 
that you load in that workflow.
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7 Assign a color to the workflow (optional).

Assigning a color can help you to identify workflows more easily. For example, you can assign 
a specific color to all workflows that are printing to the same printer. Do one of the following:

• In the layout area, right-click the workflow, click Color Indicator, and click a color.

• In the layout area, click the white stripe to the left of the workflow name, and click a color.

You can select one of the available basic colors, or you can define a custom color. To define a 
custom color, click Define Custom Colors. Custom colors must be defined in the RGB color 
space. When you have defined a color, click Add to Custom Colors.

Click OK to close the dialog box.

8 Save your changes.

TO CREATE A NEW OUTPUT DEVICE

1 Do one of the following:

• On the toolbar, click New Output Device.

• In the layout area, right-click an existing output device, and click New Output Device.

• On the File menu, point to New, and click Output Device.

An output device with the name “New Output Device 1” is created.

2 Define a unique name for the output device. Do one of the following:

• In the layout area, double-click “New Output Device 1”, overwrite the default name, and 
press <Enter>.

• On the Device tab, open the Information pane, and overwrite “New Output Device 1”.

3 On the Device tab, open the Information pane.

• Under “Manufacturer”, select the manufacturer of your output device.

Select “EFI” as the manufacturer to set up an output device for one of the following 
options: File Output Option, Fiery Option, Softproof Output Option.

• Under “Device type”, select your device type.

If no media profiles are installed, an information icon appears. In this case, you must 
install the appropriate media profiles before you continue.

You can install media profiles from the software DVD. For more information, see the 
Quick Start Guide. Alternatively, you can download the latest media profiles from the EFI 
website. 
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4 On the Device tab, open the Connection pane, and select a connection type.

• Select “Print to system printer” to print to a Windows printer that has already been set up 
as a system printer on the computer that is running the Fiery XF server software. Then 
select the printer from the drop-down list box.

This setting is only available for Windows and the system printer must be a printer that is 
supported by Fiery XF.

• Select “Print via IP network” to print to a network printer.

Type the IP address of the network printer. You can check whether the connection to the 
printer has been properly established by clicking Test. To test the connection, the printer 
must be switched on. If you receive an error message, contact your system administrator 
for advice.

Select the type of TCP/IP protocol that your printer uses for data transfer. Most printers 
support the RAW protocol and print to port 9100. The LPR protocol is normally reserved 
for Unix systems or print servers with multiple interfaces. In most cases, you can leave the 
box blank. Refer to your printer manual or ask your system administrator if you are 
unsure.

Additional settings are required to print to a Fiery Command WorkStation. 

• Select “Print via port” to print to a printer that is connected via USB to the server 
computer. The printer must be switched on when you start Fiery XF. Otherwise, the 
printer cannot be detected.

• Select “Print to file” to print to PDF/TIFF format, to create a softproof on a Caddon 
can:view output device, or to output to a Fiery output device.

Check the export path. Click Choose and browse to a different folder, if required. 
Complete the rest of your settings. The available settings depend on the type of file output. 

• Select “Print via JDF port” to set up a JDF connection to a VUTEk printer. 

• Select “Print via JDF port” to set up a JDF connection to a VUTEk printer.

Click Connect to set up the connection. 
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5 On the Media tab, open the Print Configuration pane.

• Select the type of ink that is inserted in the printer.

• Select the name of the media that you are going to use.

Fiery XF provides media profiles that have been created for specific combinations of 
media, ink and resolution. Furthermore, you can implement your own custom media 
profiles that have been created for your exact printer.

• Select a calibration set.

The calibration set defines a set of print conditions, and ensures that the printer’s behavior 
is adjusted optimally to the media. Click Catalog to view the print conditions under which 
each available calibration set was created.

When you select a media type, ink type and calibration set, Fiery XF automatically selects the 
correct media profile for that combination of settings.

6 On the Media tab, open the Media Setting pane, and make media-specific settings.

Select the source of the media: roll or sheet. Then select the media format. Alternatively, 
define a custom size by entering the required dimensions.

7 On the Special tab, open the Special Printer Settings pane, and make printer-specific settings 
(optional).

8 Assign a color to the output device (optional).

Assigning a color can help you to identify output devices more easily. For example, you can 
assign a specific color to all output devices that are printing on the same type of media. Do 
one of the following:

• In the layout area, right-click the output device, click Color Indicator, and click a color.

• In the layout area, click the white stripe to the left of the printer name, and click a color.

You can select one of the available basic colors, or you can define a custom color. To define a 
custom color, click Define Custom Colors. Custom colors must be defined in the RGB color 
space. When you have defined a color, click Add to Custom Colors.

Click OK to close the dialog box.

9 Save your changes.

After you have created a system configuration, you need to set it online.
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See also:

“To create a custom workflow template” on page 35

“Setting system configurations online/offline” on page 64

“Creating workspaces” on page 71

“Connection” on page 474

“Updating media profiles” on page 174

“Third-party media profiles” on page 176

“Printing to a Fiery output device” on page 221

“Printing to a VUTEk printer” on page 223

“JDF integration” on page 264
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SETTING SYSTEM CONFIGURATIONS ONLINE/OFFLINE 
To process and output jobs in Fiery XF automatically, the system configuration must be fully 
online at all stages.

However, there may be times when you need to set a part of the system configuration offline 
in order to make changes. By setting a system configuration offline, you prevent jobs from 
entering a workflow that is temporarily unavailable.

TO SET A SYSTEM CONFIGURATION FULLY ONLINE

1 Go to System Manager. In the layout area, connect the user to the workflow. Then connect the 
workflow to the output device.

Users, workflows and output devices must be visibly joined by a black line. You can connect a 
user to an unlimited number of workflows, but a workflow can be connected to only one 
output device.

Drag the mouse from the margin area of an object (user, workflow or output device) across to 
the second object. Make sure to drag from the margin area. If you drag from the center, it 
rearranges the order in which objects are displayed.

Connecting objects in a system 
configuration
1 Margin area

1 1 1 1
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You can also use the following menu items:

Action Description

To connect one user to 
one workflow

• In the layout area, right-click a user, point to Connected 
Workflows, and click an item that does not have a check 
mark next to it.

• In the layout area, click a user. On the Edit menu, point to 
User, point to Connected Workflows, and click an item that 
does not have a check mark next to it.

• In the layout area, right-click a workflow, point to 
Connected Users, and click an item that does not have a 
check mark next to it.

• In the layout area, click a workflow. On the Edit menu, 
point to Workflow, point to Connected Users, and click an 
item that does not have a check mark next to it.

To connect one user to all 
workflows

• In the layout area, right-click a user, and click Connect to 
All Workflows.

• In the layout area, click a user. On the Edit menu, point to 
User, and click Connect to All Workflows.

To connect all users to all 
workflows

• On the Edit menu, point to System, and click Connect All 
Users to All Workflows.

To connect one workflow 
to one output device

• In the layout area, right-click a workflow, point to 
Connected Output Device, and click an item that does not 
have a check mark next to it.

• In the layout area, click a workflow. On the Edit menu, 
point to Workflow, point to Connected Output Device, and 
click an item that does not have a check mark next to it.

To connect one output 
device to one workflow

• In the layout area, right-click an output device, point to 
Connected Workflows, and click an item that does not have 
a check mark next to it.

• In the layout area, click an output device. On the Edit 
menu, point to Output Device, point to Connected 
workflows, and click an item that does not have a check 
mark next to it.

To connect one output 
device to all workflows

• In the layout area, right-click an output device, and click 
Connect Output Device to All Workflows.

• In the layout area, click an output device. On the Edit 
menu, point to Output Device, and click Connect Output 
Device to All Workflows.
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2 Make sure that the system configuration is fully online.

A fully online system configuration is indicated by green arrows from user through to output 
device. A red rectangle means that that stage of the system configuration is offline.

Do any of the following:

• Click all red rectangles.

• Right-click an object, and click the following items (see table below).

• Click an object (user, workflow or output device). On the Edit menu, point to the 
appropriate item, and click an item:

 

TO SET A SYSTEM CONFIGURATION OFFLINE

Occasionally, you may need to make alterations to a system configuration — for example:

• You may need to add or delete a user.

• You may need to change workflow settings.

• You may need to connect a workflow to a different printer.

• You may need to service an output device.

To make changes to a system configuration, you must first stop the system configuration at 
the appropriate stage of job processing. Depending on what changes need to be done, you 
may be able to lessen the inconvenience to users by rerouting to an alternative workflow, or by 
connecting the workflow temporarily to a different output device.

You can interrupt a system configuration as follows:

• You can disconnect a user, a workflow, or an output device from the system configuration.

• You can set the system configuration offline at a certain stage.

Setting a system configuration 
online
1 Online
2 Offline

1

1

2

2

Object Menu item

User “user name” is Offline

Workflow Workflow Accepts New Jobs 
Workflow Processes and Prints Jobs

Output device “Printer name” is Offline
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1 Go to System Manager. In the layout area, set the required stage of the workflow offline.

Do any of the following:

• Click a green arrow to turn it into a red rectangle.

• Right-click an object, and click the following items (see table below).

• Click an object (user, workflow or output device). On the Edit menu, point to the 
appropriate item, and click an item:

Object Menu item

User “User name” is Online

Workflow Workflow Accepts New Jobs 
Workflow Processes and Prints Jobs

Output device “Printer name” is Online

Setting a system configuration 
offline

1 2 3 4

1 Prevents the user from logging on

2 Prevents automatic job detection. For example, hot folders are no longer 
monitored.

3 Prevents jobs from being processed by Fiery XF automatically. Stopping the 
workflow at this stage is the equivalent of loading an on-hold job.

4 Prevents jobs from being printed.
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2 Right-click a line connecting two objects, and click Disconnect.

Disconnect users, workflows, and output devices, as required. 

You can also use the following menu items:
 

Action Description

To disconnect one user 
from one workflow

• In the layout area, right-click a user, point to Connected 
Workflows, and click an item that has a check mark next to 
it.

• In the layout area, click a user. On the Edit menu, point to 
User, point to Connected Workflows, and click an item that 
has a check mark next to it.

• In the layout area, right-click a workflow, point to 
Connected Workflows, and click an item that has a check 
mark next to it.

• In the layout area, click a workflow. On the Edit menu, 
point to Workflow, point to Connected Users, and click an 
item that has a check mark next to it.

To disconnect one user 
from all workflows

• In the layout area, right-click a user, and click Disconnect 
from All Workflows.

• In the layout area, click a user. On the Edit menu, point to 
User, and click disconnect from All Workflows.

To disconnect all users 
from all workflows

• On the Edit menu, point to System, and click Disconnect 
All Users from All Workflows.

To disconnect one 
workflow from one 
output device

• In the layout area, right-click a workflow, point to 
Connected Output Device, and click an item that has a 
check mark next to it.

• In the layout area, click a workflow. On the Edit menu, 
point to Workflow, point to Connected Output Device, and 
click an item that has a check mark next to it.

To disconnect one output 
device from one workflow

• In the layout area, right-click an output device, point to 
Connected Workflows, and click an item that has a check 
mark next to it.

• In the layout area, click an output device. On the Edit 
menu, point to Output Device, point to Connected 
workflows, and click an item that has a check mark next to 
it.
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To disconnect one output 
device from all workflows

• In the layout area, right-click an output device, and click 
Disconnect Output Device from All Workflows.

• In the layout area, click an output device. On the Edit 
menu, point to Output Device, and click Disconnect 
Output Device from All Workflows.

Action Description
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WORKSPACES

A workspace is a custom view of Fiery XF. It defines what settings you can see. Your 
workspaces were initially assigned to you by the Fiery XF administrator who set you up as a 
user. You can further customize your view of Fiery XF to suit your specific needs.

If you do not have administrator rights, you can only select and customize the workspaces that 
are assigned to you. If you have administrator rights, you can additionally create and manage 
workspaces in Workspace Manager.

Selecting workspaces
If you have been assigned more than one workspace, you can switch to a workspace whose 
feature set has been set up for a different workflow environment.

TO SELECT A WORKSPACE

1 Do one of the following:

• On the tab bar, click the menu button, and point to Workspace.

• On the menu bar, click Workspace.

2 Click an item.

Select one of the following:

• A default workspace

– FULL provides access to Fiery XF’s full range of licensed features.

– PRODUCTION provides access to all settings that are required in a production 
workflow, but hides those settings that are specifically aimed at a proofing 
environment.

– PROOFING provides access to all settings that are required in a proofing workflow, 
but hides those settings that are specifically aimed at a production environment.

Depending on your user settings, you may not have access to some or all of the default 
workspaces.

• A custom workspace (if available)

If you have administrator rights, you can create your own custom workspaces.

See also:

“Creating workspaces” on page 71
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Customizing workspaces
You can simplify a workspace, by hiding tabs and panes that you do not need. Reducing the 
number of visible features makes it easier to find your way around the software. 

TO SHOW/HIDE A TAB

1 Do one of the following:

• On the tab bar, click the menu button, and point to Show.

• On the menu bar, click Workspace, and point to Property Tabs.

The menu displays the available tabs.

2 Click an item.

To hide a tab, click an item that has a check mark next to it.

To show a hidden tab, click an item that does not have a check mark next to it. To show all 
hidden tabs, click All.

TO SHOW/HIDE A PANE

1 On the pane bar, click the menu button, and click Hide.

The pane is hidden from property inspector.

To show a hidden pane, right-click anywhere in property inspector, point to Show, and click 
an item that does not have a check mark next to it. To show all hidden panes, click All.

Creating workspaces
If you have administrator rights, you can create new workspaces and edit existing workspaces. 
The default workspaces that are provided with Fiery XF cannot be edited.

You can create a workspace in two ways:

• You can save the current program view as a workspace.

• You can create a workspace in Workspace Manager.

TO SAVE THE CURRENT PROGRAM VIEW AS A WORKSPACE

This type of custom workspace enables you to save and apply settings to future jobs quickly 
and easily.

1 Do one of the following:

• On the tab bar, click the menu button, point to Workspace, and click Save Workspace.

• On the menu bar, click Workspace, point to Workspace, and click Save Workspace.

The Save Workspace dialog box appears.
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2 Enter a workspace name.

3 Click Save.

Workspaces are automatically available to all users with administrator rights. They can be 
assigned manually to other users.

TO CREATE A WORKSPACE IN WORKSPACE MANAGER

1 Do one of the following:

• On the tab bar, click the menu button, click Workspace, point to Workspace, and click 
Workspace Manager.

• On the menu bar, click Workspace, and click Workspace Manager.

2 Do one of the following:

• Click New. A new workspace corresponds to the default workspace “FULL”. It provides 
access to Fiery XF’s full range of licensed features.

• In the left-hand column, click an existing workspace (default or custom), and click 
Duplicate to copy the workspace settings.

New and duplicated workspaces are created with a default name. Overwrite the default name 
with a unique name, and press <Enter>.
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3 In the System Manager and Job Explorer columns, select the panes that you want to be visible 
in the workspace.

Select or clear the check boxes, as required. The currently applied settings from each pane are 
saved to the workspace, not the default settings.

4 Do one of the following:

• Click Apply to save your settings. Then click Close.

• Click Close. The Confirm dialog box appears. Click Yes to save your settings and to exit 
Workspace Manager.

Workspaces are automatically available to all users with administrator rights. They can be 
assigned manually to other users.

See also:

“To assign a workspace” on page 74

Editing workspaces
You can make changes to an existing workspace.

TO EDIT A WORKSPACE

1 Do one of the following:

• On the tab bar, click the menu button, point to Workspace, and click Workspace 
Manager.

• On the menu bar, click Workspace, and click Workspace Manager.

• In the layout area, click a user. On the Profile pane, open the Workspace tab, and click 
Edit.

2 In the left-hand column, click a workspace.

3 In the System Manager and Job Explorer columns, select or clear the check boxes.

The current settings from each pane, not the default settings, are saved to the workspace.

4 Do one of the following:

• Click Apply to save your settings. Then click Close.

• Click Close. The Confirm dialog box appears. Click Yes to save your settings and to exit 
Workspace Manager.

The workspace is updated. Users must restart the Fiery XF client to access the updated 
workspace. Until then, the original workspace settings continue to be available.
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Deleting custom workspaces
Make sure that the custom workspace is not selected for any user. You cannot delete a 
workspace that is currently selected.

TO DELETE A CUSTOM WORKSPACE

1 Do one of the following:

• On the tab bar, click the menu button, point to Workspace, and click Delete Workspace.

• On the menu bar, click Workspace, point to Workspace, and click Delete Workspace.

The Delete Workspaces dialog box appears.

2 Click a workspace name.

Multiple selections are possible.

3 Click Delete.

The Confirm dialog box appears.

4 Click Yes to delete the workspace.

5 Click Close to close the Delete Workspaces dialog box.

Assigning workspaces
When you have created a new workspace, you can assign it to specific users.

TO ASSIGN A WORKSPACE

1 Go to System Manager. In the layout area, click a user. On the Profile tab, open the Workspace 
pane.

2 Select the check box next to the workspace.

Users with no administrator rights cannot see the System Manager settings that have been 
made for that workspace.

You can deny the user access to a workspace by clearing the appropriate check box.

3 Save your changes.
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JOB LIST AND PREVIEW WINDOW

The preview window displays the image of a job that is selected in the job list. The job is 
previewed on the virtual sheet size. By default, the virtual sheet size is the same as the media 
size that is selected for the output device.

You can make changes to a previewed job before printing.

See also

“To set up a virtual sheet size” on page 35

Activating the preview
If the workflow is not set up to create previews, jobs are displayed as a gray box in the preview 
window, and the “Thumbnail” column of the job list is empty.

You can force a preview for a single job, or you can change the workflow setting.

TO SET UP A PREVIEW WORKFLOW

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Preview pane.

2 On the pane bar, select the check box to activate the settings.

Job Explorer
1 Job list
2 Preview window
3 Selector

2

1

3
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3 Define a resolution for the preview in dots per inch or in pixels.

If you need to edit individual pixels in a preview image, it is recommended that you select a 
high resolution. The higher the resolution, the sharper the image in a zoomed-in view, and 
the more precisely you can edit the image.

4 Save the workflow.

TO FORCE A PREVIEW OF A LOADED JOB

1 Do one of the following:

• In the job list, right-click the job, and click Preview.

• In the job list, click the job. On the Edit menu, click Preview.

Job list
The job list provides an overview of loaded jobs. The job status is color coded for easy 
recognition.

Customizing the job list
You can customize the information that is displayed in the job list:

• You can add additional columns.

• You can rearrange the order of columns.

• You can sort the order in which jobs are listed.

• You can filter the job list.

TO ADD OR REMOVE COLUMNS

In addition to the default column headings, you can display other job-specific information.

1 In the job list, right-click on any column heading, and click an item.

To add a column, click an item that does not have a check mark next to it. To remove a 
column, click an item that has a check mark next to it. The columns “Job Status” and “File 
Name” cannot be hidden.

TO REARRANGE THE COLUMN ORDER

1 Drag a column heading to the left or to the right.

The columns “Job Status”,and “File Name” cannot be rearranged.
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TO SORT THE JOB ORDER

By default, jobs are listed in the order in which they are loaded in Fiery XF. However, you can 
sort jobs according to any column heading. 

1 Click a column heading.

For example, click Job Name to sort jobs alphabetically, or click Job Size to sort jobs according 
to data volume.

An up or down arrow becomes visible in the column heading, and the jobs are resorted. Click 
the column heading again to reverse the sort order.

TO FILTER THE JOB LIST

By default, all loaded jobs are displayed in the job list. The selector enables you to filter the 
job list. For example, you can list only jobs that are loaded in a specific workflow, or that have 
a certain status. Jobs that do not meet the selected criterion are not visible in the job list.

1 Make sure that the selector is shown.

2 At the top of the selector, select “By Workflow”, “By Status”, or “By Printer”.

3 In the selector, click an item (a workflow, a status, or a printer).

The job list displays only those jobs that meet the specified criterion. To redisplay all jobs, 
click All Jobs.

See also:

“To customize the Job Explorer window” on page 28

Thumbnail images
The job list can display thumbnail images of all loaded jobs for easy recognition of content. 
To display thumbnail images, make sure that the preview setting is switched on. Make sure 
also that the “Thumbnail” column is displayed in the job list.

TO CHANGE THE SIZE OF THUMBNAIL IMAGES

1 In the job list, right-click a job, point to Thumbnail Size and click an item.

You can choose from small, medium or large.

See also:

“Activating the preview” on page 75

“Customizing the job list” on page 76
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Copying and moving jobs
You can copy or move loaded jobs between workflows and printers.

TO COPY OR MOVE JOBS TO A DIFFERENT WORKFLOW

1 Do one of the following:

• In the job list, right-click a job, point to Copy to Workflow, or Move to Workflow, and 
click an item.

• In the job list, click a job. On the Edit menu, point to Copy to Workflow, or Move to 
Workflow, and click an item.

You can copy or move jobs to any workflow to which you have access.

The Hold Job dialog box appears.

2 Do one of the following:

• Click No to start job processing immediately.

• Click Yes if you want to edit the job first.

The job is copied or moved to the new workflow. All previous job settings are overridden by 
the settings of the new workflow.

TO COPY OR MOVE JOBS TO A DIFFERENT PRINTER

1 Do one of the following:

• In the job list, right-click a job, point to Copy to Printer, or Move to Printer, and click an 
item.

• In the job list, click a job. On the Edit menu, point to Copy to Printer, or Move to Printer, 
and click an item.

You can copy or move jobs to any printer to which you have access.

The Hold Job dialog box appears.

2 Do one of the following:

• Click No to start job processing immediately.

• Click Yes if you want to edit the job first.

The job is copied or moved to the first workflow that is connected to the selected printer. All 
the job settings are transferred with the job. The job is printed using the media settings of the 
selected printer.
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Preview window

Changing the appearance of the preview window
You can change the size of the preview area:

• You can increase the size of the preview window.

• You can scale a preview.

• You can zoom in or out on a previewed area.

TO CHANGE THE SIZE OF THE PREVIEW WINDOW

1 Do one of the following:

• On the View menu, click Maximize Preview.

This setting increases the size of the preview window so that it fills the whole screen. All 
other parts of the Fiery XF program window are hidden.

To show the Fiery XF program window again, click Maximize Preview to clear the check 
mark.

• Rest the pointer along the line that separates preview window and job list. Drag the 
pointer downwards to increase the size of the preview window. Drag the pointer upwards 
to increase the size of the job list.

Be careful not to rest the pointer on the sash bar in the middle of the dividing line. If you 
click the pointer on the sash bar, you hide the preview window.

TO SCALE A PREVIEW

You can scale a preview in relation to the preview window. 

1 On the View menu, point to Fit to, and click an item.

The default setting is “Window”. It scales the sheet to fill the preview window.

You can scale a page to the width or height of the preview window. In a nesting, you can select 
multiple pages and scale the selection to fill the preveiw window. You can also scale a page to 
its actual size.

TO ZOOM IN OR OUT ON A PREVIEWED PAGE

1 Do one of the following:

• In the job list, click a job.

• In the preview window, click a page.
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2 Do one of the following:

• In the zoom box, type or select a scaling factor. 

The drop-down list box provides scaling factors from 5% to 4000%.

• On the toolbar, click the zoom tool, and click the area of the preview that you want to 
enlarge. Each time you click in the preview, the size of the preview increases by 100%. To 
zoom out, press <Alt> and click the zoom tool.

The zoom tool remains selected until you clear it. To clear the zoom tool, on the toolbar, 
click Transform Job.

• On the View menu, click Zoom in or Zoom Out.

Each time you zoom in, the size of the preview increases by 100%. Each time you zoom 
out, the size of the preview decreases by 100%.

Visual aids for page alignment
The following visual aids are available to help you with page alignment on the sheet:

• Rulers

• Guides

• Grid

• Marks

• Page Frame

• Overlaps

• Sheet Margins

Some types of visual aid can be given a magnetic property, which causes pages in their 
proximity to snap to them.

TO SHOW VISUAL AIDS

1 On the View menu, point to Visual Aids, and then click an item.

To show all visual aids, click All.

To hide a visual aid, click an item that has a check mark next to it. To clear all visual aids, click 
None.

TO ACTIVATE THE SNAP-TO FEATURE

1 On the View menu, point to Snap to, and click an item.

The snap-to feature is available for guides, and grid. In a nesting, you can also make objects 
snap to each other.
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Rulers

You can display rulers along the top and left edges of the preview window. The rulers are 
displayed in the system of measurement that is set up for Fiery XF.

By default, the 0, 0 coordinates are positioned at the top left corner of the sheet.

To set the 0, 0 coordinates at a different position (for example, the corner of a page), drag the 
pointer from the ruler intersection area of the preview window to the required position.

To reset the 0, 0 coordinates, double-click the ruler intersection area of the preview window.

Rulers
1 Default 0, 0 coordinates
2 Ruler intersection area for 

changing or resetting the 
0, 0 coordinates

2

1
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Guides

Guides are non-printable lines. By activating the snap-to feature, guides can be given a 
magnetic property, which causes pages in their proximity to snap to them.

To create a guide, drag the pointer from the horizontal or vertical ruler.

You can lock guides at their current position. On the View menu, click Lock Guides. To 
unlock guides, click Lock Guides again to remove the check mark.

To move a guide, rest the pointer on a guide. The pointer changes into a split line. Drag the 
guide to a new position. It is not possible to move locked guides.

To remove a guide, rest the pointer on a guide. The pointer changes into a split line. Drag 
horizontal guides to the horizontal ruler and vertical guides to the vertical ruler.

To remove all guides, on the View menu, click Clear Guides.

Guides are automatically deleted when you exit Fiery XF.

Guides
1 Intersecting guides

1
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Grid

The grid is a set of evenly spaced, non-printable, horizontal and vertical lines. The grid 
spacing is fixed, but adapts automatically according to the selected zoom factor. By activating 
the snap-to feature, the grid markings can be given a magnetic property, which causes pages in 
their proximity to snap to them.
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Marks

If you have set up your job with crop marks or cut marks, you can hide them from the 
preview. The position of the page on the sheet does not change.
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Page Frame

You can preview each page with a black border. By displaying page borders, you can check if a 
page has white space around it that is overlapping other pages in a nesting.
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Overlaps

You can display pages that are overlapping the sheet border or overlapping other pages. 
Overlapping pages are displayed with a red border.
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Sheet margins

You can display the non-printable margins as defined by the printer's firmware. By ensuring 
that pages are placed within the non-printable margins, you can avoid unwanted cropping in 
the printout.

See also:

“To activate the snap-to feature” on page 80
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EDITING JOBS

The preview window displays the image of the job that is selected in the job list. You can make 
manual changes to a job before printing.

If the workflow is not set up to create job previews automatically, jobs are displayed as a gray 
box in the preview window. In this case, you must to activate the preview before you can make 
manual job changes.

Depending on the workflow settings, job processing may start automatically as soon as the job 
is loaded in the job list. The following options are available to you to stop the job from being 
unnecessarily processed and printed before you have made changes:

• You can cancel job processing. 

• You can load jobs as “hold” jobs.

• You can set the workflow offline at workflow exit.

It is not possible to make job changes after you have created a step and repeat or a tiling. If 
you need to make changes, you must first reset the step and repeat or tiling.

See also:

“To cancel job processing” on page 34

“Activating the preview” on page 75

“To load a job in Fiery XF” on page 186

“To set a system configuration offline” on page 66

Rotating a job
You can rotate jobs by 90, 180, or 270 degrees. If you select “Minimal media consumption”, 
images are rotated automatically if media wastage can be reduced in this way.

TO ROTATE A JOB

1 Go to Job Explorer. In the job list, click the job.
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2 Do one of the following:

• On the Layout tab, open the Layout Options pane. Under “Rotate”, select an angle of 
rotation.

• In the preview window, right-click the page, point to Rotate, and click an angle of 
rotation.

• On the toolbar, click Transform Job. Click the down arrow next to the Rotation Angle 
button, and click an angle of rotation.

• In the preview window, rest the pointer on a page edge near to, but not directly on, a 
handle. The pointer changes into an arrowed circle. Drag the pointer in the direction that 
you want to rotate the page. When you release the mouse button, the page “snaps” to the 
nearest angle of rotation that is divisible by 90.

Mirroring a job
You can flip a job along its horizontal or vertical axis.

TO MIRROR A JOB

1 Go to Job Explorer. In the job list, click the job.

2 Do one of the following:

• On the Layout tab, open the Layout Options pane. Under “Mirror”, select a check box.

• On the toolbar, click Transform Job. Click Flip Horizontally or Flip Vertically.

• In the preview window, right-click the page, point to Rotate, and click Flip Horizontally or 
Flip Vertically.

Scaling a job
You can increase or decrease the output size of a job by applying a scaling factor.

TO SCALE A JOB FREELY

You can scale a job by dragging the previewed image.

In the preview window, rest the pointer on a corner handle of the page. The pointer changes 
into a double-headed arrow. Drag the image to scale the page.

By default, the page retains its proportions. If you change the height, the width is adjusted 
accordingly, and vice versa. To scale width and height by different factors, click the Scale 
Proportionally button to deactivate proportional scaling. When proportional scaling is 
deactivated, the button has a gray background
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You can activate proportional scaling by hold down <Shift> when you drag the image, or by 
clicking the Scale Proportionally button. When proportional scaling is activated, the button 
has a blue background.

TO SCALE A JOB RELATIVE TO THE SHEET SIZE

The following settings are available:

1 Go to Job Explorer. In the job list, click the job.

2 Do one of the following:

• On the Layout tab, open the Layout Options pane. Under “Scale page”, select an item.

• In the preview window, right-click the page, point to Scale, point to “Fit to”, and click an 
item.

• On the Edit menu, point to Scale, point to Fit to, and click an item.

TO SCALE A JOB AS A PERCENTAGE

You can scale a job by a percentage. A value greater than 100% increases the size of the page. 
A value less than 100% decreases the size of the page.

1 Go to Job Explorer. In the job list, click the job.

Setting Description

Fit to sheet size The job width or the job height is scaled to the printable width 
or height of the media, whichever is reached first.

Fit to width The job width is scaled to the printable width of the media. 
This may mean that the height of the image is clipped in the 
printout.

You can use the preview to check the effect of this setting, and 
to make sure that the page will fit properly on the selected 
media size.

Fit to height The job height is scaled to the printable height of the media. 
This may mean that the width of your image is clipped.

You can use the preview to check the effect of this setting, and 
to make sure that the page will fit properly on the selected 
media size.

This setting is not available for roll media.
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2 Do one of the following:

• On the Layout tab, open the Layout Options pane. Under “Scale page”, select “Scale job 
percentually”. In the boxes, type a width, or a height.

By default, the page retains its proportions. If you change the height, the width is adjusted 
accordingly, and vice versa. To scale width and height by different factors, click the Scale 
Proportionally button to deactivate proportional scaling. When proportional scaling is 
deactivated, the button has a gray background.

• On the toolbar, click Transform Job (1), and click the % button (2) to activate percentual 
scaling. Type a value in the appropriate box (4)(5) to define a width or height.

By default, the page retains its proportions. If you change the height, the width is adjusted 
accordingly, and vice versa. To scale width and height by different factors, click the Scale 
Proportionally button (3) to deactivate proportional scaling. When proportional scaling is 
deactivated, the button has a gray background.

• In the preview window, right-click the page, point to Scale, point to Percentual, and click 
an item.

• On the Edit menu, point to Scale, point to Percentual, and click an item.

TO SCALE A JOB NUMERICALLY

You can scale a job by defining page dimensions as numeric values.

1 Go to Job Explorer. In the job list, click the job.

2 Do one of the following:

• On the Layout tab, open the Layout Options pane. Under “Scale page”, select “Scale job 
numerically”. In the boxes, type a width, or a height.

By default, the page retains its proportions. If you change the height, the width is adjusted 
accordingly, and vice versa. To scale width and height by different factors, click the Scale 
Proportionally button to deactivate proportional scaling. When proportional scaling is 
deactivated, the button has a gray background.

Toolbar
1 Transform Job button
2 Scale Percentually button
3 Scale Proportionally button
4 Edit boxes for width and 

height

1

2

3

4

4
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• On the toolbar, click Transform Job (1), and click the % button (2) to deactivate 
percentual scaling. When percentual scaling is deactivated, the button has a gray 
background. Type a value in the appropriate box (4) to define a width or height.

By default, the page retains its proportions. If you change the height, the width is adjusted 
accordingly, and vice versa. To scale width and height by different factors, click the Scale 
Proportionally button (3) to deactivate proportional scaling. When proportional scaling is 
deactivated, the button has a gray background.

TO OUTPUT AN OVERSIZED JOB

By default, Fiery XF outputs jobs in their original size. However, if the job will not fit fully on 
the media, job processing is aborted with an error message. You can output an oversized job 
by instructing Fiery XF to print jobs that exceed the media size. In this case, the image is 
clipped in the output.

1 Go to Job Explorer. In the job list, click the job. On the Layout tab, open the Layout Options 
pane, and select the “Print jobs that exceed printable area” check box .

2 On the toolbar, click Print.

To output a job without clipping, you can scale the job, or you can set up the printer for a 
larger media size.

Cropping a job
You can change or increase the focal point of an image by removing unwanted background 
space.

TO CROP A JOB

1 Go to Job Explorer. In the job list, click the job.

2 On the toolbar, click the down arrow next to the Transform Job button, and click Crop Job.

Toolbar
1 Transform Job button
2 Percentual scaling button
3 Scale Proportionally button
4 Edit boxes for width and 

height

1

2

3

4

4
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3 In the preview, drag the pointer to select the section of the page that you want to crop.

Visual aids are available to help you to specify an exact area.
 

You can finetune the selected area before cropping it. 

• To reposition a crop box, hold down <Alt> and drag the pointer from the center of the 
crop box.

• To resize a crop box, do one of the following:

– Rest the pointer on a handle along an edge of the crop box. The pointer changes into a 
double-headed arrow. Then, drag the pointer.

– On the toolbar, in the appropriate boxes, type new values. You can change the 
dimensions of the crop area. Alternatively, you can adjust the margin width between 
the edge of the image and the crop area.

Toolbar
1 Crop Job button
2 Dimensions of crop area
3 Top/bottom margin widths
4 Left/right margin widths

1

2 3 4
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• To cancel a selected crop area, do one of the following:

– Press <Esc>.

– On the toolbar, click Reset.

– Right-click anywhere in the preview window and click Cancel crop.

When you are satisfied with the size and position of the crop box, proceed to the next step to 
crop the selected area.

4 Do one of the following:

• Press <Enter>.

• Double-click the mouse button.

• Right-click anywhere in the preview window and click Apply crop.

In the case of images with crop marks, the crop marks are reapplied to the newly cropped area. 

See also:

“Visual aids for page alignment” on page 80
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Aligning pages on the sheet
You can realign and reposition pages on the sheet.

TO ALIGN PAGES ON THE SHEET

1 Go to Job Explorer. In the job list, click the job.

2 Do one of the following:

• Align the page on the sheet

On the Layout tab, open the Layout Options pane. Under “Align page to sheet”, click a 
cell in the diagram. You can align pages vertically and horizontally. This setting takes the 
printer margins into account. 

Vertical page alignment is not possible for roll media.

• Define job margins

On the Layout tab, open the Layout Options pane. Under “Job margin”, type margin 
widths in the appropriate boxes. This setting takes the printer margins into account.

You can apply identical margins to all four sides by clicking the appropriate button, and 
defining a top margin only.

If you define margins for a nested page, remember to lock the page at its current position 
so that it is not automatically rearranged when you update the preview.

• Type in x/y coordinates

This setting defines the x/y coordinates for the top left-hand corner of the page on the 
sheet. On the toolbar, click Transform Job, and type x/y coordinates in the appropriate 
boxes.

The default setting takes the printer margins into account. You can instruct Fiery XF to 
ignore the printer margins by entering values of “0” for the top and left margins.

Visual aids are also available to help you to position pages exactly on the sheet.

See also:

“Visual aids for page alignment” on page 80

Toolbar
1 Transform Job button
2 Left margin
3 Top margin

1

2

3
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POSTSCRIPT AND PDF JOBS

Additional settings are available for PostScript and PDF jobs.

Print engines
Fiery XF supports:

• Adobe PostScript 3 Engine (also known as Configurable PostScript Interpreter or CPSI)

– CPSI can process PostScript level 3 jobs and PDF jobs with up to 127 separations. 
During job processing, jobs are converted to PostScript format.

– CPSI supports contour cutting.

– CPSI does not support native ICC profiles and ICC profile tagging in PDF objects.

• Adobe PDF Print Engine (also known as APPE)

– APPE can process PDF jobs with up to 32 separations without converting them to 
PostScript format. If APPE is applied to a PDF job with more than 32 separations, the 
print engine automatically switches to CPSI. The maximum number of separations 
that can be processed is 127.

– If APPE is applied to a job with cut contours, the printer engine automatically switches 
to CPSI.

– APPE supports native ICC profiles and ICC profile tagging in PDF objects.

– APPE can process composite jobs quicker than CPSI.

You can speed up job processing by increasing the number of Adobe print engines that are 
used.

TO SWITCH TO A DIFFERENT PDF PRINT ENGINE

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Under “PDF print engine”, click an item.

Select the CPSI or APPE print engine.

3 Save your changes.
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TO SWITCH TO A DIFFERENT IMAGE EPS/PDF PRINT ENGINE

The image EPS/PDF print engine determines whether jobs are output with the internal EFI 
module or with CPSI.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Under “Image EPS/PDFprint engine”, click an item.

• Click “Native” to output a single EPS image that is saved in a PDF frame. Only the EPS 
image is output, and not the surrounding PDF frame. This setting results in a quicker 
processing time and better output quality since, if the image is an RGB image, the selected 
source profiles are applied. This feature was developed mainly for users who print directly 
from Photoshop.

• Click "Adobe PostScript 3 Engine" to output a job with the PDF frame. This setting is 
automatically applied if the job contains more than one EPS image.

3 Save your changes.

See also:

“Adobe print engines” on page 367

EPS job detection
You can apply the following settings to EPS jobs:

• You can change the length of time that Fiery XF waits to receive all job separations.

By default, when you load a separated job, Fiery XF waits five seconds before assuming 
that the job is complete. However, for large-volume, separated EPS jobs, more time may 
be necessary to ensure that all color separations are processed as one job. Conversely, for 
EPS composite files, reducing the waiting time ensures that your jobs are output as quickly 
as possible.

• You can change the default input resolution to prevent a white edge from appearing 
between images in step-and-repeat jobs.

Occasionally, Fiery XF has difficulty correctly extracting and interpreting the resolution of 
incoming PS and PDF files. Rounding down errors may occur which cause a white edge to 
be output along the right and bottom edges of images — the result of missing pixels. The 
problem occurs only in step and repeat jobs, where a thin white line may be visible 
between images, even though no spacing is defined. You can remedy the problem by 
changing the default input resolution.
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TO CHANGE THE WAITING TIME FOR JOB COMPLETION

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Under “Waiting time for job completion”, type the number of seconds that Fiery XF waits to 
receive color separations for each job.

3 Save your changes.

TO CHANGE THE DEFAULT INPUT RESOLUTION

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Under “EPS job detection”, type a new input resolution.

Values of between 1 dpi and 720 dpi are possible. Selecting the input resolution size from the 
image helps to prevent rounding down errors.

3 Save your changes.

In-RIP separation
In-RIP separations are spot colors that have been defined in an external DTP or in a graphics 
program and saved as a single job file. You can output in-RIP information as follows:

• You can output in-RIP information as separated files.

• You can convert in-RIP information to the color space of the output device and print it as 
a composite job.

TO MAKE A SETTING FOR IN-RIP SEPARATION

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.
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2 Under “PS/PDF”, click an item.

3 Save your changes.

Setting Description

Enable PDF jobs with in-RIP separations are printed as separated files (C, M, Y, 
K, plus spot colors). Jobs with no in-RIP information are simply printed 
composite (CMYK).

Disable In-RIP information is ignored. PDF jobs are printed composite 
(CMYK). Note that pre-separated files are always printed separated, even 
though they do not contain in-RIP information.

Force In-RIP information is applied to PostScript level 3 and PostScript level 2 
jobs, as well as to PDFs that were created with older versions of Acrobat.

PostScript files with in-RIP separations normally require a special 
PostScript command to ensure that the in-RIP information is interpreted 
correctly. However, not all PostScript printers support in-RIP 
separations — PostScript level 3 does, PostScript level 2 does not. 

By forcing in-RIP separation, you make sure that the in-RIP information 
from the graphics program is processed, even if the special PostScript 
command is missing, and regardless of the type of PostScript printer that 
was used to create the file.

If you do not force the use of in-RIP separation, jobs are output as 
follows:

• PostScript jobs that were created for a PostScript level 3 printer are 
output separated on printers that support in-RIP separation. If the 
printer does not support in-RIP separation, the job is output 
composite.

• PostScript jobs that were created for a PostScript level 2 printer are 
always output composite, because spot color separations cannot be 
correctly interpreted.
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Page size definition
• PDF jobs

The page size of PDF jobs can be defined by the media box, the crop box, the bleed box, 
the art box, or the trim box.

Page boxes in PDF files

1 Media box
2 Bleed box
3 Trim box/Crop box
4 Art box

1

2

3

4

Media box Specifies the width and height of the page. The MediaBox is slightly 
larger than the actual dimensions of the printed page in order to 
include elements that extend beyond the edge of the paper, such as 
bleed and crop marks.

Bleed box Defines the region to which the contents of the page must be clipped 
when output in a production environment.

Trim box Defines the intended dimensions of the finished page after trimming. 
This type of box is used by imposition applications for arranging the 
order of pages.

Crop box Defines the region to which the contents of the page must be clipped 
when displayed or printed.

Art box Defines the region to which the contents of the page must be clipped 
when output in a production environment.
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• PostScript jobs

The page size of PostScript jobs is defined by the bounding box. Fiery XF can retrieve and 
process this page size information. However, the page definition is not always exact, due to 
rounding up or down errors that can occur when printing from some graphics programs. 
Such inaccuracies can result in image distortion in the printout. You can instruct Fiery XF 
to ignore the page size information from such jobs and to calculate the page size internally 
during job processing. 

TO SPECIFY THE SIZE DEFINTION

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Under “Size definition”, click an item.

• For PDF jobs, select an appropriate page size definition.

• For PostScript jobs, select “Calculate page size”. In this case, the page size is calculated by 
Fiery XF during job processing. The process is slower than extracting the information 
from the job, but the result is more accurate.

3 Save your changes.

Applying a working color space
You can determine which source profile is applied to PDF jobs. For PDF jobs that contain 
mainly RGB images, applying the RGB source profile ensures that you achieve the best 
possible color quality.

CMYK workflow

RGB workflow
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TO APPLY A WORKING COLOR SPACE

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Under “Working color space”, click an item.

Note the following:

• CMYK must be used in proofing workflows.

• CMYK must be used for PostScript jobs with cut contours. This is because the RGB 
working color space converts all spot colors to RGB, which prevents the cut contour from 
being extracted.

3 Save your changes.

Overprinting in composite jobs
Intentionally printing one layer of ink on top of another is known as overprinting. 
Overprinting is sometimes used to avoid the need for trapping and to prevent gaps from 
appearing between colors.

On a printing press, each color of ink that is used in a document is printed one at a time. In 
other words, each printing plate is made up only of components in one color. Color-separated 
files are created in Cyan, Magenta, Yellow, Black, plus any spot colors that are included in the 
job.

The example above shows what happens when two elements of 100% black and 50% gray 
overlap another shape of 40% Cyan.

40% Cyan

Black Gray

100% 50%
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When printed, the black overprints the cyan. This is because the cyan element is not visible 
through the 100% solid black ink. Knocking out the cyan could produce a white gap where 
the two elements join if there is even a slight misalignment between the printunits of the 
printing press.

In the case of the 50% gray, a white hole (or knockout) is left in the cyan for the gray to be 
placed. If the knockout were not performed on the cyan plate, the gray ink would mix with 
the cyan, producing an area of darker cyan.

It is not possible to print overlapping colors as a composite job because overlapping colors will 
not print on top of each other. However, in Fiery XF, you can simulate the effect of 
overprinting in composite jobs.

TO SIMULATE OVERPRINTING IN COMPOSITE JOBS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

• Go to Job Explorer. In the job list, click the job. On the File tab, open the PS/EPS/PDF 
pane.

2 Select “Simulate overprinting in composite jobs”.

This setting has no effect on separated jobs.

3 Save your changes.

If you have a license for the Spot Color Option, overprinting is incorporated into the settings 
for in-RIP separation. Therefore, it is recommended that you simulate overprinting in 
composite jobs only under the following circumstances:

• If you do not have a license for the Spot Color Option

• If you have a license for the Spot Color Option but in-RIP separation is disabled

Non-embedded fonts in PDF jobs
By default, if a PDF job contains non-embedded fonts, the missing fonts are simply replaced 
with the font Courier. However, you can instruct Fiery XF to stop job processing if a missing 
font is detected. Stopping job processing gives you an opportunity to embed missing fonts 
and reload the job before printing.

TO SET UP A WORKFLOW FOR NON-EMBEDDED FONTS

1 Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

2 Select “Stop job processing if font is missing”.

3 Save your changes.
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If you load a PDF or PostScript job that contains non-embedded fonts, the missing fonts are 
listed on the Warning/Error pane of the File tab.

TO PRINT A JOB WITH NON-EMBEDDED FONTS

If the job stops because non-embedded fonts are detected, you can override the workflow 
setting and continue job processing. If you continue with job processing, the missing fonts are 
replaced with Courier.

1 In the job list, click the job. On the File tab, open the PS/EPS/PDF pane.

2 Clear “Stop job processing if font is missing”.

3 Save your changes.

Loading multi-page jobs as single pages
By default, multi-page PDF files are loaded in Fiery XF as single jobs. If you make changes, 
the job settings are applied to all pages.

However, you may not always achieve the desired result. For example, if you crop an area of 
one page, the setting is applied to all pages. Similar problems can also arise if you apply crop 
marks to a PDF that contains pages of different sizes. You can overcome potential problems by 
loading each page separately.

TO LOAD MULTI-PAGE JOBS AS SINGLE PAGES

1 Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
PS/EPS/PDF pane.

2 Select “Divide multi-page PDF files into single page jobs”.

3 Save your changes.
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TIFF/IT AND SCITEX JOBS

TIFF/IT and Scitex CT/LW jobs are composed of a CT (image data), an LW (text data) file 
and, possibly, a final page.

Settings are available to ensure that the files are all detected as being part of the same job.

TO ENSURE THAT TIFF/IT FILES AND SCITEX FILES ARE DETECTED CORRECTLY

1 Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
TIFF/IT, Scitex CT/LW pane.

2 Under “Give priority to”, select an item.

If you give priority to TIFF/IT files, Fiery XF waits until both files are detected before 
processing the job.

If you give priority to CMYK TIFF files, which consist of one file only, Fiery XF starts job 
processing as soon as the file is detected.

3 Select an item for job recognition.

Many files are created with a final page. A final page ensures that the CT file and the LW file 
are detected as being part of the same job.

If no final page is available, Fiery XF tries to match the files by their names. If the end 
characters of the file names are different, they are not detected as belonging to the same job. 
You can instruct Fiery XF to ignore an appropriate number of characters so that both files are, 
in effect, shortened to the same name.

The job cannot be combined if no final page is available, and if Fiery XF cannot match the 
files to one job by their names.

4 Save your changes.
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SEPARATED JOBS

To print an image on an offset printing press, the image has to be separated into a minimum 
of four basic ink colors: Cyan, Magenta, Yellow, and Black. Each single-color layer is printed 
separately on top of the other to create an impression of an infinite number of different colors. 
This process is known as process color separation.

In Fiery XF, you can output separations for CMYK jobs, RGB jobs, and multi-color jobs, 
including spot colors.

TO PRINT SEPARATED FILES

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Output tab, open 
the Advanced Print Options pane.

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Advanced 
Print Options pane.

2 Under “Separations”, select an item.

• You can merge all separations into one composite job

• You can print out each separation in color

• You can print out each separation in grayscales
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3 Select “Invert colors” (optional).

This setting is used to create a color negative. You can invert the colors of composite jobs or of 
separated (color and grayscale) jobs.

4 Save your changes.

By default, all the separations are printed when you click Print. However, you can omit one or 
more separations from the print job, if required.

You can use the buttons on the toolbar to scroll through the separations in the preview. 

See also:

“Excluding spot colors from the job” on page 282
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NESTINGS

The nesting feature outputs multiple files collectively as a single job.

Setting up a nesting
You can create:

• A nesting workflow

In a nesting workflow all jobs are printed as part of a nesting. Fiery XF arranges the pages 
on the nesting sheet in accordance with the workflow settings. Jobs are processed when a 
defined state has been reached.

• A manual nesting

In a manually created nesting you have full control over which jobs are nested and how 
they are arranged on the sheet.
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TO SET UP A NESTING WORKFLOW

In a nesting workflow, job processing starts automatically when one of the following criteria 
has been met:

• The defined percentage of the sheet area has been filled

• The defined percentage of a line has been filled

• The defined length of time has elapsed since the last job was loaded

This setting overrides the other two settings. In other words. a nesting is processed after 
the set period of time, even if the minimum percentage of the sheet or line has not been 
filled.

1 Go to System Manager. In the layout area, click the workflow. On the Layout tab, open the 
Nesting pane.

2 On the pane bar, select the check box to activate the settings.

3 On the Nesting pane, complete your settings.

Use the settings to define:

• A criterion for creating a nesting

• The layout (scaling, orientation, rotation, spacing) of nested pages

4 Save the workflow.

Fiery XF automatically adds all jobs to the current nesting and outputs them according to the 
workflow settings.

TO CREATE A MANUAL NESTING

You can create a nesting from jobs that are already loaded in Fiery XF. You can nest multiple 
copies of a job by selecting the number of print copies.

It is a good idea to load jobs as “hold” jobs, so that job processing does not start as soon as 
jobs are added to the job list. However, some jobs cannot be loaded as “hold” jobs — for 
example, jobs that are loaded via a hotfolder. In this case, you can cancel job processing or set 
the workflow offline at workflow exit to prevent jobs from being processed unnecessarily.

1 Go to Job Explorer. Do one of the following:

• In the job list, right-click one or more jobs. Then, click New Nesting.

• In the job list, click one or more jobs. On the toolbar, click Create Nesting.

By clicking “All Jobs” in the Selector, you can create a nesting from jobs that are loaded in 
different workflows. If you select jobs in different workflows, a dialog box appears for you to 
select the workflow in which to create the nesting. Select a workflow and click Choose.

A nesting is created. By default, nested jobs are arranged on the media size that is set up for 
the output device. If required, you can set up a media size that overrides the default setting. 
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See also:

“Nesting (System Manager)” on page 423

“Nesting (Job Explorer)” on page 425

“To set up a virtual sheet size” on page 35

“To define the number of printed copies” on page 189

Nestings: user interface

1

2

3

4 5 6

7

Legend Description

1 Page on a nesting. Pages can be in any supported file format.

2 Nesting sheet. By default, nested jobs are arranged on the media size that is set 
up for the printer. You can override the default sheet size by selecting a virtual 
sheet size. A virtual sheet can be bigger or smaller than the default sheet size. If 
the nesting sheet is bigger, you can output the nesting as a tiling.

3 All Jobs button. Click to display all loaded jobs. This enables you to create a 
manual nesting of jobs that are loaded in different workflows.

4 Tree view of job list. It shows the nesting with nested pages.

5 Locks a page at the current position on the sheet. Click the padlock icon to lock 
or unlock a page. A locked page (closed padlock) cannot be modified, nor can it 
be rearranged on the sheet. To make modifications, you must unlock the page 
(open padlock).
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Modifying nested pages
You can apply job settings, such as color adjustments, cropping and mirroring, to nested 
pages.

Be aware that nesting settings, such as scaling and rotation, override job settings. So, for 
example, if the nesting is set up for uniform page scaling, you cannot apply a different scaling 
factor to an individual job.

You can position pages by defining top or left margins, or by entering coordinates. Visual aids 
and a snap-to feature are also available to help you to align pages exactly on the sheet.

When you have made changes, update the preview to rearrange pages in accordance with the 
new settings.

TO UPDATE THE PREVIEW

1 In the job list, click the nesting.

2 Do one of the following:

• On the Layout tab, open the Nesting pane and click Apply.

• On the Nesting menu, click Apply.

The pages are rearranged.

If required, you can prevent a page from being rearranged when you update the preview, by 
locking it in its current state and position.

See also:

“Visual aids for page alignment” on page 80

“Editing jobs” on page 88

“Aligning pages on the sheet” on page 95

“To lock a page” on page 117

6 Shows placed and unplaced pages. Placed pages are visible in the preview and can 
be printed. Unplaced pages are not visible in the preview and cannot be printed. 
Select or clear the appropriate check box to place or unplace a job. Jobs that are 
too big to fit on the nesting sheet must be scaled down before they can be placed.

7 Apply button. Click to rearrange nested pages according to the settings on the 
Nesting pane, and to update the preview.

Legend Description
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Managing nested pages and sheets
A new nesting consists always of one sheet and the pages that you selected when you created 
the nesting. This section informs you how to add new pages and sheets, and how to delete 
pages and sheets that are no longer needed.

TO NEST A NEW PAGE

Be aware that nesting settings override job settings. For example, if you have set up the nesting 
for uniform page scaling, the scaling factor of a job will change automatically when it is added 
to the nesting. Similarly, job rotation may be undone if the nesting is set up to allow rotation 
of pages in order to conserve media space.

1 Do one of the following:

• In the job list, right-click the nesting and click Add Job to Nesting. 

• Drag a job from the job list on to the nesting in the job list.

The page is arranged in the nesting. Be aware that pages that are too big to fit on the nesting 
sheet cannot be automatically placed. In this case, reduce the scaling factor. Then, in the job 
list, select “Placed” for the new job, and update the preview.

TO DELETE A NESTED PAGE

1 Do one of the following:

• In the job list, right-click the nested page, and click Delete.

• In the job list, click the nested page and press <Del>.

• In the preview, right-click a page, and click Delete.

TO REMOVE A PAGE FROM A NESTING

1 In the job list, right-click the nested page and click Remove from Nesting.

The job remains in the job list but is no longer part of the nesting.

TO CLONE A NESTED PAGE

You can create copies of nested pages. The page must already be part of the nesting.

1 Do one of the following:

• In the job list, right-click a job. On the Edit menu, click Clone. 

• In the preview, right-click a job, and click Clone.

• In the preview, select a job. On the Edit menu, click Clone.

The Clone Image dialog box appears.
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2 Enter the number of clones you want to create, and click Clone It!.

The cloned pages are placed in the nesting, but are not automatically arranged.

3 Update the preview.

You can apply individual job settings to each clone. However, if you delete the original, all the 
clones are deleted also.

You can also clone jobs by using copy and paste (Ctrl + C, Ctrl + V) to create a simple step 
and repeat. Afterwards, click Apply to rearrange the cloned pages on the sheet. As with cloned 
pages, if you delete the original, the copy is deleted also.

TO DELETE A CLONED PAGE

1 Do one of the following:

• In the job list, right-click a cloned page, and click Delete.

• In the preview, right-click a cloned page, and click Remove Clone.

TO ADD A NEW NESTING SHEET AND MOVE PAGES TO IT

A new nesting consists always of one sheet. If you nest more pages than can fit on the sheet, 
additional sheets are automatically created.

In a manual nesting, you can add new sheets manually and move pages to it. The page must 
already be part of the nesting. You cannot move jobs from one nesting to another.

It is not possible to add new sheets if the nesting is set up for roll media.

1 In the job list, click the nesting.

2 Do one of the following:

• Right-click an empty area of the preview window and click New Sheet.

• On the Nesting menu, click New Sheet.

A new sheet is added.

3 Select the nested page that you want to move to the new sheet.

You can click the page in the job list or in the preview.

4 On the Edit menu, click Cut.

The page is added to the clipboard.

5 Go to the new sheet.

You can use the buttons on the toolbar to scroll to the new sheet. Alternatively, on the Nesting 
menu, point to Go to, and click a sheet.

6 On the Edit menu, click Paste.

The page is inserted from the clipboard.
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7 Move the page to the required position on the new sheet.

8 Lock the page at its current position.

You must lock the page at a fixed position on the sheet to ensure that it is not rearranged and 
moved to a a different sheet when you update the preview.

TO DELETE A NESTING SHEET

1 Do one of the following:

• On the Nesting menu, click Delete Sheet.

• Right-click an empty area of the preview window and click Delete Sheet.

The sheet is deleted. If the deleted sheet contained pages, the pages remain in the job list but 
are no longer placed. You can rearrange the pages by selecting “Placed” and updating the 
preview.

See also:

“Visual aids for page alignment” on page 80

“Aligning pages on the sheet” on page 95

“To lock a page” on page 117

Aligning nested pages
You can align nested pages relative to each other on the sheet. You can also specify the layer 
order of overlapping pages.

TO ALIGN AND DISTRIBUTE NESTED PAGES

1 Select multiple pages in the nesting. Do one of the following:

• In the job list, hold down <Ctrl> and select the required pages.

• In the preview, hold down <Shift> and select the required pages.

• In the preview, right-click a page, point to Select and click All (to align and distribute all 
pages in the nesting).
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2 Align the selected pages, using one of the following methods:

• On the toolbar, click Align, and click an alignment type.

• Right-click anywhere in the preview and click an alignment type.

• On the Edit menu, point to Align, and click an alignment type.

You can align pages relative to each other on a sheet. Pages can be aligned according to their 
upper, lower, left or right edges or according to their vertical or horizontal centers.

3 Distribute aligned pages evenly on the sheet, using one of the following methods:

• On the toolbar, click Align, and click a distribution type.

• Right-click anywhere in the preview and click a distribution type.

• On the Edit menu, point to Align, and click a distribution type.

You can distribute pages relative to each other on a sheet. Pages can be distributed according 
to their upper, lower, left or right edges or according to their vertical or horizontal centers.

The pages are rearranged.

Aligned upper edges ...

... and horizontal centers 
distributed
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TO CHANGE THE LAYER ORDER OF OVERLAPPING PAGES

You can nest overlapping pages. Overlapping pages must be locked on the sheet to ensure that 
they are not rearranged when you update the preview.

1 In the preview, select an overlapping page.

Overlapping pages are identified by a red border.

2 Move the page up or down to a different layer. Do one of the following:

• On the toolbar, click Order, and click an order type.

• Right-click anywhere in the preview, and click an order type.

• On the Edit menu, point to Order, and click an order type.

The layer order is changed.

See also:

“To lock a page” on page 117

General nesting settings

TO RENAME A NESTING

New nestings are created with a default name. You can overwrite the default name with a 
unique name.

1 Do one of the following:

• In the job list, right-click the file name “Nesting” and click Rename.

• In the job list, click the file name “Nesting”. Then click the left mouse button again.

The file name changes into an editable box.
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2 Overwrite “Nesting” with a new name.

Copy, Paste, Cut, and Delete commands are available if you right-click on the nesting name.

3 Click anywhere outside the box to apply the change.

TO ADD A FOOTER

You can print out a footer for each page and for each sheet of a nesting. A footer can contain:

• A job ticket with information pertinent to the job

• One or two control strips for verifying color accuracy

TO CHANGE THE ALIGNMENT OF NESTED PAGES

You can align nested pages with the left, right, top or bottom edge of the sheet. Bottom 
alignment is not available for roll media.

TO LOCK A PAGE

You can lock a page in its current state, and at its current position on the sheet. By locking 
pages, you can prevent them from being modified, and from being rearranged when you 
update the preview.

1 In the job list, click the job.

2 In the “Locked” column, click the padlock icon.

If the “Locked” column is not displayed in the job list, right-click on any column heading, 
and click Locked.

See also:

“Aligning pages on the sheet” on page 95

“Footer” on page 131

Nesting footer
1 Page footer
2 Sheet footer

1
2
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TILING

If you have a license for the Production Option, you can use the tiling feature to print images 
that would normally exceed your printer’s maximum print size. Images are printed as tiles, 
and can be pieced together later to produce an oversize poster or banner.

You can create tiles from single jobs, from nestings and from step and repeats.

TO SET UP A TILING WORKFLOW

1 Go to System Manager. In the layout area, click the workflow. On the Layout tab, open the 
Tiling pane.

2 On the pane bar, select the check box to activate the settings.

3 On the Tiling pane, complete your settings.

4 Save the workflow.

When you load a job, Fiery XF automatically creates a tiling according to the workflow 
settings.

TO CREATE A MANUAL TILING

1 Go to Job Explorer. In the job list, click the job. On the Layout tab, open the Tiling pane.

2 On the pane bar, select the check box to activate the settings.

3 On the Tiling pane, complete your settings.
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4 Click Apply.

A tiling is creating. If you selected standard tiling, the default tile size is equal to the media size 
that is set up for the output device. 

See also:

“Tiling (System Manager)” on page 431

“Tiling (Job Explorer)” on page 433

Tilings: user interface

4

5

2
1

3

Legend Description

1 A selected tile is displayed in turquoise.

2 Individual tiles can be printed or omitted from the job.

3 A selected tile edge is displayed in red. Tile edges can be locked in a fixed 
position. Locked tile edges are displayed in gray.

4 Tiles can be output with overlapping to make it easier to piece them together 
after printing.

5 Apply button. Click to create a tiling or to update the preview in accordance 
with the settings made on the Tiling pane.
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Modifying tilings

TO MAKE CHANGES TO THE ORIGINAL JOB

It is not possible to modify the layout options (scaling, orientation, rotation, alignment) of a 
page in a tiled state. To modify the layout options, you must first deactivate tiling, by clearing 
the check box on the pane bar. After you have made your changes, reselect the check box on 
the pane bar. Then, click Apply to update the tiling.

Each time you update a tiling, the default settings are applied. Therefore, if you have created 
custom tiles, it is a good idea to save the settings as a preset before modifying the job. A preset 
is a template for a group of settings that are saved under a unique name. You can create presets 
in the presets menu in the pane bar. The next time you set up a tiling, you need only to select 
the preset name.

TO RESIZE ROWS AND COLUMNS

You can resize rows and columns of tiles to avoid awkward joins in your image, such as down 
the middle of a face.

Changing the size of one row or column causes the adjacent row or column to stretch or 
shrink accordingly. It is not possible to create tiles that exceed the size of the selected media.
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1 Do one of the following:

• Hold down the mouse button on a tile edge. Drag the tile edge to the new position and 
release the mouse button. The current pointer position is displayed in the preview window 
to help you to pinpoint the x or y coordinate of the edge more easily.

• Click a tile edge. On the toolbar, type an x or y coordinate for the tile edge in the 
appropriate box.

• Click a tile. On the toolbar, type a new width or height in the appropriate boxes.

TO RESIZE INDIVIDUAL TILES

You can resize individual tiles to avoid awkward joins in your image, such as down the middle 
of a face.

1 Do one of the following;

• Hold down <Alt>, and hold down the mouse button on a tile edge. Drag the tile edge to 
the new position and release the mouse button. The current pointer position is displayed 
in the preview window to help you to pinpoint the x or y coordinate of the edge more 
easily.

• Hold down <Alt>, and click a tile edge. Release the <Alt> button. On the toolbar, type an 
x or y coordinate for the tile edge in the appropriate box.
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General tiling settings

TO LOCK A TILE EDGE AT ITS CURRENT POSITION

You can lock a tile edge at a fixed position in the image. By locking tile edges, you can avoid 
joins in obtrusive places.

1 Do one of the following:

• Click a tile edge. On the toolbar, click the padlock button.

• Right-click a tile edge, and click Lock Tile Edge.

TO SELECT MULTIPLE TILES

1 Do one of the following:

• To select non-adjacent tiles, hold down <Ctrl>, and click individual tiles.

• To select adjacent tiles, hold down <Shift>, and click the first tile that you want to select. 
Then, click the last tile that you want to select. All the tiles in the rows in between are 
selected too.

TO MERGE TILES

1 Select two or more adjacent tiles.

2 Right-click the selected tiles, and click Merge Tiles.

The tiles are merged. However, be aware that it is not possible to merge tiles whose combined 
size would exceed the selected media size.

TO SPLIT A TILE INTO MULTIPLE TILES

1 Right-click a tile, and click Split Tile.

The Split Tile dialog box appears.

2 Type the number of horizontal and vertical tiles to crreate, and click OK.

The tile is split into the defined number of smaller tiles. The smallest possible tile size is one 
square inch.
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TO HIDE TILES

You can hide tiles from the preview. By hiding tiles, you can view the image more clearly.

1 Do one of the following:

• On the View menu, point to Visual Aids, and click Tiles.

To show the tiled page, click the command again.

• On the toolbar, click Transform Job.

To show the tiled image again, on the toolbar, click Tile Job.

TO EXPORT TILE SETTINGS

You can save the width, height and x/y coordinates of each tile as well as overlapping 
information as a specification sheet in Excel format. The specification sheet is a useful aid to 
installation crews who have the task of piecing the printed tiles together.

1 Right-click a tile and click Export settings.

The tile settings are saved as an Excel file in the Working folder.

TO PRINT TILES AND TILINGS

1 Do one of the following:

• To print the tiling, use the normal print command.

• To print individual tiles, right-click the tiles, and click Print Tile Immediately.

• To remove individual tiles from the print job, right-click the tiles, and click Do Not Print.
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TO DISPLAY A WYSIWYG TILE PREVIEW

You can display a WYSIWYG preview of one or all tiles.

1 On the Tiling pane, click Tiling Preview.

The Tiling Preview window appears. 

The Tiling Preview window is divided into two tabs. You can preview a single tile, or you can 
preview all tiles simultaneously. Displayed tiles are overlaid with the tile number. The tile 
numbers of the surrounding tiles are also displayed.

Tiles cannot be edited in the Tiling Preview window. However, if you resize tiles in 
Job Explorer. the change is applied immediately to the Tiling Preview window.

You can use the tools at the bottom of the window to do the following:

• Scroll through the tiles to preview a different tile.

• Scroll through the pages of a multi-page job.

• Zoom in or out on a preview. Type or select a scaling factor. The drop-down list box 
provides scaling factors from 5% to 4000%.

• Save the preview as a PDF file and use it as a guide to help you to piece the tiles together 
after printing. From the drop-down list box, select whether you want to save a single tile or 
all tiles, and click Save.
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STEP AND REPEAT

You can use the step-and-repeat feature to clone multiple copies of a job. The available 
settings make it possible to achieve many different and interesting wallpaper patterns.

You can create a step and repeat from single or multi-page jobs. If the job has multiple pages, 
each page forms one page of the step and repeat. The settings are applied identically to all 
pages. In this way, you can output a step-and-repeat job on a duplex printer for double-sided 
printing.

By default, step and repeats are created on the size of the media that is selected for the output 
device. If required, you can set up a media size that overrides the default setting.

TO SET UP A STEP-AND-REPEAT WORKFLOW

1 Go to System Manager. In the layout area, click the workflow. On the Layout tab, open the 
Step and Repeat pane.

2 On the pane bar, select the check box to activate the settings.
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3 On the Step and Repleat pane, complete your settings.

4 Save the workflow.

When you load a job, Fiery XF automatically creates a step and repeat according to the 
workflow settings.

TO CREATE A MANUAL STEP AND REPEAT

It is recommended that you apply job settings, such as scaling, rotation, and color 
adjustments, before you create a step and repeat.

1 Go to Job Explorer. In the job list, click the job. On the Layout tab, open the Step and Repeat 
pane.

2 On the pane bar, select the check box to activate the settings.

3 On the Step and Repleat pane, complete your settings.

4 Click Apply.

A step and repeat is created.

After you have created a step and repeat, the padlock icon in the top right-hand corner of the 
original job indicates that the job cannot be modified.To apply job settings, you must first 
delete all the copies.

See also:

“Step and Repeat (System Manager)” on page 427

“Step and Repeat (Job Explorer)” on page 429

“To set up a virtual sheet size” on page 35

“Editing jobs” on page 88

“Modifying step and repeats” on page 126

Modifying step and repeats
After you have created a step and repeat, the padlock icon in the top right-hand corner of the 
original job indicates that the job cannot be modified. To apply job settings, such as color 
adjustments, cropping and mirroring, to step and repeat jobs, you must first delete all the 
copies, by clearing the check box on the Step and Repeat pane bar. After you have made your 
changes, reselect the check box on the pane bar. Then, click Apply to update the step and 
repeat.

You can position pages by defining top or left margins, or by entering coordinates. Visual aids 
and a snap-to feature are also available to help you to align pages exactly on the sheet.
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If you work regularly with different step-and-repeat settings, it is a good idea to save the 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up a 
step and repeat, you need only to select the preset name.

See also:

“Visual aids for page alignment” on page 80

“Aligning pages on the sheet” on page 95

Renaming a step-and-repeat
New step and repeats are created with a default name. You can overwrite the default name 
with a unique name.

TO RENAME A STEP AND REPEAT

1 Do one of the following:

• In the job list, right-click the file name “StepAndRepeat” and click Rename.

• In the job list, click the file name “StepAndRepeat”. Then click the left mouse button 
again.

The file name changes into an edit box.

2 Overwrite “StepAndRepeat” with a new name.

Copy, Paste, Cut, and Delete commands are available if you right-click on the name of the 
step and repeat.

3 Click anywhere outside the box to apply the change.
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JOB MERGE

You can use the job merge feature to superimpose one job on top of another. The master job 
forms the background image for your content jobs.

You can merge any two jobs. The only prerequisites are:

• The content and master jobs must have the same page size. A size difference of plus or 
minus 0.1 inch is permitted.

• The background color of the content job must be defined as 100% transparent.

• Master and content jobs must have the same file extension.

If the content job is a multi-page document, the master job is applied to all pages of the 
document.

If page layout settings (rotation, scaling, etc.) or crop marks are applied to the content job, the 
settings are also applied to the merged job. However, color management settings are not 
transferred.

TO SET UP A WORKFLOW FOR AUTOMATIC JOB MERGE

1 Go to System Manager. In the layout area, click the workflow.

2 On the File tab, open the Job Merge pane.

3 On the pane bar, select the check box to activate the settings.

Job merge
1 Master file
2 Multi-page content file 

(imported into Fiery XF as 
a nesting)

3 Merged files

1 2 3
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4 In the appropriate boxes, type the file names of your master (background) and content jobs.

The file names must contain a keyword that is common to both master and content jobs.

The table below gives some examples of job merge job names.

5 Save your changes.

When you load master and content jobs, Fiery XF automatically merges them. The content 
job is superimposed on the master job. The master job disappears from the job list.

Master and content jobs must be loaded together. If you load first the master job and then the 
content job, the jobs cannot be merged.

TO MERGE JOBS MANUALLY

Manually merged jobs do not have to comply to a specific naming convention.

1 Go to Job Explorer. In the job list, click the job that will be the master (background) job.

2 On the File tab, open the Job Merge pane.

3 On the pane bar, select the check box to activate the settings.

4 Select “Master job”.

5 Save your changes.

6 In the job list, click the job that will be superimposed on the master job.

7 On the File tab, open the Job Merge pane.

8 On the pane bar, select the check box to activate the settings.

9 Select “Content job”.

10 From the drop-down list box, select the master job that you want to use as the background.

11 Save your changes.

File names for master and 
content jobs

Common keywords Master file 
identified by:

Content file 
identified by:

2013_Master_Customer.pdf

2013_Content_Customer.pdf

EFI_Master.pdf

EFI_Content.pdf

2013, Customer

EFI

Master Content

2013_EFI.pdf

2013_Exhibition.pdf

EFI_January_2013.pdf

Exhibition_January_2013.pdf

2013

January_2013

EFI Exhibition
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The content job is previewed superimposed on the defined master job.

Unlike in automatic job merge workflows, the master job remains in the job list after merging. 
As long as the master job is loaded in Job Explorer, you can apply it to other content jobs.
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FOOTER

You can output a footer at the bottom of each page or sheet.

A footer can contain:

• A job ticket with information pertinent to the job. It tells you what settings were applied 
to achieve the print result.

• Up to two control strips or media wedges. You can use control strips and media wedges to 
check the color consistency of proofing jobs.

By default, the job ticket is printed on the left of the footer, with one or two control strips on 
the right next to it. Job ticket and control strips are automatically placed on separate lines for 
all nested jobs, or if the sheet is not wide enough.
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Job ticket
The job ticket can consist of an image and up to six lines of text. 

TO CREATE A JOB TICKET

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

To create a job ticket for a nesting, click the nesting job, not a nested page.

2 On the Layout tab, open the Job Ticket pane.

3 On the pane bar, select the check box to activate the settings.

4 Select “Job Ticket for Page” or “Job Ticket for Nesting”.

• For single jobs, select “Job Ticket for Page”.

• For nestings, select “Job Ticket for Nesting” to create a job ticket for the whole nesting. 
Select “Job Ticket for Page” to create a job ticket for each page of the nesting. A nesting 
can have both types of job ticket.

5 Click Edit to review or edit the default job ticket settings.



FOOTER 133

The job ticket settings are arranged on panes. You can expand or collapse the settings for each 
pane by clicking anywhere in the pane bar.

By default, the job ticket includes the Fiery logo. You can replace the Fiery logo with your 
own image file by clicking Upload and browsing to an image file. You can upload any image 
file in JPEG or TIFF format. Alternatively, if you do not want to include an image, select 
“None”. 

The maximum permitted image size is 5 x 5 cm. If you upload a file that exceeds these 
dimensions, it will be scaled proportionally so that either the width or the height is reduced to 
5 cm. Images that are smaller than 5 x 5 cm are output in their original size. Images are always 
output color managed, providing color management is activated.

Select the appropriate check boxes to specify the content of lines 1 to 6. Line 6 has room for 
custom text.

If you work regularly with different job tickets, it is a good idea to save your settings as a 
preset. A preset is a template for a group of settings that is saved under a unique name. The 
next time you set up a job ticket, you need only to select the preset name.

6 Click OK.

Control strips and media wedges
Control strips and media wedges are made up of rows of color patches. You can use a 
spectrophotometer (color measuring device) and any color checker program, such as Verifier, 
to measure the color patches and verify color consistency between printouts.

If you have a license for the Verifier Option, you can measure the colors of a printout against 
a reference (for example, Fogra MK 11) to verify ISO 12647-7-compliancy.

You can select the following:

• A control strip or media wedge that is shipped with Fiery XF.

• Your own control strip. Control strip files must be saved to the ControlStrip folder. 
Fiery XF can process all supported file formats except separated files. There is no size 
restriction.

• A dynamic wedge. A dynamic wedge is made up of the job’s most prominent colors. Each 
dynamic wedge is, therefore, unique to that job.

TO SELECT A CONTROL STRIP OR A MEDIA WEDGE

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

To select a control strip for a nesting, click the nesting job, not a nested page.

2 On the Verify tab, open the Control Strips pane.
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3 Select a control strip or media wedge.

Make sure that you select a control strip that is compatible with your measuring device. 

4 Apply color management to the control strip (optional).

If color management is applied, the color patches are compressed into the color gamut of the 
selected reference profile. Select “Print with color management” to check the accuracy of the 
media profile.

If color management is not applied, the control strip is printed using the full color gamut of 
the printer. Clear “Print with color management” to check the color accuracy of two printers.

5 Select the control strip for the nesting sheet (optional).

By default, control strips are printed for each page.

For nestings, you can print the control strip for each page, or just once for the whole nesting. 
By selecting two control strips, you can select one control strip for the nested pages and one 
control strip for the nesting sheet.

Dynamic wedges can be created only for pages.

6 Repeat the above steps for control strip 2 (optional).

Some printers with an embedded measuring device can measure only one control strip per 
job.

7 Save your changes.

Nesting footer
1 Page footer
2 Sheet footer

1
2
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TO SELECT A DYNAMIC WEDGE

A dynamic wedge is made up of the job’s most prominent colors. For example, if a job is 
composed mainly of shades of blue, the dynamic wedge will have a high proportion of blue 
patches. As with other types of control strips, you can use the dynamic wedge to verify color 
accuracy.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

2 On the Verify tab, open the Control Strips pane.

The dynamic wedge is available for control strip 1 only.

3 Select “DynamicWedge”.

Dynamic wedges are always created for a page. In a nesting, it is not possible to create a 
dynamic wedge for a sheet.

4 Select the measuring device that you will use to measure the dynamic wedge.

5 Select the number of color patches for the dynamic wedge.

16, 32 and 64 color patches are possible. Fewer patches are printed if all the job’s key colors 
can be represented by using less than the selected number of patches.

6 Select whether you want to create a dynamic wedge that consist of process colors (CMYK), 
spot colors, or a mixture of both.

The dynamic wedge can also display L*a*b* spot color gradients. To define L*a*b* spot color 
gradients, you require a license for the Spot Color Option.

Dynamic wedge
1 Dynamic colors extracted 

from job
2 Generic media wedge in 

preview window

1

2
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7 Select “In-gamut colors only” (optional).

This setting maps out-of-gamut colors to the outer edge of the printer gamut. It ensures that 
the dynamic wedge is composed only of colors that are within the printer gamut and can, 
therefore, be realistically reproduced by the printer.

Select this setting to check how well the media profile can reproduce the printer gamut. Clear 
this setting to measure if the printout is color consistent with the original job.

In Job Explorer, you can see the effect of this setting on the Control Strips pane. A warning 
message is displayed next to colors that are not within the color gamut of the printer. If you 
select “In-gamut colors only”, a new dynamic wedge is created with colors that fit into the 
printer gamut.

8 Save your changes.

A preview is always created for jobs with a dynamic wedge, even if the preview setting is 
cleared. The preview displays a generic media wedge. The colors that have been extracted 
from the job are visible in the printout and in Job Explorer on the Control Strips pane.

See also:

“Verify workflows in Fiery XF” on page 312

Footer layout
You can change the footer layout as follows:

• You can place the job ticket and control strips on separate lines.

• You can change the horizontal and vertical distance between footer and page edge.

• You can change the width and height of the job ticket.

• You can change the font size of the job ticket.

• You can realign the footer in relation to the sheet.

TO PLACE THE JOB TICKET AND CONTROL STRIPS ON SEPARATE LINES

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

In a nesting, the job ticket and control strips are automatically placed on separate lines 
under each page.

2 On the Layout tab, open the Job Ticket pane.

3 On the Job Ticket for Page or Job Ticket for Nesting tab, click “Must not exceed page size”.
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4 Save your changes.

For nestings, you may need to update the preview. 

TO CHANGE THE DISTANCE BETWEEN FOOTER AND PAGE

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

2 On the Layout tab, open the Job Ticket pane.

3 Type in the horizontal or vertical distance between footer and page.

The vertical setting changes the distance between the bottom edge of the page and the footer. 
The horizontal setting indents the footer in relation to the left edge of the page. Page footers 
for nested pages cannot be indented.

4 Save your changes.

For nestings, you may need to update the preview.

TO CHANGE THE WIDTH AND HEIGHT OF THE JOB TICKET

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

2 On the Layout tab, open the Job Ticket pane.

3 Type in a maximum width for the job ticket.

The default width of a job ticket is the width of the page, minus the width of selected control 
strips.

4 Type in a maximum height for the job ticket.

If the job ticket information can be displayed in less than 5 cm, you can reduce the ticket 
height to prevent unwanted white space between job ticket and a control strip that is below it.

The default height is 5 cm. If a job ticket exceeds the defined ticket height, it is cropped.

5 Type in a font size.

You can specify any font size between 6 pt and 72 pt.

6 Save your changes.

For nestings, you may need to update the preview.
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TO REALIGN THE FOOTER IN RELATION TO THE SHEET

Changing the page alignment does not automatically change the footer alignment. For 
example, the footer remains left-aligned on the sheet, even if the page is centered.

You can apply the alignment setting to both page and footer. In this case, page and footer are 
realigned as if they were grouped together.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

2 On the Layout tab, open the Layout Options pane.

3 Click “Align footer”.

In a nesting, this setting is applied to the nesting footer, but not to the footers of nested pages.

4 Save your changes.

For nestings, you may need to update the preview.
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SELECTING PROFILES AND RENDERING INTENTS

The primary goal of color management is to obtain a good match across color devices — no 
easy feat when you consider that different devices use different color spaces to represent color. 
The most widely used color spaces are RGB (for digital cameras, monitors, and scanners) and 
CMYK (for inkjet printers and offset presses). 

Each color space can reproduce a different range of colors, known as the color gamut. The 
RGB color space has a much wider color gamut than the CMYK color space. Added to this, 
not all devices can reproduce accurately the full range of colors that is defined by the color 
space. The actual color capabilities between devices can vary greatly, and even two printers of 
the same model can produce slightly different color results.

To overcome this problem, the ICC (International Color Consortium) developed a 
recognized standard for color management systems to enable uniform, cross-device color 
reproduction. This standard is based on a series of profiles that control color reproduction 
from image creation to job output. Fiery XF uses the following to achieve color accuracy:

• Media profiles

• Source profiles

• Simulation (reference) profiles

• Rendering intents

• Monitor profiles

Visible color gamut

RGB color gamut

PANTONE color gamut

CMYK color gamut
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Media profiles
Media profiles describe the color reproduction properties of the printer for a specific media. 
The color reproduction properties are defined by the combination of media type, ink type, 
and print conditions.

TO SELECT A MEDIA PROFILE

1 Do one of the following:

• Go to System Manager. In the layout area, click the output device. On the Media tab, 
open the Print Configuration pane.

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Media 
Configuration pane.

2 Select the type of ink that is inserted in the printer.

3 Select the name of the media that you want to use.

4 Select a calibration set.

A calibration set is a base linearization file that is connected to the media profile. The base 
linearization file defines a set of print conditions and ensures that the printer’s behavior is 
adjusted optimally to the media. If multiple calibration sets are available, click Catalog to view 
the print conditions under which each calibration set was created.

For example, you can view the catalog to check for a screening file, or to check which 
halftoning method was used to create the base linearization file. v1 screening uses the 
halftoning method “Screening”. v2 screening uses the halftoning method “Error diffusion 
(SE1)” or “Stochastic screening (SE2)”.

You can create a new calibration set by creating a base linearization file and connecting it to an 
existing media profile.

It is also possible to select a base linearization file that is not connected to a media profile. 
Selecting a base linearization file that is not connected to a media profile enables you to print 
without applying color management. In this way, you can check the color reproduction 
properties of the printer. After you have created the base linearization file, copy it to the 
appropriate subfolder of the EFI Media Profiles folder.

5 Save your changes.

See also:

“Creating or editing a base linearization file” on page 154

“Profile Connector” on page 164

“Screening methods in Fiery XF” on page 357
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Source profiles and simulation (reference) profiles
Source profiles describe the color characteristics of the job. The color characteristics are 
defined in the graphics program, or by the input device. Source profiles provide a reliable way 
to predict the color results of a production run on a traditional printer. RGB source profiles 
ensure high-quality output in vivid colors. They do this by maintaining the larger RGB color 
gamut during job processing.

Simulation (reference) profiles describe the color reproduction properties of the printing 
machine that you are simulating on your inkjet printer. A set of generic profiles is provided 
with Fiery XF.

If you do not want to make your own color management settings, you can select a preset. You 
can select a preset in the presets menu in the pane bar. Color management presets for 
proofing, production, photo, business graphics, and convert to grayscale are provided with 
Fiery XF. They contain preselected source profiles and simulation profiles for standard 
workflows.

TO SELECT SOURCE PROFILES AND SIMULATION (REFERENCE) PROFILES

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow.

• Go to Job Explorer. In the job list, click the job.

2 On the Color tab, open the the Color Management pane.

3 On the pane bar, select the check box to activate the settings.

4 Under “Source profiles”, select a profile for CMYK jobs, a profile for RGB jobs, and a profile 
for grayscale jobs.

Commonly used source profiles are preselected for each color space. You can use the default 
profiles, or select source profiles that are more appropriate for your jobs.

You can select a source profile provided with Fiery XF, or one that was supplied with your 
input device. Custom source profiles must be copied to the Reference folder. Only profiles 
that are located in the Reference folder can be selected in Fiery XF.

Fiery XF does not provide multicolor source profiles, but you can implement custom 
multicolor profiles for five, six, or seven colors, by forcing the use of the source profile.

Fiery XF analyzes each loaded job and applies automatically the source profile for the correct 
color space. If no source profile is selected for the job’s color space, an error message appears.

5 Select “Use embedded profiles, if available” (optional).

This setting is applied to JPEG, TIFF, and PSD jobs with an embedded source profile. 
Embedded source profiles override the source profiles that are selected on this pane. Applying 
an embedded source profile ensures that the color properties of the input device are taken into 
account during job processing.
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6 Under “Simulation profile”, select a simulation profile.

You can load a simulation profile provided with Fiery XF or one supplied, for example, by a 
printing house.

EFI provides a number of additional customized profiles. You can find them in subfolders of 
the Reference Additional folder. To use these or custom simulation profiles, copy them to the 
Reference folder. Only profiles that are located in the Reference folder can be selected in 
Fiery XF.

You can also select “Use media profile”. In this case, the selected media profile is applied as the 
simulation profile. It ensures that you benefit from the maximum possible color gamut that 
can be achieved from the selected combination of output device, ink, and media.

This setting can most usefully be applied to PDF jobs that contain a mixture of elements in 
different color spaces (RGB, CMYK, Gray, etc.). By applying the media profile in place of the 
simulation profile, you can greatly improve the color reproduction of RGB images, since the 
media profile has a bigger color space. Thus, RGB images show much more detail and appear 
more saturated in the printout.

In the case of non-PDF jobs, it means jobs are converted directly to the color space of the 
media profile.

7 Under “Simulation profile”, select “Use PDF output intent, if available” (optional).

This setting is applied to PDF/X jobs with an embedded output intent. Embedded output 
intents override the simulation profile that is selected on this pane. This setting takes the 
selected working color space into account.
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8 Do one of the following:

• Under “Source profiles”, select a rendering intent for CMYK jobs, a rendering intent for 
RGB jobs, and a rendering intent for grayscale jobs. The table shows which rendering 
intent is most suitable for which type of job.

Rendering intent Suitable for printing ...

Absolute colorimetric (paper white) Proofs with paper white simulation

Perceptual Photographs

Saturated Business graphics in bright, saturated colors

Perceptual-absolute Photographs that need to be converted from a 
large source color space (RGB) to a smaller 
destination color space (CMYK)

Relative colorimetric (no paper 
white)

Proofs with no paper white simulation

Relative colorimetric with black 
point compensation

Absolute colorimetric with black 
point compensation

Proofs with or without paper white simulation

Black point compensation can be performed on 
top of the colorimetric rendering intents. It helps 
to preserve detail in dark or shadow regions of an 
image.
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• Select “Use dynamic rendering intent” (optional).

This setting analyzes the colors of the job and determines whether they can be accurately 
reproduced on the selected output device. Based on this analysis, the most appropriate 
rendering intent for the job is applied.

The simulation profile takes precedence over the source profile. If a simulation profile is 
selected, the dynamic rendering intent for the simulation profile is applied. If no 
simulation profile is selected, the rendering intent for the appropriate source profile is 
applied.

9 Save your changes.

If you work regularly with different profiles and rendering intents, it is a good idea to save 
each group of settings as a preset. A preset is a template for a group of settings that are saved 
under a unique name. You can create presets in the presets menu in the pane bar. The next 
time you set up color management, you need only to select the preset name.

See also:

“Applying a working color space” on page 101

“Rendering intents” on page 145

“Forcing the use of a source profile” on page 283

“Program structure” on page 377

Result of job analysis Applied 
rendering intent

Description

All colors are within the reproducible 
gamut of the output device

Relative 
colorimetric

This rendering intent 
reproduces the exact colors of 
the job and no gamut 
compression is necessary.

Some colors are outside the 
reproducible gamut of the output 
device

Perceptual This rendering intent 
compresses the colors of the 
job so that all colors can be 
printed without gamut 
clipping.
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Rendering intents
Rendering intents describe how out-of-gamut colors are adjusted to fit into the destination 
color gamut.

The color gamut of the source color space often exceeds that of the destination color space of 
the printer. When this happens, saturated colors are liable to become clipped (inaccurately 
represented). This is the reason why digital photographs that appear in vivid, saturated colors 
when viewed in the RGB color space of a digital camera or a computer monitor look dull in 
comparison when they are printed out using the smaller color space of a CMYK printer.

The illustration shows how different rendering intents project out-of-gamut colors to within 
the available color space.
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Fiery XF uses the following rendering intents:

Rendering intent Description

Absolute colorimetric 
(paper white)

This rendering intent leaves all colors within the destination color 
gamut unchanged, thus maintaining color accuracy. If the 
destination color gamut is smaller than the source color gamut, it 
may mean that two distinct colors from the source color gamut are 
mapped to the same color in the destination color gamut.

This rendering intent also simulates the color of the reference 
media. For example, if you select the simulation (reference) profile 
"ISOnewspaper26v4.icc" in combination with the rendering 
intent "Absolute colorimetric (paper white)", your image will be 
printed on a gray background to simulate the color of newsprint.

Perceptual This rendering intent preserves the visual relationship between 
colors in a way that is perceived natural to the human eye, by 
compressing all colors and scaling them to fit into the available 
destination color space. Since all colors are affected, even those that 
would normally lie within the color gamut of the destination color 
space are compressed, even if they could normally be accurately 
reproduced.

Saturated This rendering intent aims to preserve vivid color at the expense of 
accurate color. The source color gamut is scaled to the destination 
color gamut, but preserves relative saturation instead of hue. This 
means that color hues may shift if the destination color space is 
smaller than the source color space.

Perceptual-absolute This rendering intent was developed by EFI. It combines the 
advantages of the rendering intent “Perceptual”, with regard to 
image definition in areas of shadow, with the color accuracy and 
paper white simulation of the rendering intent “Absolute 
colorimetric”.

With this rendering intent, image data retains its definition in dark 
areas. It means that shades of color are still visible in areas of 
shadow.
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Device link profiles
In a normal workflow situation, the color space of the input device is transformed to the color 
space of the output device via the device-independent L*a*b* color space (known as the 
profile connection space). This process requires two different profiles — a source profile and a 
destination profile.

Relative colorimetric 
(no paper white)

This rendering intent compares the white point of the source color 
space with that of the destination color space and adjusts all colors 
accordingly. All colors that lie within the color gamut of the 
destination color space are accurately reproduced. Any colors that 
lie outside the color gamut of the destination color space are 
replaced by the colorimetrically closest color that can be 
reproduced. 

Relative colorimetric 
with black point 
compensation/

 
Absolute colorimetric 
with black point 
compensation

If the black point of the source color space differs greatly from that 
of the target color space, you can apply black point compensation 
on top of the rendering intents “Relative colorimetric” and 
“Absolute colorimetric”.

With black point compensation, the full dynamic range of the 
source color space is mapped to the full dynamic range of the 
destination color space. However, if the black point of the source 
color space is darker, contrast is lost during the conversion.

Activating black point compensation may cause gray shadows. 
However, this setting can be applied usefully to darker source black 
points.

Applying black point compensation may give more shadow detail 
and avoid gamut clipping if the darkest points of the source are 
darker than the proofing system is able to print. Differences in the 
black point are compensated for by introducing more deviation 
between target and proof shadow areas so, although the result will 
be visually better, the measured color values may not be as good.

Rendering intent Description
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A device link profile is a special kind of ICC profile that converts the color space of the input 
device directly into the color space of the output device, whereby the output device can be 
either a physical printer or a file format. Unlike ordinary source or destination profiles, device 
link profiles do not describe a specific color space, but define the conversion from a source 
color space to a destination color space. The basis for creating a device link profile is, 
therefore, always an ordinary ICC profile.

Device link profiles are most commonly applied to direct CMYK-to-CMYK transformations 
because converting via a device-independent color space can lead to undesirable effects, such 
as unsmooth color gradients. In a device link profile the color separations are maintained, thus 
preserving the black channel of the source profile.

Preserving the black channel of the input color space is one of the main advantages of using a 
device link profile. For this reason, device link profiles are often used during data 
preparation — for example, to convert from ISOcoated to ISOuncoated.

Furthermore, device link profiles enable you to by-pass the L*a*b* color space, thus 
preventing contamination by other colors. In other words, 50% black stays 50% black.

However, you should be aware that device link profiles are not as flexible in use as other ICC 
profiles. Each device link profile can be used only for the specific combination of source and 
destination profiles for which it was created.

TO SELECT A DEVICE LINK PROFILE TO OUTPUT TO A PRINTER

To output to a printer, copy the device link profile to the Profiles subfolder in which the base 
linearization file is located.

1 Go to System Manager. In the layout area, click an output device. On the Media tab, open the 
Print Configuration pane.

2 Under “Media name”, select the name of the device link profile.

The device link profile is listed under the name that you defined in Profile Connector. 
Fiery XF displays an appropriate message when a device link profile is selected.

3 Save your changes.
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TO SELECT A DEVICE LINK PROFILE TO OUTPUT TO FILE

If you have a license for the File Output Option, you can output jobs to TIFF or PDF format. 

To output to a file format, the device link profile must be saved to the Reference folder. 

1 Go to System Manager. In the layout area, click an output device. On the Device tab, open the 
Connection pane.

2 Under “Connection type”, select “Use device link profile”.

3 Under “Device link profile”, select the name of the device link profile.

The device link profile is listed under the name that you defined in Profile Connector. 
Fiery XF displays an appropriate message when a device link profile is selected.

4 Under “Profile”, select a simulation (reference) profile.

This profile is applied to jobs if they were created in a different color space from the source 
profile that is incorporated into the device link profile.

5 Select “Keep input resolution for non-PostScript files” (optional).

This setting is useful if you want to convert a set of digital files to a single color space without 
affecting the resolution (size) of the original image.

6 Save your changes.

See also:

“Creating a device link profile” on page 160

“Printing to file” on page 220

“Program structure” on page 377

Monitor profiles
Monitor profiles are used to simulate and verify color accuracy on a computer screen. This is 
known as "soft proofing". However, in the same way that the color output of each printer can 
vary greatly, so each monitor displays color slightly differently. To overcome this problem, it is 
important that the monitor is regularly calibrated to a certain standard. Monitor calibration 
consists of two steps:

• Adjusting the brightness and control settings on the monitor itself to set values

• Creating a monitor profile, which defines the white point, gamma and RGB phosphor 
settings

Windows and Macintosh computers provide standard monitor profiles as part of the 
operating system software. In Fiery XF you can select a monitor profile that you have created 
yourself or one that is provided with the operating system.
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TO SELECT A MONITOR PROFILE

1 On the Edit menu, click Monitor Profile.

The Monitor Profile dialog box appears.

2 Do one of the following:

• Click “System Monitor Profile” to select a monitor profile that was provided with the 
operating system.

• Click “Custom Profile” and click Choose to browse to a monitor profile that you have 
created yourself.

3 Click OK.
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CREATING AND OPTIMIZING PROFILES

Fiery XF provides for users with administrator rights a set of tools for improving the color 
reproduction of your output device:

• Color Tools is a standard component of Fiery XF. You can use it to optimize existing 
media profiles or to integrate third-party media profiles.

• Color Profiler Suite provides additional tools for creating and editing your own media 
profiles, simulation (reference) profiles, and device link profiles. Color Profiler Suite 
requires an additional license.

Each media profile that you select in Fiery XF has a base linearization file connected to it. The 
base linearization file was created for a specific output device. However, no two output devices 
are the same, and even mass-produced printers of the same model display slightly different 
color properties. Your output device will undoubtedly have different color properties from the 
output device for which the media profile was created.

You can improve the color output as follows:

• You can redefine the ink limits for the base linearization file to ensure that the color 
reproduction of your printer matches that of the reference printer for which the media 
profile was originally created.

• You can create a new base linearization file and media profile for your specific output 
device. This method is more precise and achieves overall better color results.

The system configuration
During program installation, a default linearization workflow and a default linearization 
device are created in System Manager. The linearization workflow must be connected to the 
linearization device. Only users with administrator rights can print jobs via this system 
configuration.

When you use Color Tools, you are required to print charts and to measure the color patches. 
The charts are automatically processed via the linearization workflow and printed out on the 
linearization device. During this process, all color management settings (profiles and 
rendering intents) from the workflow are ignored, since they affect the color output. When 
you create a base linearization file, it is important that all color measurements are based solely 
on the color capabilities of the printer.
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Setting up the linearization device
Before you can start Color Tools, you must first configure the linearization device. The 
linearization device must be set up with exactly the same settings as the output device whose 
color reproduction properties you want to optimize.

If you have already set up an output device, you can transfer the settings to the linearization 
device. This is a quick way to set up the linearization device if you want to create a new base 
linearization file or if you want to optimize an existing media profile. Afterwards, the 
appropriate color tool starts automatically. 

You can also set up the linearization device manually like any other output device. In this case, 
Color Tools does not start automatically.

TO TRANSFER PRINTER SETTINGS TO THE LINEARIZATION DEVICE

1 Do one of the following:

• Go to System Manager. In the layout area, right-click an output device that has already 
been set up, and click one of the following items:

– Click Linearize Device to create a new base linearization file.

– Click Re-linearize Device to optimize the ink densities of an existing base linearization 
file.

• Go to System Manager. In the layout area, click an output device that has already been set 
up. On the Device tab, open the PrintConfiguration pane. Under “Calibration set”, click 
New Linearization and Profile.

The printer settings are transferred to the linearization device. If the linearization device was 
previously set up for a different printer, you are warned that the current settings will be 
overwritten.

See also:

“Starting Color Tools” on page 153
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Starting Color Tools 
Before you can start Color Tools, you must first configure the linearization device.

TO START COLOR TOOLS

1 Do one of the following:

• On the toolbar, click Color Tools.

• On the Tools menu, click Color Tools.

The start screen appears with a list of available tools. Be aware that the start screen looks 
slightly different if you do not have a license for the Color Profiler Option. The Color Profiler 
Option provides tools that are concerned with profile creation.

If you set up the linearization device by transferring the settings from a different output 
device, Color Tools by-passes the start screen and starts the appropriate tool directly. You can 
return to the start screen at any time by closing an open tool.

2 Click the appropriate button to start the tool.
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The table shows the available tools:

See also:

“Setting up the linearization device” on page 152

General tips
Many of the tools require you to print out and measure color patches, so make sure that you 
have a measuring device (spectrophotometer) available. Many different measuring devices, 
including embedded measuring devices, are supported.

All linearization charts must be printed in their original size in order to avoid problems when 
measuring. Therefore, make sure that the linearization workflow is not set up to scale jobs.

Creating or editing a base linearization file
A base linearization file forms the basis for a media profile. It contains details of the quantities 
of ink that are necessary to achieve the maximum density of color for a specific combination 
of output device and media type while, at the same time, using as little ink as possible.

Tool Color Tools Color Profiler Suite

Create Base Linearization Yes Yes

Create Media Profile No Yes

Create Profile from Measurement No Yes

Optimize Profile Yes Yes

Create Device Link Profile No Yes

Create Reference Profile No Yes

Create Monitor Profile No Yes

Profile Connector Yes Yes

Edit Profile No Yes

Inspect Profile No Yes

Re-Linearization by Measurement Yes Yes

Visual Correction Yes Yes
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TO CREATE A NEW BASE LINEARIZATION FILE

1 Connect your measuring device.

2 Start Color Tools, and click Create Base Linearization.

3 Click the Info button, and follow the on-screen instructions to complete your base 
linearization.

You can save your base linearization file at any time and complete it at a later date. On the File 
menu, click Save Base Linearization.

When you have finished creating your base linearization file, do one of the following:

• Go on to create a media profile.

• Connect the base linearization file to an existing media profile.

• Select the base linearization file in Fiery XF. Selecting a base linearization file that is not 
connected to a media profile enables you to print without applying color management. In 
this way, you can check the color reproduction properties of the printer.

TO EDIT A BASE LINEARIZATION FILE

You can complete an unfinished base linearization file, or you can edit any custom or default 
base linearization file.

1 Connect your measuring device.

2 Start Color Tools, and click Create Base Linearization.
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3 Do one of the following:

• On the File menu, click Load Base Linearization, browse to a base linearization file, and 
click Open.

Use this setting to load an unfinished base linearization file and continue from where you 
left off. The only prerequisite is that you must use the same measuring device.

• When you have printed the first chart, click Import Data.

Use this setting to load measurement values that were obtained with a third-party 
program. The existing measurement values are used as the basis for creating a base 
linearization file. You can use any measuring device, except one that is embedded in the 
printer.

Alternatively, you can make quick changes to an existing base linearization file in Profile 
Connector.

See also:

“Media profiles” on page 140

“Setting up the linearization device” on page 152

“To edit a base linearization file” on page 155

“Creating a media profile” on page 156

“Profile Connector” on page 164

Creating a media profile
When you create a media profile, you create it for a specific combination of printer and 
media. To create a media profile, you must first create a base linearization file.

You cannot create a media profile if the linearization device is set up to print to file.
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TO CREATE A MEDIA PROFILE

1 Start Color Tools, and click Create Media Profile.

2 Click the Info button, and follow the on-screen instructions to complete your media profile.

When you have created your media profile, you can select it in Fiery XF.

See also:

“Media profiles” on page 140

Creating a profile from measurement data
If you already have a set of measurements (either in an IT8 file or in an existing ICC profile) 
when you start the Create Profile from Measurement tool, you can proceed directly to 
creating a new profile with the measurements. This method also provides a simple way to 
update the settings of an existing profile without changing its measurement data. 
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You have the choice of importing measurements from one or more IT8 files or from a single 
profile. If you import measurements from more than one file, the average of the imported 
measurement sets is used to create the profile. You might want to use the average of multiple 
measurements if your printer has inconsistent output or if you are trying to create a common 
profile for multiple printers. 

TO CREATE A PROFILE FROM MEASUREMENT DATA

1 Start Color Tools, and click Create Profile from Measurement.

2 Click the Info button, and follow the on-screen instructions to create your profile.

When you have created your profile, you can select it in Fiery XF.

See also:

“Media profiles” on page 140



CREATING AND OPTIMIZING PROFILES 159

Optimizing a media profile
You can greatly improve color accuracy by applying an L*a*b* optimization to a media 
profile. An L*a*b* optimization provides a better match for the color gamut of the simulation 
(reference) profile.

However, check the print quality first to ensure that an optimization is really necessary.

TO OPTIMIZE A MEDIA PROFILE

1 Connect your measuring device.

2 Start Color Tools, and click Optimize Profile.

3 Click the Info button, and follow the on-screen instructions to optimize your media profile.

You can save your L*a*b* optimization at any time and complete it at a later date. On the File 
menu, click Save Optimizing Job.

You can apply the L*a*b* optimization to the media profile during the final optimization step. 
If you do not want to apply the L*a*b* optimization by default, you can select it at any time 
in Fiery XF.

TO EDIT AN L*A*B* OPTIMIZATION

You can complete an unfinished L*a*b* optimization.

1 Connect your measuring device.

2 Start Color Tools, and click Optimize Profile.
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3 Do one of the following:

• On the File menu, click Load Optimizing Job, browse to the optimizing job, and click 
Open.

Use this setting to load an unfinished optimizing job and continue from where you left off. 
The only prerequisite is that you must use the same measuring device.

• When you have printed the first chart, click Import Data.

Use this setting to load measurement values that were obtained with a third-party 
program. The existing measurement values are used as the basis for creating an L*a*b* 
optimization. You can use any measuring device, except one that is embedded in the 
printer.

4 Click the Info button, and follow the on-screen instructions to optimize your media profile.

You can apply the L*a*b* optimization to the media profile during the final optimization step. 
If you do not want to apply the L*a*b* optimization by default, you can select it at any time 
in Fiery XF. 

TO SELECT AN L*A*B* OPTIMIZATION IN FIERY XF

L*a*b* optimizations must be located in the Profiles\Balance folder in order to be selected in 
Fiery XF. If necessary, copy the L*a*b* optimization file to the Balance folder before 
proceeding with the following steps.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color Management pane. 

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
Management pane.

2 Under “L*a*b* optimization”, select the L*a*b* optimization.

3 Save your changes.

See also:

“To edit an L*a*b* optimization” on page 159

“To select an L*a*b* optimization in Fiery XF” on page 160

Creating a device link profile
A device link profile combines a source color space (media profile) and a destination color 
space (simulation (reference) profile) into one profile. Device link profiles tend to produce 
more accurate results than when two separate profiles are applied. To create a device link 
profile



CREATING AND OPTIMIZING PROFILES 161

TO CREATE A DEVICE LINK PROFILE

1 Start Color Tools, and click Create Device Link Profile.

2 Click the Info button, and follow the on-screen instructions to complete your device link 
profile.

When you have created your device link profile, you need to connect it to a base linearization 
file.

See also:

“Device link profiles” on page 147

“Profile Connector” on page 164

Creating a simulation (reference) profile
Simulation (reference) profiles describe the color reproduction properties of the printing 
machine that you are simulating on your inkjet printer.
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TO CREATE A SIMULATION (REFERENCE) PROFILE

1 Start Color Tools, and click Create Reference Profile.

2 Click the Info button, and follow the on-screen instructions to complete your simulation 
(reference) profile.

When you have created your simulation (reference) profile, you can select it in Fiery XF.

Only simulation (reference) profiles that are located in the Reference folder can be selected in 
Fiery XF.

See also:

“Source profiles and simulation (reference) profiles” on page 141

“Program structure” on page 377
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Creating a monitor profile
Monitor profiles are used to simulate and verify color accuracy on a computer screen. This is 
known as "soft proofing". However, in the same way that the color output of each printer can 
vary greatly, so each monitor displays color slightly differently. To overcome this problem, it is 
important that the monitor is regularly calibrated to a certain standard.

TO CREATE A MONITOR PROFILE

1 Start Color Tools, and click Create Monitor Profile.

2 Click the Info button, and follow the on-screen instructions to complete your monitor profile.

When you have created your monitor profile, you can select it in Fiery XF.

See also:

“Monitor profiles” on page 149



CREATING AND OPTIMIZING PROFILES 164

Profile Connector
You can use Profile Connector to connect a base linearization file to a media profile or to a 
device link profile.

Furthermore, Profile Connector enables you to make quick changes to an existing base 
linearization file. For example:

• You can incorporate a screening file that was created in Dot Creator for v2 screening.

• You can change the print direction.

• You can change the total ink limit.

• You can correct inconsistencies in the length of printed jobs.

TO CONNECT A BASE LINEARIZATION FILE TO A MEDIA PROFILE OR TO A DEVICE LINK PROFILE

1 Start Color Tools, and click Profile Connector.
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2 Click the Info button, and follow the on-screen instructions to modify your base linearization 
file.

On completion, the base linearization file is saved automatically to the Media Profiles folder.

When you have modified your base linearization file, do one of the following:

• Select a new base linearization file in Fiery XF.

• Select a device link profile in Fiery XF.

• Select a new base linearization for an existing media profile

See also:

“Media profiles” on page 140

“Device link profiles” on page 147

“Dot Creator” on page 356

“Correcting the length of printed jobs” on page 373

Editing a profile
Profile Editor is a tool for modifying an existing CMYK or RGB simulation (reference) 
profile. For example, you can use it to make contrast or saturation settings, or to enter the 
precise white point of the media. Profile Editor is primarily intended for use in the production 
market to modify color output.
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TO EDIT A SIMULATION (REFERENCE) PROFILE

1 Start Color Tools, and click Edit Profile.

2 Click the Info button, and follow the on-screen instructions to complete your monitor profile.

When you save an edited simulation (reference) profile, it is saved with a new name.

See also:

“Source profiles and simulation (reference) profiles” on page 141

Inspecting a profile
Profile Inspector is a tool for inspecting and comparing the color gamuts of RGB, CMYK, 
and named ICC profiles, either individually or in pairs. The profiles are displayed as 
three-dimensional models.
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TO VIEW THE COLOR GAMUT OF AN ICC PROFILE

1 Start Color Tools, and click Inspect Profile.

2 Click the Info button, and follow the on-screen instructions to view or compare color gamuts.

Relinearizing the printer
Every printer, even mass-produced printers of the same model, display slightly different color 
properties. Added to this, the color reproduction of a printer can change over a period of time. 

You can compensate for deviances in color by performing a relinearization. A relinearization 
adjusts the ink densities to those of the reference printer on which the media profile was 
created, thus ensuring that the printer’s color reproduction properties remain constant.

It is recommended that you perform a relinearization in the following instances:

• If you are using a media profile that was not created on your exact printer —  for example, 
the media profiles that are provided with Fiery XF

• After changing the print head

• If you notice that your proofs no longer match earlier proof results —  for example, if the 
ink smudges or is not evenly distributed on the media, or if cockling occurs as a result of 
too much ink on the media.
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As a general rule of thumb, it is a good idea to perform a relinearization approximately every 
two weeks. 

TO RELINEARIZE THE PRINTER BY MEASUREMENT

When you relinearize the printer by measurement, you optimize the L*a*b* values in the base 
linearization file.

1 Connect your measuring device.

2 Start Color Tools, and click Re-Linearization by Measurement.

You can also start the Re-Linearization by Measurement tool directly by transferring the 
settings from the output device to the linearization device. If you start the Re-Linearization by 
Measurement tool in this way, many of the printer settings are already made for you. 

3 Click the Info button, and follow the on-screen instructions to create a new base linearization 
file that returns the printer’s color reproduction to its original state.

You can overwrite the current base linearization file, or you can create a new base linearization 
file by saving the results under a new name. If you create a new base linearization file, you 
must select it in Fiery XF.

See also:

“Media profiles” on page 140
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Performing visual color corrections
You can use the Visual Correction tool to modify the ink curve of individual ink channels. A 
visual correction is based purely on manual color adjustments and should therefore only be 
performed as an emergency measure by experienced users. 

TO PERFORM VISUAL COLOR CORRECTIONS

1 Start Color Tools, and click Visual Correction.

2 Click the Info button, and follow the on-screen instructions.

When you have created a visual correction file, you can select it in Fiery XF.

TO SELECT A VISUAL CORRECTION FILE IN FIERY XF

Make sure that the visual correction file is located in the Balance folder before proceeding 
with the following steps. You may need to copy the file manually to the Balance folder if it was 
originally saved to a different destination.

1 Do one of the following:

• Go to System Manager. In the layout area, click the output device. On the Media tab, 
open the Print Configuration pane. 

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Media 
Configuration pane.
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2 Under “Visual correction”, select the visual correction file.

3 Save your changes.

Modifying plate characteristics
You can modify the plate characteristics that are often applied to one-bit files. Plate 
characteristics control the size of screen dots when they are output on the platesetter. You can 
use the Visual Correction tool to compensate for varying dot gain on different media. 
However, the changes are based purely on manual adjustments and should therefore be 
performed only as an emergency measure by experienced users.

As color management normally relies on receiving linear input data to apply color 
management properly, there is a need to compensate non-linear plate characteristics of the 
one-bit files for color-accurate output. There is no fixed formula for modifying plate 
characteristics. However, in the case of contone file formats, a simple formula is applied, so 
that a 5% increase for the 50% patch will yield 55%.

TO MODIFY PLATE CHARACTERISTICS

1 Start Color Tools, and click Visual Correction.

2 Click the Info button, and follow the on-screen instructions.

When you have created a plate compensation file, you can select it in Fiery XF.



CREATING AND OPTIMIZING PROFILES 171

TO SELECT A PLATE COMPENSATION FILE IN FIERY XF

Make sure that the plate compensation file is located in the Balance folder before proceeding 
with the following steps. You may need to copy the file manually to the Balance folder if it was 
saved to a different destination.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color management pane. 

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
management pane.

2 Under “Plate compensation”, select the plate compensation file.

3 Save your changes.

See also:

“Program structure” on page 377
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UPDATING FIERY XF AND MEDIA PROFILES

EFI continues to develop its products after product launch to improve functionality or to 
increase printer support. It is, therefore, recommended that you run the update procedures 
regularly to make sure that your software and media profiles are always up to date.

Updating Fiery XF 
During the update procedure, all new and changed files for the Fiery XF server are installed in 
the appropriate program folders. If a Fiery XF client is installed on the same computer, the 
client and options are updated at the same time. Remote Fiery XF clients and options are 
updated the next time they log on to the Fiery XF server.

To update Fiery XF automatically, you need a Fiery XF server computer with Internet access. 

If the Fiery XF server is installed on a computer with no Internet access, you can obtain 
software updates and install them manually. You can obtain the update files from your EFI 
dealer, or you can copy them from a different Fiery XF server computer that does have 
Internet access.

TO UPDATE FIERY XF AUTOMATICALLY

1 Exit all Fiery XF programs.

2 Right-click the Fiery XF Control icon, and click Fiery XF Online Update.

The Updater dialog box appears.

3 Select the check box if you want to save a copy of the updated files.

You can use the copy to update a second Fiery XF server on a computer with no Internet 
access. The copy is saved in a separate folder on the desktop.

4 Click Next.

A dialog box with a list of currently available software updates appears. It indicates which 
update files are available and also gives information about file size and version number.

5 Select the check boxes of the updates you want to install, and click Next.

6 Follow the on-screen instructions to download the updated files, and to complete 
installation.

7 Restart your computer, if prompted to do so.

The next time you log on to the Fiery XF server from a remote Fiery XF client, a dialog box 
appears for you to start the update procedure. Click Install to update the remote Fiery XF 
client and options. After installation, a copy of the updated files is saved to the Updates folder.
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TO UPDATE FIERY XF MANUALLY

This procedure describes how to update a Fiery XF server with no Internet access. To perform 
the following steps, you require the update files. You can obtain the update files from your 
EFI dealer, or you can copy them from a different Fiery XF server computer that does have 
Internet access. 

1 Copy the EFI Downloads folder with the update files to the Fiery XF server computer to be 
updated.

2 Exit all Fiery XF programs.

3 Open the EFI Downloads folder.

4 Open each subfolder one at a time, and double-click the program update file.

5 Follow the on-screen instructions to complete the procedure.

The next time you log on to the Fiery XF server from a remote Fiery XF client, a dialog box 
appears for you to start the update procedure. Click Install to update the remote Fiery XF 
client and options. After installation, a copy of the updated files is saved to the Updates folder.

TO CHECK WHICH UPDATES ARE INSTALLED

If the Fiery XF server and client are installed on the same computer, you can check which 
updates are installed.

1 Do one of the following:

• Start Fiery XF. In Windows, on the ?Help menu, click Fiery XF Server Information.

• Start Fiery XF. On Macintosh, on the Help menu, click Fiery XF Server Information.

• Right-click the Fiery XF Control icon, and click Show License Information.

A list of currently installed updates is displayed on the Update information tab.

See also:

“To update Fiery XF automatically” on page 172

“To update Fiery XF manually” on page 173



UPDATING FIERY XF AND MEDIA PROFILES 174

Updating media profiles
If the Fiery XF server is installed on a computer with Internet access, you can download and 
install new and updated media profiles automatically.

If the Fiery XF server is installed on a computer with no Internet access, you can obtain new 
and updated media profiles either from your EFI dealer, or by downloading them on to a 
different computer from:

http://profiles.efi.com/index.php?command=Profiles&Tab=22&Product=1&Identifier=&Cli
ent=0&lang=1033

Afterwards you can install the profiles manually.

TO INSTALL MEDIA PROFILES AUTOMATICALLY

1 Right-click the Fiery XF Control icon, and click Fiery XF Profiles Online Update.

The Profile Update Service dialog box appears.

2 Click Next.

3 In the “Manufacturer/Model” column, click your printer manufacturer.

4 In the “Media Profiles” column, select the check box(es) for the media profiles that you want 
to install.

You can select media profiles for different printer manufacturers in one download. You can 
view the list of selected media profiles by clicking Download List. To add or remove media 
profiles from the list, click Add More Profiles to return to the Profile Update Service dialog 
box.

5 Click Download to install the selected media profiles.

6 Click Finish.

TO INSTALL MEDIA PROFILES MANUALLY

If you have obtained new or updated media profiles from your EFI dealer, you can install 
them manually.

1 Copy the media update file to a computer on which the Fiery XF server is installed.

2 Exit all programs. 

3 Double-click the media update file.

4 Follow the on-screen instructions to complete the procedure.
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Uploading standard Fiery XF files from an external source
You can upload standard Fiery XF files, such as source profiles (*.icc, *.icm), spot color tables 
(*.cxf ), L*a*b* optimizations (*.3cc), visual color correction files (*.vcc), and screening files 
(*.spt) from an external data storage medium or from the desktop. Fiery XF Uploader copies 
the files directly into the correct program folder, thus saving you from having to browse 
manually.

TO UPLOAD STANDARD FIERY XF FILES

1 Start Fiery XF.

2 On the Tools menu, click Fiery XF Uploader.

The Fiery XF Uploader dialog box appears.

3 Click the Standard Files tab.

4 Click Choose, and browse to the file.

Make sure that the data storage medium is connected to the computer, if necessary.

5 Select the file, and click Open.

6 Click Upload.

A message confirms that the file has been correctly uploaded.

7 Click OK.
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THIRD-PARTY MEDIA PROFILES 
You can implement third-party media profiles in Fiery XF.

Third-party CMYK/OG media profiles
You can use any third-party CMYK/OG media profile in Fiery XF by connecting it to an 
existing base linearization file.

TO UPLOAD A THIRD-PARTY CMYK/OG MEDIA PROFILE

1 On the Tools menu, click Fiery XF Uploader. 

The Fiery XF Uploader dialog box appears.

2 Click the Media Profiles tab.

3 Under “Media profile”, click Choose and browse to the third-party media profile.

4 Select the file and click Open.

5 Under “Printer linearization (EPL)”, click Choose and browse to the EFI Media Profiles folder.

6 Open the folder for your printer, and open the subfolder for the media type and resolution 
that most closely matches the properties of the third-party media profile.

7 Select the base linearization file, and click Open.

8 Click Upload.

A message confirms that the file has been correctly uploaded.

9 Click OK.



THIRD-PARTY MEDIA PROFILES 177

The media profile is uploaded to the My Profiles folder. You must now connect the media 
profile to the base linearization file in Profile Connector.

See also:

“Selecting profiles and rendering intents” on page 139

“Profile Connector” on page 164

“Default folders” on page 377

Third-party RGB media profiles
If you have an RGB printer, you can use RGB media profiles from your printer manufacturer 
or paper manufacturer. However, you must connect the profile to a specific media in Fiery XF 
first. A special tool called RGB Profile Connector is provided for this purpose. If you did not 
install RGB Profile Connector when you installed Fiery XF, you can do it now.

TO INSTALL RGB PROFILE CONNECTOR

1 Insert the software DVD into the computer’s DVD-ROM drive.

2 In the welcome screen, click Install Fiery XF and follow the on-screen instructions until you 
come to the “Select Features” dialog box.

3 Click Custom.

4 Under “Tools”, select “RGB Profile Connector”.

5 Continue to follow the on-screen instructions to complete the installation.

For more information, see the Quick Start Guide.

TO CONNECT AN RGB MEDIA PROFILE

To use RGB Profile Connector, you must set up an output device for an RGB printer.
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1 Do one of the following:

• In Windows, click the Start button, point to All Programs. click EFI, click Fiery XF, and 
click RGB Profile Connector.

• On Macintosh, browse to the Fiery XF/Client/RGB Profile Connector folder, and 
double-click the RGB Profile Connector program file.

The Enter network IP address dialog box appears.

2 Unter “Type”, select “Fiery XF”.

3 Select or type the IP address of the Fiery XF server computer.

A list of all available Fiery XF servers in the sub-network is displayed with their IP address in 
the drop-down list box.

4 Enter a user name and a password.

Log on with your Fiery XF login credentials.
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5 Click Connect.

A connection is set up to the Fiery XF server. If an error message appears, make sure that the 
Fiery XF server is started.

The RGB Profile Connector dialog box appears.

6 Unter “Printer name”, select your RGB printer model.

7 Unter “Ink type”, select the type of ink that is inserted in the printer.

8 Under “Media type”, select the media type that most closely matches the media for which 
the RGB media profile was created.

9 Under “Media name”, type a media name.

By default, the media name is the same as the selected media type. You can leave the name 
unchanged or type a custom media name. The media profile will be available in Fiery XF 
under the name that you define here.

10 Select the resolution, print mode and print direction that were used to create the RGB media 
profile.

This information is usually provided either in a separate file with the media profile, or it can 
be downloaded from the manufacturer’s website.

11 Click Choose and browse to your RGB media profile.

12 Select the RGB media profile and click Open.

13 Click Install.

The new combination of base linearization and ICC profile is copied to the EFI Media 
Profiles\My Profiles folder, and can be selected in Fiery XF.
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See also:

“Starting the Fiery XF server” on page 22

“To create a new output device” on page 60

“To select a media profile” on page 140

Creating a media profile using third-party profiling software
If you do not have a license for the Color Profiler Option, you can use any third-party 
profiling software to create a media profile for use in Fiery XF.

TO CREATE A MEDIA PROFILE USING THIRD-PARTY PROFILING SOFTWARE

1 Start Color Tools, click Create Base Linearization, and create a base linearization file.

The base linearization file is created in the Working folder.

2 Move the base linearization file to the My Profiles folder.

3 Do one of the following:

• Go to System Manager. In the layout area, click the output device. On the Media tab, 
open the Print Configuration pane.

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Media 
Configuration pane.

4 Under “Ink type”, select the type of ink that you used to create the base linearization file.

5 Under “Media name”, select the name of the media that you defined when you created the 
base linearization file.

6 Under “Calibration set, select the base linearization file.

If multiple files are available and you are unsure which to select, click Catalog to view the file 
properties. The correct base linearization file does not have a media profile connected to it.

7 Go to Job Explorer. Load the profiling chart from the third-party software in the Linearization 
workflow, and print the chart.

The job is printed with the base linearization file applied. No color management is applied.

8 In the third-party software, measure the printed chart, and go on to create a media profile.

The media profile that you create is based on the base linearization file.

9 Start Color Tools, and click Profile Connector. Connect the media profile with the base 
linearization file.

The media profile is copied to the same folder as the base linearization file. You can now select 
the media profile in Fiery XF.
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See also:

“To select a media profile” on page 140

“Creating or editing a base linearization file” on page 154

“Profile Connector” on page 164

“Program structure” on page 377
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MAKING COLOR ADJUSTMENTS

Tweaking job colors
If you have a license for the Production Option, easy-to-use color adjustment tools are 
available to help you to tweak the color appearance of CMYK and RGB jobs.

It is not possible to make color adjustments to multi-color jobs, jobs that contain spot colors, 
or grayscale jobs.

TO TWEAK INDIVIDUAL COLORS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color Ajustment pane.

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
Ajustment pane.

2 On the pane bar, select the check box to activate the settings.

3 Select “Apply color corrections to static wedge” (optional).

This setting can be applied to CMYK jobs only. In a proofing environment, color consistency 
must be measurable. By applying the changes to the control strip, you can verify by 
measurement that the color adjustments have been applied to all jobs.

Color corrections cannot be applied to dynamic wedges.

4 Move the color correction sliders for each color channel to add or subtract color. Alternatively, 
type a percentage in the appropriate box.

In System Manager, you can edit the CMYK and the RGB color spaces. In Job Explorer, 
Fiery XF automatically detects the color space of the selected job.

5 Move the appropriate sliders to increase or decrease brightness, contrast and saturation. 
Alternatively, type a percentage in the appropriate box.

6 Move the slider to increase or decrease the blurriness or sharpness. Alternatively, type a 
percentage in the appropriate box.

7 Save your changes.

In Job Explorer, you can compare the effect of your adjustments with the original by clearing 
and reselecting the check box in the pane bar.
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If you work regularly with different color adjustments, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you apply a 
set of color adjustments, you need only to select the preset name.

Removing color impurities
During color management, colors are converted to the CMYK color space of the printer. This 
process can result in small amounts of CMYK inks to be involuntarily added to pure color 
definitions.

Black ink
When pure black is subjected to color management, it is converted to CMYK, which 
produces a “dirty” looking black in the printout. By forcing the use of black ink, you can 
ensure that all definitions of pure black by-pass color management and are output using only 
the black ink of the printer. This setting can most usefully be applied to text and other 
elements that are defined as pure black in the graphics program. 

TO FORCE THE USE OF PURE BLACK INK

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color Management pane.

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
Management pane.

2 On the pane bar, select the check box to activate the settings.

3 Under “Color optimization”, select “Black as inkjet black”.

4 Under “Threshold”, type the percentage of black ink, at which pure black ink is used instead 
of a mixture of CMYK inks.

For example, for grayscale images, a threshold of 40% would mean that 39% black is 
composed of CMYK inks, whereas 40% black is printed with black ink only. Text and line 
diagrams are nearly always defined as 100% black, and so are less likely to be affected by a 
threshold setting.

5 Save your changes.

Process and secondary colors
If you have a license for the Production Option, you can also remove color impurities that 
have resulted during the conversion from the RGB to the CMYK color space.
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The printer tries to reproduce color as defined by the simulation (reference) profile. For 
example, sometimes, 100% yellow is defined with a greenish tint. To achieve this tint, cyan 
ink is added to yellow ink. In this case, cyan is an impure color.

You can achieve a more saturated yellow by instructing Fiery XF to ignore the percentage of 
impure color and to use pure yellow ink instead.

This setting can be applied most successfully to banners and posters. It ensures that jobs are 
printed in vivid and saturated colors, without affecting critical color areas such as grays, skin 
tones and spot colors.

TO CLEAN PROCESS AND SECONDARY COLORS OF IMPURITIES

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color Management pane.

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
Management pane.

2 On the pane bar, select the check box to activate the settings.

3 Under “Color optimization”, select one of the following:

4 Under “Threshold”, select “Automatic cleaning” or “Manual cleaning”.

In automatic cleaning mode, Fiery XF provides optimal values that are based on the selected 
printer, media and profiles. In manual cleaning mode, you can define the percentage at which 
impure color is removed. It is recommended that you use automatic cleaning.

5 Save your changes.

Setting Description

Clean colors Cleans process colors (excluding 
black) and secondary colors of 
impure color.

Clean colors and black text as inkjet black/ 
Clean colors + black text and images as inkjet black

Cleans process colors (including 
black) and secondary colors of 
impure color.

These settings are a combination of 
“Clean colors” and “Black as inkjet 
black”.
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Converting to grayscale
You can convert jobs to grayscale. Five different tints are available — from a yellowish tint 
(warm gray) to a bluish tint (cold gray).

TO CONVERT JOBS TO GRAYSCALE

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color Management pane.

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
Management pane.

2 On the pane bar, select the check box to activate the settings.

3 Under “Advanced Settings”, select “Convert to grayscale”.

4 Move the slider to select a gray tint.

5 Save your changes.

Creating a color negative
You can invert job colors to create a color negative.

TO INVERT COLORS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Output tab, open 
the Advanced Print Options pane.

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Advanced 
Print Options pane.

2 Under “Separations”, select “Merge separations”.

This setting is used to invert the colors of composite jobs.

3 Select “Invert colors”.

4 Save your changes.
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LOADING AND PRINTING A JOB

When you have set up a system configuration, you are ready to load a job and start printing. 

Loading a job
This section describes how to load a job manually in Fiery XF.

Details of how to load a job by other means are provided in the appropriate sections of this 
documentation.

TO LOAD A JOB IN FIERY XF

1 Go to Job Explorer.
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2 Do one of the following:

• On the toolbar, click Import Job.

• On the File menu, click Import Job.

• Right-click anywhere in the job list, and click Import Job.

• Drag a file directly into the job list — for example, from the desktop or from a network 
folder.

The Import to dialog box appears.

3 In the list, select the workflow.

Select the workflow that is set up with the correct settings for your job. For example:

• Load a photo that you want to print in bright, vivid colors in a photo workflow.

• Load a proofing job in a workflow that is set up to reproduce the colors of a printing press.

4 Select “Hold Job” (optional).

Held jobs are loaded in Fiery XF but are not automatically printed. You can start printing 
when you are ready — for example, after you have applied job settings.

If your job can be output according to the workflow settings, there is no need to select the 
check box.

5 Click Import.

Your job is loaded in the job list.

In a fully automatic workflow, the job is processed and printed according to the workflow 
settings. If you need to edit the job, you can cancel job processing and make job-specific 
settings.

If you loaded the job as a “hold job”, you can also make job-specific settings before printing.
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6 In the job list, click the job, and make your job settings (optional).

7 Save your changes.

See also:

“Layout Options” on page 419

“To cancel job processing” on page 34

“Printing through a hotfolder” on page 190

“Printing through a virtual printer” on page 209

Printing a job
In the following cases, printing does not start automatically and must be started by hand:

• If the job was loaded as a “hold” job.

• If the system configuration is set offline at workflow exit.

• If you previously canceled job processing.

• If the job caused an error that required attention.

By default, one copy of the whole job is printed. This means:

• In the case of a one-page job, the job is printed in its entirety.

• In the case of a multipage job, all pages are printed.

• In the case of a nesting with more than one sheet, all the sheets are printed.

Before you start printing, you can select the number of copies, specify a page range, and 
define the order in which multiple pages or sheets are printed.
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TO DEFINE THE NUMBER OF PRINTED COPIES

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Output tab, open 
the Print Settings pane.

• In Job Explorer, in the job list, click the job. On the Output tab, open the Print Settings 
pane.

To print individual pages of a multipage document, select “Print page or sheet” and type the 
required range of pages —  for example, type “2,6,10-13” to print pages 2, 6, 10, 11, 12 and 
13. Then, type the number of copies to print. 

If you enter a range of pages, you can print odd and even pages separately, by selecting the 
appropriate item from the “Pages” setting.

You can sort the order in which pages are printed. The default order for printing three copies 
of a three-page document is: 1, 1, 1, 2, 2, 2, 3, 3, 3. Sorted copies are printed in the following 
order: 1, 2, 3, 1, 2, 3, 1, 2, 3. You can reverse the print order by selecting “Reverse order”.

2 Save your changes.

TO PRINT A JOB

1 Make sure that a media is loaded in the printer and that the printer is switched on.

2 Print the job, using one of the following methods:

• On the toolbar, click Print.

• On the File menu, click Print.

• In the job list, right-click the job list, and click Print.

See also:

“Setting system configurations online/offline” on page 64

“Loading a job” on page 186
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PRINTING THROUGH A HOTFOLDER

Hotfolders are folders with predefined access rights. They enable users, who do not have 
Fiery XF installed on their computers, to copy jobs to a centrally located folder. The hotfolder 
is routinely monitored by Fiery XF, and jobs that are placed in the hotfolder are loaded 
automatically into the Fiery XF workflow and processed according to the workflow settings.

There are two ways to print jobs through a hotfolder:

• You can copy jobs manually into the hotfolder.

• You can set up Fiery XF as a virtual printer. Setting up a virtual printer enables you to 
select Fiery XF in the print menu of the graphics program. Jobs that are submitted for 
printing in this way are loaded into Fiery XF through the hotfolder.

Hotfolders are normally set up for one particular workflow. However, it is possible to set up a 
hotfolder to be monitored by more than one workflow by applying load balancing. In this 
case, jobs that are placed in the hotfolder are diverted automatically to the first idle workflow 
that becomes available.

See also:

“Printing through a virtual printer” on page 209

“Load balancing” on page 368

Creating a hotfolder in Fiery XF 
Hotfolders can be created at the following locations:

• On the same computer as the Fiery XF server (local hotfolder)
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• On a different computer from the Fiery XF server (network hotfolder)

In Windows, the following requirements must be met:

– Both computers must be logged on with the same login credentials.

– The Windows user must have administrator status.

TO SET UP A HOTFOLDER IN FIERY XF

1 Go to System Manager. In the layout area, click the workflow. 

2 Set the workflow offline by clicking on the green arrow at workflow entry.

3 On the File tab, open the Job Detection pane. Click Choose and browse to the folder that you 
want to use as a hotfolder.

Make sure that you browse to a folder on the network.

Hotfolders must be set up for sharing to enable users to access them. It is, therefore, 
recommended that you create a hotfolder that is a subfolder of a folder at root level on the 
hard disk — for example, C:\folder\hotfolder or Macintosh HD/folder/hotfolder. Observe 
the following:

• To avoid unnecessary read/write access problems, do not create a hotfolder on the desktop.

• Do not select a folder that has been mapped as an internal link.

4 Click OK.

5 Set the workflow back online by clicking the red box at workflow entry.

You must now set up the hotfolder for sharing to enable users to access it.

TO SET UP THE HOTFOLDER AS A SHARED FOLDER (WINDOWS)

Perform the following steps if the hotfolder is located on the same computer as the Fiery XF 
server. If hotfolder and Fiery XF server are installed on different computers, both computers 
must be set up with the same login credentials.
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1 In Windows Explorer, browse to the folder that contains the hotfolder — for example, 
C:\folder.

2 Right-click the folder, click Properties, and click the Sharing tab.

3 Click Advanced Sharing.

The Advanced Sharing dialog box appears.

4 Select “Share this folder”.

5 Click Permissions.

The Permissions dialog box appears.
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6 Select the group or user names to have access to the shared folder.

If the group or user is not listed, click Add and add a new object.

Do the following:

• Type the Windows user name and click Check Names to confirm that the object exists. 

• In the list, click the user name and click OK.

The object is added to the list of groups.

7 Assign full read/change privileges to the group or user.

8 Click OK and close all dialog boxes.

TO SET UP THE HOTFOLDER AS A SHARED FOLDER (MACINTOSH)

1 Browse to the folder that contains the hotfolder — for example, Macintosh HD/folder.

2 Right-click the folder and click Get Info.

3 Under “General”, select “Shared folder”.

4 Under “Sharing & Permissions”, change the privilege rights to grant read and write access to 
a user or group of users.

If the user or group of users is not listed, create a new user. Do the following:

• Under “Sharing & Permissions”, Click Add (+).

• Click New Person, and type a user name.

• Define a password. Then, confirm the password, by re-typing it in the appropriate box.

• Click Create Account.

5 Close the Info dialog box.
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See also:

“To set a system configuration offline” on page 66

“Setting up a Windows user” on page 194

Setting up a Windows user
The Fiery XF server runs on Windows as a service. By default, the login rights are defined for 
the local computer. It means that Fiery XF cannot communicate with folders that are located 
in the network.

To enable Fiery XF to communicate with hotfolders through the network, the following 
requirements must be met:

• If the Fiery XF server and the hotfolder are on different computers, both computers must 
be logged on with the same login credentials. You may need to create a new user on both 
computers.

• The Windows user must have administrator status.

You can create a new Windows user with administrator status, or assign administrator status 
to an existing user.

TO CREATE A NEW WINDOWS USER

If Fiery XF server and hotfolder are on different computers, perform the following steps on 
both computers. Alternatively, you can duplicate an existing user on the second computer.

1 In Control Panel, click User Accounts, and click Manage User Accounts.

The User Accounts dialog box appears.

2 Click the Advanced tab.

3 Under “Advanced user management”, click Advanced.
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4 In the “Name” column, right-click Users, and click New User.

5 Type a user name.

6 Define a password. Then, confirm the password, by re-typing it in the appropriate box.

Make sure to use the same user name and password for both computers.

7 Clear all the check boxes relating to the password.

8 Click Create.

TO ASSIGN ADMINISTRATOR STATUS TO A WINDOWS USER

1 In Control Panel, click User Accounts, and click Manage User Accounts.

The User Accounts dialog box appears.

2 Click the Advanced tab.

3 Under “Advanced user management”, click Advanced.

4 In the Local Users and Groups (Local) column, click Users.

5 In the “Name” column, right-click the user, and click Properties.

The Properties dialog box appears.

6 Click the Member Of tab, and click Add.

7 Under “Enter the object names to select”, type “Administrators”, and click Check Names.

The name is displayed as follows: IP address\Administrators or 
Computername\Administrators.
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8 Click OK and close all dialog boxes.

See also:

“Printing problems” on page 389
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PRINTING THROUGH UNIDRIVER 
Unidriver is a special printer driver that was developed by EFI. Like a virtual printer, 
Unidriver enables you to print directly to a Fiery XF server on Windows or Macintosh from 
any graphics program. However, Unidriver has the following advantages:

• You can print to more than one Fiery XF workflow.

• You can make custom settings that override the equivalent workflow settings in Fiery XF. 
Custom settings can be applied to all jobs —  including jobs that you submit from other 
graphics programs.

You can install Unidriver on an unlimited number of computers.

Windows
This section provides instructions on how to install, set up, and print through Unidriver for 
Windows. You need administrator or power user rights.

TO INSTALL UNIDRIVER

If Unidriver is already installed on one computer, you can copy the program files to another 
computer. By default, Unidriver is installed in the folder ..\EFI\Fiery Unidriver. Copy the 
EFI-Unidriver folder to the desktop of another computer. Then, double-click the 
PrinterInstaller application file, and follow the on-screen instructions.

If Unidriver is not already installed on another computer, you can install it from the 
installation DVD, as described below:

1 Insert the installation DVD into the DVD-ROM drive of the computer on which the graphics 
program is installed. 

The Welcome screen appears.

2 Click Fiery Tools, and open the UniDriver folder.

3 Double-click the Install Fiery Unidriver application, and follow the on-screen instructions.

TO SET UP UNIDRIVER

Make sure that Fiery XF is running before you perform the following steps.

1 Click Start, and click Devices and Printers.

2 Right-click Fiery Unidriver and click Printing preferences.

The Fiery Unidriver Printing Preferences dialog box appears.
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3 On the Fiery Unidriver tab, click Change Settings.

4 Under “Type”, select Fiery XF.

5 Under “Connection”, select the computer on which a Fiery XF server is installed. 
Alternatively, type the IP address of a Fiery XF server.

6 Under “User” and “Password, enter your Fiery XF login credentials.
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7 Click Connect.

The Fiery Unidriver Preferences dialog box appears.

8 Under “Workflow”, select a workflow.

The tabs show the settings that have been made in Fiery XF for the selected workflow. If you 
do not want to use the workflow settings from Fiery XF, you can make your own custom 
settings in Unidriver. Unidriver settings override the workflow settings from Fiery XF. When 
you have made your required changes, click “Use my settings”.

You can log on to a different Fiery XF server at any time by clicking Connect and selecting a 
different IP address.

9 Click OK to exit the Fiery Unidriver Preferences dialog box.

By default, Unidriver is installed as the default printer. If you do not want Unidriver to be the 
default printer, do the following: Click Start, click Devices and Printers, right-click the printer 
that you want to make the default printer, and click Set as default printer.
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TO PRINT A JOB

By default, jobs are printed according to the workflow settings in Fiery XF. In Unidriver you 
can apply job settings that override the workflow settings.

The actual steps that you need to perform may vary slightly from the description below, 
depending on the graphics program that you are using.

1 In the graphics program, open the job file, and select the print command.

2 In the print dialog box, select the Unidriver printer.

3 Do one of the following:

• If you do not need to make job settings in Unidriver, click OK to print your job.

If an error message informs you that the login failed, click OK. Make sure that the 
Fiery XF server is running. Then, click Connect, and log on to Fiery XF.

• To view or to make changes to Unidriver settings before printing, click Preferences, 
Properties, or similar. The FieryUnidriver Preferences dialog box appears. Select a different 
workflow, or change settings, as required. To apply your changes, click “Use my settings”.

You can revert to the Fiery XF workflow settings by clearing the “Use my settings” check 
box.

Macintosh
This section provides instructions on how to install, set up, and print through Unidriver for 
Macintosh.

After installation, the next step is to add Unidriver as a printer. You perform this step on the 
computer on which Unidriver is installed. The instructions vary, depending on whether the 
Fiery XF server is installed in the same subnet as Unidriver, or in a different subnet. Follow 
the appropriate set of instruction below. 

TO INSTALL UNIDRIVER

1 Insert the software DVD into the DVD-ROM drive of the computer on which the graphics 
program is installed. 

The Welcome screen appears.

2 Double-click Fiery Tools, double-click UniDriver, click Install Fiery Unidriver, and follow the 
on-screen instructions.
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TO ADD UNIDRIVER AS A PRINTER IN THE SAME SUBNET

Make sure that Fiery XF is running before you perform the following steps.

1 In System Preferences, click Print & Scan.
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2 Click Add (+).

If a menu opens, click Add Printer or Scanner.
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3 On the Default tab, from the list of printer names, select the name of the computer on which 
the Fiery XF server is installed, and click Add.

The Fiery XF server is added as a printer.

TO ADD UNIDRIVER AS A PRINTER IN A DIFFERENT SUBNET

Make sure that Fiery XF is running before you perform the following steps.
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1 In System Preferences, click Print & Scan.

2 Click Add (+).

If a menu opens, click Add Printer or Scanner.
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3 Click Advanced.

If the Advanced button is not available, right-click the toolbar and click Customize Toolbar. 
Then, drag the Advanced button into the toolbar.

4 Under “Type”, select “Fiery Unidriver”.

5 Under “Device”, select “Another Device”.
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6 Under “URL”, type the IP address of the computer on which the Fiery XF server is installed.

The URL must follow the following syntax: udspooler://ip=xxx.xxx.xxx.xxx/xf, where 
“xxx.xxx.xxx.xxx” stands for the IP address of the computer.

7 Under “Name, type a unique name that is easily identifiable.

This is the name of the printer that you select in the graphics program. It is a good idea to 
include the word “Unidriver” in the name.

8 Under “Use”, select “Other”.

A new dialog box appears.

9 Browse to the EFI_UD_XF.ppd file.

The PPD is located at /Library/Printers/PPDs/contents/Resources/en.lproj.

10 Select the PPD, and click Open.

You return to the Advanced tab.

11 Click Add.

The Fiery XF server is added as a printer.
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TO PRINT A JOB

By default, jobs are printed according to the workflow settings in Fiery XF. In Unidriver you 
can apply job settings that override the workflow settings.

The actual steps that you need to perform may vary slightly from the description below, 
depending on the graphics program that you are using.

1 In the graphics program, open the job file, and select the print command.

2 In the print dialog box, select the IP address of the Fiery XF server.

3 From the drop-down list box, select “Fiery Unidriver”.

4 Under “User” and “Password, enter your Fiery XF login credentials.

Print dialog box
1 Select IP address of 

Fiery XF server
2 Select “EFI Unidriver”

2

1
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5 Click Connect.

TheFieryUnidriver Preferences dialog box appears.

6 Under “Workflow”, select a workflow.

The tabs show the settings that have been made in Fiery XF for the selected workflow. If you 
do not want to use the workflow settings from Fiery XF, you can make your own custom 
settings in Unidriver. Unidriver settings override the workflow settings from Fiery XF. When 
you make custom settings, the “Use my settings” check box is automatically selected. You can 
revert to the Fiery XF workflow settings by clearing the “Use my settings” check box.

You can log on to a different Fiery XF server at any time by clicking Connect and selecting a 
different IP address.

7 Click OK to exit the Preferences dialog box.

8 Click Print.
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PRINTING THROUGH A VIRTUAL PRINTER

You can set up Fiery XF as a virtual printer. By setting up a virtual printer you can print 
directly to Fiery XF from the print command of the graphics program.

Setting up the virtual printer in Fiery XF
To print straight from a graphics program, you must first make certain settings in Fiery XF.

TO SET UP FIERY XF AS A VIRTUAL PRINTER

1 Go to System Manager. In the layout area, click the workflow.

2 Set the workflow offline by clicking on the green arrow at workflow entry.

3 On the File tab, open the Job Detection pane.

4 Create a hotfolder.

On Macintosh, make sure that the hotfolder has write access for everyone. If the hotfolder is a 
subfolder, all parent folders must also have read access. To check the access rights, right-click 
the folder, and click Get Info. Under “Sharing & Permissions”, change the privilege settings, if 
required.

5 Click "Create virtual printer".

6 Type a printer name (optional).

This is the name that will be displayed in the print dialog box of the graphics program. You 
can use the default printer name, or you can type a custom printer name. If you type a custom 
printer name, it is recommended that you do not use a name that contains special characters.

7 Save your changes.

8 Set the workflow online, by clicking on the red rectangle at workflow entry.

9 Make sure that the virtual printer is set up for printer sharing in the operating system.

• Windows: 
Click Start, point to Devices and Printers, right-click the virtual printer, and click Printer 
properties. On the Sharing tab, select “Share this printer”. Select also “List in the 
directory” to ensure that the virtual printer can be seen by other users on the network.

• Macintosh: 
Open System Preferences. In Print & Scan, check that the virtual printer is displayed. In 
the printer list, select the virtual printer, and make sure that the check box for sharing the 
printer on the network is selected. Then, click Sharing Preferences and make sure that 
“Printer Sharing” is selected.
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Once you have set up Fiery XF, certain settings are needed on the computer on which the 
graphics program is installed.

See also:

“Creating a hotfolder in Fiery XF” on page 190

“Setting up the computer on which the graphics program is installed” on page 210

Setting up the computer on which the graphics program is installed
Before you can start printing, you must set up Fiery XF as a virtual printer on the computer 
on which the graphics program is installed. This documentation gives details of how to set up 
the Windows 7 and Macintosh OS X 10.8 operating systems. Other operating systems may 
be slightly different.

Before performing the steps in the following sections, make sure of the following:

• The workflow must be online in System Manager.

• The virtual printer must be set up correctly for printer sharing. Otherwise the virtual 
printer cannot be detected in the network.

See also:

“Setting system configurations online/offline” on page 64

“Setting up the virtual printer in Fiery XF” on page 209

Printing from Windows to a Fiery XF Windows server
In Windows, Fiery XF automatically creates a shared printer that can be used like any other 
shared printer.

Perform the following steps on the computer on which the graphics program is installed.

TO SET UP A CONNECTION TO A LOCAL FIERY XF VIRTUAL PRINTER

If the Fiery XF server and the graphics program are installed on the same computer, the 
virtual printer is immediately visible in the print menu of the graphics program. No further 
steps are necessary, and you can now print to the virtual printer from your graphics program. 

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER (REQUIRES INTERNET ACCESS)

If the Fiery XF server and the graphics program are installed on different computers, you have 
to add the virtual printer as a new printer. Perform the following steps on the computer on 
which the graphics program is installed.

Use this method if the computer that is running the graphics program has Internet access.
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1 Start your web browser, type the IP address or the computer name of the Fiery XF server, and 
press <Enter>.

Use the following syntax:

\\xx.xxx.xxx.xxx or \\computername

The View remote printers window appears, and the virtual printer is displayed.

If the printer is not found, make sure that it is correctly set up to be listed in the directory.

2 Double-click the virtual printer.

You can now print to the virtual printer from your graphics program.

Be aware of the following:

Windows creates just one driver for either a 64-bit or for a 32-bit operating system. If the 
Fiery XF server and the graphics program are installed on computers that are running 
Windows in different modes, additional steps are necessary.

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER (DOES NOT REQUIRE INTERNET ACCESS)

If the Fiery XF server and the graphics program are installed on different computers, you have 
to add the virtual printer as a new printer. Perform the following steps on the computer on 
which the graphics program is installed.

Use this method if the computer that is running the graphics program does not have Internet 
access.

1 Click Start, click Devices and Printers, and click Add a printer.

The Add Printer dialog box appears.

2 Select “Add a network, wireless or Bluetooth printer”.

Alist of available printers is displayed.

3 If the virtual printer is not listed, select “The printer that I want isn’t listed”.

A dialog box for finding a printer by name or by TCP/IP address appears.

4 Select “Select a shared printer by name”, and type the name of the virtual printer.

Use the following syntax:

\\computername\printername or http://computername/printers/printername/.printer

If you do not know the computer name, you can search for it on the computer that is running 
the Fiery XF server. Click Start, right-click Computer, and click Properties. Under 
“Computer name, domain, and workgroup settings”, look for the computer name.

5 Click Next.

The virtual printer is installed.

6 Click Next.
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7 Set the virtual printer as the default printer (optional).

8 Print a test page to check that the virtual printer is working properly (optional).

The test page appears in the job list of Fiery XF.

9 Click Finish.

You can now print to the virtual printer from your graphics program.

Be aware of the following:

Windows creates just one driver for either a 64-bit or for a 32-bit operating system. If the 
Fiery XF server and the graphics program are installed on computers that are running 
Windows in different modes, additional steps are necessary.

TO SET UP A FIERY XF VIRTUAL PRINTER ON A MIXTURE OF WINDOWS 64-BIT AND WINDOWS 32-BIT OPERATING 
SYSTEM

After you have set up a connection to the remote virtual printer, you need to perform the 
following additional steps if the Fiery XF server and the graphics program are installed on 
computers that are running Windows in different modes — for example, if the Fiery XF 
server is installed on a Windows 64-bit operating system, and the graphics program is 
installed on a Windows 32-bit operating system.

1 Do the following:

• On the computer with the Fiery XF server:

– Click Start, point to Devices and Printers, right-click the virtual printer and click 
Printer properties. On the Advanced tab, make a note of the driver name. The default 
driver name is “EFI XF Fiery XF Printer”. Click OK.

– Copy the appropriate PPD folder from the Tools folder to the desktop of the computer 
that is running the graphics program.
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• On the computer with the graphics program:

– On the desktop, open the PPD folder that you copied from the Fiery XF server 
computer. In a text program, open the EFI setup information file. Under [EFI], 
overwrite the driver name so that it matches exactly the name that you made a note of. 
For example, overwrite “EFI Colorproof XF” with “EFI XF Fiery XF Printer”.

– Click Start, point to Devices and Printers, and click Add a printer. The Add Printer 
dialog box appears. Click “Add a network, wireless or Bluetooth printer”, and click 
Next. Click “The printer that I want isn’t listed”, and click Next.

Select “Select a shared printer by name”, and type the IP address or the computer name 
of the Fiery XF server computer, followed by the name of the virtual printer. Use the 
following synatx:

\\xxx.xxx.xxx.xxx\virtualprintername or \\computername\virtualprintername.

If you do not know the computer name, you can search for it on the computer that is 
running the Fiery XF server. Click Start, right-click Computer, and click Properties. 
Under “Computer name, domain, and workgroup settings”, look for the computer 
name.

Then click Next. When you are prompted to search for the driver, click Browse, browse 
to the modified *.inf file on your desktop, and click Open. Continue to follow the 
on-screen instructions to complete the procedure.

See also:

“Setting up the virtual printer in Fiery XF” on page 209

“To set up a Fiery XF virtual printer on a mixture of Windows 64-bit and Windows 32-bit 
operating system” on page 212

“Printing from a graphics program to the Fiery XF virtual printer” on page 218

“Default folders” on page 377

Printing from Macintosh to a Fiery XF Macintosh server
Perform the following steps on the computer on which the graphics program is installed.

TO SET UP A CONNECTION TO A LOCAL FIERY XF VIRTUAL PRINTER

In Macintosh OS X, Fiery XF automatically creates a shared printer that can be used like any 
other shared printer. No further steps are necessary, and you can now print to the virtual 
printer from your graphics program.

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER IN THE SAME SUBNET

If the Fiery XF server and the graphics program are installed on different computers, you have 
to add the virtual printer as a new printer.
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1 In System Preferences, click Print & Scan.

2 Click Add (+).

If a menu opens, click Add Printer or Scanner.

3 On the Default tab, from the list of printer names, select the Fiery XF virtual printer.

4 Under “Use”, review the setting.

• If the Fiery XF client is installed on the computer, “EFI Colorproof XF” is selected. It 
means that the appropriate PPD is available. Click Add to add the Fiery XF printer to the 
list of available printers.

• If the Fiery XF client is not installed on the computer, “Generic PostScript Printer” is 
selected. It means that the appropriate PPD is not available. In this case, you need to 
install it from the Macintosh software DVD. Insert the Macintosh software DVD into the 
DVD-ROM drive. Then, under “Use”, select “Other”, browse to the EFI Fiery XF.ppd on 
the DVD, and click Open. The PPD is located in the Fiery Tools folder. Click Add to add 
the Fiery XF printer to the list of available printers.

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER IN A DIFFERENT SUBNET

If the Fiery XF server and the graphics program are installed on different computers, you have 
to add the virtual printer as a new printer.

1 In System Preferences, click Print & Scan.

2 Click Add (+).

If a menu opens, click Add Printer or Scanner.

3 Click Advanced.

If the Advanced button is not available, right-click the toolbar and click Customize Toolbar. 
Then, drag the Advanced button into the toolbar.

4 Under “Type”, select “Internet Printing Protocol (http).

5 Under “Device”, select “Another Device”.

6 Under “URL”, type the IP address or the computer name of the computer on which the 
Fiery XF server is installed, followed by the name of the virtual printer.

Use the following syntax:

http://xxx.xxx.xxx.xxx:631/printers/virtualprintername or 
http://computername:631/printers/virtualprintername
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7 Under “Use”, review the setting.

• If the Fiery XF client is installed on the computer, it means that the appropriate PPD is 
already available. Select “Select Printer Software”. In the list of available printers, select the 
EFI Colorproof XF printer, and click OK. Click Add to add the Fiery XF printer to the list 
of available printers.

• If the Fiery XF client is not installed on the computer, it means that the appropriate PPD 
is not available. In this case, you need to install it from the Macintosh software DVD. 
Insert the Macintosh software DVD into the DVD-ROM drive. Then, under “Use”, select 
“Other”, browse to the EFI Fiery XF.ppd on the DVD, and click Open. The PPD is 
located in the Fiery Tools folder. Click Add to add the Fiery XF printer to the list of 
available printers.

Occasionally, problems arise when you try and print to the Fiery XF virtual printer that is 
located in a different subnet. Although the virtual printer can be selected in the graphics 
program, the jobs are not loaded in Fiery XF.

See also:

“Printing from a graphics program to the Fiery XF virtual printer” on page 218

“To print to a Fiery XF Macintosh server in a different subnet” on page 218

Printing from Windows to a Fiery XF Macintosh server
Perform the following steps on the computer on which the graphics program is installed.

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER

If the Fiery XF server and the graphics program are installed on different computers, you have 
to add the virtual printer as a new printer. Perform the following steps on the computer on 
which the graphics program is installed.

Use this method if the computer that is running the graphics program does not have Internet 
access.

1 Click Start, click Devices and Printers, and click Add a printer.

The Add Printer dialog box appears.

2 Select “Add a network, wireless or Bluetooth printer”.

Alist of available printers is displayed.

3 If the virtual printer is not listed, select “The printer that I want isn’t listed”.

A dialog box for finding a printer by name or by TCP/IP address appears.
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4 Select “Select a shared printer by name”, and type the IP address or the computer name of 
the Fiery XF server computer, followed by the name of the virtual printer.

Use the following syntax:

http://xxx.xxx.xxx.xxx:631/printers/virtualprintername or 
http://computername:631/printers/virtualprintername

If you do not know the computer name, you can search for it on the computer that is running 
the Fiery XF server. Click Start, right-click Computer, and click Properties. Under 
“Computer name, domain, and workgroup settings”, look for the computer name.

5 Click Next.

The virtual printer is installed.

6 Click Next.

7 Set the virtual printer as the default printer (optional).

8 Print a test page to check that the virtual printer is working properly (optional).

The test page appears in the job list of Fiery XF.

9 Click Finish.

You can now print to the virtual printer from your graphics program.

Occasionally, problems arise when you try and print to the Fiery XF virtual printer that is 
located in a different subnet. Although the virtual printer can be selected in the graphics 
program, the jobs are not loaded in Fiery XF.

See also:

“To print to a Fiery XF Macintosh server in a different subnet” on page 218

Printing from Macintosh to a Fiery XF Windows server
Perform the following steps on the computer on which the graphics program is installed.

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER IN THE SAME SUBNET

1 In System Preferences, click Print & Scan.

2 Click Add (+).

If a menu opens, click Add Printer or Scanner.

3 On the Windows tab, search for the Windows computer on the network.

4 Select the computer, and select the Fiery XF virtual printer.

When prompted to do so, log in with your Windows user password. 
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5 Under “Use”, review the setting.

• If the Fiery XF client is installed on the computer, it means that the appropriate PPD is 
already available. Select “Select Printer Software”. In the list of available printers, select the 
EFI Colorproof XF printer, and click OK. Click Add to add the Fiery XF printer to the list 
of available printers.

• If the Fiery XF client is not installed on the computer, it means that the appropriate PPD 
is not available. In this case, you need to install it from the Macintosh software DVD. 
Insert the Macintosh software DVD into the DVD-ROM drive. Then, under “Use”, select 
“Other”, browse to the EFI Fiery XF.ppd on the DVD, and click Open. The PPD is 
located in the Fiery Tools folder. Click Add to add the Fiery XF printer to the list of 
available printers.

TO SET UP A CONNECTION TO A REMOTE FIERY XF VIRTUAL PRINTER IN A DIFFERENT SUBNET

1 In System Preferences, click Print & Scan.

2 Click Add (+).

If a menu opens, click Add Printer or Scanner.

3 On the Default tab, from the list of printer names, select the Fiery XF virtual printer.

4 Click Advanced.

If the Advanced button is not available, right-click the toolbar and click Customize Toolbar. 
Then, drag the Advanced button into the toolbar.

5 Under “Type”, select “Windows printer via spoolss”.

6 Under “Device”, select “Another Device”.

7 Under “URL”, type the IP address of the computer on which the Fiery XF server is installed 
and the name of the Fiery XF virtual printer.

Use the following syntax:

smb://xxx.xxx.xxx.xxx/virtualprintername or smb://computername/virtualprintername

8 Under “Use”, review the setting.

• If the Fiery XF client is installed on the computer, it means that the appropriate PPD is 
already available. Select “Select Printer Software”. In the list of available printers, select the 
EFI Colorproof XF printer, and click OK. Click Add to add the Fiery XF printer to the list 
of available printers.

• If the Fiery XF client is not installed on the computer, it means that the appropriate PPD 
is not available. In this case, you need to install it from the Macintosh software DVD. 
Insert the Macintosh software DVD into the DVD-ROM drive. Then, under “Use”, select 
“Other”, browse to the EFI Fiery XF.ppd on the DVD, and click Open. The PPD is 
located in the Fiery Tools folder. Click Add to add the Fiery XF printer to the list of 
available printers.
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Printing from a graphics program to the Fiery XF virtual printer
To print directly to the Fiery XF virtual printer, Fiery XF must be set up correctly.

TO PRINT A JOB

1 Start Fiery XF.

If Fiery XF is not started, it is not available as a printer in the graphics program.

2 Open the image file in the graphics program and select the print command.

3 Select the Fiery XF printer.

The settings you make in the print dialog box, such as the number of printed copies, 
overwrite the equivalent setting in Fiery XF.

4 Click OK.

The job is sent to Fiery XF and appears in the job list. 

General tips:

• In Windows, you are requested to enter your Windows user password when you submit a 
job to the Fiery XF virtual printer. To avoid having to retype your password for each job, 
select “Remember this password in my keychain”.

• When printing directly from a graphics program on roll media or a custom media size, the 
printable media length is restricted to slightly less than two meters. To overcome the 
problem, try loading the job by drag and drop.

TO PRINT TO A FIERY XF MACINTOSH SERVER IN A DIFFERENT SUBNET

Occasionally, problems arise if the Fiery XF server is installed on a Macintosh computer that 
is located in a different subnet. Although the Fiery XF virtual printer can be selected in the 
graphics program, the jobs are not loaded in Fiery XF. In this case, you need to make a setting 
in Common Unix Printing System (CUPS) version 1.4.4 or newer. This version is installed by 
default on all Macintosh computers that are running Mac OS X 10.6.4 or higher.

1 Start your web browser, and type http://localhost:631/admin, and press <Enter>.

CUPS starts.

If an error message informs you that the web interface is currently disabled, start Terminal. 
Type the following line of text, and press <Enter>:

cupsctl WebInterface=yes

You can disable the web interface by typing cupsctl WebInterface=no, if required.

2 In the CUPS window, click the Administration tab.

3 Under “Server Settings”, select “Allow printing from the Internet”.

4 Click Change Settings.
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See also:

“Setting up the virtual printer in Fiery XF” on page 209
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PRINTING TO FILE

If you have a license for the File Output Option, you can output jobs to TIFF or PDF format. 
One license lets you set up a maximum of five output devices that print to file.

TO SET UP THE OUTPUT DEVICE TO PRINT TO FILE

1 Go to System Manager. In the layout area, click the output device. On the Device tab, open 
the Information pane.

2 Under “Manufacturer”, select “EFI”.

3 Under “Device type”, select a print-to-file format.

4 On the Device tab, open the Connection pane, and complete your settings.

5 In the layout area, connect the output device to a workflow.

6 Save your changes.

See also:

“Setting system configurations online/offline” on page 64

“Connection” on page 474
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PRINTING TO A FIERY OUTPUT DEVICE

If you have a license for the Fiery Option, you can set up a maximum of five Fiery output 
devices in Fiery XF.

It is recommended that you do not perform any job settings at the Fiery Command 
WorkStation. If you make job-specific settings at the Fiery Command WorkStation, the color 
management settings from the Fiery Command WorkStation are applied on top of the color 
management settings from Fiery XF. The result is non-accurate color output.

TO SET UP A FIERY OUTPUT DEVICE

1 Go to System Manager. In the layout area, click the output device. On the Device tab, open 
the Information pane.

2 Under “Manufacturer”, select “EFI”.

3 Under “Device type”, select “EFI Fiery”.

Fiery XF provides a generic media profile for the Fiery Option. However, to achieve 
high-quality results, it is recommended that you create your own media profiles. To create 
media profiles, you require a license for the Color Profiler Option.

When you define a name for a custom media profile in Color Profiler Suite, it is important to 
ensure that the device is easily identifiable in the name. The reason for this is that all Fiery 
output devices are selected as “EFI Fiery” on the Setup pane. Therefore, when you select “EFI 
Fiery”, the media profiles for all Fiery devices are displayed on the Media pane.

If you do not want to print directly to a Fiery output device, you can save your jobs to PDF 
format instead by selecting “EFI PDF Output”. To print to file, you require the File Output 
Option.

4 On the Device tab, open the Connection pane.

5 Under “Connection type”, select an item.

The usual setting is "print to file". However, you can print to an IP network printer instead, if 
required.

To output to a Fiery Command WorkStation, type the IP address of the Fiery output device. 
Then, click “LPR queue” and type a queue name: “Print”, “Hold” or “Direct”. Some versions 
of Fiery Command WorkStation also support printing via port 9100.

6 On the Connection pane, complete your settings.

7 In the layout area, connect the output device to a workflow.

8 Save your changes.
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See also:

“Setting system configurations online/offline” on page 64

“Connection” on page 474
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PRINTING TO A VUTEK PRINTER

If you have a license for the VUTEk Printer Option, you can set up one VUTEk printer.

See also:

“To create a new output device” on page 60

Setting up Fiery XF
It is recommended that you do not change the print resolution when printing to a VUTEk 
printer. Considerable discrepancies can result, as the print resolution is already defined by the 
selected color profile and the print resolution is also dependent on the selected printer.

TO SET UP A VUTEK PRINTER

1 Go to System Manager. In the layout area, click the output device. On the Device tab, open 
the Information pane.

2 Under “Manufacturer”, select “EFI VUTEk”.

3 Under “Device type”, select a VUTEk printer.

4 On the Device tab, open the Connection pane.

5 Under “Connection type”, select an item.

By default, jobs are printed to RTL and GIF format. The RTL file is the data file that is sent 
to the printer. The GIF file is used to display a preview of the job on a VUTEk PrintStation. 
GIF files, but not RTL files, can be opened in any conventional graphics program.

• File output

When you print to file, print files are saved in RTL and GIF format to the specified export 
folder. You can deactivate GIF files on the Special Printer Settings pane, if required.

The names of print files are customizable. 

• Print via JDF port

All VUTEk Pro, GS, GSr, and S3 series printers support JDF (Job Definition Format). 
JDF enables Fiery XF to receive information, such as media consumption and ink 
consumption, from the printer. If you select a JDF-compliant printer as the device type, 
you can print via the JDF port.

When you print via the JDF port, print files are saved in RTL and GIF format to the 
JDF/Upload folder.

6 On the Connection pane, complete your settings.
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7 On the Media tab, open the Print Configuration pane, and complete your settings.

Fiery XF provides generic profiles for use with VUTEk printers. However, you can create your 
own profiles, if preferred. The Color Profiler Option provides a full set of tools with which to 
create media profiles. Media profiles must be saved to the EFI Media Profiles folder.

8 On the Media tab, open the Media Setting pane, and complete your settings.

9 On the Special tab, open the Special Printer Settings pane.

10 Select “Print head control bar” (optional).

A control bar is made up of stripes for each of the available printer inks. By printing a control 
bar with each job, it ensures that ink keeps flowing through all the ink nozzles, and thus helps 
to prevent blockages.

Settings are available for defining the appearance of the control bar and its position in relation 
to the job.

11 Under “RTL preview creation”, clear the “Create GIF previews of RTL files” check box 
(optional).

If the printer is set up to print to file, the print files are created in RTL and in GIF format. 
The GIF file is used to display a preview of the job on a VUTEk PrintStation. If you do not 
need to display a preview, you can clear this check box. GIF files cannot be deactivated if you 
are printing via the JDF port.

12 Under “Resolution”, select a resolution.

You can specify a printer resolution. The bigger the job that you are printing, the fewer ink 
droplets per inch you need, because the printed image will be viewed from a greater distance. 

If your printer uses solvent ink, be aware that the density of color will be reduced if you 
change the resolution. It is recommended that you do not change the print resolution for UV 
printers.
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13 In the layout area, connect the output device to a workflow.

14 Save your changes.

See also:

“Setting system configurations online/offline” on page 64

“Connection” on page 474

“Print Configuration” on page 477

“Media Setting” on page 478

“Creating and optimizing profiles” on page 151

“Setting up a JDF connection” on page 265
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PRINTING TO A CADDON CAN:VIEW CABINET

If you have a license for the Softproof Output Option, you can print to a Caddon can:view 
cabinet. The Softproof Output Option enables you to simulate and measure color output on 
a high-resolution screen. Verifying the color accuracy of a soft proof is cost-effective and saves 
media without compromising on the quality of the proof.

To create a reliable soft proof, all the devices must be precisely calibrated to ensure color 
consistency across the workflow.

Setting up Fiery XF
This section describes which steps are necessary to set up a workflow and output device in 
Fiery XF.

TO SET UP A WORKFLOW

To print to a Caddon can:view cabinet, it is recommended that you set up a verify workflow. 

Note the following:

• You can set up the workflow for one or two static control strips. The dynamic wedge is not 
supported.

• The following measuring devices are supported: ES-1000 and X-Rite i1. Make sure that 
you select control strips that are specifically for these devices.

TO SET UP AN OUTPUT DEVICE FOR CADDON CAN:VIEW

1 Go to System Manager. In the layout area, click the output device. On the Device tab, open 
the Information pane.

2 Under “Manufacturer”, select “EFI”.

3 Under “Device type”, select “EFI Softproof Output”.

When you select the Softproof option, the “Description” box changes to “Device ID”.

4 Type the device ID of the Caddon can:view device.

The device ID is the serial number of the Caddon can:view cabinet. You can get the device ID 
from the Preferences dialog box in the Caddon can:connect software.

5 On the Device tab, open the Connection pane, and complete your settings.

6 In the layout area, connect the output device to a workflow.

7 Save your changes.
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See also:

“Setting system configurations online/offline” on page 64

“Connection” on page 474

“To set up a verify workflow” on page 313

Setting up the Caddon hardware and software
This section describes which steps are necessary to set up the Caddon hardware and software.

TO SET UP THE CADDON CAN:VIEW CABINET

1 Calibrate the Caddon can:view cabinet using the Caddon calibration wizard.

Use the calibration wizard to create a monitor profile, to calibrate the lamps, and to measure 
the ambient light conditions. The ambient light conditions are taken into account in the 
high-end preview. This process takes approximately one hour.

For more information, see the product documentation.

TO SET UP THE CADDON CAN:CONNECT SOFTWARE

The Caddon can:connect software runs on the Caddon can:view cabinet. The program is 
used to display, measure, and analyze spectralphotometric image data.

Jobs that are loaded in Fiery XF are also visible in the job list of the can:connect software.

1 In the Preferences dialog box, type the IP address of the Fiery XF server.

For more information, see the product documentation.

Verifying color accuracy

TO VERIFY THE COLOR ACCURACY OF A JOB

1 Make sure that your measuring device is connected to the Caddon can:view cabinet.

2 In Fiery XF, load the job.

3 Print the job.

The print file is sent to Caddon can:connect and displayed on the cabinet screen. In Fiery XF, 
the job receives the job status “Can be verified”.

4 In Caddon can:connect, right-click the job in the job list, and click Verify.

5 Measure the control strip.

For more information, see the product documentation.
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After measuring, the measurement data and job status are displayed simultaneously in 
Caddon can:connect and on the Verify pane in Fiery XF.

If a job fails verification, you may be able to improve on the result by performing a 
job-specific optimization. This process optimizes the job’s color management by creating a 
correction profile that is a better match for the color gamut of the simulation (reference) 
profile. Click Optimize and reprint the job to the Caddon can:view cabinet. Then, repeat the 
verify procedure.

You can open and analyze the measurement data in Verifier — for example, to compare 
against a simulation (reference) profile.

See also:

“To load a job in Fiery XF” on page 186

“To print a job” on page 189

“To verify the color accuracy of a job” on page 319
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CROP MARKS

Crop marks are lines that are printed at the corners of a page, a sheet, or a tile to indicate 
where to trim.

TO SET UP CROP MARKS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Finishing tab, open 
the Crop Marks pane.

• Go to Job Explorer. In the job list, click the job. On the Finishing tab, open the Crop 
Marks pane.

2 On the pane bar, select the check box to activate the settings.

3 Select “Page Marks”, “Sheet Marks”, or “Tile Marks”.

Sheet marks are available for nestings only.

4 Select a crop marks type.

Choose between “Standard”, “Corner”, “Frame” and “Tombo”. If you have a license for the 
Production Option, FOTOBA crop marks are also available.

Types of crop marks
1 Standard
2 Corner
3 Frame
4 Tombo

1

2

3

4
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5 Define the appearance of the crop marks.

You can specify the line thickness and length, as well as the distance between crop marks and 
job. Some of the settings are not available for certain types of crop marks.

The default color is black. By clicking the black box, you can select a different color.

6 Define a bleed setting (optional).

The bleed setting repositions the crop marks in relation to the image. By adding a frame, you 
can insert white space between image and crop marks. By cutting the image, you can crop 
each edge by a defined margin. Cut the image to eliminate unwanted paper white or to reduce 
the size of the image. 

The distance to job is also taken into account when you apply bleed. For example, if you place 
crop marks 1 cm from the image and add a frame with 1 cm bleed, the crop marks are 
positioned 2 cm from the image.

7 Save your changes.

If you work regularly with different crop marks, it is a good idea to save each group of settings 
as a preset. A preset is a template for a group of settings that are saved under a unique name. 
You can create presets in the presets menu in the pane bar. The next time you set up crop 
marks, you need only to select the preset name.

See also:

“FOTOBA crop marks” on page 234

Bleed
1 Add frame
2 Cut image

1

2
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GROMMET MARKS

If you have a license for the Production Option, you can print grommet marks. Grommet 
marks are often used in the production market to mount advertising banners and flags by 
feeding a rod through the grommet marks.

TO SET UP GROMMET MARKS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Finishing tab, open 
the Grommet Marks pane.

• Go to Job Explorer. In the job list, click the job. On the Finishing tab, open the Grommet 
Marks pane.

2 On the pane bar, select the check box to activate the settings.

3 Select “Page Marks”, or “Sheet Marks”.

Grommet marks for sheets are available for nestings only.

4 Select a grommet marks type.

Choose between “Circle”, “Ring”, and “Crosshair”.

Grommet marks
1 Circle
2 Ring
3 Crosshair

1 2

3
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5 Define the appearance of the grommet marks.

You can specify the diameter and the line thickness. Line thickness is not available for circle 
grommet marks.

The default color is black. By clicking the black box, you can select a different color.

6 Define a margin (optional).

By default, grommet marks are positioned along the edge of the image. You can reposition 
grommet marks relative to the edge of the image by defining a margin width and selecting 
“Inside” or “Outside”. The margin is applied to all four edges.

Margin
1 No margin (default)
2 Inside margin
3 Outside margin

1 2

3
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7 Define the distance from the job corner to the first grommet mark (optional).

This setting lets you fix the exact horizontal and vertical position of end grommet marks. The 
value you enter is the distance from the job corner to the center of the grommet mark.

Additional grommet marks are positioned between the two end points in accordance with the 
settings below.

8 Do one of the following:

• Define the number of grommet marks.

Each edge can have a different number of grommet marks. If no grommet marks are 
required along one edge, type “0” in the appropriate box.

• Define the targeted distance between grommet marks.

If no grommet marks are required along one edge, type “0” in the appropriate box.

The total available distance is equal to the width or height of the image. If the edge of the 
image is not exactly divisible by the targeted distance, the distance between grommet 
marks is rounded up or down to ensure that the grommet marks are distributed evenly 
apart. The actual calculated distance between grommet marks is displayed under the value 
you entered.

9 Save your changes.

If you work regularly with different grommet marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up 
grommet marks, you need only to select the preset name.

Distance from job corner
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FOTOBA CROP MARKS

If you have a license for the Production Option, you can print FOTOBA crop marks. 
FOTOBA crop marks are designed to enable precise positioning of the cutting blade on each 
device. The Cut Marks Option provides full support for Digitrim devices, as well as for XL 
and WR roll cutters.

TO SET UP FOTOBA CROP MARKS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Finishing tab, open 
the Crop Marks pane.

• Go to Job Explorer. In the job list, click the job. On the Finishing tab, open the Crop 
Marks pane.

2 On the pane bar, select the check box to activate the settings.

3 Select “Page Marks”, “Sheet Marks”, or “Tile Marks”.

Sheet marks are available for nestings only.

4 Select a type of FOTOBA crop marks.

Choose between “FOTOBA DIGITRIM”, “FOTOBA XL” and “FOTOBA WR”.

5 For FOTOBA XL or FOTOBA WR: Select “Cut fixed media slug (8 mm)” (optional). 

This setting applies a cut slug of 8 mm. The cut slug defines the distance between two cutting 
blades on devices with more than one blade. The cut slug is applied on top of the bleed 
setting.

In nestings and step and repeats, this setting can be applied only to pages.
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6 Define the appearance of the FOTOBA crop marks.

The available settings vary, depending on the type of FOTOBA crop marks you have selected.

For FOTOBA DIGITRIM, you can define a line thickness for horizontal crop marks.

For FOTOBA XL and FOTOBA WR, you can make independent settings for horizontal and 
vertical line thickness. By default, the vertical line thickness for FOTOBA WR is set to “0”, so 
that only horizontal crop marks (top and bottom) are visible. To add vertical crop marks, type 
a value in the appropriate box.

7 Define a color (optional).

The default color is black. By clicking the black box, you can select a different color.

8 Define a bleed setting (optional).

The bleed setting repositions the crop marks in relation to the image. By adding a frame 
around the image you can add white space between image and crop marks.

9 Save your changes.

If you work regularly with different FOTOBA marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up 
FOTOBA marks, you need only to select the preset name.
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KIPCUT MARKS

If you have a license for the KIP Printer Option, you can print KIPCut marks on a KIP 
C7800 printer and cut them on a connected FOTOBA KipCut cutter. KIPCut marks are 
used primarily for step and repeat jobs, or for nestings whose jobs are scaled to the same size.

TO SET UP KIPCUT CROP MARKS

The workflow template “KIPCut” is provided for production applications to help you to set 
up a workflow for jobs with KIPCut marks. The steps below explain how to customize the 
workflow for your specific needs.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Finishing tab, open 
the Crop Marks pane.

• Go to Job Explorer. In the job list, click the job. On the Finishing tab, open the Crop 
Marks pane.

2 On the pane bar, select the check box to activate the settings.

3 Select “Page Marks”, “Sheet Marks”, or “Tile Marks”.

Sheet marks are available for nestings only.

4 Select KIPCut.



KIPCUT MARKS 237

5 Define the appearance of the KIPCut crop marks.

You can define a line thickness for vertical and horizontal crop marks.

For wider jobs, you can increase the printable paper width by removing the KIPCut mark on 
the right. Select the appropriate check box.

6 Set an offset margin (optional).

The offset defines the non-printed margins at the top and bottom of the sheet. The offset 
margins ensure a smooth and correct paper feed from printer to cutter.

7 Define the distance between KIPCut marks and job.

8 Define a bleed setting (optional).

The bleed setting repositions the KIPCut marks in relation to the image. Type positive bleed 
values to insert white space between image and KIPCut marks. Type negative bleed values to 
eliminate any unwanted white space that is visible around the job after cutting. Be aware that 
negative bleed causes the knife to cut into the job, which makes the image smaller. You can 
counteract this by scaling the job in Fiery XF to preserve the original dimensions after cutting.

EFI provides a separate document on how to print and cut FOTOBA KIPCut marks using 
Fiery XF, a KIP C7800 printer, and a FOTOBA KipCut cutter. Visit our website at: 
http://w3.efi.com/services/fiery-wide-format-services/knowledge-center.

9 Save your changes.

If you work regularly with different KIPCut marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the pane bar menu. The next time you set up KIPCut marks, 
you need only to select the preset name.
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CUTTING OPTIONS

The following cutting licenses are available:

• Production Option

– You can set up grommet marks.

– You can set up FOTOBA marks.

• Cut Marks Option

– You can set up many different types of cutting marks, including i-cut level 1 and 
level 2, and EuroSystems OptiSCOUT Design 7 (for SUMMA F series).

– You can set up a connection to the Zünd Cut Center and print the cutting information 
to ZCC format.

• KIPCut Option

You can set up KIPCut marks to print on a KIP C7800 printer and to cut on FOTOBA 
KIPCut cutter.

• Print & Cut Option

This option provides support for a wide range of print-and-cut devices.

• Cut Server Option

This option outputs jobs to a wide range of additional cutters and routing tables that are 
not supported directly in Fiery XF.

For all five options, you require also the Spot Color Option. The Spot Color Option enables 
in-RIP separation, which ensures that the cut contour can be exported as a separated file.

See also:

“Grommet marks” on page 231

“FOTOBA crop marks” on page 234

“KIPCut marks” on page 236

Cut contours
To process jobs with cut contours:

• The cut contour must be created properly in the graphics program.

• The name of the cut contour must be defined in Fiery XF.
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Cut contours in the graphics program
In order for Fiery XF to extract cut contours from the job, observe the following when 
creating the image file in the graphics program:

• The cut contour must be defined as a CMYK spot color.

• The cut contour must be defined in a separate layer.

• Cut contours can be saved in different layers.

• The layer with the cut contour must be the top layer of the job. For example, in Illustrator, 
the cut contour layer must be at the top of the list of layers. 

If the job contains a lot of transparencies, it can slow down the RIPing speed. To get round 
this problem, it is recommended that you flatten all transparency levels. In Illustrator: On 
the Object menu, click Flatten Transparency, and clear the check box for converting all 
strokes to outlines.

If all transparencies are flattened, the cut contour can be extracted, even if it is not the top 
layer of the job.

Fiery XF provides a set of default cut contour names that are commonly used in the industry. 
Each name represents a particular cutting type. Fiery XF detects automatically cut contours 
with a default name. The default cut contour names are:

• Regmark

• Crease

• Kiss Cut

• Laser Cut

• Pen Plot

• Router Cut

• Score

• Through Cut

• CutContour

• Die line

Cut contours in Fiery XF
Fiery XF detects automatically the default contour names. If a cut contour is saved under a 
non-default name, you can either define it in System Manager, or you can select it in 
Job Explorer. When defined in System Manager, the cut contour becomes globally available 
for all future jobs. if you select a cut contour for a loaded job in Job Explorer, it is valid for the 
current job only.
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Fiery XF must handle all cut contours separately. In-RIP separation ensures that the cut 
contour can be exported as a separated file. If a cut contour cannot be detected in Fiery XF, 
the layer is processed as if it were a spot color in a composite job.

See also:

“i-cut cutter” on page 241

“Zünd Cut Center” on page 243

“Print-and-cut device” on page 245

“Cut Server” on page 247

Cut contours around bounding box (level 1 cut)
If a cutter is set up in Fiery XF, you can automatically create cut contours around non-vector 
graphics. For example, if you load a TIFF job, Fiery XF creates a cut contour around the 
document.

Many different cutting methods are available, depending on the selected cutting device. To 
select a cutting method, go to System Manager. On the Finishing tab, open the Cut pane. In 
the “Contour source” column of the contour colors table, select “Bounding Box”. In the 
“Method” column, double-click the selected item. Then, click the down arrow and click a 
different cutting method.

Setting up the cutter in Fiery XF
Fiery XF can output directly to an i-cut cutter, to a Zünd Cut Center, or to any supported 
print-and-cut device. Furthermore, if you have a license for the Cut Server Option, you can 
process register marks from a wide range of additional cutters and routing tables from many 
different manufacturers.
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i-cut cutter
i-cut marks enable you to save to file complex, irregular cutting paths that have been defined 
in any popular graphics program. i-cut marks act as an orientation guide for a built-in or 
auxilliary cutter, or for a print-and-cut plotter.

Fiery XF supports i-cut marks level 1, level 2, level 3 and level 5. I-cut marks level 4 
(barcodes) are not supported.

• i-cut level 1 converts the bounding box into a rectangular cut path.

The i-cut marks define the position of the substrate on the table. They are automatically 
placed around the job. You can adjust the position of the cut marks by editing the bleed 
value. It is not possible to add, delete or change the position of individual marks.

• i-cut level 2 enables Fiery XF to extract and save to file i-cut marks, and complex, irregular 
cut contours from EPS and PDF jobs.

• i-cut level 3 enables i-cut layer names to be extracted from EPS and PDF jobs.

• i-cut level 5 enables the insertion of i-cut register marks inside bounding boxes.

TO SET UP I-CUT MARKS

1 Go to System Manager. In the layout area, click the workflow.

The workflow template “Contour cutting” is provided for production applications to help 
you to set up a workflow for jobs with i-cut level cut marks.

2 On the Finishing tab, open the Cut pane.

3 On the pane bar, select the check box to activate the settings.

4 Under “Device manufacturer”, select “iCut”.

5 Under “Device type”, select “i-cut”.

6 Under “Cut marks type”, select an i-cut type.

Choose from “i-cut filled”, “i-cut reverse” or “i-cut ring”.

i-cut
1 i-cut level 1 (in a nesting)
2 i-cut level 2

1
2
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7 Do one of the following:

• Define how many i-cut marks are positioned along the horizontal and vertical edges of the 
image.

The minimum number of i-cut marks is two vertical and two horizontal.

• Define the distance between two i-cut marks along each edge of the image. 

This setting can result in a larger gap between the last i-cut mark and the corner of the 
image if the length of the edge is not exactly divisible by the defined distance.

8 Click “Print with tinted background” (optional).

On some media types, the cut marks can be difficult to see. This setting overcomes the 
problem by printing the cut marks on a yellowish background.

9 Click “Print between layout elements” (optional).

This setting prints cut marks between nested pages and step and repeat elements.

10 Define a bleed setting (optional).

The bleed setting repositions the i-cut marks in relation to the image. The i-cut marks are an 
orientation guide for the cutting machine. By adding a frame around the image you can add 
white space between image and i-cut marks. By cutting the image, you can crop each edge by 
a defined margin. Cut the image to eliminate unwanted paper white or to reduce the size of 
the image. It is not possible to move i-cut marks inside the bounding box (i-cut level 1) or 
inside the cut contour (i-cut level 2).

11 Under “Export path”, select a folder in which to save the cut contour files.

Click Choose and browse to a different folder if you do not want to use the default folder.

The following cut contour files are created during job processing:

• i-cut level 1 creates an *.cut file.

• i-cut level 2 creates a *.cut file and an *.ai file.

12 Under “Contour cutting”, select “Extract contour path from EPS/PDF”.

If you do not extract the contour path from EPS/PDF jobs, or if the job does not contain a 
contour path, the bounding box is automatically used as the cut contour.
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13 Define non-default cut contours (optional).

If your jobs regularly contain cut contours that are saved under a non-default name, you can 
define them here. The cut contours you define in System Manager are automatically applied 
to all workflows.

• Under the table, click Add (+).

A new row is added to the contour colors table.

• In the “Contour source” column, overwrite “Enter spot color name” with the exact name 
of the cut contour from the graphics program. Then press <Enter>.

• In the “Method” column, double-click the selected item. Then, click the down arrow and 
click a different cutting method (optional). Alternatively, click User defined to define a 
custom cutting method.

If your jobs are often created with different cut contour names, you can select them on a 
job-to-job basis in Job Explorer.

If you work regularly with different types of cut marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up cut 
marks, you need only to select the preset name.

14 Save your changes.

See also:

“Managing cut contours” on page 250

Zünd Cut Center
The Zünd Cut Center enables you to save more than one cutting path per job. When working 
with the Zünd Cut Center, the software dynamically guides you through the cutting process 
by continually offering best choices that are based on the available cutting tools, the material 
to be cut, and quality requirements.

TO SET UP A ZÜND CUT CENTER

1 Go to System Manager. In the layout area, click the workflow.

The workflow template “Zund Cut Server Connectivity” is provided for production 
applications to help you to set up a workflow for jobs with i-cut level cut marks.

2 On the Finishing tab, open the Cut pane.

3 On the pane bar, select the check box to activate the settings.

4 Under “Device manufacturer”, select “Zund”.

The “Send to cut server after printing” check box is automatically selected. Clear the check 
box if you do not want the cut data to be sent automatically to the Zünd Cut Center after 
printing.
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5 Under “Device type”, select a Zünd G3- or S3-series cutter.

6 Under “Cut marks type”, select a Zünd marks type.

Choose between “Zund circle (Camera)”, “Zund reverse circle (Camera)”, “Zund cross 
(Manual)”, and “Zund reverse cross (Manual)”.

7 Define the distance between two Zünd marks along each edge of the image. 

This setting can result in a larger gap between the last Zünd mark and the corner of the image 
if the length of the edge is not exactly divisible by the defined distance.

8 Click “Print with tinted background” (optional).

On some media types, the cut marks can be difficult to see. This setting overcomes the 
problem by printing the cut marks on a yellowish background.

9 Click “Print between layout elements (optional).

This setting prints cut marks between nested pages and step and repeat elements.

10 Define a bleed setting (optional).

Zünd marks are positioned relative to the media box. The bleed setting adds a frame of white 
space around the media box. Be aware that you cannot apply the bleed setting to the trim box.

11 Under “Export path”, do one of the following:

• Click “Export path” to select a folder in which to save the cut contour files.

Click Choose and browse to a different folder if you do not want to use the default folder.

• Click “IP address” to submit the cut contour files directly to a Zünd Cut Center.

Type the IP address of the Zünd Cut Center. Then, type the IP port. The IP port could be 
50000. For more information, see the Zünd Cut Center documentation.

You can check whether the connection to the Zünd Cut Center has been properly 
established by clicking Test. To test the connection, the ZCC software must be started. If 
you receive an error message, contact your system administrator for advice.

A *.zcc file is created during job processing.

12 Under “Contour cutting”, click “Extract contour path from EPS/PDF”.

If you do not extract the contour path from EPS/PDF jobs, or if the job does not contain a 
contour path, the bounding box is automatically used as the cut contour.
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13 Define non-default cut contours (optional).

If your jobs regularly contain cut contours that are saved under a non-default name, you can 
define them here. The cut contours you define in System Manager are automatically applied 
to all workflows.

• Under the table, click Add (+).

A new row is added to the contour colors table.

• In the “Contour source” column, overwrite “Enter spot color name” with the exact name 
of the cut contour from the graphics program. Then press <Enter>.

• In the “Method” column, double-click the selected item. Then, click the down arrow and 
click a different cutting method (optional).

Advanced settings are available for some cutting methods. Click the pen button to open 
the Advanced contour settings dialog box. You can change the line length, the bit 
diameter, the grooving angle, and the z depth.

• In the “Mode” column, double-click “Standard”. Then, click the down arrow and click a 
mode (optional).

The mode affects speed and quality. The speed setting ensures that the printout is cut as 
quickly as possible, but it may not be exact. With the quality setting, the cut is more 
precise, but it takes longer.

If your jobs are often created with different cut contour names, you can select them on a 
job-to-job basis in Job Explorer.

If you work regularly with different types of cut marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up cut 
marks, you need only to select the preset name.

14 Save your changes.

See also:

“Managing cut contours” on page 250

Print-and-cut device
Fiery XF enables you to print and cut register marks with a wide range of different 
print-and-cut devices. Print-and-cut devices must be set up in Fiery XF as a printer.

TO SET UP A PRINT-AND-CUT DEVICE AS A PRINTER

1 Go to System Manager. In the layout area, click the output device.

2 On the Device tab, open the Connection pane, and set up the printer.

3 On the Media tab, open the Print Configuration pane, and select a media.
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4 On the Special tab, open the Special Printer Settings pane. Under “Contour cutting”, select a 
mode.

The following settings are available:

5 Save your changes. 

TO PRINT AND CUT IN ONE STEP

Perform the following steps to cut the job immediately after printing.

1 Go to System Manager. In the layout area, click the workflow. 

2 On the Finishing tab, open the Cut pane.

3 On the pane bar, select the check box to activate the settings.

4 Under “Device manufacturer”, select None.

5 Under “Contour cutting”, click “Extract contour path from EPS/PDF”.

If you do not extract the contour path from EPS/PDF jobs, or if the job does not contain a 
contour path, the bounding box is automatically used as the cut contour.

6 Define non-default cut contours (optional).

The cut contours you define in System Manager are automatically applied to all workflows. It 
is useful to define cut contours if your jobs always use the same names.

• Under the table, click Add (+).

A new row is added to the contour colors table.

• In the “Contour source” column, overwrite “Enter spot color name” with the exact name 
of the cut contour from the graphics program. Then press <Enter>.

If your jobs are often created with different cut contour names, you can select them on a 
job-to-job basis in Job Explorer.

If you work regularly with different types of cut marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up cut 
marks, you need only to select the preset name.

7 Save your changes.

Print mode Description

Print Prints the job, but does not cut the contour data.

Print & Cut Prints the job and cuts the contour data.

Cut only Cuts the contour data, but does not create a printout.
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TO PRINT AND CUT IN TWO STEPS

Perform the following steps to cut the job as a separate step. For example, use this method if 
you want to laminate your job before cutting.

• To print the job:

– Go to System Manager. In the layout area, click the output device, and open the 
Special tab.

– Under “Contour cutting”, select the print mode “Print”. Then, click “Enable printer 
cut marks”.

– In the layout area, click the workflow. On the Finishing tab, open the Cut pane.

– On the pane bar, select the check box to activate the settings.

– Under “Contour cutting”, click “Extract contour path from EPS/PDF”.

If you do not extract the contour path from EPS/PDF jobs, or if the job does not 
contain a contour path, the bounding box is automatically used as the cut contour.

• To cut the job:

– Go to Job Explorer. In the job list, click the job. On the Output tab, open the Special 
Printer Settings pane.

– Under “Contour cutting”, select the mode “Cut only”.

– On the toolbar, click Print & Cut.

Alternatively, right-click the job in the job list, and click Print & Cut.

See also:

“Connection” on page 474

“Print Configuration” on page 477

“Managing cut contours” on page 250

Cut Server 
The Cut Server Option increases productivity by seamlessly connecting job output and 
finishing processes. One license entitles you to install the software on up to four different 
computers and to set up a maximum of two different cutters for each in Fiery XF. Therefore, 
you can drive up to eight cutting devices in parallel.

Cut Server enables you to cut register marks with a wide range of cutters and routing tables, 
thus eliminating the need to work with different software applications for each cutter. 
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TO INSTALL CUT SERVER

You can install Cut Server on any Windows computer. The Fiery XF server does not have to 
be installed on the same computer.

1 Insert the software DVD into the DVD-ROM drive of a Windows computer.

In the Welcome screen, click Install Fiery XF.

2 Display the contents of the DVD in Windows Explorer.

3 Open the EFI Cut Server folder, and double-click the AUTORUN application file.

4 Follow the on-screen instructions to complete the installation.

5 Install the Cut Server license on a computer that is running the Fiery XF server software.

TO SET UP FIERY XF

1 Go to System Manager. In the layout area, click the workflow.

2 On the Finishing tab, open the Cut pane.

3 On the pane bar, select the check box to activate the settings.

4 Under “Device manufacturer”, select a cutter manufacturer.

The “Send to cut server after printing” check box is automatically selected. This setting 
ensures that jobs are submitted first to Cut Server and then forwarded to the cutter that you 
select on this pane. Clear the check box if you do not want the cut data to be sent 
automatically to the cutter after printing.

5 Under “Device type”, select a cutter type.

6 Under “Cut marks type”, select a cut marks type.

7 Under “Export path”, select a folder in which to save the cut contour files.

Click Choose and browse to a different folder if you do not want to use the default folder. The 
export folder must also be set up as the hotfolder in Cut Server. If a hotfolder is already set up 
in Cut Server, select it as the export folder here.

An *.ai file and an xml job ticket are created during job processing.

8 Under “Contour cutting”, click “Extract contour path from EPS/PDF”.

If you do not extract the contour path from EPS/PDF jobs, or if the job does not contain a 
contour path, the bounding box is automatically used as the cut contour.
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9 Define non-default cut contours (optional).

The cut contours you define in System Manager are automatically applied to all workflows. It 
is useful to define cut contours if your jobs always use the same names.

• Under the table, click Add (+).

A new row is added to the contour colors table.

• In the “Contour source” column, overwrite “Enter spot color name” with the exact name 
of the cut contour from the graphics program. Then press <Enter>.

• In the “Method” column, double-click the selected item. Then, click the down arrow and 
click a different cutting method (optional).

If your jobs are often created with different cut contour names, you can select them on a 
job-to-job basis in Job Explorer.

If you work regularly with different types of cut marks, it is a good idea to save each group of 
settings as a preset. A preset is a template for a group of settings that are saved under a unique 
name. You can create presets in the presets menu in the pane bar. The next time you set up cut 
marks, you need only to select the preset name.

10 Save your changes.

TO SET UP CUT SERVER

1 Start Cut Server. Do one of the following:

• Double-click the program icon on the desktop.

• Click the Start button, point to All Programs, click EFI, click EFI Cut Server1, and click 
EFI Cut Server.

The EFI Cut Server Login dialog box appears.

2 From the drop-down list box, select the Fiery XFserver on which the Cut Server license is 
installed.

3 Click Select.

The Add Setup dialog box appears.
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4 Follow the on-screen instructions to set up your cut device.

Afterwards, the program window appears.

5 On the Edit menu, click Preferences, and make sure that a hotfolder is set up.

The hotfolder must match the export folder in Fiery XF. Browse to the export folder that you 
defined in Fiery XF. Then, click OK.

Although Cut Server must be installed on a Windows computer, it can receive jobs from an 
Fiery XF server that is installed on either Windows or Macintosh.

For more information on using Cut Server, see the Cut Server help.

See also:

“Licensing” on page 42

“Managing cut contours” on page 250

Managing cut contours
To process a job with cut contours correctly in Fiery XF, the following criteria must be met:

• In the graphics program, the cut contour must be created in a spot color.

• The spot color must be defined in Fiery XF.

It is a good idea to load cut contour jobs as “hold” jobs. That way, you can check the cut 
contour settings before job processing starts.
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TO DEFINE NON-DEFAULT CUT CONTOURS FOR KNOWN SPOT COLORS

Follow these steps if:

• The cut contour is a known spot color.

• The cut contour is not a default cut contour.

1 Go to Job Explorer. In the job list, click the job. On the Finishing tab, open the Cut pane.

The contour colors table shows the job’s cut contours.

“CutContour” is a default contour color that is detected in Fiery XF. The other three cut 
contours are recognized spot colors, but they have not been defined as cut contours in 
Fiery XF.

If the table displays an unknown spot color, you must define the unknown spot color.

2 Under “Contour cutting”, click “Extract contour path from EPS/PDF”.

If you do not extract the contour path from EPS/PDF jobs, or if the job does not contain a 
contour path, the bounding box is automatically used as the cut contour.

3 Select the check box next to each required cut contour.

By selecting the check box, you enable Fiery XF to extract the cut contour.

Job with cut contours
1 Default cut contour
2 Undefined cut contours

1
2
2
2
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4 Save your changes.

The scissor icon indicates which cut contours will be extracted.

TO SELECT CUT CONTOURS FOR UNKNOWN SPOT COLORS

Follow these steps if:

• The cut contour is a default cut contour.

• The cut contour is an unknown spot color.
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Cut contours that have been defined in a spot color that is not recognized in Fiery XF are 
shown as follows:

You must first define the spot color and then select the cut contour.

1 Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors pane.

The spot color table shows the unknown spot color.

2 Define the unknown spot color.

Job with cut contour in an 
unknown spot color
1 Cut pane

1
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3 Save your changes.

4 On the Finishing tab, open the Cut pane.

The contour colors table shows the job’s cut contours.

5 Select “Extract contour path from EPS/PDF”.

6 Select the check box next to each required cut contour.

7 Save your changes.

The scissor icon indicates which cut contours will be extracted.
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See also:

“Cut contours in the graphics program” on page 239

“To select cut contours for unknown spot colors” on page 252

“To define spot colors for a loaded job” on page 276

Processing cut contours
Before printing cut contours, check the following:

• Make sure that in-RIP separation is set to “Force”. By forcing in-RIP separation, you 
ensure that cut contours are output as separated files.

• Make sure that the working color space is set to “CMYK”. The RGB working color space 
converts all spot colors to RGB, which prevents the cut contour from being extracted.

If you have a license for the Advanced Layout Option, you can often reduce media 
consumption considerably. The Advanced Layout Option is a tool with advanced nesting 
features that take specific job shapes into consideration by nesting jobs according to their 
contours. You can also use the Advanced Layout Option to create cut contours.

TO OUTPUT JOBS WITH CUT CONTOURS

1 Go to Job Explorer. In the job list, click the job.

2 Do one of the following:

• On the toolbar, click Print & Cut.

• In the job list, right-click the job in the job list, and click Print & Cut.

TO EXCLUDE CUT CONTOURS FROM THE OUTPUT

You can exclude cut contours from a job by ensuring that no cut file is created. In this case, 
the separation with the cut contour is printed out composite.

1 Go to Job Explorer. In the job list, click the job. On the Finishing tab, open the Cut pane.

2 Under “Contour cutting”, clear “Extract contour path from EPS/PDF”.

3 Save your changes.

4 Print the job.

TO EXCLUDE THE COLOR SEPARATION WITH THE CUT CONTOUR FROM THE OUTPUT

You can output a job that excludes the separation with the cut contour layer.

1 Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors pane.
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2 In the spot color table, clear the check box for the cut contour.

3 Save your changes.

4 Print the job.

The separation with the cut contour is excluded from the output. The cut contour is neither 
extracted from the job, nor is it printed composite.

TO REMOVE VISIBLE CONTOUR MARKINGS FROM THE OUTPUT

Normally, contour markings are not visible in the printout. However, occasionally, the 
contour may be seen as a white outline. This is because the overprinting attribute of most 
contours is set to knock out and not to overprint.

In this case, you need to open the file in an external program, such as Enfocus PitStop, and set 
the overprinting setting to overprint.



CUTTING OPTIONS 257

The following illustration shows the effect of applying the overprint setting.
.

See also:

“In-RIP separation” on page 98

“Applying a working color space” on page 101

“Advanced Layout” on page 258
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ADVANCED LAYOUT 
The Advanced Layout Option is a smart nesting program. It provides many professional 
functions that are not part of the standard nesting feature of Fiery XF. If you have a license for 
the Advanced Layout Option, you can:

• Nest jobs according to their contours

• Create cut contours that are based on individual image shape with an automatic bleed that 
clones image content

• Create perfectly aligned double-sided prints

• Optimize cut contours for smoothness

• Place i-cut marks and grommet marks around the smart nesting

Be aware that jobs are assumed to be ready for output. In Advanced Layout, jobs can be 
scaled, but they cannot otherwise be edited.

Advanced Layout supports the following file formats: JPG, TIFF, PSD, PDF and image EPS.
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TO EXPORT A JOB TO ADVANCED LAYOUT

1 Go to Job Explorer. Do one of the following:

• In the job list, right-click one or more jobs, and click Advanced Layout.

• In the job list, click one or more jobs. On the toolbar, click Layout.

If you select multiple jobs from different workflows simultaneously, you are prompted to 
choose a workflow for Advanced Layout. Only one set of workflow settings can be exported.

The job is exported and the Advanced Layout program window opens.

The program window displays the jobs on the right, and an empty layout (plate) on the left. If 
Advanced Layout is not running when you export jobs from Fiery XF, the plate has the same 
size as the media that is selected for the Fiery XF output device. If Advanced Layout is already 
started, the current plate size from Advanced Layout is used. You can define a new plate size in 
Advanced Layout, if required.

All workflow settings from Fiery XF that affect the job’s appearance, such as scaling and spot 
color definitions, are exported with the job to Advanced Layout. In contrast, only a minimum 
of job settings are exported: the scaling factor, and the defined number of copies.

After you have created a smart nesting, you can send it back to Fiery XF for printing. For 
more information, see the Advanced Layout help.
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ONE-BIT FILES

If you have a license for the OneBit Option, you can process one-bit files that have been 
produced by an imagesetter, a platesetter or a digital print solution in the pre-press industry.

To create one-bit files, these output devices have an integrated RIP that converts PostScript 
and PDF files into screen dots. The screen dot information is saved in the form of one-bit 
TIFF files — one file for each color separation.

Since these files have already been RIPed by an external RIP, the integrated RIP of Fiery XF is 
not applied during one-bit-file processing. The necessary screening information (screen dot 
shape and size, screen ruling) is simply extracted from the one-bit file when the digital proof is 
printed. 

Therefore, digital proofs that are output with the OneBit Option are not only color accurate, 
but also give a true screen representation of the final print run. This makes the OneBit 
Option an ideal tool with which to check for possible moiré patterns or rosettes.

The following one-bit file formats are supported: Tiff G4, Tiff G3, Packbit, LZW compressed 
Tiff, uncompressed Tiff, Presstek, Huffman, PCX, Len, Harlequin, Pagebuffer, Founder, 
DSC1/DCS2 (copy-dot format).

It is recommended that you do not use a laser printer to output one-bit files, due to the 
different screening methods. You cannot create high-quality proofs if you apply both laser 
screening and one-bit screening to a job. Laser printers are, therefore, only suitable for 
creating imposition proofs.

You can modify the plate characteristics that are often applied to one-bit files. Plate 
characteristics control the size of screen dots when they are output on the platesetter.



ONE-BIT FILES 261

TO SET UP A WORKFLOW FOR ONE-BIT FILES

1 Go to System Manager. In the layout area, click the workflow. On the File tab, open the 
One-bit pane.

2 Do one of the following:

• Type the number of seconds’ wait before job completion.

This setting determines how long Fiery XF waits for incoming one-bit files that belong to 
the same job. When this time span has elapsed, Fiery XF assumes that all the files have 
been received and starts printing.

• Select “Number of one-bit files in a job” and type a number.

This setting defines how many one-bit files belong to each job. Fiery XF waits until the 
defined number of one-bit files has been received before starting to print.

This setting overrides “Waiting time for job completion” and prevents jobs from being 
automatically printed when the time-out period has elapsed. Since printing starts as soon 
as all one-bit files have been received, it prevents unnecessary idle time.

3 Select “Sub-directory for each job” (optional).

This setting determines whether a sub-directory is created for each job. You must select this 
setting if your one-bit files were created by a RIP that automatically generates sub-directories 
in which to save one-bit files.

4 Under “File name contains the name of the color separations”, select or define a character 
sequence that fits the file naming convention of your one-bit files.

This setting ensures that Fiery XF correctly recognizes the job name and all one-bit files that 
belong to each job. Make sure that you select a character sequence that is generic for all the 
files that you process.

By default, Fiery XF analyzes file names from right to left, whereby the file extension is not 
taken into account. 

The variables have the following meanings:

%j Represents the job name.

%c Represents the name of the one-bit file.

%f Stands for “ignore”. It is most often used to instruct Fiery XF to ignore consecutive 
numbers (such as film numbers) that are automatically added to the file name by 
some RIP solutions. By inserting a number, you can define how many characters 
are ignored — for example, %4f.
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Example:

5 Select “Analyze file name from left to right” (optional).

By default, Fiery XF analyzes file names from right to left. However, in some cases it may be 
preferable to read file names from the left.

Example:

6 Select “Extract color separation from file header” (optional).

If you select this setting, the color information is extracted from the file header (information 
contained in the one-bit file itself ) instead of from the file name of the one-bit file.

This setting is useful if the individual color separations cannot be identified in the name of the 
one-bit files — some RIP devices do not save the color separation as part of the file name.

If you are using the Macintosh version of Fiery XF, you may find that the file name is 
truncated at 32 characters, which makes it impossible to identify the color separation. In this 
case, this setting may provide a convenient way to get round the problem. Alternatively, you 
can rename the files before loading in Fiery XF.

One-bit file names Character sequence Description

01_efiflyer_(cyan).tif 
02_efiflyer_(magenta).tif 
03_efiflyer_(yellow).tif 
04_efiflyer_(black).tif

%f_%j_(%c).tif • Fiery XF processes files that use an 
underscore as the separator.

• Fiery XF processes files whose color 
separations are set in parentheses.

• Fiery XF ignores all characters in 
the file name to the first underscore 
(when read from right to left).

One-bit file names Character sequence Description

efiflyer-(cyan)-00157.tif 
efiflyer-(magenta)-00158.tif 
efiflyer-(yellow)-00159.tif 
efiflyer-(black)-00160.tif

efiflyer-(cyan)-01-00.tif 
efiflyer-(magenta)-02-00.tif 
efiflyer-(yellow)-03-00.tif 
efiflyer-(black)-04-00.tif

%j-(%c)-%5f.tif • Fiery XF processes files that use a 
dash as the separator.

• Fiery XF processes files whose color 
separations are set in parentheses.

• Fiery XF ignores all characters in 
the file name after the second dash 
(when read from left to right)
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7 Under “Proofing method”, select an item.

8 Save your changes. 

TO CHANGE THE PROOFING METHOD OF A ONE-BIT JOB

Settings for one-bit jobs are made at workflow level. In Job Explorer, you can change only the 
proofing method. The proofing method affects the print quality and print speed.

1 Go to Job Explorer. In the job list, click the job. On the File tab, open the One-bit pane.

2 Under “Proofing method”, select an item.

The available settings are:

• Imposition proof

• Contract proof

• Contract proof with sharp dots

3 Save your changes.

See also:

“One-bit (System Manager)” on page 408

“One-bit (Job Explorer)” on page 409

“Modifying plate characteristics” on page 170

Proofing method Description

Imposition proof Select this item if you want to make a final check before 
going to press.

Note that imposition proofs are not color accurate. 
Therefore, use this setting only to check the content and 
completeness of the elements of the printing copy.

Contract proof Select this item to create a color-accurate screen proof.

Contract proofs are color managed. For this reason, they 
are often seen as a binding color contract between 
customer and printing house. A contract proof is usually 
the final proof that is created before going to press.

Contract proof with sharp 
dots

Select this item to create a quick, color-accurate screen 
proof.

The print quality is slightly lower than that of a standard 
contract proof.
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JDF INTEGRATION

JDF enables bidirectional communication between Fiery XF and other JDF-compliant 
devices. Fiery XF supports JDF-compliant devices and programs from EFI and third-party 
manufacturers.

You can integrate JDF into a Fiery XF workflow:

• Fiery XF can transmit information about the current job status back to the Management 
Information System (print MIS device),.

• Fiery XF can receive information about media consumption and ink consumption from 
the printer.

• If supported by the particular combination of JDF devices, Fiery XF can receive 
print-ready jobs from the print MIS device and submit them to the printer.

 

The following JDF/JMF file formats are supported:

• MIME package

• JDF/JMF with content (URL)

• JDF/JMF without content
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Setting up a JDF connection
To set up a JDF connection, certain settings are necessary at the print MIS device, in 
Fiery XF, and at the output device.

Before setting up a JDF connection, make sure of the following:

• The workflow name and the output device name cannot contain special characters.

• The workflow must be connected to a valid output device.

TO SET UP A JDF CONNECTION TO A PRINT MIS DEVICE

1 Go to System Manager. On the Tools menu, click System Information.

2 Under “General settings”, select “Enable JDF communication”, and click OK.

3 On the Edit menu, click JDF Device Registration.

4 Type the IP address and the port number of the workstation on which the MIS software is 
installed.

The default port number is 9200 in http mode and 12443 when running as https. You can 
check that the connection has been established by clicking Test.

TO SET UP A JDF CONNECTION TO A JDF-COMPLIANT OUTPUT DEVICE

1 Go to System Manager. On the Tools menu, make sure that “System Information” is selected.

2 Under “General settings”, select “Enable JDF communication”, and click OK.
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3 On the Edit menu, click JDF Export Folder.

By default, processed jobs are saved to the JDF\UploadFiles folder. The printer retrieves them 
from this folder. If your computer configuration permits it, it is recommended that you 
browse to a folder on a different partition to free up disk space on the C drive.

4 In the layout area, click the output device. On the Device tab, open the Connection pane.

5 Under “Connection type”, select “Print via JDF port”.

One VUTEk printer license enables you to print to an unlimited number of output devices 
via the JDF port or via file output. The only prerequisite is that all the output devices, 
including the linearization device, must be configured to print to the same VUTEk printer.

6 Type the IP address of the printer, and the IP port.

The default IP port is 8013. For more information, ask your system administrator.

You can check that the connection has been established by clicking Connect. To test the 
connection, the printer must be switched on. If you receive an error message, contact your 
system administrator for advice.

7 Save your changes.

See also:

“Creating a system configuration” on page 50

“To create a new output device” on page 60

“Printing to a VUTEk printer” on page 223

Mapping a print MIS database to a base linearization file in Fiery XF
When you select a media name in Fiery XF, a base linearization file is applied. The base 
linearization file contains details of the print settings for the job: printer model, ink type, 
number of inks, and print resolution. Print MIS devices and Digital StoreFront manage 
media types differently. The media sizes are saved in a database, but the database entries do 
not contain details of print settings.
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So that you can use the database entries from print MIS devices, a special tool called Media 
Mapper is provided. This tool enables you to link each database entry to a base linearization 
file in Fiery XF.

When you set up a JDF connection to a print MIS device in Fiery XF, the contents of the 
database are automatically submitted to Fiery XF. The database is regularly synchronized.

TO MAP A PRINT MIS DATABASE TO BASE LINEARIZATION FILES IN FIERY XF

1 On the Tools menu, click Map Media.

The Map Media dialog box appears. The left-hand side displays a list of media from the print 
MIS database. The right-hand side displays the media names that are available in Fiery XF.

2 Under “XF Media”, select a manufacturer, a printer, and an ink type.

3 Do one of the following:

• Drag a print MIS media from the left-hand side on to a Fiery XF media name.

• Right-click the MIS media, and click Map.

The print settings from the base linearization file are displayed. Be aware that some media 
may have more than one base linearization file. From the drop-down list box, select the base 
linearization file that was created for the desired print settings.

4 Click Save.

When you load a JDF job, Fiery XF applies the base linearization file that is linked to the 
print MIS media.

You can export details of media mappings to a CSV file. On the Edit menu, click Export 
Media Catalog.

TO PROCESS JDF JOBS WITH AN UNMAPPED MEDIA

If the media that is selected for an incoming JDF job is not mapped to a base linearization file, 
the job receives an error status in Fiery XF. You can link the job to an appropriate base 
linearization file by right-clicking the job and clicking Map media. The Map Media dialog 
box appears. The workflow printer is pre-selected. Alternatively, you can create a new base 
linearization file for a print MIS database entry.

See also:

“To create a new base linearization file” on page 155

“To map a print MIS database to base linearization files in Fiery XF” on page 267
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JDF jobs in Fiery XF 
JDF Connector runs as a service. It starts up automatically whenever the Fiery XF server is 
started. If the server is not running, the JDF connection is interrupted.

How JDF jobs are loaded in Fiery XF depends on the number of content files that are 
attached. Jobs with only one content file are loaded as single jobs. Jobs that have either no 
content files or multiple content files are loaded as nestings.

Job names are retained. If a JDF job is submitted without a job name, it receives a default job 
name. You can rename it, if required.

In the job list , the job status is displayed in the ”JDF Status” column. If the column is not 
displayed, you can add it. The following statuses are possible:

See also:

“Customizing the job list” on page 76

“To add a content file to a JDF job” on page 269

Viewing JDF job information
The following job information must be entered in the JDF-compliant program before 
submitting the job:

• Job ID

• Customer ID, name, info

The following information is optional:

• Content or URL to the content

• Job name

• Job description

• Media size

• Orientation

• Number of printouts

Status Meaning

Submitting The JDF job is being loaded.

Received The JDF job is ready for printing.

Not complete The loaded JDF job has no content. You must add a 
content file before job processing can start.

Completed Job processing has been completed.
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TO VIEW JDF JOB INFORMATION IN FIERY XF

1 Go to Job Explorer. In the job list, click the job. On the File tab, open the JDF Ticket pane.

2 Click Details.

The JDF Job Properties dialog box appears. It displays details of the following:

• Job

• Media, media consumption, media wastage

• Ink, ink consumption

• Printing time

Adding content files
You can add files to JDF containers that were submitted to Fiery XF either with no content 
files or with multiple content files. It is not possible to add further content to JDF jobs that 
were created from just one content file.

To add content to JDF jobs, use one of the following methods:

TO ADD A CONTENT FILE TO A JDF JOB

1 In the job list, right-click the JDF container, and click Add Content File.

The Import Job dialog box appears.

You can add a file in any format that is supported in Fiery XF. Content files that are added in 
Fiery XF are neither automatically placed, nor are they arranged on the media.

2 Browse to the job you want to add as content, and click Open.

The job is added to the JDF container.

3 In the job list, for each content file, click “Placed”.

If the “Placed” column is not displayed, you can add it.

4 On the Layout tab, open the Nesting pane.

5 Click Apply to arrange the images on the sheet.

You can also add content files to a JDF job by assigning a JDF ticket.
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TO ASSIGN A JDF TICKET 

In MIS-controlled environments, it is often desirable to track jobs, regardless of how they are 
submitted to Fiery XF.

A JDF ticket is created for each JDF job that is loaded in Fiery XF. However, occasionally you 
may need to load a job by another means, such as directly from a graphics program. This 
would be necessary, for example, if the image is in a format that is not supported for JDF. In 
this case, you can add a job by assigning a JDF ticket.

1 In the job list, click the job that you want to add to the JDF job.

2 On the File tab, open the JDF Ticket pane.

3 Under “Attach JDF ticket”, from the drop-down list box, select the JDF job, and click Apply.

JDF ticket names are made up of the job ID and the file name. If the job has been loaded with 
the default name, you can rename it with a unique name to make it easier to identify.

The job is moved and becomes part of the JDF job.

See also:

“Customizing the job list” on page 76

Editing JDF jobs in Fiery XF
Normally, JDF jobs that are submitted to Fiery XF are processed as soon as they enter the job 
list. Therefore, if you need to edit a JDF job in Fiery XF, make sure that the workflow is set 
up as a “hold” workflow.  When you have made your required changes, you can start printing 
manually.

You can edit content files like any other job. If your JDF job contains multiple content files, 
the nesting settings are also available. 

TO DELETE CONTENT FILES

1 Do one of the following:

• In the job list, right-click the content file, and click Delete.

• In the job list, right-click the content file. In the toolbar, click Delete Job.

• In the job list, right-click the content file. Press <Del>.

See also:

“To set a system configuration offline” on page 66

“Editing jobs” on page 88

“Aligning nested pages” on page 114
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BACKUP AND RESTORE

By backing up your settings, you can restore Fiery XF to an earlier state quickly and easily. 
There are two types of backup:

• A system configuration backup

Back up your system configuration before reinstalling Fiery XF. Afterwards, by loading the 
system configuration backup file in the new installation, you can quickly and easily restore 
Fiery XF to its former state.

• An environment backup

Back up your environments if you need to output repeat jobs at regular intervals. By saving 
and restoring environment backups, you can be sure that you use exactly the same settings 
each time. You can also use an environment backup to provide customers with exact 
workflow/printer information.

Backing up a system configuration
A system configuration backup saves:

• The Fiery XF server configuration

• All user settings

• All workflow settings, including workspaces, selected presets, base linearization files, spot 
color tables and profiles

• All printer setups
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TO BACK UP A SYSTEM CONFIGURATION

1 Go to System Manager. On the File menu, click Backup.

2 Select the check boxes of the items you want to back up.

The server configuration is saved by default.

3 Define a backup location.

By default, system configuration backups are saved to two destinations: the Backup folder and 
the desktop. To change the second destination, click Select and browse to a new destination.

4 Click Save.

A dialog box appears when the backup has been successfully saved.

5 Click OK to complete the backup procedure.

TO RESTORE A SYSTEM CONFIGURATION

Restoring a system configuration causes all existing files of the same name to be overwritten. 
All non-backed-up user, workflow and printer setups are reset to their default values.

1 Go to System Manager. On the File menu, click Restore.

The Restore dialog box appears. It displays the contents of the Backup folder.

2 Click the backup file.

If the folder is empty, click Choose and browse to the backup file. Unless you defined a 
different destination during the backup procedure, the file is located on the desktop. Select 
the backup file and click Open.
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3 Click OK.

A dialog box appears when the backup has been successfully restored.

4 Click OK, and then restart the Fiery XF server to view the restored system configuration.

Saving an environment
An environment backup saves:

• All workflow settings, including selected profiles, presets, base linearization files and spot 
color tables

• The printer setup

TO SAVE AN ENVIRONMENT

You can save an environment for a workflow or for a job.

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the File menu, click 
Save as Environment.

• Go to System Manager. In the layout area, right-click the workflow and click Save as 
Environment.

• Go to Job Explorer. In the job list, click the job. On the File menu, click Save as 
Environment.

• Go to Job Explorer. In the job list, right-click the job and click Save as Environment.

The Save as Environment dialog box appears. If you are saving a workflow environment, the 
workflow settings are displayed. For a job environment, you can type your own job 
description.
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2 Define a backup location.

By default, environment backups are saved to two destinations: the Environments folder and 
the desktop. To change the second destination, click Choose and browse to a new destination.

3 Click Save.

A dialog box appears when the backup has been successfully saved.

4 Click OK to complete the backup procedure.

TO RESTORE AN ENVIRONMENT

Environments can be restored only in System Manager.

1 Do one of the following:

• In the layout area, right-click an empty area, and click Import Environment.

• On the File menu, click Import Environment.

The Import Environment dialog box appears. It displays the contents of the Environments 
folder.

2 Click the backup file.

If the folder is empty, click Choose and browse to the backup file. Unless you defined a 
different destination during the backup procedure, the file is located on the desktop. Select 
the backup file and click Open.

3 Select “Allow overwriting” (optional).

If you select this check box, only files with unique names are restored. All existing files of the 
same name are overwritten.

4 Click OK.

A dialog box appears when the restore has been successfully completed.

5 Click OK.

• If an appropriate output option license is available, workflow and output device are 
restored and connected to each other. However, check the printer connection before 
printing through the restored environment.

• If an insufficient number of appropriate output option licenses is available, workflow and 
output device are restored, but not connected to each other.

• If no appropriate output option license is available, the workflow is restored, but not the 
output device.
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SPOT COLORS

A spot color is any color that can be printed with its own ink in a single print run. In contrast, 
process color printing uses a mixture of cyan, magenta, yellow, and black to produce other 
colors.

Spot colors can be produced in a much more vibrant range of colors than can be created from 
mixing process colors. As a result, spot colors are often used to print company logos. Many 
different manufacturers produce spot colors, together with a set of swatch books with printed 
examples of the colors.

Fiery XF manages the spot colors of major spot color manufacturers in an internal spot color 
library. These colors are automatically detected in Fiery XF.

If you load a job that contains a spot color whose name is not known in Fiery XF, you must 
define it before the job can be correctly output.

To define and process jobs with spot colors, you require the Spot Color Option.

Defining spot colors
You can define spot colors:

• In Job Explorer

Job Explorer provides a quick and easy way to define spot colors for a job that is already 
loaded in Fiery XF.

• In Color Editor

Color Editor is a comprehensive program for defining, measuring and editing spot colors. 

Defined spot colors are saved in a spot color table. You can select a spot color table for a single 
job or integrate it into a workflow.
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TO DEFINE SPOT COLORS FOR A LOADED JOB

If you load a job with undefined spot colors, the job is displayed as a gray box in the preview 
window. Job processing is aborted with an error message.

1 Go to Job Explorer. In the job list, click the job. On the Colors tab, open the Spot Colors pane.

In the spot color definition table, undefined spot colors are listed as “Unknown”.

Spot Colors pane
1 Unknown spot colors

1
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2 In the “Source” column of the table, click the down arrow next to an unknown spot color, and 
click the type of spot color that you want to define.

• You can define a spot color by mapping it to a color from the internal spot color library. 
The internal spot color library contains thousands of different spot colors from major spot 
color manufacturers. Select “PANTONE”, “HKS”, “TOYO” or “DIC”.

• You can define a spot color by entering color values in the selected color space. Select 
“CMYK”, “CMYKOG”, “CMYKRGB”, “CMYKO”, “CMYKV”, “CMYKOV”, 
“CMYKRB” or “L*a*b*”.

• You can define a spot color by creating an alias to another spot color in the spot color 
table. Select “Alias”.

• You can assign a spot color to a printer ink channel, such as one that contains a spot color, 
white ink, clear ink, or metallic ink. Select “PRINTER”.
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3 In the “Map to” column of the table, define unknown spot colors.

The table below describes how to fill out the “Map to” column.

“Source” 
column

Description “Map to” column

CMYK, 
CMYKO, 
CMYKOG, 
CMYKOV, 
CMYKRB, 
CMYKRGB, 
CMYKV, 
L*a*b*

Defines a spot color in the selected 
color space.

Type the required color values in 
the appropriate boxes.

PANTONE, 
HKS, TOYO, 
DIC

Selects a color from the internal 
spot color library.

Scroll through the list and select 
the spot color that you want to use.

Alias Creates a link between two spot 
colors. Any changes that you make 
to the original color are 
automatically applied to the alias 
color also.

Select Cyan, Magenta, Yellow, 
Black, or any custom spot color 
from the current spot color table.

PRINTER Selects a printer ink channel to 
ensure that the printer ink is used. 
If your printer supports white ink, 
clear ink, or metallic inks, you can 
assign any of these additional 
printer inks in addition to the 
original spot color definition. The 
additional inks are printed either 
behind or on top of the original 
spot color.

The “PRINTER” setting is useful 
in the packaging industry, where 
gold or silver metallic colors are 
often used.

Color management is by-passed for 
printer inks during job processing.

Select the printer ink channel that 
you want to use.

Some settings have an “inverted” 
equivalent,. They can be 
recognized by the letters “INV” in 
their name.

If you select an inverted setting, the 
inversely proportional amount of 
ink is applied — for example, 0% 
color instead of 100% color, or 
70% color instead of 30% color.

With the clever use of an inverted 
setting, you can simulate the final 
print run on any colored substrate.
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4 In the “Apply as” column of the table, select a printer-specific color (optional).

If your printer supports white ink, clear ink, or metallic inks, you can assign any of these 
additional printer inks in addition to the original spot color definition. The additional inks 
are printed either behind or on top of the original spot color. This feature enables you to 
create many interesting special effects, particularly if your printer supports multi-pass 
(multi-layer) printing. Be aware that to create such special effects, printer-specific settings are 
required on the Special Printer Settings pane. EFI provides aseparate documents on how to 
incorporate printer inks into a Fiery XF workflow. Visit our website at: 
http://w3.efi.com/services/proofing-services/knowledge-center.

5 Save your changes.

A spot color table is created and the preview is updated. This process can take a short while. 

The spot color table is a preset of all the spot colors that are contained in the current job. You 
can also select the spot color table for different jobs or integrate it into the workflow.

See also:

“Selecting a spot color table” on page 279

“Color Editor” on page 287

Selecting a spot color table
You can select a spot color table for a single job, or you can integrate it into a workflow.

By integrating a spot color table into the workflow, you ensure that the spot colors are 
automatically detected in all jobs that contain those spot colors.

Only spot color tables that are saved to the Spotcolors folder can be selected in Fiery XF.

Spot Colors pane
1 Selected spot color table

1
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TO SELECT A SPOT COLOR TABLE

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Spot Colors pane.

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors 
pane.

2 Under “Spot color library“, select a custom spot color table.

3 Save your changes.

Editing spot color tables
In Job Explorer you can edit spot color tables, as follows:

• You can add new spot colors.

• You can change spot color definitions.

• You can tweak a spot color that aliases a different spot color.

Each time you save changes, a new spot color table is created. The new spot color table is 
saved under the original name, plus an incremental number. Therefore, you can easily revert 
to an earlier spot color table, if necessary.

TO ADD NEW SPOT COLORS TO AN EXISTING SPOT COLOR TABLE

1 Load a job with undefined spot colors.

2 Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors pane.

3 Under “Spot color library”, select a custom spot color table.

4 Define unknown spot colors.

5 Save your changes.

TO CHANGE SPOT COLOR DEFINITIONS

1 Load a job that contains the spot color that you want to edit.

2 Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors pane.

3 Under “Spot color library”, select a custom spot color table.

4 In the spot color definition table, make the required changes.

5 Save your changes.
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TO EDIT SPOT COLORS THAT ALIAS AN INTERNAL SPOT COLOR

The spot colors of spot color manufacturers are defined in the device-independent L*a*b* 
color space and saved as a name that cannot be edited — for example, PANTONE 
YELLOW C, or TOYO 0008.

If the output is not exactly as you want, you can make color adjustments. To adjust the color 
values, you must convert the spot color to editable values in your printer’s color space.

1 Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors pane.

2 Under “Spot color library“, select a custom spot color table.

3 In the “Source” column of the table, click the down arrow next to the spot color, and click 
Inkjet.

The spot color is displayed in the color space of the selected printer.

4 Make the required color adjustments by editing the color values.

5 Save your changes.

You can also edit spot color tables in Color Editor. To open the selected spot color table, click 
Color Editor.

See also:

“To define spot colors for a loaded job” on page 276

“Color Editor” on page 287

Outputting undefined spot colors
If you load a job with undefined spot colors, the job is displayed as a gray box in the preview 
window. Job processing is aborted with an error message. If you want to output jobs without 
first defining unknown spot colors, you can replace all unknown spot colors with a warning 
color that is easily recognizable in the printout.

TO PRINT JOBS WITH UNKNOWN SPOT COLORS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Colors tab, open the 
Spot Colors pane.

• Go to Job Explorer. In the job list, click the job that contains unknown spot colors. On 
the Colors tab, open the Spot Colors pane.
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2 Under “Print unknown spot colors”, select the check box.

The default warning color is orange, but you can define your own warning color by typing 
new CMYK values in the appropriate boxes. You can reselect the default warning color by 
clicking Reset.

3 Save your changes.

Excluding spot colors from the job
You can exclude spot colors from the job. The advantages of excluding spot colors are:

• You can print each color as a separated file.

• You can print jobs without having to define unknown spot colors.

TO EXCLUDE A SPOT COLOR FROM THE JOB

1 In Job Explorer, in the job list, click the job. On the Color tab, open the Spot Colors pane.

2 In the first column of the spot color definition table, clear the check boxes, as required.

By clearing a check box, you can exclude it from the job. By default, all spot colors are 
selected. 

3 Save your changes.

Changing the sequence of inks
By default, spot colors are printed on top of the process colors, irrespective of the order that is 
defined in the graphics file. However, the ink sequence can greatly affect the printed result. A 
spot color that is printed below the process colors looks completely different if it is printed on 
top of the process colors.

You can sort the sequence in which the job colors are printed. However, the process colors are 
treated as a a block and cannot be moved individually. The reason for this is that the color 
output of all process colors is described by the simulation (reference) profile and not by a spot 
color definition.

TO CHANGE THE SEQUENCE OF INKS

1 In Job Explorer, in the job list, click the job. On the Color tab, open the Spot Colors pane.

2 In the spot color definition table, click a color.

3 Underneath the spot color definition table, click an arrow button to move the color up or 
down the list.

4 Save your changes.
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Changing the search order
During job processing, Fiery XF searches for each spot color definition in a specified search 
order. The default search order depends on the type of workflow template that is 
applied — the search order for a proofing workflow is different from that for a production 
workflow. Fiery XF applies the first instance of each spot color it detects according to the 
specified search order.

It can be useful to change the default search order if a spot color name exists multiple times 
but each has different color values — for example, if you have redefined a spot color that is 
embedded in the source file with your own CMYK color values. The printed result can be 
very different, depending on which spot color definition is used.

In the above example, using the default search order, Fiery XF would apply the CMYK color 
definition. By changing the search order, you can force Fiery XF to apply the spot color 
definition from the source file.

TO CHANGE THE SEARCH ORDER

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Colors tab, open the 
Spot Colors pane.

• Go to Job Explorer. In the job list, click the job. On the Colors tab, open the Spot Colors 
pane.

2 Under “Search priority”, define the order in which Fiery XF looks for spot colors.

You do not have to include all four types of spot color definitions in the search order. You can 
also select “None” to reduce the number of possible spot color sources that are searched. If 
you select “None” for all four boxes, it deactivates the spot color search feature. In this case, all 
spot colors are displayed as “Unknown”, and job processing cannot continue.

Forcing the use of a source profile
Each incoming PostScript and TIFF job is analyzed to determine whether it was created in the 
CMYK or in a multicolor (CMYKOG/CMYKOGB/CMYKRGB) color space. Based on this 
analysis, Fiery XF applies the appropriate CMYK or multicolor source profile that is selected 
in the color management settings.

Although Fiery XF can process mulicolor in both PostScript and TIFF format, it is 
recommended that you use PostScript format, whenever possible.

By default, Fiery XF treats PostScript and TIFF jobs as described below:
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• PostScript jobs

To apply a multicolor source profile to PostScript jobs, the job and the profile must be 
created for the same ink channels. If a job contains ink channels that are missing from the 
source profile, those colors are treated as spot colors. 

The table below shows how a multicolor source profile is applied to PostScript jobs:

• TIFF jobs

The color information is read from the file header, if available. In this case, the source 
profiles are applied as for PostScript jobs.

If the color information cannot be read from the file header, only the number of color 
channels is important, not the colors themselves. To process a job with seven ink channels, 
you can use any multicolor source profile with seven colors. The job is always processed 
using the colors of the multicolor profile.

You can override the default setting and force Fiery XF to apply a specific source profile.

Color space of job Selected multicolor 
source profile

Applied source profile

CMYK None CMYK

CMYKOG CMYKOG CMYKOG

CMYKOGB CMYKOG CMYKOG 
Define B as a spot color.

CMYKRGB CMYKOG CMYK 
Define RGB as spot colors.

CMYKRGB CMYKRGB CMYKRGB
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TO FORCE THE USE OF A SOURCE PROFILE

1 Go to System Manager. On the Color tab, open the Spot Colors pane.

2 Under “Input handling”, click an item.

• Force CMYK

The table below shows the effect of forcing the use of the CMYK source profile:

• Force multicolor

The table below shows the effect of forcing the use of the multicolor source profile:

RGB and grayscale jobs are not affected by these settings.

See also:

“To select source profiles and simulation (reference) profiles” on page 141

Color space of job File format Applied source profile: CMYK

CMYKO/ 
CMYKOG/ 
CMYKOV/ 
CMYKRG/ 
CMYKOGB/ 
CMYKRGB/ 
CMYKV

PostScript CMYK is printed. OG/OGB/RGB are 
treated as spot colors.

CMYKO/ 
CMYKOG/ 
CMYKOV/ 
CMYKRG/ 
CMYKOGB/ 
CMYKRGB/ 
CMYKV

TIFF CMYK is printed. The multicolor channels 
are lost.

Color space of job File format Applied source profile: multicolor

CMYKO/ 
CMYKOG/ 
CMYKOV/ 
CMYKRG/ 
CMYKOGB/ 
CMYKRGB/ 
CMYKV

PostScript 
TIFF

If the multicolor source profile and the job 
have the same number of ink channels, all 
colors are printed.

If ink channels are missing from the 
multicolor source profile, those colors are 
treated as spot colors.
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PANTONE PLUS spot color library
You can switch from using the standard internal PANTONE spot color library to PANTONE 
PLUS. PANTONE PLUS is a spot color library that includes contemporary metallic, pastel 
and neon colors. When selected, the PANTONE PLUS color library is applied to all 
PANTONE spot color definitions.

TO SELECT THE PANTONE PLUS SPOT COLOR LIBRARY

1 Go to System Manager. On the Tools menu, click System Information.

The System Information dialog box appears.

2 Under “General settings”, select “Use PANTONE PLUS color definitions”.

3 Click OK.

The new setting takes effect immediately. You do not have to restart Fiery XF.

Deleting a spot color table
Spot color tables are saved in the ProgramData\EFI\Fiery XF\Server\Profiles\Spotcolor folder. 
Open the Spotcolor folder and delete the spot color table that is no longer needed.

You can also delete spot color tables by cleaning up Fiery XF.

See also:

“Cleaning up Fiery XF” on page 382
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COLOR EDITOR

A spot color is any color that can be printed with its own ink in a single print run. In contrast, 
process color printing uses a mixture of cyan, magenta, yellow, and black to produce other 
colors.

Spot colors can be produced in a much more vibrant range of colors than can be created from 
mixing process colors. As a result, spot colors are often used to print company logos. Many 
different manufacturers produce spot colors, together with a set of swatch books with printed 
examples of the colors.

Fiery XF manages the spot colors of major spot color manufacturers in an internal spot color 
library. These colors are automatically detected in Fiery XF.

If you load a job that contains a spot color whose name is not known in Fiery XF, you must 
define it before the job can be correctly output. 

To define and process jobs with spot colors, you require the Spot Color Option.

You can define spot colors:

• In Job Explorer

Job Explorer provides a quick and easy way to define spot colors for a job that is already 
loaded in Fiery XF. 

• In Color Editor

Color Editor is a comprehensive program for defining, measuring and editing spot colors.

Defined spot colors are saved in a spot color table. You can select a spot color table for a single 
job or integrate it into a workflow.

See also:

“Spot colors” on page 275
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Starting Color Editor 

TO START COLOR EDITOR (IF A SPOT COLOR JOB IS LOADED)

Use this method to edit a spot color table for a loaded job.

1 Go to Job Explorer. In the job list, click the job. On the Colors tab, open the Spot Colors pane.

2 Click Color Editor.

Color Editor starts. The spot colors from the loaded job are displayed.

You can also define and edit spot colors for a loaded job without starting Color Editor. 
However, Color Editor provides a much wider range of settings.

TO START COLOR EDITOR (IF NO SPOT COLOR JOB IS LOADED)

Use this method to create or edit a spot color table if no spot color job is loaded.

1 Do one of the following:

• On the toolbar, click Color Editor. 

• On the Tools menu, click Color Editor.

The Spot Color Table dialog box appears.

Color Editor
1 Custom spot colors
2 Definition of the selected 

custom spot color
3 Internal spot color library

1

2

3
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2 Do one of the following:

• Select a previously created spot color table, and click OK.

Select this setting to add new spot colors to an existing spot color table. In most cases, it is 
recommended that you save all spot colors to one spot color table. You can open any spot 
color table in CXF, BCT, ICC, or TAB format.

• Select “Create a new spot color table”, and click OK.

Select this setting to define spot colors that are optimized to the color gamut of your 
printer.

The New Table dialog box appears.

– Type a unique name for the spot color table.

– Select a Fiery XF workflow.

Color Editor retrieves information about the color space, and the color gamut of the 
printer that is connected to the workflow. Color Editor uses this information to check 
whether new spot colors can be correctly reproduced by the printer.

There is no need to select a workflow if the spot color table will be used for more than 
one workflow. 

– Select a calibration set.

The calibration set defines the settings for ink type, media name, and base linearization 
file for the selected printer. The calibration set is important for defining 
printer-dependent spot colors.

– Click OK.
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By selecting a workflow and a calibration set, you can use Color Editor for the following 
purposes:

– You can convert L*a*b* spot colors into the color gamut of the selected printer. It is 
easier to edit spot colors that are defined in the color space of the printer.

– You can reduce delta E values of L*a*b* spot colors by creating and applying a spot 
color optimization file. A spot color optimization file is a correction profile that 
attempts to improve the color accuracy of the selected spot colors and their gradients.

The Preferences dialog box provides additional settings to help you to achieve exactly the 
right color. You can open the Preferences dialog box from the New Table dialog box, or 
you can make preference settings later in Color Editor.

• Select “None”, and click OK.

Select this setting to define spot colors for a specific workflow.

Color Editor starts. If you opened an existing spot color table, the spot colors are displayed.

See also:

“To define spot colors for a loaded job” on page 276

“Preferences dialog box” on page 290

Preferences dialog box
In the Preferences dialog box you can make general settings that are applied to all spot colors 
that you define in Color Editor. The available settings are described in the following sections. 
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TO OPEN THE PREFERENCES DIALOG BOX

1 Do one of the following:

• On the toolbar, click Preferences.

• On the Edit menu, click Preferences.

• On the File menu, click New Table. In the New Table dialog box, click Preferences.

The Preferences dialog box appears.

2 Complete your settings.

3 Click Save.

To reset the settings on all Preferences tabs to their original values, click Defaults.
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Color Definition tab
The following settings are available:

• Overprint settings

– Ink overprinting characteristics

Normally, when two different colored objects overlap, there is a knock-out effect. They 
will not print on top of each other. Intentionally printing one layer of ink on top of 
another is known as overprinting.

The overprint setting defines how two or more spot colors will behave when printed on 
top of each other.

A higher setting results in a darker printout. For example, an overprint value of 100% 
means that the colors will be completely added to each other — something that is not 
possible on a proper printing press.

A lower setting results in lighter printouts because colors appear more opaque and hide 
parts of other colors.

– Gamma

Modify the dot gain simulation for overprinting spot colors. This setting is applied to 
areas with a mixture of spot colors and process colors, or to areas that consist of more 
than one spot color. It lets you define non-linear behavior for overprinting.

– Method

Overprinting in the CMYK color space is based on a simple CMYK addition.

In the L*a*b* color space, the default setting is based on the Bradford and ROMM 
chromatic adaptation transforms (CATs). CATs are able to predict corresponding colors 
under different illuminantion sources. Fiery XF supports many different chromatic 
adaptation models, including Bradford CAT, XYZ Scaling, vonKries, and Sharp CAT. 
Select a CAT to define the overprint behavior of L*a*b* colors.

You can accentuate the brightness of overprinted colors that are very similar to each 
other — for example, yellow on yellow, or magenta on red.

• White point settings

The color tint of the media is known as the white point. The white point of the print 
media affects the color accuracy of the printout. Particularly in a proofing workflow, it is 
important to be able to simulate accurately the color tint of the final media.

Use a measuring device to measure the media white point. The measured white point is 
taken into account in your spot color definitions. By including the paper white in the spot 
color definition, spot color values can easily be adjusted for use with different media to 
ensure that color accuracy is maintained whatever substrate is used.
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• Gamut check settings

Check how accurately an L*a*b* spot color can be reproduced using the selected profiles. 
You can also check if an L*a*b* spot color lies within the color gamut of your printer. The 
color gamut describes the full range of colors that the printer can reproduce.

During job processing, spot colors that are out of gamut are mapped to the nearest possible 
color within the available color gamut. The deviation in color is displayed as a delta E 
value.

Define the acceptable tolerance limit as a delta E value. Delta E is used to measure the 
mathematical difference between two colors in the L*a*b* color space.

This setting allows spot colors that lie within the tolerance area around the color gamut to 
be accepted as in gamut. Color Editor applies a default delta E value of 5.0, measured in 
the delta E 2000 format. You can change these values, if required.

See also:

“Overprinting in composite jobs” on page 102

“Checking the color accuracy of L*a*b* spot colors” on page 301

Measurement and Display tab
The following settings are available:

• Measurement device settings

You can use an ES-1000 or ES-2000 measuring device to define a 100% colorant and 
gradients, or to measure the white point of a media. Click Settings to make device-specific 
settings.

• Light conditions

Define how spectrophotometric values are converted to L*a*b*.

Select a light (illuminant) source: D-50 (horizon light), D-65 (artificial daylight at noon) 
and C (daylight).

Select an observer angle: Two degrees is the default setting, but the larger viewing angle of 
ten degrees is sometimes used in the packaging or textile industry

• Monitor profile

Monitor profiles are used to simulate and verify color accuracy on a computer screen. 
Windows and Macintosh computers provide standard monitor profiles as part of the 
operating system software.

You can select a monitor profile that is provided with the operating system, or you can 
select a custom monitor profile. To select a custom monitor profile, click Choose and 
browse to the profile.
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Gradation tab
If you have a spot color with different gradients and find that one gradient is too bright or too 
pale in the printout, you can modify the brightness by adding or subtracting color along the 
gradation curve.

To modify a point along the curve, drag the point upward (to add color), or downward (to 
subtract color). Alternatively, you can type the required coordinates directly in the table.

Adding spot colors in Color Editor
This section describes the basic procedure for defining spot colors in Color Editor. For more 
specific settings, see the appropriate sections of this documentation.

TO ADD SPOT COLORS

1 Start Color Editor.

2 Do one of the following:

• To add a new spot color:

– On the lower toolbar, click Add.

– Right-click an existing spot color, and click Add.

• To duplicate an existing spot color:

You can duplicate a custom spot color, or you can duplicate a spot color from the internal 
spot color library. The internal spot color library contains spot colors from major spot 
color manufacturers.

– On the lower toolbar, click Duplicate

– Right-click an existing spot color, and click Duplicate.

– Drag a spot color from the internal spot color library to the custom spot color section.

3 Under “Spot color name”, type a name.

The name must match exactly the spot color name from the job.

4 Under “Transparency”, move the slider to define the degree of transparency/opacity 
(optional)

A transparency setting of 100% means that if the spot color overlaps another color the colors 
underneath will shine through. By contrast, if you define a spot color with a transparency 
value of 0%, colors that are overlapped by the spot color are not visible.
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5 Under “Spot color definition at 100%”, select one or both of the following:

• “Independent” lets you measure a 100% colorant in the independent CIE L*a*b* or CIE 
LCH color space. The default measuring device is ES-1000. If you have an ES-2000, you 
must select it first in the Preferences dialog box.

Connect your measuring device, click Measure, and follow the on-screen instructions to 
measure a color patch.

Spot colors that are defined in the L*a*b* color space can be included in the dynamic 
wedge.

• “Dependent” lets you type color values in the color space of the source profile or media 
profile. Select “Source” or “Printer”. Then, from the drop-down list box, select a spot color 
type, and type color values in the appropriate boxes.

If your printer supports white ink, clear ink, or metallic inks, you can also define 100% 
color values and gradients for these ink channels. Select “Printer” as the dependent type 
and “Automatic” as the spot color type. The additional ink channels are listed as “1”, “2” 
and “3”. Rest the pointer on “1”, “2” or “3” to show the respective ink channel.

6 Do one of the following:

• On the toolbar, click Save.

• On the File menu, click Save.

A spot color patch is displayed under “My Custom Spot Colors”. Independent L*a*b* color 
definitions take preference over CMYK/OG/RGB/O/V/OV/RB printer-dependent color 
definitions.

7 Confirm or change the name of the spot color table, click Save.

CXF is the new default file format for spot color tables. However, you can also save spot color 
tables in BCT format. BCT format is compatible with earlier versions of Fiery XF.

A dialog box appears.
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8 Select the appropriate check boxes to apply the spot color table to the required workflows. 
Alternatively, click “Select all”.

If a workflow already has a spot color table assigned to it, the original spot color table is 
overridden but remains available in the list for reselection.

9 Click OK.

The spot color table is created. It is applied to the workflows that you selected.

See also:

“Starting Color Editor” on page 288

“Measurement device settings” on page 293

“Adding color gradients” on page 300

“Applying spot color tables to Fiery XF workflows” on page 310

Creating aliases
You can create a fixed link to an existing spot color. An alias spot color has exactly the same 
color properties as the original spot color, but is saved under a different name — for example, 
you could set up the spot color “NewSpotColor” as an alias for a PANTONE color. 

You cannot edit the color properties of an alias spot color, but you can edit the gradation and 
transparency values. However, any changes you make to the original spot color are 
automatically applied to the alias also.

By creating an alias, you can ensure that exactly the same color values are used for both spot 
colors, without renaming the spot color in the graphics application.

TO CREATE A SPOT COLOR ALIAS

1 Start Color Editor.

2 Under “My Custom Spot Colors”, select a spot color.
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3 Under “Use as alias for”, click the ... button.

The Select Alias dialog box appears.

4 In the table, select the spot color for which you want to create an alias.

You can select an existing custom spot color or a spot color from the internal spot color 
library.

To search for a spot color, type the name of the spot color in the Search box. The Search box 
has a filter function that ensures that only the spot colors that meet the search criterion are 
displayed.

5 Click Use Selection.

The color values of the original spot color are transferred to the alias. Any additional changes 
that you make to the original spot color are automatically applied to the alias also.

To remove the link to an alias spot color, click Clear Alias. If you remove the alias, the spot 
color receives the default color values of a new spot color.
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See also:

“Starting Color Editor” on page 288

Assigning a spot color to a printer ink channel
If your printer supports white ink, clear ink, or metallic inks, you can assign any of these 
additional printer inks in addition to the original spot color definition. The additional inks 
are printed either behind or on top of the original spot color.

This feature enables you to create many interesting special effects, particularly if your printer 
supports multi-pass (multi-layer) printing. Be aware that to create such special effects, 
printer-specific settings are required on the Special Printer Settings pane. EFI provides 
separate documents on how to incorporate printer inks into a Fiery XF workflow. Visit our 
website at: http://w3.efi.com/services/proofing-services/knowledge-center.

You can use the available settings to simulate the final production run on a white or colored 
substrate. Interesting special effects can be achieved for use in the packaging industry if your 
printer supports the appropriate ink colors.

TO ASSIGN A SPOT COLOR TO A PRINTER INK CHANNEL

1 Start Color Editor.

2 Under “My Custom Spot Colors”, select a spot color.
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3 Under “Apply as”, click the ... button.

The Apply As dialog box appears.

4 In the table, select the printer ink channel that you want to use to print the spot color.

To search for a printer ink channel, type the name in the Search box. The Search box has a 
filter function that ensures that only the printer ink channels that meet the search criterion are 
displayed.

Some settings have an “inverted” equivalent. They can be recognized by the letters “INV” in 
their name. If you select an inverted setting, the inversely proportional amount of ink is 
applied — for example, 0% color instead of 100% color, or 70% color instead of 30% color.

With the clever use of an inverted setting, you can simulate the final print run on any colored 
substrate.

5 Click Use Selection.
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See also:

“Starting Color Editor” on page 288

Adding color gradients
You can define up to 99 color gradients for each spot color. Color gradients that are defined in 
the L*a*b* or LCH color space can be included in the dynamic wedge.

TO ADD COLOR GRADIENTS

1 Start Color Editor.

2 Unter “My Custom Spot Colors”, select a spot color.

3 Click the Characterization tab.

By default, the diagram shows the 0% and 100% color values of one ink. 100% represents the 
full-tone color that you defined on the Color Definition tab. 0% represents the color of the 
media. By default, 0% equals the unmeasured value for pure white. If your media is not pure 
white, you can change the color value for 0%.

Initially, the diagram displays the color curve for just one color. You can change the displayed 
color via the drop-down list box above the grid diagram. Alternatively, you can display all inks 
simultaneously by selecting “All”.

4 In the “Ink” column, type a gradient between 1 and 99.
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5 Do one of the following:

• To add color gradients in the printer’s color space, type appropriate values in the 
characterization table.

• To add color gradients in the L*a*b* or LCH color space, connect your measuring device, 
click Measure, and follow the on-screen instructions to measure a color patch.

The default measuring device is ES-1000. If you have an ES-2000, you must select it first 
in the Preferences dialog box.

The spot color and its gradients are displayed. You can view the spot color from any angle by 
dragging the pointer to rotate the diagram.

After you have defined a gradient in the printer’s color space, you can finetune it by dragging 
the appropriate point along the curve in the diagram.

6 Save your changes.

See also:

“Starting Color Editor” on page 288

“Color Definition tab” on page 292

“Measurement device settings” on page 293

Checking the color accuracy of L*a*b* spot colors
You can check how accurately an L*a*b* spot color can be reproduced using the selected 
profiles. You can also check if an L*a*b* spot color lies within the color gamut of your printer. 
The color gamut describes the full range of colors that the printer can reproduce. During job 
processing, spot colors that are out of gamut are mapped to the nearest possible color within 
the available color gamut. The deviation in color is displayed as a delta E value.



COLOR EDITOR 302

Color Editor applies a default delta E value of 5.0, measured in the delta E 2000 format. It 
effectively widens the color gamut by this value. It allows spot colors that lie within the 
tolerance area around the color gamut to be accepted as in gamut. You can change the 
tolerance limit in the Preferences dialog box, if required.

TO CHECK THE COLOR ACCURACY OF L*A*B* SPOT COLORS

1 Start Color Editor.

2 Select one or more L*a*b* spot colors.

3 On the lower toolbar, click Gamut Check.

4 Select a printer.

5 Select a print configuration set.

The print configuration set contains details of the base linearization file that is connected to 
the media profile. If you have created a custom print configuration set, you can select it here. 
Otherwise, select the default preset. The default preset is the print configuration set that is 
selected for the media.

6 Click Next.

Color Editor checks whether each selected spot color is in-gamut for the selected printer, and 
displays the following information:

• The percentage of in-gamut spot colors

• The average delta E

• The maximum delta E

7 Click Finish.
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In the program window, the delta E result for each selected spot color is displayed in the dE 
column. The delta E of a selected spot color is also displayed on the Color Definition tab. 
Green indicates “in gamut”. Red indicates “out of gamut”.

The delta E value indicates how accurately the spot color can be reproduced.

Result of gamut check
1 Delta E column
2 Delta E of selected spot 

color

1

2
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Be aware that it is possible for a spot color to yield a delta E that exceeds the defined tolerance 
limit but still be in gamut (green).

In the diagram above, the spot colors yield the following results:

If a spot color is out of gamut, you may be able to reduce the delta E value. Try the following:

• Switch to a different combination of printer and print configuration set. By switching 
between printers and print configuration sets, you can quickly find out which 
combination will yield the best results.

Result of gamut check
1 Spot color 1 with delta E 

inside tolerance limit
2 Spot color 2 with delta E 

outside tolerance limit
3 Spot color 3 inside color 

gamut

1

2

3

Spot color Result Description

1 Green Spot color is out of gamut but is within the acceptable 
tolerance limit.

2 Red Spot color is out of gamut and outside the acceptable 
tolerance limit.

3 Green Spot color is in gamut.

Red Spot color is in gamut but outside the acceptable 
tolerance limit.
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• Apply a spot color optimization file. A spot color optimization file is a correction profile 
that attempts to improve the color accuracy of the selected spot colors and their gradients. 
You can optimize in-gamut spot colors that are outside the acceptable delta E tolerance 
limit.

See also:

“Starting Color Editor” on page 288

“Color Definition tab” on page 292

“Optimizing L*a*b* spot colors” on page 305

Converting L*a*b* spot colors to the color space of the printer
You can convert L*a*b* spot colors to the color space of the printer. It is easier to edit spot 
colors that are defined in the ink colors of the printer.

TO CONVERT L*A*B* SPOT COLORS TO THE COLOR SPACE OF THE PRINTER

1 Start Color Editor.

2 Select one or more L*a*b* spot colors.

3 On the lower toolbar, click Gamut Check.

4 Select a printer.

5 Select a print configuration set.

The print configuration set contains details of the base linearization file that is connected to 
the media profile. If you have created a custom print configuration set, you can select it here. 
Otherwise, select the default preset. The default preset is the print configuration set that is 
selected for the media.

6 Click Next.

7 Click Finish.

After you have converted the spot color to the color space of the printer, you can check 
whether the spot color is in gamut.

See also:

“Starting Color Editor” on page 288

“Checking the color accuracy of L*a*b* spot colors” on page 301

Optimizing L*a*b* spot colors
You may be able to reduce the delta E values of spot colors by applying a spot color 
optimization file. A spot color optimization file is a correction profile that provides a better 
match for the color properties of the selected printer.
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TO OPTIMIZE AN L*A*B* SPOT COLOR

1 Connect your measuring device.

2 Start Color Editor.

3 Select one or more L*a*b* spot colors.

You can optimize custom spot colors, and spot colors from the internal spot color library.

4 On the lower toolbar, click Optimize.

5 Select your measuring device.

Click Settings to make device-specific settings.

6 Select a printer.

7 Select a print configuration set.

The print configuration set contains details of the base linearization file that is connected to 
the media profile. If you have created a custom print configuration set, you can select it here. 
Otherwise, select the default preset. The default preset is the print configuration set that is 
selected for the media.

8 Click Next.

A optimization job is created in Job Explorer and printed. The optimization job consists of a 
chart of the spot colors to be optimized.

9 Follow the on-screen instructions to measure the chart.

10 Click Next.

The results of the optimization are displayed. Color Editor displays the achieved average delta 
E and the maximum delta E.

11 Do one of the following:

• Click Iterate to repeat the optimization procedure until no further optimization is 
possible. In the optimization table, click the best set of results, and then click Finish, and 
save your optimization.

• Click Verifier to start Verifier.

• Click Finish, and save your optimization.

The spot color optimization file is applied to all workflows that are using that spot color table.

The spot color optimization file is saved to the Spotcolors folder and selected on the Color 
Management pane of the Color tab.

See also:

“Starting Color Editor” on page 288
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General operations in Color Editor
The following sections describe general operations to help you in your everyday work with 
Color Editor.

Creating a new spot color table

TO CREATE A NEW SPOT COLOR TABLE

1 Start Color Editor.

2 Do one of the following:

• On the toolbar, click New Table.

• On the File menu, click New Table.

The New Table dialog box appears.

3 Type a unique name for the spot color table.

4 Select a Fiery XF workflow (optional).

There is no need to select a workflow if the spot color table will be applied to multiple 
workflows. Spot colors can be optimized for only one combination of calibration set and 
printer.
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5 Select a calibration set (optional).

The calibration set defines the settings for ink type, media name, and base linearization file for 
the selected printer. The calibration set is important for defining printer-dependent spot 
colors.

By selecting a workflow and a calibration set, you can use Color Editor for the following 
purposes:

• You can convert L*a*b* spot colors so that they fit into the color gamut of the selected 
printer.

• You can reduce delta E values, by creating and applying an L*a*b* optimization file that 
provides a better match for the color gamut of the media profile.

6 Click OK.

See also:

“Starting Color Editor” on page 288

Opening a spot color table
You can open an existing spot color table to make edits.

TO OPEN A SPOT COLOR TABLE

1 Start Color Editor.

2 Do one of the following:

• On the toolbar, click Open.

• On the File menu, click Open.

3 From the list, select a spot color table.

The following file formats are supported: CXF, BCT, ICC, and TAB.

4 Click Open.

See also:

“Starting Color Editor” on page 288
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Replacing spot color names
You can rename custom spot colors by replacing all or part of the name.

TO REPLACE A SPOT COLOR NAME

1 Start Color Editor.

2 Do one of the following:

• On the toolbar, click Find and replace.

• On the Edit menu, click Find and Replace.

The Find and Replace dialog box appears.

3 Under “Find what”, type the name of the spot color whose name you want to replace.

You can also search for parts of a name. For example, if you search for “2013”, Color Editor 
will find all spot colors with “2013” anywhere in their name.

4 Under “Replace with”, type the new name.

Color Editor will replace all instances of the search word.

5 Specify your search options (optional).

You can modify your search by taking upper/lower-case characters into account, or by 
searching for a full name only.

6 Click the appropriate buttons to find and replace spot color names.

7 Click Close.

See also:

“Starting Color Editor” on page 288

Importing spot colors
You can add spot colors by importing them from another spot color table.

TO IMPORT SPOT COLORS

1 Start Color Editor.

2 Do one of the following:

• On the toolbar, click Import.

• On the File menu, click Import.

The Spotcolor folder opens.

3 Select a spot color table, and click Open.

The following file formats are supported: CXF, BCT, ICC, and TAB.
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It is not possible to save two spot colors with the same name in one spot color table. If a spot 
color name exists in both spot color tables, the Import Conflict dialog box appears. In this 
case, you can either rename or replace one of the spot colors.

The spot colors are imported.

See also:

“Starting Color Editor” on page 288

Applying spot color tables to Fiery XF workflows
When you save a new spot color table for the first time, you are prompted to select the 
Fiery XF workflows to which the spot color table will be applied.

This section describes how to assign spot color tables in Color Editor after the spot color table 
has been created. 

TO APPLY A SPOT COLOR TABLE TO A FIERY XF WORKFLOW

1 Start Color Editor.

2 Open a spot color table.

Setting Description

Rename Rename a spot color in either of the spot color tables. This may 
be useful if two spot colors of the same name have different 
color values. Use this setting to keep both spot colors.

Replace Replace a spot color in either of the spot color tables. This 
setting overwrites the name and the spot color values, thus 
providing an easy way to merge two spot colors.

Cancel/Cancel All Do not import conflicting spot colors. In this case, spot colors 
remain unchanged in both spot color tables. Click Cancel to 
skip the displayed conflict. Click Cancel All to skip all 
conflicting spot colors.
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3 Below the toolbar, click the down arrow to open the drop-down list box.

4 Select or clear the check boxes, as required.

5 Save your changes.

See also:

“Selecting a spot color table” on page 279

“Starting Color Editor” on page 288

“Opening a spot color table” on page 308
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VERIFYING COLOR CONSISTENCY IN A FIERY XF 
WORKFLOW

If you have a license for the Verifier Option, you can check the color consistency of your jobs. 
Delta E tolerance values define the acceptable error margin when verifying color accuracy 
against a reference.

The Verifier Option supports the following latest norms:

• ISO 12647-7 (defines the requirements for contract proofing)

• ISO 12647-8 (defines the requirements for validation print)

• Fogra PSD Print Check

You can check for color consistency as follows:

• You can set up a verify workflow in Fiery XF. This method is recommended for comparing 
profile-to-proof, proof-to-proof, and proof-to-print applications.

• You can can load, measure or compare two sets of color values directly in Verifier. This 
method is recommended for comparing print-to-profile or print-to-print applications, and 
for measuring single color patches.

See also

“Verifier” on page 325

Verify workflows in Fiery XF
A verify workflow is recommended for the following purposes:

• To verify a proof (or print) for ISO 12647-7, 12647-8, G7 compliance or do a Fogra PSD 
Print Check

• To verify any house standard

• To achieve Fogra Proof Certification

• To verify color consistency across sites

Comparing profile-to-proof is one of the most useful applications. In an everyday situation, 
you can compare the color values of a proof that has been created on your printer with the 
color values from the profile that simulates the printing press. A good color match indicates 
that the proof lies within the defined tolerances and that the printing process is being correctly 
reproduced.
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You can check the color consistency of a job that is printed at different sites by creating a 
remote container. A remote container contains all the information that is required to create a 
color-accurate proof at multiple sites. Remote containers can be transferred easily between 
locations — for example, by FTP server. 

TO SET UP A VERIFY WORKFLOW

1 Go to System Manager. Create a new workflow.

Default workflow templates are available that are already set up with the basic settings for a 
verify workflow. The workflows have the word “Verify” in their name. However, make sure 
that the selected control strip is compatible with your measuring device (see step 5 below).

If you use the default workflow template “Remote_Out_(ISOcoated_v2)”, a remote container 
is created of the measured results. A remote container is required to verify color accuracy at 
two or more sites.

If you prefer to set up a custom verify workflow from scratch, make sure to include the 
following settings:

2 Go to System Manager. In the layout area, click the workflow. On the Layout tab, open the 
Footer pane.

3 On the pane bar, select the check box to activate the settings.

4 Set up a job ticket.

The job ticket is a prerequisite for achieving Fogra Proof Certification, but is not essential for 
other forms of color verification.

5 On the Verify tab, open the Control Strips pane.

6 On the pane bar, select the check box to activate the settings.
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7 Do the following:

• Select one or two control strips.

You can select a static control strip or “DynamicWedge”.

– Each static control strip has been created for a specific measuring device. Make sure 
that you select a static control strip that is compatible with your measuring device.

– A dynamic wedge is made up of the job’s most prominent colors. Each dynamic wedge 
is, therefore, unique to that job.

The table below shows which type of control strip you can select for each reference. The 
reference defines the standard that you want to achieve.

• Specify whether color management is applied to the control strip.

If the selected profiles and rendering intents are applied to the control strip, the color 
patches are compressed into the color gamut of the selected reference profile. Select “Print 
with color management” to check the accuracy of the media profile.

If the selected profiles and rendering intents are not applied to the control strip, the color 
patches are printed using the full color gamut of the printer. Clear “Print with color 
management” to check the color consistency of two printers.

• Select whether the control strip is printed for each page or for each sheet.

By default, control strips are printed for each page. However, for nestings, you can print 
control strips for each page of the nesting, and/or for the whole nesting. Dynamic wedges 
can be created only for pages.

8 On the Verify tab, open the Verify Control Strip 1 pane.

9 On the pane bar, select the check box to activate the settings.

Type of control strip Target colors of reference

Reference 
profile

Measurement 
file from 
remote 
container 
(JDF)

SWOP/ 
GRACoL

Fogra 
characterization 
data

EFI Verifier Chart Yes Yes No No

IDEAlliance ISO 12647-7 Yes Yes Yes No

Ugra Fogra-MediaWedge Yes Yes Yes Yes

Dynamic wedge Yes No No No
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10 Do the following:

• Select “Stop job printing after first job fails verification” (optional).

If one job fails verification, you can prevent successive jobs in the job list, that will also 
inevitably fail verification, from being unnecessarily printed. This situation can occur, for 
example, if the wrong media is loaded in the printer.

• Select “Print label after verification automatically” (optional).

Some printers with an integrated measuring device can print out a label with the results of 
the color verification. The label includes all the necessary ISO 12647-7/8-compliant 
information and is printed regardless of whether the job passes color verification or not. 
Alternatively, by selecting “Print only if verification results passed”, you can specify that a 
label is printed only if all the measured results are within the defined tolerances.

• Under “Characterization data”, select a reference.

– Generated from reference profile

This setting measures the color output against the colors that can be achieved by the 
simulation (reference) profile.

– MKCheck10 and MKCheck11 characterization data

Characterization data sets define a combination of printing conditions for standard 
printing processes. The job colors are measured against the reference and any deviation 
from the reference is calculated in terms of delta E.

For Ugra/Fogra media wedges, you can select a set of characterization data (Fogra, 
IFRA, PSR, or SWOP) to define a standardized printing condition. The table below 
shows which characterization data to use for which reference profile.

it8 characterization data is authorized measured data from the Fogra Institute. The 
measurement is based on the Altona Test Suite and the ISOcoated_v2 simulation 
(reference) profile.

Reference profile Characterization data

ISOcoated.icc Fogra 27

ISOwebcoated.icc Fogra 28

ISOuncoated.icc Fogra 29

ISOuncoatedyellowish.icc Fogra 30

ISOcoated_v2_eci.icc/ 
ISOcoated_v2_300_eci.icc

Fogra 39

SC_paper_eci.icc Fogra 40

PSO_MFC_paper_eci.icc Fogra 41

PSO_SNP_paper_eci.icc Fogra 42
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PSO_Coated_NPscreen_ISO12647_eci.icc Fogra 43

PSO_Uncoated_NPscreen_ISO12647_eci.icc Fogra 44

PSO_LWC_Improved_eci.icc Fogra 45

PSO_LWC_Standard_eci.icc Fogra 46

PSO_Uncoated_ISO12647_eci.icc Fogra 47

PSO_INP_Paper_eci.icc Fogra 48

PSO_Coated_v2_300_Matte_laminate_eci.icc Fogra 49

PSO_Coated_v2_300_Glossy_laminate_eci.icc Fogra 50

PSR_LWC_PLUS_V2_PT.icc PSR_LWC_PLUS_V2

PSR_LWC_STD_V2_PT.icc PSR_LWC_STD_V2

PSRgravureMF.icc PSRgravureMF

PSR_SC_STD_V2_PT.icc PSR_SC_STD_V2

PSR_SC_PLUS_V2_PT PSR2_SC_PLUS_V2

ISOnewspaper26v4.icc IFRA26

PaC.Space_CMYK_gravure_V1a.icc PaC.Space

GRACoL2013_CRPC6.icc CRPC6 - IDEAlliance ISO 
12647-7 Control Wedge 2013 
GRACoL2013_CRPC6 Ref

GRACoL2013UNC_CRPC3.icc CRPC3 - IDEAlliance ISO 
12647-7 Control Wedge 2013 
GRACoL2013UNC_CRPC3 Ref

SWOP2013C3_CRPC5.icc CRPC5 - IDEAlliance ISO 
12647-7 Control Wedge 2013 
SWOP2013C3_CRPC5 Ref

SWOP2013C5.icc IDEAlliance ISO 12647-7 
Control Wedge 2013 
SWOP2013C5 Ref

EFIJMPA3 EFIJMPA3

JapanColor2011Coated JapanColor

Reference profile Characterization data
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– Open measurement file

You can verify the color output of a job by using as a reference the color values from a 
measurement file. A measurement file is saved in a remote container (*.RPF) and 
contains the color measurement results of the job from an earlier verification. Thus, 
remote containers provide an easy way to check the color accuracy of a job that is 
printed at different sites. 

If the remote container has been created without a measurement file, the reference 
profile is used instead.

• Under “Delta E format”, select a tolerancing system for measuring color deviation.

Color accuracy is measured in terms of delta E. Delta E is the mathematical difference 
between two colors in the L*a*b* color space.

• Under “Target tolerances preset”, define the acceptable deviation for color accuracy.

Tolerance values define the maximum error margin that is acceptable when verifying the 
color accuracy of a printout against a reference. For example, if you define a tolerance limit 
of 3, a measured delta E of 2.5 would be accepted as color accurate, whereas a delta E 
measurement of 3.2 would not be considered color accurate.

A certain amount of deviation is almost unavoidable. Due to differing printing conditions 
(printer, ink, media, etc.), it is generally impossible to obtain 100% identical prints on two 
different output devices.

By default, a job is verified as color accurate only if all color measurements are within the 
defined tolerance limits. However, by enabling measurement approval in Verifier, you can 
gain full control over whether a job passes or fails verification. For example, you can force 
a pass result if some delta E values are marginally exceeded.

You can select a set of predefined target tolerances or you can define you own.

– Predefined tolerances

Predefined presets are available for recognized standards. The predefined tolerance 
limits are specified for ISO 12647-7 (contract proofing), ISO 12647-8 (validation 
proofing), G7-compliant verification of proof jobs, or the Fogra PSD Print Check. 
They can be applied either to daily proof production (verification based on an 
ISO 12647-7 or 12647-8-compliant media wedge) or for certification purposes (such 
as FograCert).
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You can modify the predefined tolerance presets, if required.

Note that delta T tolerances can be measured only for the primary colors — for 
example, 100% cyan or 50% magenta. It is not possible to calculate delta T values for 
colors that are composed of a mixture of cyan, magenta, yellow and black.

– Dynamic wedge

A dynamic wedge is made up of the job’s most prominent colors. For example, if a job 
is composed mainly of shades of blue, the dynamic wedge will have a high proportion 
of blue patches. For the dynamic wedge, you can define only general delta E tolerances. 
Other values are not permitted due to the unique composition of color patches for each 
job. 

– Custom

You can define your own tolerance limits (house standard) by editing the values in the 
“Tolerance” column. Custom tolerances provide an easy way to adapt quickly to the 
latest norms.

Custom tolerances are applied to the current workflow only. You cannot save custom 
tolerances as a preset on the Verify Control Strip panes. However, if you want to save 
custom tolerances, you can do so in Verifier. Custom presets from Verifier can later be 
applied to multiple workflows. 

11 Save the workflow.

Predefined preset Use for:

ISO 12647-7 Contract Proof “Media 
Wedge”

ISO 12647-7 (contract proofing)

ISO 12647-8 Validation Print “Media 
Wedge” CD2

ISO 12647-8 (FograCert validation print 
certification)

G7-ISO12647-7 Proofing System G7-compliant verification of proof jobs

Dynamic wedge Verification of a job’s key colors, including 
spot colors

Fogra PSD Side-by-Side (ISO/TS 
15311)

Fogra PSD Spot Colors (ISO/TS 
15311)

Fogra PSD Media-Relative (ISO/TS 
15311)

Verifcation of Process Standard Digital 
compliance level (A, B or C) to do a print 
check for each printout in daily 
production.

Fogra PDS Spot Colors (ISO/TS 15311) is 
available only for the dynamic wedge

G7 Grayscale Compliance G7-grayscale-compliant output

Japan Color Contract Proof Japan Color-compliant (contract proofing)

Softproofing (FograCert Softproof ) Softproof verification (on-screen)
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TO VERIFY THE COLOR ACCURACY OF A JOB

1 Load a job.

If the workflow is set up to print two control strips, you can use one or both to verify color 
accuracy. To deactivate a control strip, clear the check box in the appropriate pane bar of the 
Verify tab.

2 Print the job.

After printing, the job is automatically submitted to Verifier. In the job list, the job status 
changes to “Can be verified”.

3 Connect your measuring device to your computer.

4 Start Verifier. Do one of the following:

• On the toolbar, click Verifier.

• On the Tools menu, click Verifier.

• Go to Job Explorer. On the Verify tab, open the Verify Control Strip pane. In the pane bar, 
select the check box to activate the settings. On the Verify Control Strip pane, click the 
Verify button.

Verifier starts. The printed job is displayed on the Job List/Preview tab.
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5 On the Job List/Preview tab, expand the job file and double-click the job.

The color values of the selected reference are displayed in the left-hand table.

Verifier program window
1 Job on Joblist/Preview tab

1
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6 Follow the on-screen instructions to measure the printed control strip.

The measured readings are displayed in the right-hand table. The results of the comparison 
are displayed in the “Results” area.

7 Compare the results.

The “Results” area shows you whether or not the measured results are within the tolerances. 
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8 Do one of the following:

• Click Send.

• On the File menu, click Save to JDF and send.

Saving the measurement data to the JDF provides a record of the color accuracy. You can 
save multiple sets of measurement data to one JDF file.

The measurement results are sent back to Fiery XF. The results are displayed in Job Explorer 
on the appropriate Verify Control Strip pane.

If color accuracy is approved, the job receives the status “Verified”. In this case, the 
verification procedure is complete. If color accuracy could not be approved, the job receives 
the status “Verification failed”.

By default, a job is verified as color accurate only if all color measurements are within the 
defined tolerance limits. However, by enabling measurement approval in Verifier, you can 
gain full control over whether a job passes or fails verification. For example, you can force a 
pass result if some delta E values are marginally exceeded.

If a job fails verification, you may be able to improve on the result by performing a 
job-specific optimization. This process optimizes the job’s color management by creating a 
correction profile that is a better match for the color gamut of the simulation (reference) 
profile. Afterwards, you must reprint the job and repeat the verify procedure.

It is not possible to optimize jobs if any of the following have been applied:

• Color adjustments

• Clean colors

• Perceptual or Saturated rendering intent

• Dynamic rendering intent
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9 Click Optimize, and reprint the job.

The Optimize button optimizes one control strip only. If your job has two control strips and 
you want to optimize them simultaneously, right-click the job in the job list, and click 
Optimize And Print.

10 Repeat the verification procedure until no further optimization is possible.

See also:

“To load a job” on page 32

“To print a job” on page 33

“To create a workflow” on page 58

“Job ticket” on page 132

“To select a dynamic wedge” on page 135

“Custom” on page 318

“Setting up Verifier” on page 327

“Analyzing verification results” on page 335

“Verifying color consistency across sites” on page 349

“Glossary” on page 534

Achieving an ISO 12647-7-compliant proof
To achieve an ISO 12647-7-compliant proof, the following requirements must be met:

• The workflow must be set up to include the following settings:

Setting Description

Control Strip 1 Select a Ugra/Fogra media wedge (v2.2/v3.0) or any 
ISO 12647-7-compliant media wedge

Characterization data Select Fogra MKCheck10 or Fogra MKCheck 11 reference 
data

Job ticket Set up the job ticket to contain the following information:

• Name of the proofing software

• Colorant

• Substrate

• Printing condition to be simulated

• Color profiles used

• Date and time of printout
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• The delta E and delta H values of the Ugra/Fogra media wedge must be within the defined 
tolerances.

See also:

“To set up a verify workflow” on page 313
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VERIFIER

If you have a license for the Verifier Option, you can check the color consistency of your jobs. 
Delta E tolerance values define the acceptable error margin when verifying the color accuracy 
against a reference.

The Verifier Option supports the following latest norms:

• ISO 12647-7(defines the requirements for contract proofing)

• ISO 12647-8 (defines the requirements for validation print)

• Fogra PSD Print Check

You can check for color consistency as follows:

• You can load, measure or compare two sets of color values directly in Verifier. This method 
is recommended for comparing print-to-profile or print-to-print applications, and for 
measuring single color patches.

• You can set up a verify workflow in Fiery XF. This method is recommended for comparing 
profile-to-proof, proof-to-proof, and proof-to-print applications.You can load, measure or 
compare two sets of color values directly in Verifier. This method is recommended for 
comparing print-to-profile or print-to-print applications, and for measuring single color 
patches.
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Starting Verifier

TO START VERIFIER

1 Do one of the following:

• On the toolbar, click Verifier.

• On the Tools menu, click Verifier.

6

7

4

9

5

8

1 2
3

01

Legend Description

1 Displays the first set of color values in the color measurement table (M1).

2 Displays the second set of color values in the color measurement table (M2).

3 The delta E warning indicator displays the amount of deviation from the 
reference in terms of delta E. Delta E is the mathematical difference between two 
colors in the L*a*b* color space.

4 The 2D view represents a cross-section of the L*a*b* color space. Point to a node 
to highlight the corresponding color value and the delta E value in the 
appropriate tables.

5 Changes the cutting plane in the 2D view. Use the slide bar to show the a*b* 
dimensions for a particular L* value.

6 Displays the 3D view of the color gamut.
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You can customize the appearance of Verifier.

See also:

“3D Viewer” on page 337

“Customizing the Verifier user interface” on page 341

Setting up Verifier
Verifier can be used for the following purposes:

• You can verify a proof (or print) against a simulation (reference) profile or characterization 
data

• You can verify any house standard

• You can verify color consistency between two prints

• You can measure single color patches

You set up Verifier in the Preferences dialog box.

TO OPEN THE PREFERENCES DIALOG BOX

1 Do one of the following:

• Click Edit.

• In Windows, on the File menu, click Preferences.

• On Macintosh, on the Verifier menu, click Preferences.

TO SELECT A MEASURING DEVICE

Each control strip and media wedge is designed for use with a specific measuring device. 
When you select a measuring device, the control strips, and media wedges for that measuring 
device become available for selection. You cannot measure a control strip or a media wedge if 
it is not compatible with the selected measuring device.

7 Opens the 2D or 3D Viewer. The Viewer windows are an enlarged view of the 
displayed 2D or 3D view. Comprehensive settings are available in 3D Viewer.

8 The results area shows whether the measured values for delta E and paper white 
are within the defined tolerances. Additional tabs show whether the measured 
values for delta E and paper white are within the tolerances defined for each 
color channel.

9 Sets up a connection to the measuring device.

10 Opens the Preferences dialog box.

Legend Description
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1 Connect your measuring device.

2 Open the Preferences dialog box, and click the General tab.

3 Under “Measuring device”, make sure that your measuring device is selected.

This setting acts as a filter and ensures that only those charts, control strips, and media wedges 
for the selected measuring device are available.

Device-specific settings are also available. For example, you can select a resolution, or specify 
that you want to measure single color patches.

If you are using an ES-1000 measuring device and want to measure a control strip, as opposed 
to single color patches, you can check the direction of measurement. This setting ensures that 
the color patches are measured in accordance with the movement of the measuring device over 
the control strip.

4 Under “User interface”, select a beep tone (optional).

By default, Verifier uses the beep tone from the measuring device. Select the check box to use 
the beep tone from the operating system instead.

5 Click OK.

TO SET UP VERIFIER

To set up Verifier, the following three steps are necessary:

• Select a color strip or media wedge.

• Select a reference.

• Define tolerance values.

This section deals with the basic steps that are necessary to set up Verifier and verify color 
accuracy.

1 Open the Preferences dialog box, and click the General tab.

2 Under “Chart or wedge selection”, select a control strip or media wedge.

The control strips have been created for different purposes. They vary in layout and the 
number of color patches. The table below shows which type of control strip is suitable for 
checking against which type of reference.

Type of control strip Target colors of reference

Measurement file 
from remote 
container (JDF)

SWOP/ 
GRACoL

Fogra characterization 
data

EFI Verifier Chart Yes No No

IDEAlliance ISO 12647-7 Yes Yes No

Ugra Fogra-MediaWedge Yes Yes Yes
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You can also use a custom control strip. Click Add (+), browse to the control strip file. Select 
the control strip file, and click Open. By default, control strips are loaded from the Color 
Verifier Charts folder.

3 Under “Characterization data”, select a reference.

The reference defines the target colors for your printouts. The job colors are measured against 
the reference and any deviation from the reference is calculated in terms of delta E.

For Ugra/Fogra media wedges, you can select a set of characterization data (Fogra, IFRA, 
PSR, or SWOP) to define a standardized printing condition. The table below shows which 
characterization data to use for which simulation (reference) profile.

it8 characterization data is authorized measured data from the Fogra Institute. The 
measurement is based on the Altona Test Suite and the ISOcoated_v2 simulation (reference) 
profile.

Reference profile Characterization data

ISOcoated.icc Fogra 27

ISOwebcoated.icc Fogra 28

ISOuncoated.icc Fogra 29

ISOuncoatedyellowish.icc Fogra 30

ISOcoated_v2_eci.icc/ 
ISOcoated_v2_300_eci.icc

Fogra 39

SC_paper_eci.icc Fogra 40

PSO_MFC_paper_eci.icc Fogra 41

PSO_SNP_paper_eci.icc Fogra 42

PSO_Coated_NPscreen_ISO12647_eci.icc Fogra 43

PSO_Uncoated_NPscreen_ISO12647_eci.icc Fogra 44

PSO_LWC_Improved_eci.icc Fogra 45

PSO_LWC_Standard_eci.icc Fogra 46

PSO_Uncoated_ISO12647_eci.icc Fogra 47

PSO_INP_Paper_eci.icc Fogra 48

PSO_Coated_v2_300_Matte_laminate_eci.icc Fogra 49

PSO_Coated_v2_300_Glossy_laminate_eci.icc Fogra 50

PSR_LWC_PLUS_V2_PT.icc PSR_LWC_PLUS_V2

PSR_LWC_STD_V2_PT.icc PSR_LWC_STD_V2

PSRgravureMF.icc PSRgravureMF

PSR_SC_STD_V2_PT.icc PSR_SC_STD_V2



VERIFIER 330

4 Select to load the characterization data set automatically (optional).

This setting saves you from having to search for and load the characterization data set 
manually. When you have measured the control strip, the measured values are verified 
automatically against the reference. The characterization data set is loaded from a defined 
folder.

By default, the characterization data set is loaded from the IT8_CharacterizationData folder. 
However, you can change the default folder and load the characterization data from there.

5 Under “User interface”, click “Enable measurement approval” (optional).

By default, a job is verified as color accurate only if all color measurements are within the 
defined tolerance limits. However, by enabling measurement approval, you can gain full 
control over whether a job passes or fails verification. For example, you can force a pass result 
if some delta E values are marginally exceeded.

6 Click the Comparison Settings tab, and define the target tolerances.

Tolerance values define the maximum error margin that is acceptable when verifying the color 
accuracy of a printout against a reference. For example, if you define a tolerance limit of 3, a 
measured delta E of 2.5 would be accepted as color accurate and would generate a “passed” 
result. On the other hand, a delta E measurement of 3.2 would produce a “not passed” result.

A certain amount of deviation is almost unavoidable as, due to differing printing condtions 
(printer, ink, media, etc.), it is generally impossible to obtain 100% identical prints on two 
different output devices.

PSR_SC_PLUS_V2_PT PSR2_SC_PLUS_V2

ISOnewspaper26v4.icc IFRA26

PaC.Space_CMYK_gravure_V1a.icc PaC.Space

GRACoL2013_CRPC6.icc CRPC6 - IDEAlliance ISO 12647-7 
Control Wedge 2013 
GRACoL2013_CRPC6 Ref

GRACoL2013UNC_CRPC3.icc CRPC3 - IDEAlliance ISO 12647-7 
Control Wedge 2013 
GRACoL2013UNC_CRPC3 Ref

SWOP2013C3_CRPC5.icc CRPC5 - IDEAlliance ISO 12647-7 
Control Wedge 2013 
SWOP2013C3_CRPC5 Ref

SWOP2013C5.icc IDEAlliance ISO 12647-7 Control 
Wedge 2013 SWOP2013C5 Ref

EFIJMPA3 EFIJMPA3

JapanColor2011 Coated JapanColor

Reference profile Characterization data
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You can select a set of predefined target tolerances or you can define you own.

• Predefined tolerances

Predefined presets are available for recognized standards. The predefined tolerance limits 
are specified for ISO 12647-7 (contract proofing), ISO 12647-8 (validation proofing), 
G7-compliant verification of proof jobs, or for the Fogra PSD Print Check. They can be 
applied either to daily proof production (verification based on an ISO 12647-7 or 
12647-8-compliant media wedge) or for certification purposes (such as FograCert), 
whereby “Media Wedge” as well as the “Chart” presets are required.

Note that delta T tolerances can be measured only for the primary colors — for example, 
100% cyan or 50% magenta. It is not possible to calculate delta T values for colors that are 
composed of a mixture of cyan, magenta, yellow and black.

• Dynamic wedge

A dynamic wedge is made up of the job’s most prominent colors. For example, if a job is 
composed mainly of shades of blue, the dynamic wedge will have a high proportion of blue 
patches. For the dynamic wedge, you can define only general delta E tolerances. Other 
values are not permitted due to the unique composition of color patches for each job.

Predefined preset Description

ISO 12647-7 Contract Proof 
“Media Wedge”

ISO 12647-7 (contract proofing)

ISO 12647-8 Validation Print 
“Media Wedge” CD2

ISO 12647-8 (FograCert validation print 
certification)

G7-ISO12647-7 Proofing System G7-compliant verification of proof jobs

Dynamic wedge Verification of a job’s key colors, including spot 
colors

Fogra PSD Side-by-Side (ISO/TS 
15311)

Fogra PSD Spot Colors (ISO/TS 
15311)

Fogra PSD Media-Relative 
(ISO/TS 15311)

Verifcation of Process Standard Digital compliance 
level (A, B or C) to do a print check for each 
printout in daily production

Fogra PDS Spot Colors (ISO/TS 15311) is 
available only for the dynamic wedge

G7 Grayscale Compliance G7-grayscale-compliant output

Japan Color Contract Proof Japan Color-compliant (contract proofing)

Softproofing (FograCert 
Softproof )

Softproof verification (on-screen)
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• Custom tolerances

You can define your own tolerance limits (house standard). Custom tolerances provide also 
an easy way to adapt quickly to the latest norms.

The Normative and Informative buttons affect job verification as follows:

When you have defined the required tolerance limits, you can save them as a preset. Click 
Save and define a unique name.

You can transfer custom tolerance presets to Fiery XF and apply them to any verify 
workflow. To make a preset available in Fiery XF, select “Show preset in Fiery XF client”.

To create a preset for a dynamic wedge, select “Use for dynamic wedge”.

7 Click OK.

See also:

“General settings” on page 344

“To change the default folders” on page 345

“Saving and loading measurement data” on page 345

“Default folders” on page 377

Achieving an ISO 12647-7-compliant proof
The procedures require you to print out and measure media wedges. Verifier supports the use 
of Ugra/Fogra media wedges and IT8.7/4 profiling charts. The following examples show how 
to use Verifier to create an ISO 12647-7-compliant proof.

Predefined preset Description

Normative Normative values are evaluated. If any of the measurements 
lie outside the specified range of tolerance, Verifier will 
indicate that the result is not satisfactory and the job will fail 
the verification.

Informative Informative values are evaluated for reference purposes only 
and have no effect on whether the job passes or fails the 
verification. Only normative tolerances are taken into 
account. It means that a job can be successfully verified, 
even if an informative value exceeds the defined tolerance 
limits.

Off If you select "Off", the tolerance limit is not evaluated, and 
it is not included in the evaluation.
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To create a compliant proof, the following criteria must be met:

• The job ticket printed on the proof must contain the following information:

– The name of the proofing software,

– Colorant

– Type of substrate

– Printing condition to be simulated

– Color profiles used

– Time and date of printout

• The delta E and delta H values of the Ugra/Fogra media wedge must be within the defined 
tolerances.

TO VERIFY ISO 12647-7 COMPLIANCY BY MEASUREMENT

1 Make sure that you have a printout of an ISO 12647-7-compliant media wedge.

2 Connect your measuring device to your computer.

3 Start Verifier.

4 Open the Preferences dialog box, and make the following settings:

On the General tab:

• Under "Measuring device", select your measuring device.

If you are using an ES-2000, you can select from three types of measuring conditions. 
They are defined by ISO 13655, as follows:

– M0

The UV content of the speciment illumination is not defined. Measuring occurs in one 
step.

– M1

The UV content of the specimen illumination is defined as D50. Measuring occurs in 
two steps.

– M2

Requires that the spectral power distribution of the speciment illumination is in the 
wavelength range of 420 nm to 700 nm, with no substantial radiation power in 
wavelengths below 400 nm. Corresponds to UV cut. Measuring occurs in two steps.
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If your printer has an embedded UV cut measuring device, you can cause it to simulate a 
non-UV cut device by selecting the appropriate check box. In Europe, non-UV color 
values are usually used for proofing purposes.

• Under "Chart or wedge selection", select the media wedge that you printed.

On the Comparison Settings tab:

• Under "Tolerance limits", select "ISO 12647-7 Contract Proof "Media Wedge"".

5 Click OK to close the Preferences dialog box.

6 For the first set of measurement values (M1): From the "Fogra_MKCheck11" folder, load a 
Fogra characterization data set —  for example, Fogra39.it8 (for ISOcoated_v2_eci.icc).

7 For the second set of measurement values (M2): Click Measure, and measure the media 
wedge.

8 On the File menu, click Save (optional).

You can save a record of the measurement data to *.txt or to *.csv format. The file can be 
opened in any EFI proofing software.

9 Analyze the results.

TO VERIFY ISO 12647-7 COMPLIANCY BY COMPARING MEASUREMENT DATA WITH REFERENCE DATA

1 Start Verifier.

2 Open the Preferences dialog box.

3 On the Comparison Settings tab: Select "ISO 12647-7 Contract Proof "Media Wedge"".

4 Click OK to close the Preferences dialog box.

5 For the first set of measurement values (M1): Click Open, and load the Ugra/Fogra media 
wedge measurement data.

6 For the second set of measurement values (M2): Click Open. From the “Fogra_MKCheck11” 
folder, load a Fogra characterization data set — for example, Fogra39.it8 (for 
ISOcoated_v2_eci.icc).

7 Analyze the results.

See also:

“Analyzing verification results” on page 335

“Saving and loading measurement data” on page 345

“To load measurement data” on page 347
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Analyzing verification results
When you have obtained measurement data, you can analyze the result.

• Results area

The Results tab contains a summary of the overall result. If any of the measurements lie 
outside the specified range of tolerance, Verifier indicates a result of "Not passed". Pointing 
the mouse in the Results area highlights the corresponding color patch in the tables.

A green check mark indicates that the overall measurement is within the tolerance limit. A 
red cross warns you if a measurement exceeded the maximum tolerance values.

The remaining tabs contain a detailed breakdown of the results. The number of tabs 
depends on the tolerance limits that you defined. For example, if you selected an ISO 
12647-7 media wedge or G7, delta T values are not evaluated.
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• Delta E table

You can use the drop-down list box in the table heading to display the color deviation in 
delta E, delta H, delta T or delta Ch, depending on the selected reference.

• Sorting reference data

If you have measured an ECI2002 random chart, you can evaluate it against a visually 
arranged IT8.7/4 chart by reorganizing the IT8.7/4 color patches. Right-click on one of 
the tables and click Sort as reference data. When you resort reference data, the following 
happens:

– Visually arranged IT8.7/4 color patches are reorganized so that they match the order of 
the random chart.

– All non-ECI2002 values are ignored.

By sorting as reference data, you can compare any combination of IT8.7/4 chart and 
Ugra/Fogra media wedge that is selected as the control strip, because only the Ugra/Fogra 
media wedge data is taken into account. Similarly, this setting lets you use the test form 
ISO12647_7_Evaluation_A.pdf to verify printing conditions whose characteristic data is 
available only as ECI2002 and not as IT8.7/4 data.
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• 2D Viewer

In the 2D Viewer, “Show whole gamut” displays a cross-section of the L*a*b* color space 
at a specific L value. Use the slide bar, to move the cutting plane to show the a*b* 
dimensions for the desired L* value.

• 3D Viewer

The 3D Viewer shows the full color gamuts of both sets of measurement data. You can 
drag the 3D model to rotate it. By viewing the 3D model from all sides, you can see where 
the measured color values do not fit into the color gamut of the reference.

2D Viewer
1 Show 2D view
2 Enlarge 2D view
3 Cutting plane at L* = 50

1

2

3

3D Viewer
1 Show 3D view
2 Enlarge 3D view

1

2
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The enlarged 3D view provides additional viewing settings measurement data.

You can use the enlarged 3D view to see how any L*a*b* color would be reproduced in the 
available color gamut. Out-of-gamut colors are mapped to their nearest point on the edge 
of the available color gamut. Select “Enable projection”, click Projection Point and type an 
L*a*b* value in the dialog box. Select whether you want the color to be mapped to the M1 
or M2 color gamut.
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The following diagram applies some of the settings that are available in 3D Viewer and 
shows how an out-of-gamut color is mapped to the edge of the available color gamut. 

Printing verification results
You can print out verification results as a protocol, as a label, or as a screenshot.

TO SET UP A PRINTER

1 Do one of the following:

• In Windows, on the File menu, click Select printer.

• On Macintosh, on the Verifier menu, click Page Setup.

2 In the Print Setup dialog box, select your printer.

3 Click OK.

3D Viewer
1 Out-of-gamut color mapped 

to edge of available color 
gamut

1
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TO PRINT OUT VERIFICATION RESULTS

1 On the File menu, point to Print, and click an item.

• Screenshot

You can print an image of the current program window.

• Protocol

The printed protocol includes ISO-12647-7- and ISO-12647-8-compliant information. It 
also displays CMYK gradation curve diagrams depicting all reference and measured points 
along the curve.

Before printing, complete the Protocol Properties dialog box with job-specific 
information. By clicking Save properties, you can save the information to the defined data 
folder and load it again later as a template for future jobs.
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• Label

The label includes all the criteria that is required to verify ISO 12647-7 and 
12647-8-compliancy, or G7 or Fogra PSD Print Check compliancy.

Before printing, complete the Print preview dialog box with job-specific information. By 
clicking Save properties, you can save the information to the defined data folder and load 
it again later as a template for future jobs.

Customizing the Verifier user interface
You can customize the appearance of Verifier.

TO CHANGE THE DISPLAY LANGUAGE

By default, Verifier is displayed in the language of the operating system. Follow the steps 
below to change the display language in Windows. On Macintosh, you can change the 
language via the international settings in System Preferences.

To display one of the supported Asian languages on a PC, Verifier must be running on an 
operating system that supports double-byte fonts.

1 Open the Preferences dialog box, and click the General tab.

2 Under “User interface”, select a language.

3 Click OK.

4 Restart Verifier for the new language to take effect.
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If you change the display language, make sure that the help set for that language is also 
installed. Otherwise, no help will be available. You can install the help sets for the supported 
languages from the software DVD.

TO CHANGE THE DELTA E WARNING INDICATOR

The delta E table displays the amount of deviation from the reference in terms of delta E.

By default, the amount of deviation is indicated by the following color code:

You can remove the color-coded warning indicator.

1 Open the Preferences dialog box, and click the General tab.

2 Under “User interface”, clear “Enable Delta E warning indicator”.

3 Click OK.

Color Delta E value

White The color patch is within the permitted tolerance.

Yellow The color patch exceeds the permitted average tolerance limit but is 
within the maximum tolerance limit.

Red The color patch exceeds the permitted maximum tolerance limit and, 
therefore, fails verification.
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TO CHANGE THE DISPLAY MODE OF THE M1/M2 TABLES

There are two display modes: tile and cascade.

1 Right-click on the delta E table and click an item.

TO ADJUST THE BRIGHTNESS SETTING

You can adjust the brightness of the displayed color values.
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1 Open the Preferences dialog box, and click the General tab.

2 Under “Monitor gamma”, move the slider, as required.

Move the slider to the left to increase the brightness. Move the slider to the right to decrease 
the brightness.

3 Click OK.

See also:

“To open the Preferences dialog box” on page 327

General settings
You can select a color space and a delta E format for displaying color values. You can also 
select a light source. The light source has a great impact on the way colors are perceived by the 
human eye.

TO CHANGE THE COLOR SPACE

You can change the color space in which the measured readings are displayed.

1 Do one of the following:

• On the View menu, point to Color space and click an item.

• Right-click anywhere in a color measurement table, point to Color space and click an 
item.

You can choose between RGB, L*a*b*, XYZ, CIELCH, or Density. L*a*b* ist the default 
color space.

“Density” is available only if color values are already displayed. In a color-accurate proof, the 
displayed density values are comparable with the density values that are obtained during a 
production run. However, be aware that the density values of individual inkjet inks are not the 
same as the density vlaues of printing inks. This is because the composition of inks on an 
offset printing machine is different from the inks on an inkjet printer.

TO CHANGE THE DELTA E FORMAT

Color accuracy is measured in terms of delta E. Delta E is the mathematical difference 
between two colors in the L*a*b* color space.

1 Select a tolerancing system for measuring color deviation. Do one of the following:

• On the View menu, point to Delta E format, and click an item.

• Right-click anywhere in the delta E table, and click an item.

You can choose between dE CIE L*a*b*, dE CMC, dE 94, and dE 2000.
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TO SPECIFY THE LIGHT SOURCE AND OBSERVER ANGLE FOR SPECTRAL DATA CONVERSION

Different light sources make colors appear differently. To convert spectral data to the L*a*b* 
color space, Verifier takes the light (illuminant) setting and the observer angle into account.

1 Open the Preferences dialog box, and click the General tab.

2 Under “General”, click the required light source for spectral data conversion.

D-50 (5003 K) is the international norm for horizon sunlight on a clear morning/evening. 
D-65 (6504 K) represents midday light (noon), and C (6774 K) stands for average daylight, 
but excludes ultraviolet radiation.

3 Under “General”, click the required observer angle for spectral data conversion.

The angle of view affects the color sensitivity of the eye. Colors are perceived most precisely 
if they strike the area of the fovea in the eye, which is most sensitive to color. The standard 
viewing angle is 2°, but 10° is sometimes used in the packaging or textile industry.

4 Click OK.

TO CHANGE THE DEFAULT FOLDERS

Verifier uses default folders to save and load data. You can change the default folders.

1 Open the Preferences dialog box, and click the General tab.

2 Under “Define default folders”, click Choose.

The Browse for Folder dialog box appears.

3 Browse to the required folder, and click OK.

4 Click OK.

See also:

“To open the Preferences dialog box” on page 327

“Glossary” on page 534

Saving and loading measurement data
You can save measurement data to CSV, TXT or JDF format. By default, the files are saved to 
the Temp folder. You can save multiple sets of measurement data to one file.

TO SAVE MEASUREMENT DATA TO A CSV OR TXT FILE

1 On the File menu, click Save.

The Save As dialog box appears.

2 Type a file name, and select a file type.
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3 Click Save.

The Save data to CSV/TXT dialog box appears.

4 Select the check box for one or both sets of measurement data.

5 Click OK.

TO ADD MEASUREMENT DATA TO A JDF FILE

The JDF file contains the job settings and measurement data (if available). The JDF file is 
saved to the remote container.

1 On the File menu, click Add data to JDF.

It is not possible to create a new JDF file using this command. Measurement data can only be 
added to an existing JDF file.

The Save As dialog box appears.
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2 Select the JDF file, and click Save.

The Add data to JDF dialog box appears.

3 Select the check box for one or both sets of measurement data.

4 Click OK.

TO COPY MEASUREMENT DATA TO THE CLIPBOARD

You can copy measurement results to the clipboard for insertion into a spreadsheet. Color 
values can be copied in the displayed color space (RGB, L*a*b*, XYZ, CIELCH or Density) 
or as spectral data. Spectral data is measured and is not influenced by light conditions. 
Spectral data can be used to calculate the equivalent L*a*b*, XYZ or Density values.

1 Right-click on the M1 or M2 table, point to Copy to clipboard and click Table M1/M2 or 
Spectral data.

2 Insert the data from the clipboard into a spreadsheet program.

TO LOAD MEASUREMENT DATA

You can load measurement data in CSV, TXT or JDF format.

1 Do one of the following:

• Click Open. There are two Open buttons — one for the first set of measurement data 
(M1) and one for the second set of measurement data (M2).

• On the File menu, click Open M1 or Open M2.

• Right-click anywhere in one of the tables, and click Load M1 or Load M2.
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2 Browse to the file, and click Open.

The following dialog box appears. The dialog box may look slightly different, depending on 
the format of the file that is being loaded.

3 Select a set of measurement data, and click OK.

Logging on to a different Fiery XF server
When you start Verifier from Fiery XF, you are automatically logged on to the same Fiery XF 
server as the Fiery XF client.

TO LOG ON TO A DIFFERENT FIERY XF SERVER

You can log on to any Fiery XF server in your network.

1 Do one of the following:

• In Windows, on the File menu, click Login.

• On Macintosh, on the Verifier menu, click Login.

The Login dialog box appears.

2 Enter your Fiery XF login credentials.

3 Select the IP address of the Fiery XF server computer.

A list of all available Fiery XF servers in the sub-network is displayed with their IP address. 
Ask your system administrator if you are not sure which TCP/IP address to use.

4 Click OK.

The connected Fiery XF server is displayed at the bottom of the program window.
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VERIFYING COLOR CONSISTENCY ACROSS SITES

A remote container is used to save a Fiery XF job and its settings in a single file. Remote 
containers can be transferred easily between locations — for example, by FTP server. They 
contain all the information that is needed to create and verify a color-accurate replica of the 
job at different sites.

Remote containers are created either after the job has been printed or, in a verify workflow, 
after the control strip has been measured in Verifier and the results have been transmitted 
back to Fiery XF.

A remote container contains the following:

• The job file (PDF, Image EPS, or TIFF/one-bit only)

• A JDF file (job settings and measurement data (if available))

• Reference profiles

• Control strips

• Spot color table

• L*a*b* optimization (optional)

You can load and process a remote container in any EFI proofing program.

Creating a remote container
You can set up any workflow to create a remote container. Alternatively, you can create a new 
workflow using the workflow template “Remote_Out_(ISOcoated_v2)”. This workflow is set 
up with all the basic settings. You can modify the default workflow settings, if required.

Whichever workflow you use, make sure that the selected control strip is compatible with 
your measuring device.

TO SET UP A WORKFLOW TO CREATE A REMOTE CONTAINER

If you set up a custom workflow, make sure to include the following settings:

1 Go to System Manager. In the layout area, click the workflow. On the Output tab, open the 
Remote File Output pane.
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2 Set up the workflow to create a remote container automatically or manually.

• In an automatic workflow, a remote container is created automatically after printout or, in 
a verify workflow, after the control strip has been measured in Verifier and the results have 
been transmitted back to Fiery XF.

• In a manual workflow, you can create a remote container in Job Explorer when you are 
ready.

3 Save your changes.

TO CREATE A REMOTE CONTAINER MANUALLY

Remote containers can be created manually from PDF, Image EPS, and mono TIFF jobs only. 
Follow this procedure if the workflow has been set up to create remote containers manually.

1 Go to Job Explorer. In the job list, click the job. On the Output tab, open the Remote File 
Output pane.

2 Click “Manually”. Then, complete the rest of your settings on this pane.

3 Do one of the following:

• On the Output tab, open the File Output pane and click Create Now.

• In the job list, right-click the job, and click Create Remote Container.

See also:

“Remote File Output” on page 458

“Verify workflows in Fiery XF” on page 312

Processing a remote job at the recipient site
You can load a remote container in any EFI proofing product. The information that is saved 
to the remote container enables you to print and verify the color accuracy of the original at 
different sites.

TO SET UP THE WORKFLOW AT THE RECIPIENT SITE

You can import a remote container into any workflow. However, in this case, a few settings are 
necessary, as described below.

Alternatively, you can create a new workflow using the workflow template “Remote_In”. This 
workflow is set up with all the basic settings that are necessary to process a remote container in 
a verify workflow. You can modify the default workflow settings, if required.

Whichever workflow you use, make sure that the selected control strip is compatible with 
your measuring device.

If you set up a custom workflow, make sure to include the following settings:

1 Go to System Manager. In the layout area, click the workflow.
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2 On the File tab, open the Job Detection pane. Under “Remote job import”, select to use the 
settings of the remote job.

This setting ensures that the original color management settings, including the simulation 
(reference) profile, are automatically selected when you load the job.

3 On the Verify tab, open the Verify Control Strip 1 pane. Do the following:

• On the pane bar, select the check box to activate the settings.

• Under “Characterization data”, select “Open Measurement File”. 

This setting is necessary to verify the color consistency of a job at different sites. It ensures 
that the color values from the remote container are used as the reference. If the remote 
container was created without measurement data, the simulation (reference) file is used 
instead.

• Under “Target tolerance preset”, define the acceptable deviation for color accuracy.

Tolerance values define the maximum error margin that is acceptable when verifying the 
color accuracy of a printout against a reference. For example, if you define a tolerance limit 
of 3, a measured delta E of 2.5 would be accepted as color accurate, whereas a delta E 
measurement of 3.2 would not be considered color accurate. 

4 Save your changes.

TO PROCESS A REMOTE CONTAINER AT THE RECIPIENT SITE

The most accurate results are achieved if you use the same printer model and media that were 
used to create the original. Color accuracy is further enhanced if both printers are optimally 
calibrated.

1 Load the remote container.

You can load a remote container from like any other job.

If the workflow is set up to print two control strips, you can use one or both to verify color 
accuracy. To deactivate a control strip, clear the check box in the appropriate pane bar of the 
Verify tab.

2 Print the job.

After printing, the job is automatically submitted to Verifier. In the job list, the job status 
changes to “Can be verified”.

3 Connect your measuring device to your computer.
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4 Start Verifier. Do one of the following:

• On the toolbar, click Verifier.

• On the Tools menu, click Verifier.

• Go to Job Explorer. On the Verify tab, open the Verify Control Strip pane. In the pane bar, 
select the check box to activate the settings. On the Verify Control Strip pane, click the 
Verify button.

Verifier starts. The printed job is displayed on the Job List/Preview tab.

5 On the Job List/Preview tab, expand the job file and double-click the job file.

The measured values from the remote container are displayed on the left.
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6 Follow the on-screen instructions to measure the printed control strip.

The measured color values are displayed in the table on the right. The results of the 
comparison are displayed in the “Results” area.
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7 Send the results back to Fiery XF. Do one of the following:

• Click Send.

• On the File menu, click Save to JDF and send.

Saving the measurement data to the JDF provides a record of the color accuracy. You can 
save multiple sets of measurement data to one JDF file. The JDF file is saved to the Temp 
folder.

The measurement results are sent back to Fiery XF. The results are displayed in Job Explorer 
on the appropriate Verify Control Strip pane.

If color accuracy is approved, the job receives the status “Verified”. In this case, the 
verification procedure is complete. If color accuracy could not be approved, the job receives 
the status “Verification failed”.

By default, a job is verified as color accurate only if all color measurements are within the 
defined tolerance limits. However, by enabling measurement approval in Verifier, you can 
gain full control over whether a job passes or fails verification. For example, you can force a 
pass result if some delta E values are marginally exceeded.

If a job fails verification, you may be able to improve on the result by performing a 
job-specific optimization. This process optimizes the job’s color management by creating a 
correction profile that is a better match for the color gamut of the simulation (reference) 
profile. Afterwards, you must reprint the job and repeat the verify procedure.
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See also:

“Verify workflows in Fiery XF” on page 312

“To set up a verify workflow” on page 313

“To set up Verifier” on page 328

“Analyzing verification results” on page 335
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DOT CREATOR

If you have a license for the Dot Creator option, you can create screening files (*.spt) from 
continuous-tone data and implement them in Fiery XF via the media profile.

Halftone screening
Continuous tones are difficult to output satisfactorily on conventional printing presses. This 
is because, unlike photography, differences in lightness cannot be directly reproduced in offset 
printing. Printed paper either has color or it does not. It is not possible to print “just a little 
color”.

Halftone screening is the name of the process that is used to overcome this problem. Here, 
color is represented by rows of dots, whereby the size of each dot and the distance between 
them can be varied to depict different color densities. The larger the dots and the closer the 
distance between them, the darker the reproduced color tone.

During conventional inkjet proofing, the printer driver receives color information from the 
color management module (CMM) and outputs the job using all the available printer inks.

However, for screened output, Fiery XF sends color information for the four process colors 
only. Thus, it is not possible to output screening files of jobs that have already been color 
managed. Colors, including spot colors, are reproduced from CMYK inks by printing ink 
dots next to or on top of each other.

Dot shape
Screen angle

Screen ruling
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Halftone screening can be applied to composite jobs and to separated jobs.

• Composite output

Composite output provides a more accurate simulation of printing technologies that use 
wide-screen ruling.

During composite output, all colors (process colors and spot colors) are printed on one 
page. Colors are printed on top of each other according to a defined screen ruling. This 
method can be used to simulate silk-screen screening on conventional inkjet printers.

• Separated output

Separated output can replace traditional imagesetter technologies that use wide-screen 
rulings — for example, in the silk-screen industry.

During separated output, each color channel is printed on a different page. All colors 
(process colors and spot colors) are reproduced in shades of gray. This method can be used 
to print on transparent dot film media using a conventional inkjet printer.

Screening methods in Fiery XF
Fiery XF supports two types of screening methods — v1 and v2.

• v1 screening

Using the v1 method, the screening file is applied to the output data. The printer driver 
processes the screening file and creates the output data. It means that the paper white 
simulation and full tones are also screened.

Output as 
contone data

Job

SPT EPL

Printer 
driver Printout

CM and spot 
color 
processing
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• v2 screening

With the v2 method, the screening file is applied to the input data. The input data is 
separated into grayscales, then the SPT file creates the screened data. Thereafter, the 
separated files are treated the same as one-bit files. For v2 screening, you require a license 
for the OneBit option.

This method of screening permits higher screen rulings and does not screen paper white 
simulations or full tones.

When applying the v2 screening method, observe the following:

– Input files must be in the CMYK color space. v2 screening cannot be applied to RGB 
or L*a*b* data.

– The screening and printer resolution must be the same.

– It is not possible to create a remote container from jobs with v2 screening.

The table below compares the two screening methods:

CM and 
spot color 
processing

Grayscale 
separation

Job
SPT

EPL

Printer 
driver Printout

v1 v2

AM screening — 
achievable screen ruling

100 lpi (with certain screen 
settings)

Up to 150 lpi (depending on 
the printer configuration)

Screening settings 
definable for each color in 
job

Yes. Spot colors can be linked 
to one of the screening settings 
for C, M, Y or K. The default 
setting is black.

Yes. Spot colors can be linked 
to one of the screening settings 
for C, M, Y or K. The default 
setting is black.

Output Composite printout in pure 
inkjet CMYK screening

Composite printout includes 
screening for each color in job.

Screen dot Pure inkjet dots Color-managed dots. Use of 
light inks.

Color accuracy By overprinting of pure inkjet 
dots

By overprinting of 
color-managed dots

Paper white simulation Screened Contone

Full-tone reproduction Screened Contone
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The differences in output are illustrated in the following diagram.

Fiery XF uses different methods to implement v1 and v2 screening:

• The v1 method requires you to create a new base linearization file and a new media profile 
that incorporates the screening file. To create a new media profile, you require a license for 
the Color Tools Option.

• For the v2 method you can connect the screening file to an existing base linearization file 
and media profile. The only requirement is that the screening file and the base 
linearization file must be created for the same printer resolution.

Contone printer mode 
support

No Yes

Linearization/profiling New linearization and 
profiling using the screening 
file necessary

Can be connected to any 
existing base linearization file, 
as long as the screening 
resolution is the same as the 
printer resolution.

Speed - Up to 50% slower than v1

Dot sharpness - Slightly less sharp than v1

v1 v2

Printing press v2 screening

Color-managed dots. Norm 
and light color. Color 
management via inkjet 
halftoning.

Color accurate, with same 
screening

v1 screening

Pure inkjet CMYK. Color 
management via 
overprinting of pure inkjet 
dots.

Color accurate, but 
different screening
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Fiery XF applies automatically a screening method, based on the halftoning method from the 
base linearization file.

Starting Dot Creator

TO START DOT CREATOR

1 Do one of the following:

• On the toolbar, click Dot Creator.

• On the Tools menu, click Dot Creator.
 

Halftoning method from base linearization file Applied screening method

Screening v1 screening

Error diffusion (SE1) or Stochastic screening (SE2) v2 screening

EPL (Screening) + SPT 
 
EPL (SE1/SE2) + SPT

EPL (Screening) + SPT

EPL (SE1/SE2) + SPT

v1 screening

v2 screeningJob
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Creating screening files
One halftone screen is created for each of the four process colors cyan, magenta, yellow and 
black. Light inks are not supported. Each halftone screen is then rotated and printed at a 
different angle to prevent moiré patterns from appearing. The usual print order is: cyan, 
magenta, yellow, black.

Dot Creator provides three industry-standard settings for screen angles:

• C=15, M=75, Y=0, K=45

• C=8, M=51.5, Y=27, K=75

• C=18.4, M=71.6, Y=0, K=45

You can create halftone screens based on one of these settings or, alternatively, define your 
own customized screen angles for each color channel.

TO CREATE A SCREENING FILE WITH PREDEFINED SCREEN ANGLES

You can save your settings as a preset at any stage of the procedure, if required. By saving your 
settings, you can quickly and easily reload the preset at a later date to make further changes.

1 Start Dot Creator.

2 Select a halftone printer.

It is not possible to implement screening files for contone printers.

3 Select a resolution.

4 Select a dot shape.

Choose from round, diamond, square, line, ellipse.

Y 90°
K 75°

M 45°

C 15°
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5 Select a screen ruling and a screen angle.

6 Select “Rotate by 7.5° to prevent moiré” (optional).

This setting rotates all screen angles by 7.5° counter-clockwise to simulate the screen angles 
that are commonly used in flexographic printing.

Moiré patterns can occur as a result of an unfavorable combination of print resolution and 
screen ruling — for example, if two halftone screens with only slightly different screen rulings 
are superimposed or if they are rotated by only slightly different angles. The screen angles 
C 15 degrees, M 45 degrees, K 75 degrees and Y 90 degrees or 0 degrees produce the best 
results.

Screened printouts without moiré patterns are generally only possible with screen rulings of 
up to 150 lpi.

7 Click Preview to display a preview.

8 Save your settings as a preset (optional).

By saving your settings, you can quickly and easily reload your settings at a later date.

9 Click Save.

The screening file is saved to the Screening folder.

When you have created a screening file, you can to incorporate it into a media profile.

TO CREATE A SCREENING FILE WITH CUSTOM SCREEN ANGLES

You can save your settings as a preset at any stage of the procedure, if required. By saving your 
settings, you can quickly and easily reload the preset at a later date to make further changes.

1 Start Dot Creator.

2 Click Advanced.

3 Select a halftone printer.

It is not possible to implement screening files for contone printers.

4 Select a resolution.

5 Select a dot shape.

Choose from round, diamond, square, line, ellipse.
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6 Select “Prevent moiré” (optional).

Dot Creator assesses the risk of moiré patterns and modifies the settings accordingly.

Moiré patterns can occur as a result of an unfavorable combination of print resolution and 
screen ruling — for example, if two halftone screens with only slightly different screen rulings 
are superimposed or if they are rotated by only slightly different angles. The screen angles 
C 15 degrees, M 45 degrees, K 75 degrees and Y 90 degrees or 0 degrees produce the best 
results.

Screened printouts without moiré patterns are generally only possible with screen rulings of 
up to 150 lpi.

7 Type a screen ruling and a screen angle for each process color. 

8 Click Preview to display a preview.

You can show or hide selected colors from the preview by selecting or clearing the check boxes 
in the “Show” column.

9 Click Save.

The screening file is saved to the Screening folder.

When you have created a screening file, you can to incorporate it into a media profile.

See also:

“Incorporating a screening file into a media profile” on page 363

Incorporating a screening file into a media profile
There are two ways to incorporate a screening file into a media profile:

• You can create a new base linearization file and a new media profile.

• You can connect a screening file to an existing media profile.

The following prerequisites apply:

– The screening file and the base linearization file must have been created for the same 
printer resolution

– The base linearization file must have been created for the halftoning method “Error 
diffusion (SE1)” or “Stochastic screening (SE2)”.

When incorporated into the media profile, your jobs are output at the screen angles that are 
defined in the screening file. 

If you have a license for the Spot Color Option, you can change the screen angles for 
individual jobs.

Screen angles cannot be applied to one-bit files.
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See also:

“Creating or editing a base linearization file” on page 154

“Profile Connector” on page 164

“Changing screen angles” on page 364

Changing screen angles
If you have a license for the Spot Color Option, you can change the screen angles for a loaded 
job. This setting can be useful if you are printing separated gray films on a transparent media. 
By default, all spot colors are screened using the screen angle for black.

TO CHANGE THE SCREEN ANGLES

1 Go to Job Explorer. In the job list, click the job. On the Color tab, open the Spot Colors pane.

The spot color table shows which screen angle is used for each color. The default setting for all 
spot colors is black, but you can select the screen angle of any other process color in the “*” 
column. Scroll to the right to view this column.
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INCREASING JOB SPEED

Many factors affect the speed at which job processing occurs in Fiery XF. The following 
sections describe ways to increase job processing speed.

General tips
The following are general tips that can help you to speed up job processing:

• Deactivate the preview setting. By deactivating the preview settings, you save the time that 
would otherwise be needed to create preview files.

• Make sure that the computer is not running multiple tasks concurrently. Shutting down 
unnecessary tasks frees up extra system resources for Fiery XF.

• Convert complex PostScript jobs to PDF/X-1a format.

• Select a calibration set with a lower print resolution. Printing at 720 x 720 dpi means four 
times less data to process than at 1440 x 1440 dpi.

• In the graphics program, convert jobs to a lower input resolution before loading in 
Fiery XF.

• In a production workflow, select a workflow template that has been especially designed for 
fast job output.

• Deactivate in-RIP separation to print separated files as a composite job using the printer’s 
CMYK inks. If necessary, you can select “Simulate overprinting in composite jobs” 
instead, which is faster to process.

• If you do apply in-RIP separation, do not set the search priority to look for spot colors in 
the source files. Instructing Fiery XF to scan source files for spot color definitions adds to 
the overall processing time.

• Do not rotate jobs or select minimal media consumption.

• Avoid applying color adjustments unless they are absolutely necessary.

• Avoid simulating final run characteristics.

• Install the profile folders and system folders on a separate hard drive.
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See also:

“To create a workflow” on page 58

“Activating the preview” on page 75

“Rotating a job” on page 88

“In-RIP separation” on page 98

“Overprinting in composite jobs” on page 102

“Media profiles” on page 140

“Making color adjustments” on page 182

“Changing the search order” on page 283

“Simulating distinctive print characteristics” on page 374

“Changing the profile folders and system folders” on page 381

RIP and print on the fly
By default, Fiery XF completes job processing and then starts printing.

RIPing and printing “on the fly” means that job processing and printing occur 
simultaneously. As soon as one chunk of job data has been processed, it is printed.

This setting increases the speed at which jobs are output. However, the printer may pause 
from time to time, which can lead to undesirable lines in the printout.

TO ACTIVATE RIP AND PRINT ON THE FLY

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Select “RIP and print on the fly”.

3 Save your changes.

RIP resolution
The RIP resolution is the resolution that is used to process a job. Afterwards, the job is 
converted to the print resolution.

The RIP resolution affects the print speed and the print quality. The higher the RIP 
resolution, the better the print quality, but the longer it takes to print the job. Conversely, a 
lower RIP resolution prints faster but results in a draft-like print quality.

It is not possible to process a job at a higher RIP resolution than the print resolution.

Do not use this setting when processing one-bit files. A low RIP resolution results in fuzzy 
dots in the output.
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TO REDUCE THE RIP RESOLUTION

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Move the slider to “Fast”.

3 Save your changes.

Bi-directional printing
You can set up bi-directional printing for the workflow. Bi-directional printing is faster than 
unidirectional printing, as the print head prints in both directions. However, the result may 
be less accurate. Not all printers support bi-directional printing.

TO ACTIVATE BI-DIRECTIONAL PRINTING

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Select “Print bi-directional”.

3 Save your changes.

Adobe print engines
You can speed up job processing by increasing the number of Adobe print engines that are 
used. Normally, jobs are processed one after another by one single CPU core. By increasing 
the number of Adobe PostScript 3 engines and Adobe PDF print engines, you can process 
multiple PostScript/PDF jobs simultaneously.

TO INCREASE THE NUMBER OF ADOBE PRINT ENGINES

1 Go to System Manager. On the Tools menu, click System Information.

The System Information dialog box appears.

2 Under “General settings”, increase the number of print engines to be used.

The default number of print engines for CPSI and for APPE is equal to the maximum 
number of CPU cores that are available for the operating system — two for 32-bit computers 
and four for 64-bit computers.

3 Save your changes.

This setting is a global setting that is applied to all workflows. You must restart the Fiery XF 
server for the new value to take effect.
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Multi-threaded halftone processing
The conversion of contone to halftone data is the most time-consuming stage of job 
processing. By activating multi-threaded halftone processing, the job’s conversion to halftone 
data is spread out among several CPU cores, thus speeding up the output.

Multi-threaded halftone processing is a global setting that is automatically applied to all 
workflows. However, not all output devices support this feature. It is available only for certain 
halftone printers that are driven by an EFI printer driver.

Generally speaking, the time-saving potential is greatest for the following types of jobs:

• Jobs that apply the halftoning method SE1. SE1 halftoning takes longer to process than 
SE2 halftoning

• Jobs with a higher output resolution

Be aware that the simultaneous processing of multiple jobs can slow down the output of some 
jobs. This happens because only one job can be assigned a higher priority and be processed by 
several CPU cores. This job is therefore printed first, while other jobs are each processed by a 
single CPU core at a slower rate.

TO ACTIVATE MULTI-THREADED HALFTONE PROCESSING

1 Go to System Manager. On the Tools menu, click System Information.

The System Information dialog box appears.

2 Under “General settings”, select “Use multi-threaded halftone processing”.

3 Save your changes.

Load balancing
If you load jobs into Fiery XF through a hotfolder, you can set up the hotfolder to be 
monitored by workflows that are set up on one or more installations of Fiery XF. With load 
balancing, jobs that are placed in the hotfolder are diverted automatically to the first idle 
workflow that becomes available.

Load balancing ensures that all the available system resources are used as efficiently as possible. 
As an example, if one workflow is busy processing a large-volume job, or if one Fiery XF 
server encounters a problem, job processing can continue via a different workflow. When a 
job starts being processed, it is automatically moved to the JobFolder to prevent it from being 
processed multiple times or by two workflows simultaneously.
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The following diagrams illustrate two possible scenarios for using load balancing.

Note the following:

• Workflows that monitor the same hotfolder may not necessarily be configured identically. 
This can result in unsatisfactory color results if the workflow settings are different, or if a 
different printer is connected.

• This setting cannot be applied to jobs in a multi-file format (for example, one-bit, DCS, 
Scitex, TIFF/IT or delta lists).

TO SET UP LOAD BALANCING

1 Go to System Manager. In the layout area, click the workflow. On the File tab, open the Job 
Detection pane.

2 Set up a hotfolder.

Example of load balancing using 
different Fiery XF servers

Example of load balancing using 
different workflows
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3 Select “Enable load balancing”.

4 Repeat the previous steps for a second workflow.

Make sure that you select the same hotfolder that is set up for the first workflow.

5 Save your changes.

See also:

“Printing through a hotfolder” on page 190

High-priority printing
You can increase the speed at which jobs are processed by setting up a high-priority workflow. 
In a high-priority workflow, all jobs are processed before jobs from other workflows that are 
printing to the same output device. Jobs that are already being processed are completed first.

TO SET UP A HIGH-PRIORITY WORKFLOW

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Select “High-priority workflow”.

3 Save your changes.

TO ASSIGN HIGH-PRIORITY STATUS TO A JOB

When multiple jobs in Job Explorer are being processed simultaneously, you can assign 
high-priority status to one of them. A high-priority job goes straight to the front of the print 
queue and is the next to be RIPed.

1 Go to Job Explorer. In the job list, right-click a job that is in the “Processing” state, and click 
High Priority.

You can remove high-priority status from a job by right-clicking it and clicking Normal 
Priority.
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IMPROVING PRINT QUALITY

The following sections describe ways to achieve the best possible print quality.

General tips
The following are general tips to help you to achieve the best possible print quality:

• Make sure that the printer is properly calibrated. Some printers have an internal 
calibration feature that you can activate from the Special tab in System Manager.

• Use a high-quality media that is suitable for the job. For example, use a proofing media for 
CMYK proofing jobs, and use photo paper for vivid output of photographic images.

• Make sure that you select profiles and rendering intents that are suitable for your job.

• Relinearize the printer. By performing a relinearization, you adjust the ink densities to 
those of the reference printer on which the media profile was created. A relinearization 
helps to ensure that the printer’s color reproduction properties remain constant.

• Optimize the media profile to ensure that you get the best possible color results from your 
printer.

• For verify jobs with the status “Verification failed”, it may be possible to get within the 
tolerances by performing a job-specific optimization. This process optimizes the job’s color 
management by creating a correction profile that is a better match for the color gamut of 
the simulation profile.

• Use Color Editor to optimize a spot color. If you are not satisfied with the color quality of 
a spot color in the printout, you can replace it by measuring a truer color representation in 
another printout.

• Force the use of pure black ink to remove CMY inks. You can achieve a more saturated 
black by removing CMY inks.

• Remove color impurities that can occur in color management during the conversion from 
RGB to CMYK.

• Make color adjustments by tweaking the percentage of ink for individual ink channels.



IMPROVING PRINT QUALITY 372

See also:

“Selecting profiles and rendering intents” on page 139

“Optimizing a media profile” on page 159

“Relinearizing the printer” on page 167

“Tweaking job colors” on page 182

“Black ink” on page 183

“Process and secondary colors” on page 183

“Optimizing L*a*b* spot colors” on page 305

“Verify workflows in Fiery XF” on page 312

RIP and print on the fly
By default, Fiery XF completes job processing and then starts printing.

RIPing and printing “on the fly” means that job processing and printing occur 
simultaneously. As soon as one chunk of job data has been processed, it is printed.

This setting increases the speed at which jobs are output. However, the printer may pause 
from time to time, which can lead to undesirable lines in the printout.

TO DEACTIVATE RIP AND PRINT ON THE FLY

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Clear “RIP and print on the fly”.

3 Save your changes.

RIP resolution
The RIP resolution is the resolution that is used to process a job. Afterwards, the job is 
converted to the print resolution.

The RIP resolution affects the print speed and the print quality. The higher the RIP 
resolution, the better the print quality but the longer it takes to print the job. Conversely, a 
lower RIP resolution prints faster but results in a draft-like print quality.

It is not possible to process a job at a higher RIP resolution than the print resolution.

Use this setting when processing one-bit files. A high RIP resolution ensures sharp dots in the 
output.
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TO INCREASE THE RIP RESOLUTION

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Move the slider to “High quality”.

3 Save your changes.

Bi-directional printing
You can deactivate bi-directional printing for the workflow. Bi-directional printing is faster 
than unidirectional printing, as the print head prints in both directions. However, the result 
may be less accurate. Not all printers support bi-directional printing.

TO DEACTIVATE BI-DIRECTIONAL PRINTING

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Speed pane.

2 Clear “Print bi-directional”.

3 Save your changes.

Correcting the length of printed jobs
You can compensate for any inconsistency in the length of the printed image by adjusting the 
output dimensions. Such inconsistencies can occur as a result of a particular combination of 
printer and media.

The file Lineal_01.ps is provided in the Samples folder to help you to adjust the size of the 
printed image. It consists of a set of ruler markings for a length and width of 0.5 m x 0.5 m.

This setting is independent of the hardware setting that is available at the control panel of 
some printers.

TO ADJUST THE LENGTH OF PRINTED JOBS

1 Print out the file Lineal_01.ps and measure the length of the ruler markings.

If the measurement is not accurate, you can compensate for the difference.

2 Go to System Manager. In the layout area, click the output device. On the Media tab, open the 
Media Setting pane.

3 Under “Media size correction”, type the target length and the actual length.

4 Save your changes.

You can also integrate the media length correction into the base linearization file.
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See also:

“Creating or editing a base linearization file” on page 154

“Profile Connector” on page 164

Simulating distinctive print characteristics
You can simulate distinctive print characteristics that are associated with the following 
printing methods:

• Gravure printing

You can simulate the effect that occurs in gravure printing when ink is not evenly 
transferred from the cylinder.

• Flexo printing

You can define the smallest dot size to be printed. In flexo printing, the smallest dot that 
can be etched onto a flexographic printing plate may be as small as 2%, but may gain to as 
much as 12% on the press due to the nature of the photopolymer plate material and the 
printing process.

• Offset printing

You can reproduce an image that more closely resembles output on a printing press. It 
creates a less smooth effect than an inkjet printout.

TO SIMULATE A PRINTING METHOD

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Output tab, open 
the Advanced Print Options pane.

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Advanced 
Print Options pane.
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2 Under “Simulate final run characteristics”, do one of the following:

• For gravure printing, define the area coverage of missing dots as a percentage. The 
illustration shows missing dot simulatation up to an area coverage of 40%.

• For flexo printing, define where the first printable dot will start. This setting can be 
applied to contone data, but not to halftone data. The illustration shows how a setting of 
10% will cause dots that are smaller than 10% to be ignored.

• For offset printing, define the percentage of noise to be added.

3 Save your changes.

100% 0%40%

100% 10% 0%

100% 0%
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Smoothing gradations
You can smooth out uneven color gradations in inkjet production printing. Uneven color 
gradations can appear in light areas of low contrast as banding or as visible blocks of solid 
color. They are often caused by extreme image compression.

Use this setting to smooth out uneven color gradations in inkjet production printing. Uneven 
color gradations can appear in light areas of low contrast as banding or as visible blocks of 
solid color. They are often caused by extreme image compression.

TO SMOOTH OUT GRADATIONS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Output tab, open 
the Advanced Print Options pane.

• Go to Job Explorer. In the job list, click the job. On the Output tab, open the Advanced 
Print Options pane.

2 Under “Dynamic smoothing”, click “Smooth out gradations and compression artefacts”.

3 Save your changes.

Simulating light conditions
By default, the media profiles that are provided with Fiery XF are based on the standard D-50 
light source. You can process your jobs to simulate different light conditions.

TO SIMULATE LIGHT CONDITIONS

1 Do one of the following:

• Go to System Manager. In the layout area, click the workflow. On the Color tab, open the 
Color Management pane.

• Go to Job Explorer. In the job list, click the job. On the Color tab, open the Color 
Management pane.

2 On the pane bar, select the check box to activate the settings.

3 Under “Light adaptation”, do one of the following:

• Select a light source.

• Enter the L*a*b* values of custom light conditions.

You can measure a light source using any conventional measuring device.

4 Save your changes.
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PROGRAM STRUCTURE

The tables below give an overview of the folder structure of Fiery XF to enable you to locate 
files quickly and easily.

A direct link to some of the most commonly used folders is also available:

• In Windows, click the Start button, point to All Programs. click EFI, click Fiery XF, click 
Links, and then click the folder to open.

• On Macintosh, click the Links icon in the Dock, and then click the folder to open.

Default folders
• Installation folder

Unless you choose a different location, fix program components of Fiery XF are installed 
by default in the following folder:

* If you chose not to install Fiery XF at the default location, all the program folders, 
including the Server folder, are installed in the user-defined folder.

Windows* 32 bit on 32-bit OS \Program Files\EFI\Fiery XF 
(Fiery XF client only)

32 bit on 64-bit OS \Program Files(x86)\EFI\Fiery XF 
(Fiery XF client only)

64 bit on 64-bit OS \Program Files\EFI\Fiery XF 
(Server folder only)

\Program Files(x86)\EFI\Fiery XF 
(all other program folders)

Macintosh /Applications/EFI Fiery XF
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• Program Files folder

The Fiery XF folder contains the following subfolders:

Folder name Subfolder name Contains

Client Program files for Fiery XF, 
including additionally 
licensed options

Documentation HTML Help files and PDF 
user manual

IT8_CharacterizationData IT8.7/4 profiling charts for 
Fogra Proof Certification

MonitorProfile Default and custom monitor 
profiles

Samples • EFI_Form_Offset 
reference test files

• Lineal_01.ps for 
calculating media size 
correction

• Print & Cut test files

• Test files for white ink 
printing

EFI RGB Profile 
Connector

Program files

JDF Program files

Application3 Program files relating to 
Verifier and Color Tools. The 
it8 chart and characterization 
data files are located in 
subfolders.

Tools Program file for Fiery XF 
server information

FograCert FograCert test forms for Fogra 
Proof Certification

PPD PPDs

Printer PnP 
(Windows only)

Plug and play files for 
supported printers

USB Measurement Devices 
(Windows only)

Device drivers for supported 
measuring devices
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• Work folder

You will find all work files directly associated with job processing located in the following 
folders:

If you cannot see the ProgramData folder, it may be because it is set up as a hidden folder 
on your computer. Open Control Panel, and search for “Show hidden files and folders”. 
On the View tab, make sure that the advanced setting “Show hidden files, folders, and 
drives” is selected.

The folder EFI Fiery XF contains the following folders and subfolders:

Windows \ProgramData\EFI\EFI XF

Macintosh /Library/Application Support/EFI/EFI XF

Folder name Subfolder name Contains

Client Working Temporary files. Used to 
save:

• Base linearization and 
profiling files from 
Color Tools

• Remote containers to be 
created manually

Log Log files. Important in case 
of support queries.

ClientPreview Preview files
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Server Backup Backup files of system 
configurations

ControlCharts it8 files for the checking the 
measured color values of the 
control strips

ControlStrip Control strips for footer

Environments Backup files of environments

Export Default folder for 
print-to-file jobs

JobFolder Temporary job files

Log Log files. Important in case 
of support queries.

Logo Copies of logo files that are 
selected for job ticket

Output Print (bco) files

Preview Preview files

Profiles Profiles and files that affect 
the color output

    \Balance Default 3cc files; vcc and vpc 
files

    \Monitor Monitor profiles

    \Reference • Profiles that are in 
common use in the 
industry

• Device link profiles

    \Reference Additional Additional reference profiles 
that are in common use 
around the world

    \Spotcolor Spot color tables

    \SpotColorOptimization Spot color optimization files

Remote Remote containers (rpf files)

Screening Screening files (spt)

Tickets Record of all actions taken in 
Fiery XF Control. Important 
for support cases.

Folder name Subfolder name Contains
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• Media profiles

Media profiles are installed in the following folders:

• License files

License files are installed in the following folders:

Changing the profile folders and system folders
You can redefine the path to important server folders and select a new location for media 
profiles, reference profiles, the JobFolder, output files, and temporary files, including CPSI 
and APPE files. As an example, you can move media profiles to a different partition to free up 
disk space on the C drive.

TO MOVE THE PROFILE FOLDERS AND SYSTEM FOLDERS TO A DIFFERENT LOCATION

1 Right-click the Fiery XF Control icon, and click Fiery XF Server Stop.

2 Right-click the Fiery XF Control icon, and click Server File Maintenance.

The Server File Maintenance dialog box appears.

3 Click the appropriate Choose button and browse to the new folder.

4 Click OK.

Windows \ProgramData\EFI\EFI Media Profiles

Macintosh /Library/Application Support/EFI/EFI Media Profiles

Windows \Program Files\FlexLM

Macintosh /Applications/FlexLM
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CLEANING UP FIERY XF 
Fiery XF creates different types of files during job processing. Some files remain in the server 
program folders indefinitely after job completion, so that an excessive volume of data can 
build up over time.

You can clean up Fiery XF by deleting the following types of files when they are no longer 
needed:

TO DELETE FILES IMMEDIATELY

Follow this procedure to delete output files, preview files, temporary files, spot color tables, all 
jobs from the job list, or log files.

1 Go to System Manager. On the System menu, point to Clean Up, and click an item.

Alternatively, click All to delete all types of files.

File type Description

Source files For every job that you load in Fiery XF, a source file is created 
in the Server\JobFolder folder. If you delete the source files, the 
jobs themselves are not removed from the job list.

Output files An output file (print file) is created in the Server\Output folder 
when you send a job to the printer.

Preview files If the preview function is activated, a preview file is created in 
the Server\Preview folder.

Temporary files Various temporary files are created in the Server\Temp folder.

Spot color tables A spot color table is created in the Server\Profiles\Spotcolor 
folder when you define a spot color. Every time you save 
changes, a new spot color is created with a consecutive number 
added to its name.

Spot color tables that are currently in use cannot be cleaned up.

Job list You can delete all jobs from the job list. However, the job list 
cannot be deleted if jobs are currently being processed.

Log files Log files are created in the Server\Log folder. They provide a 
record of all Fiery XF processes and are required by EFI 
Support to assist with problem solving.
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TO DELETE FILES AFTER A SPECIFIED CRITERION HAS BEEN MET

Follow this procedure to delete source files, output files, and preview files.

1 Go to System Manager. In the layout area, click the workflow. On the Workflow tab, open the 
Basic Information pane.

2 Under “Source files”, specify when sources files are deleted.

Source files can be deleted:

• Automatically after printing

• After a certain number of days has elapsed. Type the time span in days.

• From a hotfolder. Select the check box to delete source files from a hotfolder.

The setting you make for source file deletion is automatically applied to output and preview 
files.

3 Under “Output/preview files”, specify when output and preview files are deleted.

Output and preview files can be deleted:

• Automatically after printing

• After a certain number of days has elapsed. Type the time span in days.

If you have previously made a setting to delete source files, the same setting is automatically 
applied to output and preview files. An independent setting is possible only if source files are 
never deleted.
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TROUBLESHOOTING

If you encounter problems while working with Fiery XF, try performing the suggested 
solutions. If the problem still persists, contact EFI Support.

Server and logging on problems

I cannot see the server user interface? How can I log on?

Cause: The server runs as a service, so it has no user interface. All actions are 
initiated from the client software.

Remedy: To start the client, do one of the following:

• Click the program icon on the desktop (Windows) or in the Dock 
(Macintosh).

• Right-click the Fiery XF Control icon, and click Fiery XF Client Start.

I am working with Windows. The server does not accept any connection from a client. What 
can I do?

Cause: A firewall is set up which is blocking the communication.

Remedy: Unlock ports 50005 - 50026. For more information, see the Windows 
help.

I am working with Windows. Although I am able to log on to Fiery XF successfully, I cannot 
see any users, workflows or output devices.

Cause: A firewall is set up which is blocking the communication.

Remedy: Unlock ports 50005 - 50026. For more information, see the Windows 
help.
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When I try and log on, I get the error message “The user ‘admin’ is unknown. Please make 
sure that you type in the correct name.”

Cause: The usr_0000.xml file may be missing.

Remedy: In the Tickets folder, search for the usr_0000.xml file.

If you find the usr_0000.xml file, cut and paste it to a destination outside 
the Tickets folder. Then restart the server. A new usr_0000.xml file is 
automatically created.

If the usr_0000.xml file is missing but you find a usr.0000.bak file, restart 
the server. During server restart, a new usr_0000.xml is automatically 
created.

If you cannot find either a usr.0000.xml or a usr.0000.bak file, contact EFI 
Support for a new usr.0000.xml file. When you receive the file, copy it to 
the Tickets folder.

The start screen appears briefly and then closes. Why is this?

Cause: This behavior occurs because Microsoft Windows uses the Data Execution 
Prevention (DEP) feature to help prevent damage from viruses and from 
other security threats.

Remedy: Deactivate Data Execution Prevention for Fiery XF as follows:

1 Right-click Computer, and click Properties.

2 Click Advanced system settings.

The System Properties dialog box appears. The Advanced tab is selected.

3 Click the Settings button for performance.

4 Click the Data Execution Prevention tab.

5 Select “Turn on DEP for all programs and services except those I select:”. 
Then click Add and browse to the Client folder.

6 Select all the application files with the extension *.exe and add them to 
the list of programs that are not affected by DEP.

7 Then click Add and brows to the Server folder. Add all the application files 
that are located in the Server folder in the same way.
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License problems

Fiery XF cannot find the license

Cause: There may be licenses for different dongle IDs in the FlexLM folder.

Remedy: Make sure that the dongle for which the software is licensed is currently 
plugged in.

Cause: The base license(s) may have been removed from the FlexLM folder. If you 
have upgraded the software from an older version, you still require the 
original licenses of the previous versions.

Remedy: Make sure that the license for the predecessor version(s) as well as for the 
upgrade license are correctly installed in the FlexLM folder.

The license file downloaded from the activation website cannot be installed.

Cause: The downloaded license file may have the wrong file extension.

Remedy: Check the file extension of the license file. Licenses with the extension *.txt 
are not detected in Fiery XF. Change the file extension from txt to lic.

If the file extension is not visible, open Control Panel, and search for 
“Show hidden files and folders”. On the View tab, make sure that the 
advanced setting “Show hidden files, folders, and drives” is selected.

There is no valid license

Cause: Fiery XF Control may not be running.

Remedy: Make sure that Fiery XF Control is online before trying to log on to the 
client. Right-click the Fiery XF Control icon, and click Fiery XF Server 
Start.

Cause: One or more Windows services required by Fiery XF may not be running.

Remedy: Right-click the Fiery XF Control icon, and click Fiery XF Server 
Configuration. Check that the following services are started:

• EFI License Manager

• EFI XF Server

• DebugLog

If necessary, select the service that is currently not running and click 
“Retart the service”.
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Cause: The dongle is not detected.

Remedy: Connect the dongle to a different USB port.

To check whether the dongle is detected, right-click the Fiery XF Control 
icon, and click Show Dongle ID.

If the dongle is not detected, reinstall the dongle driver. You can download 
the latest dongle driver from http://www.aladdin.com/support/hasp.aspx. 
In the section for end-user downloads, select the HASP HL device driver.

Cause: The license file may have been generated for an incorrect dongle ID.

Remedy: Make sure that the right dongle ID is shown in the license file(s) of the 
purchased options.

To check the dongle ID, right-click the Fiery XF Control icon, and click 
Show Dongle ID.

To verify the dongle ID of the license, open the license file in a text editor 
(for example, Wordpad).

Check that the license file contains the following information:

• The name of the server computer

• The dongle ID

If the dongle IDs do not match, send an e-mail to:

• eu.activation@efi.com (for Europe/Asia/Australia/Africa)

• activation@efi.com (for North and South America)

In the e-mail, provide details of:

• the EAC code(s) of the incorrectly generated license(s)

• the correct dongle ID (from Fiery XF Control)

• the incorrectly typed dongle ID (that is printed in the license file)

Cause: If you are updating from an earlier version of the software, the licenses 
from the earlier version may have been deleted from the FlexLM folder.

Remedy: Fiery XF requires the license files from all earlier versions in addition to the 
upgrade license. If necessary, reinstall previously removed licenses. To 
reinstall licenses, right-click the Fiery XF Control icon, and click Activate 
Fiery XF.

To check which licenses are installed, right-click the Fiery XF Control 
icon, and click Show License Information. You must have a license for at 
least one server, one client and one Output Option M.

Cause: The system date and time may not be set up correctly.

Remedy: Check the BIOS setting in Windows.
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Cause: The license files may not be detected.

Remedy: Try reinstalling all the license files. With the exception of the file 
default.lic, remove all license files from the FlexLM folder and then 
reinstall each file separately. Right-click the Fiery XF Control icon, and 
click Activate Fiery XF.

Make sure to install via Fiery XF Control. Do not simply copy license files 
to the FlexLM folder.

I am unable to set up or connect any more output devices

Cause: You do not have enough Output Option licenses.

Remedy: Purchase an additional Output Option license.

Cause: You may be trying to set up the same printer via two different connection 
types.

Remedy: Make sure that all instances of the printer (including the linearization 
device) use the same connection type.

My printer is not listed in the printer list

Cause: You may be trying to connect to an output device that requires a separate 
license.

Remedy: Make sure that the installed license supports your printer model.

Why does Fiery XF tell me that there are not enough licenses available?

Cause: Quite often a printer is configured with two IP addresses, so Fiery XF 
assumes that it is two different output devices. This problem can occur 
quite often in connection with the linearization device.

Remedy: Make sure that multiple instances of an output device are configured in 
Fiery XF with the same IP address.

See also:

“Licensing the software” on page 42

“Regenerating a license file” on page 47



TROUBLESHOOTING 389

Printing problems

Why am I unable to load any jobs?

Cause: Fiery XF requires a certain amount of free disk space. If less than 2.5% free 
disk space or less than 5 GB free disk space is available, you may not be 
able to load and process jobs.

Remedy: Ensure that the hard disk has sufficient free space.

Cause: You may not have enough valid output licenses. Bear in mind that your 
software may have been shipped with a 30-day license that allows you to set 
up a connection to up to ten output devices, A standard, permanent license 
includes one output option for a medium-sized printer up to 18 inches 
wide.

Remedy: To check whether you have enough output licenses, proceed as follows:

1 Go to System Manager. In the layout area, disconnect all output devices 
from all workflows. Then, click the linearization device.

2 On the Device tab, open the Information pane. Under “Manufacturer”, 
select “Select a manufacturer”.

3 Save the settings for the linearization device.

4 Connect one output device to one workflow.

5 In Job Explorer, try and load a job.

If you are still not able to load a job, ensure that the amount of used disk 
space does not exceed 95%. If necessary, free up additional space on the 
hard disk.

During job processing a bco file is created in the default Output folder. You 
can reduce the amount of hard disk space that Fiery XF requires during job 
processing by defining a different folder as follows:

6 Stop the Fiery XF server.

7 In the Server folder, open the Tickets folder.

8 In a text editor, open the sys_0000.xml file.

9 Search for the line that begins “<Print type=”, and type in a new path.

Cause: The dongle may have become unplugged from the computer while the 
server is still running.

Remedy: Make sure that the dongle is properly inserted.
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Why do I get the error message “Invalid page height”?

Cause: The information from the bounding box is not taken into account.

Remedy: Go to System Manager. In the layout area, click the workflow. On the File 
tab, open the PS/EPS/PDF pane. Under “Size definition”, select “Calculate 
page size”.

The linearization cannot be processed

Cause: A corrupt base linearization file is being applied.

Remedy: Go to System Manager. In the layout area, click the output device. On the 
Media tab, open the Print Configuration pane. Check the calibration set 
that is selected for the output device.

Open the base linearization file in Profile Connector, a tool provided with 
Color Tools, and make sure that the name of the selected media profile 
matches that of the connected media profile.

If this does not help, try reconnecting the base linearization file and the 
media profile in Profile Connector.

What does the error message “Command Error” mean?

Cause: Some printers can be used with two different types of ink (for example, 
Ultrachrome Photo and Matte). The error message occurs if the type of ink 
that is selected in Fiery XF does not match the type of ink that is inserted 
in the printer. 

Remedy: Make sure that you select the right type of ink for the output device. The 
black ink cartridge lets you identify which type of ink is being used. Go to 
System Manager. In the layout area, click the output device. On the Media 
tab, open the Print Configuration pane and make the correct ink type 
setting.
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I have set up a hotfolder in a network, but submitted jobs do not appear in the job list. What 
is the problem?

Cause: The Fiery XF server runs on Windows as a service. By default, the login 
rights are defined for the local computer. It means that Fiery XF cannot 
communicate with folders that are located in a network environment. This 
may present problems if you wish to print jobs via a hotfolder.

Remedy: Assign network access rights for the Fiery XF server as follows:

1 Right-click the Fiery XF Control icon, and click Fiery XF Server 
Configuration.

2 Right-click EFI XF Server, click Properties, and click the Log On tab.

3 Click “This account”, and assign network access rights for the Fiery XF 
server.

4 Click OK.
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Color management problems

Initialization of CMM failed

Cause: There could be a wrong setting on the Color Management pane, or the 
media profile may be corrupt.

Remedy: Check the color management settings for the workflow. Check also the 
quality settings for the output device.

Media profile problems

I am trying to use a media profile that I received from a supplier. Why can I not select it in 
Fiery XF?

Cause: The media profile is not connected to a base linearization file.

Remedy: The media profile must always be connected to a base linearization file in 
order to be available for selection in Fiery XF. Make sure that the media 
profile has been connected to a base linearization file.

I have created a media profile, but why can I not select it in Fiery XF?

Cause: The profile may not be saved under a unique name, which makes it 
difficult to find in the list of available media profiles.

Remedy: It is recommended that you create a calibration set for a unique media 
name, so that the profile can be found more easily in Fiery XF. You can 
create a new calibration set by creating a base linearization file and 
connecting it to an existing media profile.

Cause: The base linearization file is not saved in the Profiles folder.

Remedy: Make sure that the base linearization file and the ICC profile are saved in 
the EFI Media Profiles folder.
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Why do I receive the error message “Selected profile is invalid”?

Cause: The media profile may not be correctly connected to the base linearization 
file. Only media that are linked to a base linearization file are listed on the 
Media pane for the output device. If the media is not listed, it could be 
because Fiery XF is not able to detect the base linearization file.

Remedy: Make sure that the media profile has been correctly connected to a base 
linearization file.

On the Color Management pane, check the profile selection for the 
workflow.

Why can Fiery XF not find my installed media profiles?

Cause: The path to the media profiles may not be correct.

1 Right-click Fiery XF Control, and click Fiery XF Server Stop.

2 Right-click Fiery XF Control, and click Server File Maintenance.

3 Do one of the following:

• Correct the path to the media profiles.

• Copy the media profiles into the defined Media Profiles folder.

See also:

“Third-party media profiles” on page 176

“Creating or editing a base linearization file” on page 154

“Profile Connector” on page 164

USB device problems

When I connect my USB measuring device to the computer, I am requested to install the 
device driver. Should the device driver not be detected automatically?

Cause: Occasionally the device driver may not be detected automatically when 
you connect the USB device to the computer.

Remedy: If the wizard prompts you to install the device driver from DVD, display 
the contents of the DVD, browse to the USB Measurement Devices folder 
and install the appropriate device driver.

Alternatively, download the current device driver from the manufacturer’s 
website.
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Why can my USB device (for example, dongle) not be found?

Cause: The device driver may not be correctly installed.

Remedy: Install the device driver as follows:

1 Right-click My Computer and click Properties.

2 Click Device Manager.

3 Search for Universal Serial Bus controllers.

4 Expand the list and search for the device that is not detected. 
Non-detected devices appear with a question mark next to them.

5 Right-click the device entry and click Update Driver Software.

6 Download and install the current driver by selecting the recommended 
setting.

Cause: The USB cable may be too old.

Remedy: Use the USB cable that is shipped with the ES-1000 or ES-2000 measuring 
device. Problems can arise if you use a lower-quality cable with a newer 
measuring device.

Cause: A third-party software may be accessing the measuring device.

Remedy: Deactivate or uninstall any third-party software that is accessing the 
measuring device.

Cause: The ES-1000 and ES-2000 measuring devices run as a service (Windows 
only). It is possible that the service has stopped running.

Remedy: Restart the service: Right-click the Fiery XF Control icon, and click 
Fiery XF Server Configuration. In the list of services, select EFI ES1000 or 
EFI ES2000, and then click Restart the service.

Why can the dongle not be detected since I updated the operating system to Mac OS x 10.8?

Cause: The dongle driver needs updating.

Remedy: The newest version is available from 
http://sentinelcustomer.safenet-inc.com/sentineldownloads/.?s=&c=End+
User&p=Sentinel+HASP&o=Mac&t=Runtime+%26+Device+Driver. 
Download and install “Sentinel HASP/LDK Mac OS X Run-time GUI 
Installation”.
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EFI Support
If you run into difficulties while working with Fiery XF and you cannot find the solution in 
this manual, contact your reseller or distributor for technical assistance.

Make sure to provide the following information when contacting your reseller or distributor:

• Version name and release number of your software

• License information

• Printer model

• Operating system with version number

• Details of additional hardware and software that is installed (for example, ISDN boards, 
virus scanners)

TO FIND THE CONTACT DETAILS FOR YOUR REGION

1 Do one of the following:

• On the Help menu, click EFI Technical Support.

• Visit http://www.efi.com/support/overview.

Knowledge Center
EFI has set up an online knowledge center to supplement the information found in this user 
manual. The Knowledge Center is filled with useful information and tips on working with 
Fiery XF. It also contains articles on how best to linearize certain printers or how to obtain 
good results with layered printing. Therefore, if you are having trouble getting to grips with a 
certain feature of Fiery XF, visit our website at:

http://w3.efi.com/services/fiery-wide-format-services/knowledge-center

Online user forum
The online forum is open to all users of Fiery XF. It enables you to post questions that are 
related to any area of Fiery XF directly to members of the EFI team. Furthermore, it permits 
open discussion with other forum members and thus provides an ideal platform for 
communicating with other users. To register as a forum member, visit our website at:

http://proofingforums.efi.com

http://www.efi.com/bestcolor
http://www.efi.com/bestcolor
http://proofingforums.efi.com
http://www.efi.com/bestcolor
http://www.efi.com/bestcolor
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Fiery Global University
Fiery Global University is an easy-to-use, self-paced Internet-based platform that delivers 
around-the-clock training content whenever you need it. It provides training videos to help 
you to get to grips with some of the more difficult features of Fiery XF. To visit the Fiery 
Global University, visit our website at:

http://w3.efi.com/en/Fiery/dm/promo/fiery-global-university

http://w3.efi.com/en/Fiery/dm/promo/fiery-global-university
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UNINSTALLING

This section describes how to uninstall Fiery XF (including licensed options and freely 
available tools) and media profiles.

TO UNINSTALL IN WINDOWS

1 Open Control Panel.

2 Do one of the following:

• Windows 7/8: Under “Programs”, click “Uninstall a program”.

• Windows Server 2008: Click Software.

3 In the list of installed programs, click the program that you want to uninstall.

4 Do one of the following:

• Windows 7/8: Click Uninstall.

• Windows Server 2008: Click Remove.

5 Follow the ôon-screen instructions to complete the procedure.

After uninstalling, make sure that you restart your computer before reinstalling the software.

TO UNINSTALL ON MACINTOSH

1 Insert the software DVD into the DVD-ROM drive.

2 Double-click the drive icon to mount the DVD.

3 Open the Uninstallers folder, and double-click the program that you want to uninstall.

To remove Fiery XF, you must also uninstall Color Profiler Suite.

4 Follow the on-screen instructions to complete the procedure.

After uninstalling, make sure that you restart your computer before reinstalling the software.
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SUMMARY OF FEATURES AND SETTINGS

This section provides a summary of the features and settings that are available in Fiery XF. Be 
aware that some of the panes and dialog boxes describe features that require an appropriate 
license and may not be visible in your configuration of Fiery XF.

• Property inspector of the Fiery XF client

The descriptions are also displayed as context-sensitive help in the user interface of 
Fiery XF. You can access the context-sensitive help via the menu buttons in property 
inspector. Right-click a menu button and click Help. 

– “User Account” on page 403
– “Workspace” on page 404

Property inspector
1 Menu button

1
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– “Job Detection” on page 405
– “PS/EPS/PDF” on page 406
– “One-bit (System Manager)” on page 408
– “One-bit (Job Explorer)” on page 409
– “TIFF/IT, Scitex CT/LW” on page 410
– “Job Merge” on page 411
– “JDF Ticket” on page 413
– “Source File Information” on page 414
– “Warning and Error” on page 415
– “Subfiles” on page 416
– “Job Variations” on page 417
– “Virtual Sheet Size” on page 418
– “Layout Options” on page 419
– “Job Ticket” on page 421
– “Nesting (System Manager)” on page 423
– “Nesting (Job Explorer)” on page 425
– “Step and Repeat (System Manager)” on page 427
– “Step and Repeat (Job Explorer)” on page 429
– “Tiling (System Manager)” on page 431
– “Tiling (Job Explorer)” on page 433
– “N-Up” on page 436
– “Booklet” on page 437
– “Crop Marks, FOTOBA marks, and KIPCut marks” on page 439
– “Grommet Marks” on page 440
– “Cut (System Manager)” on page 441
– “Cut (Job Explorer)” on page 444
– “Color Adjustment” on page 446
– “Color Management” on page 447
– “Color Management (Cretaprint)” on page 450
– “Spot Colors (System Manager)” on page 452
– “Spot Colors (Job Explorer)” on page 453
– “White Ink And Decoration” on page 455
– “Print Settings” on page 456
– “Advanced Print Options” on page 457
– “Remote File Output” on page 458
– “Media Settings” on page 459
– “File Output” on page 460
– “File Output (Cretaprint)” on page 462
– “Media Configuration” on page 463
– “Print Configuration” on page 464
– “Print Bar Configuration” on page 465
– “Control Strips” on page 466
– “Verify Control Strip (System Manager)” on page 467
– “Verify Control Strip (Job Explorer)” on page 468
– “Basic Information” on page 470
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– “Preview” on page 471
– “Speed” on page 472
– “Information” on page 473
– “Connection” on page 474
– “Print Configuration” on page 477
– “Media Setting” on page 478
– “Special Printer Settings” on page 479
– “Device” on page 480

• Color Editor

– “Managing spot colors” on page 481
– “Color Definition tab” on page 482
– “Characterization tab” on page 483
– “Gradation tab” on page 484
– “Preferences: Color Definition tab” on page 485
– “Preferences: Measurement and Display tab” on page 487
– “Preferences: Gradation tab” on page 488
– “Select alias for new spot color” on page 489
– “Select an ink channel for the new spot color” on page 490
– “Find and replace spot colors” on page 491
– “Create a new spot color table” on page 492
– “Apply spot color table to workflows” on page 493
– “Check the color accuracy of L*a*b* spot colors” on page 494
– “Convert L*a*b* spot colors to the color space of the printer” on page 495
– “Optimize L*a*b* spot colors” on page 496
– “Solve naming conflicts when importing spot color tables” on page 497

• Color Tools

– “Create a base linearization file (printer settings)” on page 498
– “Create a base linearization file (non-VUTEk printers)” on page 503
– “Create a base linearization file (VUTEk printers)” on page 507
– “Create a base linearization file (VUTEk printers legacy procedure)” on page 513
– “Optimize a media profile” on page 522
– “Profile Connector” on page 527
– “Perform a relinearization” on page 531
– “Make visual corrections” on page 529
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Tabs
Job and workflow settings are arranged on tabs. Each tab is subdivided into panes. For 
example, the Workflow tab consists of three panes: Basic Information, Preview, and Speed.

You can display the panes that are available for each tab by clicking the appropriate button in 
the tab bar of property inspector.

The menu button on the right of the menu bar contains the following items:

• Show

Shows or hides tabs. Point to Show, and click an item without a check mark next to it to 
add it to the tab bar. Click an item with a check mark next to it to remove it from the tab 
bar. Click All to add all tabs to the tab bar.

A maximum of five tabs are visible in the tab bar at a time. You can scroll to the left and 
right to view tabs that are not visible. Alternatively, shortcuts are available via the menu 
button. Click the menu button and click an item to go straight to the tab and to display its 
available panes.

• Workspace

A custom view of Fiery XF is known as a workspace. A workspace defines the areas of 
Fiery XF that each user can see and use. The basic workspace for each user is defined by 
the administrator when the user is created. Fiery XF is customizable for each user. 

If you have been assigned more than one workspace, you can select which workspace to 
display.

Furthermore, if you have administrator rights, you can do the following:

– You can customize your view of the user interface by hiding areas of the selected 
workspace that you do not need.

– You can save the current view of Fiery XF as a new workspace, or delete a custom 
workspace that is no longer needed.

– You can create or modify a custom view of Fiery XF in Workspace Manager. Workspace 
Manager lets you select individual settings from Fiery XF’s range of features and save 
them under a unique name.

See also:

“Property inspector” on page 31

“Workspaces” on page 70
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Panes
Job and workflow settings are arranged on tabs. Each tab is subdivided into panes. For 
example, the Workflow tab consists of the panes Basic Information, Preview, and Speed.

If you right-click anywhere in property inspector, menu items become available:

• Point to Show, and click an item without a check mark next to it to show the pane. Click 
an item with a check mark next to it to hide the pane. Click All to show all panes for the 
selected tab.

• Shortcuts are also available. Click an item to go straight to the selected pane and to display 
the available settings.

The menu button on the right of the pane bar contains the following items:

• Expand/Collapse

Expands or collapses the settings for each pane. Expand a pane to view its settings.

• Hide

Hides a pane, so that it is no longer visible. To redisplay a hidden pane, right-click 
anywhere in property inspector, point to Show, and click an item without a check mark 
next to it.

• Reset to Default

On some panes, you can return the current settings to their default values.

On some panes, you can save the current settings as a preset. A preset is a template for a group 
of settings that is saved under a unique name. Custom presets can be deleted, but not 
predefined presets. The selected preset is displayed in the pane header. You can save, select, or 
delte a preset by clicking the down-arrow in the center of the pane header.

See also:

“Property inspector” on page 31
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User Account

Create a new user or change the profile of an existing user.

A user profile consists of a user name and a password to log on to Fiery XF. The user profile 
defines also the role of the user: Administrator or User.

• Administrators are permitted to create, set up and manage system configurations in 
System Manager, and to load jobs and make job-specific settings in Job Explorer.

• Users are permitted only to load jobs and make job-specific settings in Job Explorer.

You can customize each user’s vew of Fiery XF by assigning workspaces.

See also:

“Creating a system configuration in System Manager” on page 57
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Workspace

A workspace is a custom view of Fiery XF. It defines the settings that each user can see and 
use. Settings to which a user does not have access are hidden from view.

The predefined workspaces provide access to a specific range of settings. Administrators can 
also create custom workspaces. Each user can be assigned one or more workspaces. Click Edit 
to open the Workspace Manager.

See also:

“Workspaces” on page 70
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Job Detection

• Hotfolder

Set up a hotfolder so that users, who do not have the Fiery XF client installed on their 
computers, can send jobs to Fiery XF. A hotfolder is a folder on the network that is 
routinely monitored by Fiery XF. Jobs that are placed in the hotfolder are loaded 
automatically into the workflow.

• Enable load balancing

Enable a hotfolder to be monitored by more than one workflow. With load balancing, jobs 
that are placed in the hotfolder are diverted automatically to the first idle workflow that 
becomes available.

• Create virtual printer

Set up Fiery XF as a virtual printer so that users can select Fiery XF in the print command 
of their graphics program.

• Remote job import

A remote container saves a CMYK job and its settings in a single file. A remote container is 
used primarily to verify the color accuracy of a job that is printed at multiple sites. When 
you process a remote container in Fiery XF, you can apply the job settings or the workflow 
settings.

See also:

“Printing through a hotfolder” on page 190

“Load balancing” on page 368

“Printing through a virtual printer” on page 209

“Processing a remote job at the recipient site” on page 350

“Warning and Error” on page 415
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PS/EPS/PDF

• Stop job processing if font is missing

By default, if a PDF job contains non-embedded fonts, the missing fonts are replaced with 
the font Courier. If preferred, you can instruct Fiery XF to stop job processing if a missing 
font is detected.

• Divide multi-page PDF files into single-page jobs (System Manager only)

By default, a multi-page PDF job is loaded as a single job. It means that job settings are 
applied to all pages. To make individual page settings, load each page as a separate job.

• Size definition

For PDF jobs, the page size is defined by the media box, crop box, bleed box, art box, or 
trim box. For PostScript jobs, the page size is defined by the bounding box. Fiery XF can 
retrieve this page size information from the job. However, the page size definition is not 
always exact, due to rounding up or rounding down errors that can occur when printing 
from some graphics programs. Such inaccuracies can result in image distortion in the 
printout.

To overcome the problem, you can instruct Fiery XF to ignore the page size information 
from the job. In this case, the page size is calculated by Fiery XF during job processing 
instead. The process is slower than extracting the information from the job, but the result 
is more accurate.

• In-RIP separation

In-RIP separations are spot colors that have been defined in an external RIP or in a DTP 
program and saved as a single job file. You can select whether in-RIP information is output 
as separated files (Enable), or converted to the color space of the output device and printed 
as a composite job (Disable).

PostScript files with in-RIP separations normally require a special PostScript command to 
ensure that the in-RIP information is interpreted correctly. However, not all PostScript 
printers support in-RIP separations — PostScript level 3 does, PostScript level 2 does not. 

By forcing in-RIP separation, you can make sure that the in-RIP information from the 
graphics program is processed, even if the special PostScript command is missing, and 
regardless of the type of PostScript printer that was used to create the file.

• Simulate overprinting in composite jobs

Intentionally printing one layer of ink on top of another is known as overprinting. 
Overprinting is sometimes used to prevent gaps from appearing between colors.

On a printing press, each color of ink is printed one at a time. In other words, each 
printing plate is made up only of components in one color.

It is not possible to print overlapping colors as a composite job because overlapping colors 
will not print on top of each other. However, in Fiery XF, you can simulate the effect.
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• Working color space

The working color space determines which source profile is applied to a PDF job. For 
PDF jobs that contain mainly RGB images, applying the RGB source profile ensures that 
you achieve the best possible color quality.

CMYK must be used as the working color space in proofing workflows and for PostScript 
jobs with cut contours.

• EPS job detection

When you load a separated job, Fiery XF waits five seconds before assuming that the job is 
complete. You can increase or decrease the waiting time. For example, for large-volume, 
separated EPS jobs, more time may be necessary to ensure that all color separations have 
been received and can be processed as one job. Conversely, for EPS composite files, 
decreasing the waiting time ensures that jobs are output as quickly as possible.

Occasionally, Fiery XF has difficulty correctly extracting and interpreting the resolution of 
incoming PS and PDF files. In step and repeat jobs, rounding down errors may occur 
which cause a white edge to be output along the right and bottom edges of images. By 
selecting the input resolution size from the image, you can prevent rounding down errors.

• PDF print engine

Use “Adobe PostScript 3 Engine” (CPSI) for jobs with cut contours, and for PDF jobs 
with up to 255 separations. This setting converts jobs to PostScript format.

Use “Adobe PDF Print Engine” (APPE) to process PDF jobs with ICC profiles and ICC 
profile taggings, or to process PDF jobs with no more than 32 separations. If the job has 
more than 32 separations, CPSI is automatically applied. APPE can process composite 
jobs quicker than CPSI.

• Image EPS/PDF print engine

Use the “Native” setting to output a single EPS image without the surrounding PDF 
frame. Use "Adobe PostScript 3 Engine" to output an EPS image with the PDF frame. 

"Adobe PostScript 3 Engine" results in a quicker processing time and better output quality 
since, if the image is an RGB image, the selected source profiles are applied. This setting is 
automatically applied if the job contains more than one EPS image.

See also:

“PostScript and PDF jobs” on page 96
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One-bit (System Manager)

You can process one-bit files that have been produced in the pre-press industry by an 
imagesetter, a platesetter, or a digital print solution.

Since one-bit files have already been RIPed by an external RIP, the integrated RIP of Fiery XF 
is not applied. The screening information (screen dot shape and size, screen ruling) is 
extracted from the one-bit file when the digital proof is printed.

Therefore, digital proofs that are output with the OneBit Option are not only color accurate, 
but also give a true screen representation of the final print run.

To ensure that Fiery XF correctly recognizes the job name and all one-bit files that belong to 
each job, make sure that you select or define a character sequence that is generic for all the 
files that you process. Some predefined character sequences are provided. The variables have 
the following meanings:

By default, Fiery XF analyzes file names from right to left, whereby the file extension is not 
taken into account.

See also:

“One-bit files” on page 260

%j Represents the job name.

%c Represents the name of the one-bit file.

%f Stands for “ignore”. It is most often used to instruct Fiery XF to ignore consecutive 
numbers (such as film numbers) that are automatically added to the file name by 
some RIP solutions. By inserting a number, you can define how many characters 
are ignored — for example, %4f.
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One-bit (Job Explorer)

Select a proofing method for one-bit files.

• Imposition proof

Make a final check before going to press. Note that imposition proofs are not color 
accurate. Therefore, use this setting only to check the content and completeness of the 
elements of the printing copy.

• Contract proof

Create a color-accurate screen proof. Contract proofs are color managed. They are often 
seen as a binding color contract between customer and printing house. A contract proof is 
usually the final proof that is created before going to press.

• Contract proof with sharp dots

Create a quick, color-accurate screen proof. The print quality is slightly lower than that of 
a standard contract proof.
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TIFF/IT, Scitex CT/LW

• Give priority to

TIFF/IT files are composed of a CT (image data) and an LW (text data) file. If you give 
priority to TIFF/IT files, Fiery XF waits until both files are detected before processing the 
job. If you give priority to CMYK TIFF files, which consist of only one file , Fiery XF 
starts job processing as soon as the file is detected.

• File recognition

Many TIFF/IT files and Scitex CT/LW files are created with a final page. A final page 
ensures that the CT file and the LW file are detected as being part of the same job.

If no final page is available, Fiery XF tries to match the files by their names. If the end 
characters of the file names are different, they are not detected as belonging to the same 
job. You can instruct Fiery XF to ignore an appropriate number of characters so that both 
files are, in effect, shortened to the same name.

The job cannot be processed if no final page is available, and if Fiery XF cannot match the 
files to one job by their names.

See also:

“TIFF/IT and Scitex jobs” on page 105
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Job Merge

Use the job merge feature to superimpose one job on top of another. The master job forms the 
background image for your content jobs. For example, a master job could consist of a 
company logo, which is repeated for all jobs.

You can merge any two files. The only prerequisites are:

• The content and master jobs must have the same page size. (A size difference of plus or 
minus 0.1 inch is permitted.)

• The background color of the content job must be defined as 100% transparent.

• Master and content jobs must have the same file extension.

On the pane bar, select the check box to activate the settings.

The file names of your master (background) and content jobs must contain a keyword that is 
common to both master and content jobs.

The table below gives some examples of job merge job names.

Job merge
1 Master file
2 Multi-page content file 

(imported into Fiery XF as 
a nesting)

3 Merged files

1 2 3

File names for master and 
content jobs

Common keywords Master file 
identified by:

Content file 
identified by:

2013_Master_Customer.pdf

2013_Content_Customer.pdf

EFI_Master.pdf

EFI_Content.pdf

2013, Customer

EFI

Master Content

2013_EFI.pdf

2013_Exhibition.pdf

EFI_January_2013.pdf

Exhibition_January_2013.pdf

2013

January_2013

EFI Exhibition
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See also:

“Job merge” on page 128
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JDF Ticket

A JDF ticket is created for each JDF job that is loaded in Fiery XF from a JDF-compliant 
application. Occasionally, you may need to load a job by another means, such as directly from 
a graphics program. This could be necessary if the image is in a format this is not supported 
by the JDF-compliant application. In this case, you can send an empty JDF job to Fiery XF 
and add the image as a content file by assigning a JDF ticket.

See also:

“Adding content files” on page 269
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Source File Information

View job-related information, such as file name, color space, job size, selected output device, 
etc.
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Warning and Error

Display messages that affect job processing.

Warnings warn you of problems with the job, but do not cause job processing to be canceled.

Errors report serious problems that prevent job processing from continuing. You can display 
the last reported error in the job list by adding the column “Last Error”. In the job list, 
right-click on any column heading, and click Last Error.
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Subfiles

List pages contained in the following types of jobs: nestings, step and repeats, Scitex, TIFF-IT, 
one-bit
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Job Variations

The settings on this pane are specific to the Cretaprint workflow.

• You can print out a proof of the job to check the color accuracy. Proofs are processed in the 
Cretaprint Proofing Workflow and are output on the proof printer.

• You can make color adjustments to a job by editing the original file in Photoshop. 
Photoshop must be installed on the same computer as the Fiery XF client. Your changes 
are saved as a variation of the original job. 

• You can create a print file either from the original job, or from a job variation. Print files 
are saved in RPF format to the Export folder that is set up for the Cretaprint printer. RPF 
files can be output on a Cretaprint printer. If you have a license for the Cretaprint TIFF 
Output Option, you can create print files in TIFF format.

For more information, see the Quick Start Guide.
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Virtual Sheet Size

The default media size corresponds to the size of the media that is set up for the printer. In 
most cases, this is the correct setting. However, using a different sheet size can be useful in 
some circumstances. For example:

• Selecting a smaller sheet size can give you more flexibility when arranging pages on 
nestings, such as if roll paper is set up for the printer.

• Selecting a larger sheet size enables you to print large jobs to file (without creating a tiling) 
for output on a different printer.

You can select a predefined sheet size, or define a custom sheet size by entering sheet 
dimensions.
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Layout Options

Use the settings on this pane to arrange single pages, nestings, and step and repeat jobs on a 
sheet.

• Print jobs that exceed printable area

Normally, if a job does not fit on the selected sheet size, the job is not printed. If you select 
this setting, the job is printed, but the portion that does not fit on the sheet is cropped.

• Rotate

Rotate jobs by 90°, 180° or 270°. If you select “Minimal media consumption”, images are 
rotated automatically if doing so will reduce media wastage.

• Mirror

Flip jobs along their horizontal or vertical axis.

• Scale page

Define a scaling factor to increase or decrease the size of a job. The scaling factors take the 
printer margins into account. For example, a job that is scaled to sheet width will not 
overlap into the non-printable area that is defined by the printer margins.

• Position

Type x and y coordinates to position the top, left-hand corner of the job at specific 
coordinates on the sheet.

• Align page to sheet

By default, the page is positioned left-aligned on the sheet. Click a cell in the diagram to 
change the alignment setting. For example, if you select the middle cell, jobs are centered 
horizontally and vertically on the sheet. For roll media, only horizontal alignment is 
possible. This setting is applied to single jobs, nested pages, and tiles.

The alignment settings are based on the sheet size, and do not take the printer margins 
into account. A job that is left-aligned on the sheet may overlap into the non-printable 
area that is defined by the printer margins.

• Job margin

Define vertical and horizontal margins. Adding margins can help you to align images more 
precisely on the sheet. Printer hardware margins are applied on top of this setting.

• Align footer

The footer alignment is not affected by the “Align page to sheet” setting. Selecting this 
check box positions the footer left-aligned under the page.
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See also:

“Scaling a job” on page 89

“Aligning pages on the sheet” on page 95

“Footer” on page 131
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Job Ticket

A footer can consist of:

• A job ticket with information that is pertinent to the job. It tells you what settings were 
applied to achieve the print result.

• Up to two control strips or media wedges. Control strips and media wedges are used to 
check the color consistency of proofing jobs. You can select control strips and media 
wedges on the Verify tab.

Use the settings on this pane to define the layout of the footer. Click Edit to select the content 
of the job ticket.

You can print a job ticket per page or per nesting:

• For single jobs, select “Job Ticket for Page”.

• For nestings, select “Job Ticket for Nesting” to create one job ticket for the whole nesting. 
Select “Job Ticket for Page” to create a job ticket for each page of the nesting. 
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See also:

“Footer layout” on page 136
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Nesting (System Manager)

Create a nesting to output multiple jobs collectively as a single job. On the pane bar, select the 
check box to activate the settings.

• Create nesting after a minimum of

Define the criterion for creating a nesting. As soon as the criterion has been met, a nesting 
is created from the loaded jobs. All subsequently loaded jobs become part of the next 
nesting.

• Optimization

Nested pages can be arranged so that they take up as little space as possible on the sheet, or 
they can be arranged so that, after printing, they can be cut out using as few straight 
horizontal or vertical cuts as possible.

• Orientation

Pages can be nested in their original orientation, in portrait format, or in landscape format. 
You can also permit pages to be automatically rotated, if doing so will make better use of 
the available space on the sheet.
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• Scaling

You can scale all nested pages to the same size. Select “Uniform scaling” to activate the 
settings. Then, select a default size from the list, or define a custom size by typing a width 
and a height and then clicking the plus (+) button.

• Spacing

Define a horizontal and vertical distance between nested pages. Job-specific control strips 
and job tickets are taken into account.

You can also define a border around the nesting to simulate a picture mount. This setting 
takes into account the non-printable margin.

• Ignore non-processed jobs

By default, a nesting is not printed if it contains a page that cannot be processed — for 
example, if a job contains unknown spot colors. Exception: if the nesting contains a page 
that does not fit on the sheet, the nesting is still printed, but without the oversized page.

By selecting “Ignore non-processed jobs”, you can instruct Fiery XF to print the nesting 
and to exclude jobs that cannot be processed.

See also:

“Nestings” on page 108
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Nesting (Job Explorer)

Create a nesting to output multiple jobs collectively as a single job. On the pane bar, select the 
check box to activate the settings.

To create a nesting, do one of the following:

• In the job list, right-click one or more jobs. Then click New Nesting.

• In the job list, click one or more jobs. Then, on the toolbar, click Create Nesting.

The following settings are available:

• Optimization

Nested pages can be arranged so that they take up as little space as possible on the sheet, or 
they can be arranged so that, after printing, they can be cut out using as few straight 
horizontal or vertical cuts as possible.

• Orientation

Pages can be nested in their original orientation, in portrait format, or in landscape format. 
You can also permit pages to be automatically rotated, if doing so will make better use of 
the available space on the sheet.
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• Scaling

You can scale all nested pages to the same size. Select “Uniform scaling” to activate the 
settings. Then, select a default size from the list, or define a custom size by typing a width 
and a height and then clicking the plus (+) button.

• Spacing

Define a horizontal and vertical distance between nested pages. Job-specific control strips 
and job tickets are taken into account.

You can also define a border around the nesting to simulate a picture mount. This setting 
takes into account the non-printable margin.

• Apply

Click Apply to update the preview with your changes.

• Ignore non-processed jobs

By default, a nesting is not printed if it contains a page that cannot be processed — for 
example, if a job contains unknown spot colors. Exception: if the nesting contains a page 
that does not fit on the sheet, the nesting is still printed, but without the oversized page.

By selecting “Ignore non-processed jobs”, you can instruct Fiery XF to print the nesting 
and to exclude jobs that cannot be processed.

You can also clone jobs by using copy and paste (Ctrl + C, Ctrl + V) to create a simple step 
and repeat. Afterwards, click Apply to rearrange the cloned pages on the sheet.

See also:

“Nestings” on page 108



427

Step and Repeat (System Manager)

Create a step-and-repeat to clone multiple copies of a job and output them as one print job. 
The available settings make it possible to achieve many different and interesting wallpaper 
patterns. On the pane bar, select the check box to activate the settings. You can save your 
settings as a preset.

• Total number of

Type in the required number of copies. Copies are arranged in rows, and the original 
image is included in the total number. Alternatively, create as many copies as will fit on the 
sheet.

• Rows and columns

Type in the number of rows and columns to be filled. Alternatively, fill as many rows 
and/or columns as will fit on the sheet.

• Spacing

Define a horizontal and vertical distance between copies.

You can also define a border around the step and repeat to simulate a picture mount. This 
setting takes into account the non-printable margin.
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• Step offset (requires the Production Option)

Define the amount of horizontal or vertical shift between copies.

• Flip every alternate (requires the Production Option)

Flip alternate rows or columns.

See also:

“Step and repeat” on page 125
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Step and Repeat (Job Explorer)

Create a step-and-repeat to clone multiple copies of a job and output them as one print job. 
The available settings make it possible to achieve many different and interesting wallpaper 
patterns. On the pane bar, select the check box to activate the settings. You can save your 
settings as a preset.

• Total number of

Type in the required number of copies. Copies are arranged in rows, and the original 
image is included in the total number. Alternatively, create as many copies as will fit on the 
sheet.

• Rows and columns

Type in the number of rows and columns to be filled. Alternatively, fill as many rows 
and/or columns as will fit on the sheet.

• Spacing

Define a horizontal and vertical distance between copies.

You can also define a border around the step and repeat to simulate a picture mount. This 
setting takes into account the non-printable margin.
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• Step offset (requires the Production Option)

Define the amount of horizontal or vertical shift between copies.

• Flip every alternate (requires the Production Option)

Flip alternate rows or columns.

• Apply

Click Apply to update the preview with your changes.

After you have created a step and repeat, the padlock icon in the top, left-hand corner of the 
original job indicates that the job cannot be modified. To make changes to the size or 
orientation of the original job, you must first delete all copies by clearing the check box on the 
pane bar. After you have made your changes, reselect the check box on the pane bar and click 
Apply.

See also:

“Step and repeat” on page 125
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Tiling (System Manager)

Use the tiling feature to print images that would normally exceed your printer’s maximum 
print size. Images are printed as tiles, and can be later pieced together to produce an oversize 
poster or banner. On the pane bar, select the check box to activate the settings. You can save 
your settings as a preset.

• Standard tiling

The default tile size is equal to the media size that is set up for the output device. If 
required, you can set up a custom tile size by typing in tile dimensions, or by defining a 
number of rows or columns to fit on the sheet.

• Overlapping

An overlap margin describes a border of the tile that is repeated on two adjacent tiles. 
Printing with overlapping can help you to piece tiles together more precisely after printing.

• Glue area

The glue area is an unprinted border that is used to glue tiles together after printing. It is 
visible only in the printout. You cannot see it in the preview. Tile footer and glue area 
overlap if both are defined.

• Apply glue area to overlapping only

By default, the glue area is added on to the overlap margin. By clearing the check box, you 
can apply a glue area to tiles that do not have an overlap margin. In this case, the glue area 
simply provides an additional non-printed border around each printed tile. The border can 
help to protect the edges of tiles that are printed on delicate media from damage, which 
would otherwise make reprinting necessary.
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• Rotate every second tile by 180°

Inconsistencies in color density can occur when using grande-format printers with UV 
ink. This feature can lessen the effect of color deviances in large areas of single color (for 
example, blue sky). Rotating every other file by 180 degrees can help to create an invisible 
seam when piecing tiles together.

• Overlapping marks

Overlapping marks are a visible aid to help you to align overlapping tiles accurately after 
printing. You can specify the length, the thickness and the color of overlapping marks.

Standard marks are printed at each end of the overlap area. The dashed line is printed 
along the length of the overlap area.

A dashed line is recommended for large overlap areas, which would otherwise be difficult 
to align using standard marks that are too far apart. 

• Tile footer

You can create overlapping margins in which to print tile numbers, file name, printer 
name, printer resolution, custom text, and tile marks. Tile numbers help you to piece the 
tiles together in the right order, and tile marks help with alignment. Use the boxes to 
define:

– The length and thickness of marks

– The distance between tile marks and tile

The tile footer is visible only in the printout. You cannot see it in the preview. Tile footer 
and glue area overlap if both are defined.

• Create nesting from tiles

You may be able to reduce media consumption by printing tiles collectively as a nesting 
and by allowing tiles to be rotated. You can define a horizontal and vertical distance 
between tiles.

See also:

“Tiling” on page 118
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Tiling (Job Explorer)

Use the tiling feature to print images that would normally exceed your printer’s maximum 
print size. Images are printed as tiles, and can be later pieced together to produce an oversize 
poster or banner. On the pane bar, select the check box to activate the settings. You can save 
your settings as a preset.

• Standard tiling

The default tile size is equal to the virtual sheet size. If required, you can set up a custom 
tile size by typing in tile dimensions, or by defining a number of rows or columns to fit on 
the sheet. After you have created a tiling, you can resize individual tiles to avoid awkward 
joins in your image.

• Overlapping

An overlap margin describes a border of the tile that is repeated on two adjacent tiles. 
Printing with overlapping can help you to piece tiles together more precisely after printing.

• Glue area

The glue area is an unprinted border that is used to glue tiles together after printing. It is 
visible only in the printout. You cannot see it in the preview. Tile footer and glue area 
overlap if both are defined.
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• Apply glue area to overlapping only

By default, the glue area is added on to the overlap margin. By clearing the check box, you 
can apply a glue area to tiles that do not have an overlap margin. In this case, the glue area 
simply provides an additional blank border around each printed tile. The border can help 
to protect the edges of tiles that are printed on delicate media from damage, which would 
otherwise make reprinting necessary.

• Rotate every second tile by 180°

Inconsistencies in color density can occur when using grande-format printers with UV 
ink. This feature can lessen the effect of color deviances in large areas of single color (for 
example, blue sky). Rotating every other file by 180 degrees can help to create an invisible 
seam when piecing tiles together.

• Overlapping marks

Overlapping marks are a visible aid to help you to align overlapping tiles accurately after 
printing. You can specify the length, the thickness and the color of overlapping marks.

Standard marks are printed at each end of the overlap area. The dashed line is printed 
along the length of the overlap area.

A dashed line is recommended for large overlap areas, which would otherwise be difficult 
to align using standard marks that are too far apart.

• Tile footer

You can create overlapping margins in which to print tile numbers, file name, printer 
name, printer resolution, custom text, and tile marks. Tile numbers help you to piece the 
tiles together in the right order, and tile marks help with alignment. Use the boxes to 
define:

– The length and thickness of marks

– The distance between tile marks and tile

The tile footer is visible only in the printout. You cannot see it in the preview. Tile footer 
and glue area overlap if both are defined.

• Create nesting from tiles

You may be able to reduce media consumption by printing tiles collectively as a nesting 
and by allowing tiles to be rotated. You can define a horizontal and vertical distance 
between tiles.

• Apply

Click Apply to update the preview with your changes.
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• Tiling Preview

Click TilingPreview to display an enlarged tile preview. You can preview a single tile, or 
you can preview all tiles simultaneously. Displayed tiles are overlaid with the tile number. 
You can save the preview as a PDF file and use it as a guide to help you to piece the tiles 
together after printing.

Tiles cannot be edited in the Tiling Preview window. However, if you resize tiles in 
Job Explorer. the change is applied immediately to the Tiling Preview window.

See also:

“Tiling” on page 118
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N-Up

In book printing, it is common practice to print different pages together in one impression of 
the printing press to save time and media wastage. Book printers often refer to pages being 
printed as 16-up or 32-up.

On the pane bar, select the check box to activate the settings. You can save your settings as a 
preset.

• Pages per sheet

Select from 2-up, 4-up, 6-up, 9-up, or 16-up.

• Do not rotate

By default, pages are automatically rotated, if doing so will make better use of the available 
space on the sheet. Select the check box if you want to prevent pages from being rotated.

• Spacing between elements

Define a horizontal and vertical distance between pages.

• Around N-up (picture mount)

Use margins to position the pages of the N-up on the sheet. This setting takes into account 
the non-printable margin.

• Apply (Job Explorer only)

Click Apply to update the preview with your changes

9-up
1 Horizontal spacing between 

elements
2 Vertical spacing between 

elements
3 Margin around N-up

2

1

3
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Booklet

This setting creates a double-sided, 2-up booklet that is folded down the middle. 2-up means 
that two pages are printed on one sheet. To create a booklet, you require a duplex printer. 

On the pane bar, select the check box to activate the settings. You can save your settings as a 
preset.

• Folding direction

Select the direction of the fold. The most usual type of booklet is folded along its longer 
edge: booklets in portrait format have a vertical fold down the middle, whereas booklets in 
landscape format have a horizontal fold. To create a booklet that is folded along its longer 
edge, select “Horizontal” or “Vertical”, as appropriate. To fold the booklet along its shorter 
edge, select “Orthogonal to long edge”.

• Do not rotate

By default, pages are automatically rotated, if doing so will make better use of the available 
space on the sheet. Select the check box if you want to prevent pages from being rotated.

Folding direction
1 Vertical fold
2 Horizontal fold
3 Orthogonal to long edge

1

2

3

3
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• Around booklet (picture mount)

Use margins to position the pages of the 2-up booklet on the sheet. You can create a gutter 
margin by defining different margins for left and right, or for top and bottom. The gutter 
margin is the space that is used to bind printed materials. The margins are mirrored for 
facing pages of the booklet to ensure that the gutter margin is always the inner margin.

This setting takes into account the non-printable margin.

• Apply (Job Explorer only)

Click Apply to update the preview with your changes.

Margins
1 Gutter margin

1
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Crop Marks, FOTOBA marks, and KIPCut marks

Crop marks, FOTOBA and KIPCut marks are printed lines that indicate where to trim. Crop 
marks are normally trimmed by hand, whereas FOTOBA marks and KIPCut marks are 
normally trimmed automatically by machine.

On the pane bar, select the check box to activate the settings. You can print marks per page, 
per sheet or per tile. You can save your settings as a preset.

The bleed setting repositions the marks in relation to the image. By cutting the image, you 
can crop each edge by a defined margin. By adding a frame, you can insert white space 
between image and marks.

See also:

“Crop marks” on page 229

“FOTOBA crop marks” on page 234

“KIPCut marks” on page 236
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Grommet Marks

Grommet marks are often used in the production market to mount advertising banners and 
flags by feeding a rod through the grommet marks. On the pane bar, select the check box to 
activate the settings. You can save your settings as a preset.

You can print grommet marks per page or per sheet. Use the available settings to define the 
number and position of grommet marks in relation to the image.

See also:

“Grommet marks” on page 231
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Cut (System Manager)

To process jobs with cut contours, you require an appropriate license:

• Cut Marks Option

This option provides support for i-cut, EUROSYSTEMS, and Zünd Cut Center.

• Print & Cut Option

This option provides support for a wide range of print-and-cut devices.

• Cut Server Option

This option outputs jobs to a wide range of additional cutters and routing tables that are 
not supported directly in Fiery XF.

For all three options, you require also the Spot Color Option. The Spot Color Option enables 
in-RIP separation, which ensures that the cut contour can be exported as a separated file.

On the pane bar, select the check box to activate the settings. You can save your settings as a 
preset.

• Send to cut server after printing (requires the Cut Server Option)

Jobs are submitted first to Cut Server and then forwarded to the cutter. Select an 
appropriate device manufacturer and device type on this pane to activate this setting. This 
setting is not available for i-cut, EUROSYSTEMS, and Zünd G3 cutters.

• Device manufactuer 
Device type 
Cut marks type

Select your cut device and the type of cut marks you want to use.

• Number of cut marks (i-cut only)

Enter the required number of i-cut marks along the horizontal and vertical edges. A 
minimum of three marks are printed bottom and right to help with sheet alignment on the 
cutter.

• Minimum distance between cut marks (i-cut/EUROSYSTEMS/Zünd G3 only)

Define the minimum distance between two cut marks. The distance between the last mark 
and the corner may be smaller if the dimensions of the page are not exactly divisible by the 
defined distance.

• Print with tinted background color (requires the Cut Marks Option)

Cut marks can be difficult to detect on some media types. You can overcome the problem 
by printing the cut marks on a yellowish background.

• Print between layout elements (requires the Cut Marks Option)

Print cut marks between step-and-repeat pages, and between nested pages.
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• Bleeding (requires the Cut Marks Option)

The bleed setting repositions the cut marks in relation to the image. By cutting the image, 
you can crop each edge by a defined margin. By adding a frame, you can insert white space 
between image and cut marks. Some cut devices do not support “negative bleeding”.

• Export path

Define a folder in which to save contour cutting files. To print to Cut Server, the folder 
must be set up as a hotfolder in in Cut Server.

• IP address (Zünd G3 only)

Type the IP address of the computer on which the ZCC software is installed. Then, type 
the IP port that the ZCC software uses to communicate — for example, 9100, 8080 or 
8088

• Contour cutting

The table contains a list of contour types that are commonly used in the industry. They are 
automatically detected by Fiery XF. You can add custom contour types. The cut contour 
must be defined as a spot color in the graphics program. The spot colot must be defined in 
Fiery XF.

In order for Fiery XF to extract cut contours from the job, observe the following when 
creating the image file in the graphics program:

– The cut contour must be defined as a CMYK spot color.

– The cut contour must be defined in a separate layer.

– The layer with the cut contour must be the top layer of the job. For example, in 
Illustrator, the cut contour layer must be at the top of the list of layers.

If the job contains a lot of transparencies, it can slow down the RIPing speed. To get 
round this problem, it is recommended that you flatten all transparency levels. In 
Illustrator: On the Object menu, click Flatten Transparency, and clear the check box 
for converting all strokes to outlines.

If all transparencies are flattened, the cut contour can be extracted, even if it is not the 
top layer of the job.

– Cut contours can be saved in different layers.

You can define a cutting method, such as “Bevel-cut” or “Kiss-cut”, for some Zünd G3 
output devices and for all i-cut output devices. Cutting mode and advanced settings are 
available for all Zünd G3 devices.

• Extract contour path from EPS/PDF

Select the check box to extract the contour path from EPS and PDF jobs. If the check box 
is cleared, the contour cutting file contains only a cut frame (bounding box).
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See also:

“Cutting Options” on page 238
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Cut (Job Explorer)

To process jobs with cut contours, you require an appropriate license:

• Cut Marks Option

This option provides support for i-cut, EUROSYSTEMS, and Zünd Cut Center.

• Print & Cut Option

This option provides support for a wide range of print-and-cut devices.

• Cut Server Option

This option outputs jobs to a wide range of additional cutters and routing tables that are 
not supported directly in Fiery XF.

For all three options, you require also the Spot Color Option. The Spot Color Option enables 
in-RIP separation, which ensures that the cut contour can be exported as a separated file.

On the pane bar, select the check box to activate the settings. You can save your settings as a 
preset.

• Send to cut server after printing (requires the Cut Server Option)

Jobs are submitted first to Cut Server and then forwarded to the cutter. Select an 
appropriate device manufacturer and device type on this pane to activate this setting. This 
setting is not available for i-cut, EUROSYSTEMS, and Zünd G3 cutters.

• Device manufactuer 
Device type 
Cut marks type

Select your cut device and the type of cut marks you want to use.

• Number of cut marks (i-cut only)

Enter the required number of i-cut marks along the horizontal and vertical edges. A 
minimum of three marks are printed bottom and right to help with sheet alignment on the 
cutter.

• Minimum distance between cut marks (i-cut/EUROSYSTEMS/Zünd G3 only)

Define the minimum distance between two cut marks. The distance between the last mark 
and the corner may be smaller if the dimensions of the page are not exactly divisible by the 
defined distance.

• Print with tinted background color (requires the Cut Marks Option)

Cut marks can be difficult to detect on some media types. You can overcome the problem 
by printing the cut marks on a yellowish background.

• Print between layout elements (requires the Cut Marks Option)

Print cut marks between step-and-repeat pages, and between nested pages.
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• Bleeding (requires the Cut Marks Option)

The bleed setting repositions the cut marks in relation to the image. By cutting the image, 
you can crop each edge by a defined margin. By adding a frame, you can insert white space 
between image and cut marks. Some cut devices do not support “negative bleeding”.

• Export path

Define a folder in which to save contour cutting files. To print to Cut Server, the folder 
must be set up as a hotfolder in Cut Server.

• IP address (Zünd G3 only)

Type the IP address of the computer on which the ZCC software is installed. Then, type 
the IP port that the ZCC software uses to communicate — for example, 9100, 8080 or 
8088

• Contour cutting

The table shows which spot colors are available as cutting paths. You can select which 
cutting paths to apply to the job by selecting the appropriate check box in the table. If the 
cut contour is an unknown spot color, you must define the spot color first.

Select “Extract contour path from EPS/PDF” to activate the table.

In order for Fiery XF to extract cut contours from the job, observe the following when 
creating the image file in the graphics program:

– The cut contour must be defined as a CMYK spot color.

– The cut contour must be defined in a separate layer.

– The layer with the cut contour must be the top layer of the job. For example, in 
Illustrator, the cut contour layer must be at the top of the list of layers.

If the job contains a lot of transparencies, it can slow down the RIPing speed. To get 
round this problem, it is recommended that you flatten all transparency levels. In 
Illustrator: On the Object menu, click Flatten Transparency, and clear the check box 
for converting all strokes to outlines.

If all transparencies are flattened, the cut contour can be extracted, even if it is not the 
top layer of the job.

– Cut contours can be saved in different layers.

• Extract contour path from EPS/PDF

Select the check box to extract the contour path from EPS and PDF jobs. If the check box 
is cleared, the contour cutting file contains only a cut frame (bounding box).

See also:

“Cutting Options” on page 238
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Color Adjustment

Tweak the color appearance of jobs, or modify the brightness, contrast, saturation, or 
sharpness. On the pane bar, select the check box to activate the settings. You can save your 
settings as a preset.

Color adjustments can be applied to CMYK and RGB jobs, but not to multi-color jobs, jobs 
that contain spot colors, or grayscale jobs. Color adjustments can also be applied to control 
strips, but not to dynamic wedges. 

See also:

“Making color adjustments” on page 182
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Color Management

To obtain the desired color output requires the careful selection of profiles and rendering 
intents for each job.

• The source profile describes the intended color characteristics of the job. The color 
characteristics are defined in the graphics program, or by the input device.

• The simulation (reference) profile describes the color reproduction properties of the 
printing machine that you want to simulate on your inkjet printer.

• The rendering intent describes how out-of-gamut colors are adjusted to fit into the 
destination color gamut of the printer. You can select a rendering intent for each source 
profile and for the simulation (reference) profile.

Fiery XF detects the color space of each incoming job and applies automatically the selected 
profiles and rendering intents for that color space.

On the pane bar, select the check box to activate the settings. You can save your settings as a 
preset. Predefined color management presets for proofing, production, photo, business 
graphics, and convert to grayscale are provided with Fiery XF. They contain preselected 
source profiles and simulation profiles for standard workflows..

The following additional settings can help you to manage color reproduction even further.

• Use embedded profiles, if available

An embedded profile defines the color characteristics of the job when it was created. It is 
recommended that you apply embedded profiles if they are available.

For jobs that do not have an embedded profile, the selected source profile is applied 
instead.

• Use dynamic rendering intent

This setting analyzes the colors of each job and applies automatically the appropriate 
rendering intent. If the job’s colors can be reproduced correctly by the selected printer, the 
rendering intent “Relative colorimetric” is applied. If the job’s colors are outside the color 
gamut of the selected or the attached source profile, the rendering intent “Perceptual” is 
applied. The perceptual rendering intent compresses all colors into the available 
destination color space.

• Source profiles

Select a source profile that is provided with Fiery XF, one that was supplied with your 
input device, or one that is embedded in the job. Custom source profiles must be located 
in the Reference folder.

Fiery XF does not provide multicolor source profiles, but you can implement custom 
multicolor profiles, if required.
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• Use PDF output intent, if available

This setting can be applied to PDF and PostScript jobs. It ensures that if an output intent 
is embedded in a PDF/X-3 file, it is applied as the simulation (reference) profile.

If this setting is applied to jobs that do not have an embedded PDF output intent, the 
selected simulation profile is used instead. If no simulation profile is selected, the source 
profile is used.

• Simulation profiles

Select a simulation profile that is provided with Fiery XF, or one that was supplied by your 
printing house. Custom simulation profiles must be located in the Reference folder.

You can also select “Use media profile”. In this case, the selected media profile is applied as 
the simulation profile. It ensures that you benefit from the maximum possible color gamut 
that can be achieved from the selected combination of output device, ink, and media.

This setting can most usefully be applied to PDF jobs that contain a mixture of elements 
in different color spaces (RGB, CMYK, Gray, etc.). By applying the media profile in place 
of the simulation profile, you can greatly improve the color reproduction of RGB images, 
since the media profile has a bigger color space. Thus, RGB images show much more detail 
and appear more saturated in the printout.

In the case of non-PDF jobs, it means jobs are converted directly to the color space of the 
media profile.

• Convert to grayscale

Convert jobs to grayscale. Five different tints are available — from a bluish tint (cold gray) 
to a yellowish tint (warm gray).

• L*a*b* optimization

Select an L*a*b* optimization file. You can greatly improve color accuracy by applying an 
L*a*b* optimization to a media profile. An L*a*b* optimization provides a better match 
for the color gamut of the simulation (reference) profile.

To create an L*a*b* optimization file, you need the Color Profiler Option or the Verifier 
Option.

• Spot color optimization

Select an L*a*b* optimization file for a custom spot color that was defined in the CIE 
L*a*b* color space. An L*a*b* optimization file is a correction profile that provides a better 
match for L*a*b*-defined spot colors using the media profile. By applying an L*a*b* 
optimization file you can greatly improve color accuracy by reducing delta E values. 

To create an L*a*b* optimization file for custom spot colors, you need the Spot Color 
Option.
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• Color optimization

– Black as inkjet black

When pure black is subjected to color management, it is converted to CMYK, which 
produces a “dirty” looking black in the printout. By applying this setting, you can 
ensure that all definitions of pure black by-pass color management and are output 
using only the black ink of the printer. This setting can most usefully be applied to text 
and other elements that are defined as pure black in the graphics program. 

In addition, you can type the percentage of black ink, at which pure black ink is used 
instead of a mixture of CMYK inks. For example, for grayscale images, a threshold of 
40% would mean that 39% black is composed of CMYK inks, whereas 40% black is 
printed with black ink only. Text and line diagrams are nearly always defined as 100% 
black, and so are less likely to be affected by a threshold setting.

– Clean colors

If you have a license for the Production Option, you can also remove color impurities 
that have resulted during the conversion from the RGB to the CMYK color space. In 
automatic cleaning mode, Fiery XF provides optimal values, based on the selected 
media and profiles. In manual cleaning mode, you can define the percentage at which 
color impurities are removed.

Additional settings are available that enable you to apply “Black as inkjet black” and 
“Clean colors” simultaneously.

• Plate compensation

Select a plate compensation file that you created in Color Tools or in Color Profiler Suite. 
A plate compensation file is often used to modify the plate characteristics of one-bit files.

• Light adaptation

By default, the media profiles that are provided with Fiery XF are based on the standard 
D-50 light source. You can process your jobs to simulate different light conditions.

See also:

“Source profiles and simulation (reference) profiles” on page 141

“Optimizing a media profile” on page 159

“Optimizing L*a*b* spot colors” on page 305

“Removing color impurities” on page 183

“Modifying plate characteristics” on page 170
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Color Management (Cretaprint)

The settings on this pane help you to achieve the desired color output for each job.

On the pane bar, select the check box to activate the settings.

• Files already in printer color space

This setting lets you replicate the color properties of a previously printed job. Color 
consistency with the original job is achieved by applying the source profile. The source 
profile ensures that the color gamut is maintained and no gamut clipping takes place.

It is recommended that you use this setting if your printer has new inks, or if you are using 
a different printer.

• Use embedded profiles, if available (System Manager) 
Use embedded profiles (Job Explorer)

An embedded profile defines the color characteristics of the job when it was created. It is 
recommended that you always apply profiles that are embedded in the job.

If your job does not have an embedded profile, or if you deactivate this setting, the source 
profile is applied instead.

• Source profile

The source profile describes the intended color characteristics of the job. The color 
characteristics are defined in the graphics program, or by the input device. In Fiery XF, the 
source file is applied:

– If the job does not have an embedded profile

– If the “Use embedded profiles” check box is cleared

Select a source profile that is provided with Fiery XF, or one that was supplied with your 
input device. Custom source profiles must be located in the Reference folder. Fiery XF 
does not provide multicolor source profiles, but you can implement custom multicolor 
profiles, if required.

The source profile must be in the same color space as the job. The job cannot be processed 
if the color space of job and source profile do not match, and if no embedded profile is 
available.
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• Select output mode

The output mode is concerned with the use of black ink.

– Max. GCR

This setting applies automatically the maximum possible amount of black ink, while 
using less ink for the other colors. You do not have any control over the amount of ink 
that is applied.

– Rich black

This setting is available only if an ICC profile has been created for your particular print 
environment. You can create ICC profiles for up to four colors in Color Tools. 
Color Tools is a standard component of Fiery XF. To create multi-color ICC profiles, 
use Color Tools or a third-party software. 

When you create your own ICC profile, you can reduce the black generation length so 
that less black ink is added to colored areas. By limiting the use of black ink, you 
increase automatically the use of colored inks. The process involves creating a new base 
linearization file, linking it to the ICC profile, and attaching it to the PKGX profile 
package. 

• Proof from

You can create a proof either from the vRGB job or from separated files. The color 
accuracy is generally better if you proof separated files, but separated files take longer to 
process than vRGB.

If you select ink saving, you can only proof separated files. By proofing separated files, you 
can assess accurately the effect of ink saving on the individual inks.

• Reference target

The reference target ensures that two jobs are printed using the color gamut that is 
common to two PKGX profile packages. In the ceramics industry, the same design is often 
used for wall tiles and floor tiles. Fiery XF can take the different glaze and firing conditions 
into account to make sure that you achieve identical color results.

In effect, it reduces the available color gamut, but ensures color consistency of two jobs 
that have different glaze configurations and that are set up to print on different Cretaprint 
printers.

For the floor tile workflow, select as the reference target the profile package for wall tiles. 
For the wall tile workflow, select as the reference target the profile package for floor tiles.

• Color correction curve

A visual correction file is a modified base linearization file. The color correction curve lets 
you tweak individual color channels to modify your printer’s color reproduction 
properties. You can create color correction curves in Color Tools.

For more information, see the Quick Start Guide.
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Spot Colors (System Manager)

A spot color is any color that can be printed with its own ink, as opposed to being composed 
from a mixture of ink colors, such as CMYK. 

• Input handling

This setting gives you control over which source profile is applied.

The multicolor ink channels of PostScript jobs are processed differently from those of 
TIFF jobs. Depending on the file format and the selected multicolor profile, some ink 
channels may be lost or you may have to define them as spot colors.

• Custom spot color library

Spot colors that you define in Fiery XF are saved in a spot color table. From the 
drop-down list box, select an available spot color table.

• Search priority order

Fiery XF searches for each spot color definition in a specified search order. The default 
search order depends on the type of workflow template that is applied — the search order 
for a proofing workflow is different from that for a production workflow. Fiery XF applies 
the first instance of each spot color it detects according to the specified search order.

It can be useful to change the default search order if a spot color name exists multiple times 
and if each definition has different color values — for example, if you have redefined a 
spot color that is embedded in the source file with your own CMYK color values.

• Unknown spot colors

Assign a warning color to print jobs without first having to define unknown spot colors. 
All unknown spot colors are printed in the warning color.

See also:

“Forcing the use of a source profile” on page 283

“Defining spot colors” on page 275

“Changing the search order” on page 283

“Outputting undefined spot colors” on page 281

“Color Editor” on page 287
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Spot Colors (Job Explorer)

A spot color is any color that can be printed with its own ink, as opposed to being composed 
from a mixture of ink colors, such as CMYK. 

If you load a job with undefined spot colors, the following happens:

• The job is displayed as a gray box in the preview window.

• In the table, the spot color is listed as “Unknown”.

You must define the unknown spot color before the job can be correctly output:

• You can define a spot color by mapping it to a color from the internal spot color library. 
The internal spot color library contains thousands of different spot colors from major spot 
color manufacturers.

• You can define a spot color by entering color values in the selected color space.

• You can define a spot color by creating an alias to any existing custom spot color. 

• You can define a spot color by selecting an additional printer ink channel that contains a 
spot color.

The following settings are available:

• Table

Use the table to define spot colors. In the “Source” column, click the down arrow next to 
an unknown spot color, and then click the type of spot color that you want to define. In 
the “Map to” column of the table, define your spot color. In the toolbar, click Save to 
create a spot color table.

• Custom spot color library

Spot colors that you define in Fiery XF are saved in a spot color table. Select a spot color 
table.

• Search priority order

Fiery XF searches for each spot color definition in a specified order. The default search 
order depends on the type of workflow template that is applied — the search order for a 
proofing workflow is different from that for a production workflow. Fiery XF applies the 
first instance of each spot color it detects according to the specified search order.

It can be useful to change the default search order if a spot color name exists multiple times 
and if each definition has different color values — for example, if you have redefined a 
spot color that is embedded in the source file with your own CMYK color values.

• Color Editor

Opens Color Editor, a comprehensive program for defining, measuring and editing spot 
colors.
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• Unknown spot colors

Assign a warning color to print jobs without first having to define unknown spot colors. 
All unknown spot colors are printed in the warning color.

See also:

“Defining spot colors” on page 275

“Changing the search order” on page 283

“Outputting undefined spot colors” on page 281

“Color Editor” on page 287



455

White Ink And Decoration

The settings on this pane help you to achieve special color effects.

On the pane bar, select the check box to activate the settings.

• Keep spot color

Output white as a spot color, as defined in the job.

• Create white ink layer

– Dynamic gamut expansion

Print a layer of white ink only under areas where the glaze color is darker than the color 
that is being printed on top of it. By adding a white layer, you can reproduce light 
colors on dark glazes.

The glaze coloris defined on the Print Configuration pane.

– Flood

Print a layer of white ink under all colored areas of the job. By adding a white layer, you 
can reproduce light colors on a darker colored glaze. 

• Create decoration layer

– Gloss/matte glaze

Add a layer of clear ink on top of all colors.

– 3D texturing/micro relief

Add one or more layers of decoration glaze or reactive inks to produce a 3D or textured 
effect. Fiery XF analyzes the job and creates a decoration layer. You can open the job in 
Adobe Photoshop from the Job Variations pane to view the decoration layer.

– Spread and choke

Create overlaps (spreads) or underlaps (chokes) to compensate for unsightly gaps or 
white space between colors on the finished tile.
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Print Settings

To print individual pages of a multipage document, select “Print page or sheet” and type the 
required range of pages —  for example, type “2,6,10-13” to print pages 2, 6, 10, 11, 12 and 
13. Then, type the number of copies to print. 

If you enter a range of pages, you can print odd and even pages separately, by selecting the 
appropriate item from the “Pages” setting.

You can sort the order in which pages are printed. The default order for printing three copies 
of a three-page document is: 1, 1, 1, 2, 2, 2, 3, 3, 3. Sorted copies are printed in the following 
order: 1, 2, 3, 1, 2, 3, 1, 2, 3. You can reverse the print order by selecting “Reverse order”.

See also:

“Printing a job” on page 188
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Advanced Print Options

• Separations

You can output separations for CMYK jobs, RGB jobs, and multi-color jobs, including job 
with spot colors.

When processing separated jobs, you can merge all separations into one composite job, or 
print out each separation in color or in grayscales. You can also print an inverted image 
(negative) of your jobs.

• Smooth out gradations and compression artefacts

Use this setting to smooth out uneven color gradations in inkjet production printing. 
Uneven color gradations can appear in light areas of low contrast as banding or as visible 
blocks of solid color. They are often caused by extreme image compression.

• Simulate final run characteristics

You can simulate distinctive print characteristics that are associated with the following 
printing methods:

– Gravure printing

You can simulate the effect that occurs in gravure printing when ink is not evenly 
transferred from the cylinder. Under “Show missing dots up to”, use the slider to define 
the percent area coverage of missing dots.

– Flexo printing

You can define the smallest dot size to be printed. In flexo printing, the smallest dot 
that can be etched onto a flexographic printing plate may be as small as 2%, but may 
gain to as much as 12% on the press due to the nature of the photopolymer plate 
material and the printing process.

Under “Define first printable dot up to”, use the slider to define the percent area 
coverage of dots that are below the printing surface. Non-printing dots occur mainly in 
highlight areas. This setting can be applied to contone data, but not to halftone data.

– Offset printing

You can reproduce an image that more closely resembles output on a printing press. It 
creates a less smooth effect than an inkjet printout. Under “Add noise up to”, use the 
slider to define the percentage of noise to be added.

See also:

“Separated jobs” on page 106

“Simulating distinctive print characteristics” on page 374

“Smoothing gradations” on page 376
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Remote File Output

A remote container is used to save a CMYK job and its settings in a single file. Remote 
containers can be transferred easily between locations — for example, by FTP server. They 
contain all the information that is needed to create an exact replica of the job at different sites. 
Remote containers can be loaded and processed in any EFI proofing program.

You can create a remote container automatically or manually. A remote container is created 
automatically after printout or, in a verify workflow, after the control strip has been measured 
in Verifier and the results have been transmitted back to Fiery XF. You can create a remote 
manually by clicking Create Now in Job Explorer when you are ready. Remote containers can 
be created manually from PDF, Image EPS, and TIFF jobs only.

• Export to

– If the workflow is not integrated into Fiery Web Control Center, remote containers are 
created by default in the Remote\Out folder.

– If the workflow is integrated into Fiery Web Control Center, remote containers are 
created by default in the Server\Remote\WCC folder.

If required, you can define a custom folder by clicking Choose. This enables you, for 
example, to define a different output folder for each workflow. However, it is 
recommended that you use subfolders of the default folder.

You can set up the output folder as a hotfolder, so that jobs are uploaded automatically to 
the workflow.

• Compression

Compress the print file that is saved to the remote container to reduce the overall volume 
of data. ZIP is the safest form of compression and results in no loss of data when the file is 
extracted. A minimum amount of data may be lost when you use JPEG compression.

• Immediately after spooling

Create a remote container from a PDF, image PDF, or mono TIFF job without having to 
print or verify the job first.

• Include 3cc profile

L*a*b* optimization files have the extension 3cc. It is only useful to save L*a*b* 
optimization files as part of the remote container if the recipient of the remote container is 
using the same printer model and the same media as you, but has an EFI product that 
cannot create L*a*b* optimization files.

See also:

“Creating a remote container” on page 349
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Media Settings

• Source

Select the type of paper feed: single-sheet or roll media.

• Format

The default media format corresponds to the format that is set up for the printer. You can 
override the default setting to print out a job on a different media size. Select a different 
media format, or define a custom size by entering the required dimensions and clicking the 
plus (+) button.



460

File Output

• Use device link profile

You can apply a device link profile that you have created in Color Profiler Suite or by using 
a third-party software program. A device link profile combines a source color space (media 
profile) and a destination color space (simulation (reference) profile) into one profile. 
Device link profiles tend to produce more accurate results than when two separate profiles 
are applied.

• Export path

Define a folder in which to save the print files. Click Choose and browse to the folder.

• Naming

Use character sequences to define a naming convention for print files. Each character 
sequence ensures that specific information is included in the file name. Add a separator, 
such as an underline (_) or a hypen (-), between two character sequences to make file 
names easier to read. For example, type “%job_%work” to include the job name and the 
name of the workflow in the file name. You can also include custom text, such as 
GS3250LX Pro_%job_%jobid.

The following character sequences are available:

• Compression

You can compress print files to reduce the overall volume of data. ZIP is the safest form of 
compression and results in no loss of data when the file is extracted. A minimum amount 
of data may be lost when you use JPEG compression. PackBits is very effective for 
reducing the size of TIFF files that contain large areas of solid color.

Character sequence Description

%c Counter

%jobid Job ID

%t Tile number

%p Page number

%out Output device

%cm Color mode

%job Job name/nesting name

%res Resolution

%work Workflow

%date Date
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• Resolution

You can specify a resolution for the print file. For image files, a resolution of 300 dpi is 
normally sufficient. For vector graphics, a resolution of at least 1200 dpi is recommended 
to avoid any loss in quality. The higher the resolution you select, the bigger the file. If 
quality is not so important or if you need to send the file electronically, select a lower 
resolution to keep the volume of data to a minimum.

• Keep input resolution for non-PostScript files

You can keep the input resolution of non-PostScript files. As an example, you could use 
this setting to convert a set of digital files to a single color space without affecting the 
resolution (size) of the original images.

See also:

“Device link profiles” on page 147

“Creating a system configuration in System Manager” on page 57



462

File Output (Cretaprint)

• Export path

Define a folder in which to save the print files. Click Choose and browse to the folder.

• Naming

Use character sequences to define a naming convention for print files. Each character 
sequence ensures that specific information is included in the file name. Add a separator, 
such as an underline (_) or a hypen (-), between two character sequences to make file 
names easier to read. For example, type “%job_%work” to include the job name and the 
name of the workflow in the file name. You can also include custom text, such as 
PR3_%job_%jobid.

The following character sequences are available:

• Encrypt output files (requires the TIFF Output Option)

Create an open TIFF file (default setting) or an encrypted TIFF file. Encrypted TIFF files 
cannot be edited in a graphics program.Both types of files (open and encrypted) can be 
loaded in any EFI Cretaprint printer.

See also:

“Creating a system configuration in System Manager” on page 57

Character sequence Description

%jobid Job ID

%out Output device

%cm Color mode

%job Job name

%var Name of job variation

%res Resolution

%work Workflow

%date Date/time
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Media Configuration

The settings on this pane provide an easy way to apply a different media profile to a loaded 
job.

• Ink type

Select the type of ink that is inserted in the printer.

• Media name

The media name is the name under which base linearization file and media type are 
connected.

• Calibration set

Select a calibration set. The calibration set is a combination of ink type, media, and base 
linearization file.

Click Catalog to display the base linearization files that are available for the media and to 
view the print conditions under which they were created. The base linearization file 
defines a set of print conditions and ensures that the printer’s behavior is adjusted 
optimally to the media. Select one to apply.

The best printing results are achieved if you use a calibration set that has been created for 
your specific combination of printer and media. Click New Linearization and Profile to 
create a new base linearization file for your specific print conditions. Afterwards, you can 
connect the base linearization file to an existing media profile..

• Visual correction

A visual correction file is a modified base linearization file. The visual correction tool in 
Color Tools and Color Profiler Suite lets you tweak individual color channels to modify 
your printer’s color reproduction properties.

See also:

“Performing visual color corrections” on page 169
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Print Configuration

The settings on this pane provide an easy way to select a different output profile for a loaded 
job.

• Glaze type

Select the type of glaze to be used.

• Print bar configuration

Select the print bar configuration that has the combination of inks that you want to use.

• Profile name

Select a profile name. The profile defines a set of print conditions, such as the print 
resolution, the print speed, the kiln temperature, and the number of kiln passes. The print 
conditions are listed below the selected profile name. The profile name and the print 
conditions are defined in Color Tools when the profile is created.

• Catalog (System Manager only)

Click Catalog to display the available profile names and to view the print conditions under 
which each was created. Select one to apply.

• Visual correction

A visual correction file is a modified output TIFF file. The visual correction tool in 
Color Tools and Color Profiler Suite lets you tweak individual color channels to modify 
your printer’s color reproduction properties.

• Glaze color configuration

The glaze color forms the background color for printing. However, the glaze color can vary 
between batches. You can compensate for deviances in color by measuring the glaze color 
and incorporating the measurement into the profile.

Use this setting to correct any deviation in the white point of the base glaze color. By 
adjusting the white point, you can achieve consistent colors from batch to batch.

In Verifier, use a measuring device to determine the color value of a glazed tile. Type the 
L*a*b* value in the appropriate boxes, and click Update Profile.

You can return the profile to its previous state by selecting “Show original values” and 
clicking Update Profile. When you update the profile in this way, the glaze measurement 
that is currently saved to the profile is replaced with the glaze measurement that was saved 
before it.

See also:

“Performing visual color corrections” on page 169
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Print Bar Configuration

In System Manager, you can change the order in which the ink channels are printed on the 
Cretaprint printer. Use the up/down buttons if the print bars have been swapped around at 
the printer and the order no longer matches the order defined in the profile. 

You can also duplicate color channels to increase the total ink coverage or to distribute ink 
more evenly. An ink limit of 50% for two identical color channels often achieves a smoother 
result than 100% for one color channel.

Use the button with the left-pointing arrow to reset your changes and revert the print bars to 
their original order.

In Job Explorer, you can view the available ink channels and the order in which they are 
printed, but you cannot make any changes.

For more information, see the Quick Start Guide.
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Control Strips

A control strip is printed out as part of the footer. Control strips and media wedges are made 
up of rows of color patches. You can use a spectrophotometer (color measuring device) and 
any color checker program, such as Verifier, to measure the color patches and verify color 
consistency between printouts.

You can use a control strip that is provided with Fiery XF, or a custom control strip. Custom 
control strips must be located in the ControlStrip folder.

Fiery XF also supports the dynamic wedge. A dynamic wedge is a control strip that is made up 
of the job’s most prominent colors. Each dynamic wedge is, therefore, unique to that job. The 
dynamic wedge is available only for control strip 1.

You can select up to two control strips for each job.

• Print with color management

Apply the selected profiles and rendering intents to the control strip, as well as to the 
image.

• Use on nesting sheet instead of job sheet

By default, control strips are printed for each page. However, for nestings, you can print 
control strips for each page of the nesting, and/or for the whole nesting. Dynamic wedges 
can be created only for pages.

See also:

“Control strips and media wedges” on page 133
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Verify Control Strip (System Manager)

You can incorporate Verifier into your workflow. A verify workflow is recommended for the 
following purposes:

• To verify a proof (or print) for ISO 12647-7 or 12647-8 or G7 compliance, or to do a 
Fogra PSD Print Check

• To verify any house standard

• To achieve Fogra Proof Certification

• To verify color consistency across sites

On this pane you define the acceptable tolerance values for the verification. On the pane bar, 
select the check box to activate the settings. If you cannot activate the settings, make sure that 
you have selected a control strip on the Control Strips pane.

• Stop job printing after first job fails verification

If one job fails verification, you can prevent successive jobs in the job list, that will also 
inevitably fail verification, from being unnecessarily printed. This situation can occur, for 
example, if the wrong media is loaded in the printer.

• Print label after verification automatically

Some printers with an integrated measuring device can print out a label with the results of 
the color verification. Select the appropriate check boxes to define under which conditions 
a label is printed.

• Characterization data

Characterization data sets define a combination of printing conditions for standard 
printing processes.

• Delta E format

Delta E is the mathematical difference between two colors in the L*a*b* color space. Color 
accuracy is measured in terms of delta E.

• Target tolerance preset

Predefined presets for recognized standards are available. They can be applied either for 
daily proof production (verification baed on an ISO 12647-7 or 12647-8-compliant 
media wedge), for certification purposes (such as FograCert) or for ISO digital printing 
verification. You can also enter your own acceptable custom tolerance limits in the table.

See also:

“Verify workflows in Fiery XF” on page 312
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Verify Control Strip (Job Explorer)

You can incorporate Verifier into your workflow. Verifier can be used for the following 
purposes:

• To verify a proof (or print) for ISO 12647-7 or 12647-8 or G7 compliance, or to do a 
Fogra PSD Print Check

• To verify any house standard

• To achieve Fogra Proof Certification

• To verify color consistency

You define the tolerance values for a verify workflow in System Manager. If the check box on 
the pane bar is selected in System Manager, jobs are submitted to Verifier automatically after 
printing. If the check box is cleared, it indicates a manual workflow. A manual workflow lets 
you submit jobs for verification in Job Explorer when you are ready.

On the pane bar, select the check box to activate the settings. If you cannot activate the 
settings, make sure that you have selected a control strip on the Control Strips pane.

As long as you continue to apply the control strip that is selected for the workflow, the 
selected tolerance values remain valid. You can select a different control strip, if preferred. In 
this case, the selected tolerance values are overridden, and the reference profile forms the basis 
for the color verification.

• Stop job printing after first job fails verification

If one page fails verification, you can prevent successive pages of a multipage job, that will 
also inevitably fail verification, from being unnecessarily printed. This situation can occur, 
for example, if the wrong media is loaded in the printer.

• Print label after verification automatically

Some printers with an integrated measuring device can print out a label with the results of 
the color verification. Select the appropriate check boxes to define under which conditions 
a label is printed.

• Verify (button)

Click this button to submit a job to Verifier. The button is available only after the job has 
been printed and the job has received the status “Can be verified”.

• Optimize (button)

After verification in Verifier, the job is submitted back to Fiery XF. If it receives the status 
“Verification failed”, it may be possible to get within the defined tolerances by performing 
a job-specific optimization. Click this button to start job optimization. Afterwards, you 
must reprint the job and repeat the verification procedure.

It is not possible to optimize jobs if any of the following have been applied: color 
adjustments, clean colors, perceptual or saturated rendering intent, dynamic rendering 
intent.
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See also:

“Verify workflows in Fiery XF” on page 312
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Basic Information

Type a name for a new workflow or change the name of an existing workflow. It is not 
possible to change the name of the default linearization workflow. The “Description” box 
shows the settings of the workflow template. You can edit the text to reflect custom settings or 
add comments.

Additional files are automatically created during job processing. They are normally deleted 
only when you delete the job from the job list. If desired, you can delete source files, output 
files, and preview files according to a certain criterion.

See also:

“Cleaning up Fiery XF” on page 382
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Preview

A preview is an image of a selected job. It enables you to review job settings and layout settings 
before printing. A preview is displayed in Job Explorer when you select a job in the job list.

To create a preview, select the check box on the pane bar, and then select a resolution. If you 
want to edit individual pixels in a preview image, it is recommended that you select a high 
resolution. The higher the resolution, the sharper the image in a zoomed-in view, and the 
more precisely you can edit the image.

However, be aware that previews of large jobs require a lot of memory space and can take a 
long time to create. In this case, it is recommended that you select a lower resolution.
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Speed

Use the following settings to speed up job output:

• High-priority workflow

All jobs in a high-priority workflow go straight to the front of the print queue. It means 
that if more than one workflow is printing to the same printer, jobs from the high-priority 
workflow are printed first.

• Print bi-directional

Bi-directional printing is faster than unidirectional printing, as the print head prints in 
both directions. However, the result may be less accurate. Not all printers support 
bi-directional printing.

• RIP and print on the fly

By default, Fiery XF completes job processing and then starts printing.

RIPing and printing “on the fly” means that job processing and printing occur 
simultaneously. As soon as one chunk of job data has been processed, it is printed.

This setting increases the speed at which jobs are output. However, the printer may pause 
from time to time, which can lead to undesirable lines in the printout.

• RIP resolution

The RIP resolution is the resolution that is used to process a job. Afterwards, the job is 
converted to the print resolution.

The RIP resolution affects the print speed and the print quality. The higher the RIP 
resolution, the better the print quality but the longer it takes to print the job. Conversely, a 
lower RIP resolution prints faster but results in a draft-like print quality.

It is not possible to process a job at a higher RIP resolution than the print resolution.

See also:

“Increasing job speed” on page 365
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Information

To set up a printer, the appropriate media profiles for that printer must be installed. If an error 
message is displayed during setup, install the appropriate media profiles via Fiery XF Control.

• Name

Give your output device a name that makes it easily recognizable to users. 

• Description

Use the description area to make a note of the printer’s location, or any other information.

• Manufacturer

Select a device manufacturer.

To print to file, you require the File Output Option. Select EFI as the manufacturer.

• Device type

Select an output device. Some printers have more than one driver — for example, 
halftone, contone, or RGB. Make sure that you select the correct driver for your output 
device.

See also:

“Updating media profiles” on page 174
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Connection

Set up a connection to the output device. Select one of the following connection types:

• Print to system printer (Windows only)

Select the printer that has been set up as the Windows system printer. The same printer 
must also be set up in Fiery XF.

• Print via IP network

Type the IP address of a network printer. Click Test to check that a connection has been 
properly established. The printer must be switched on.

Select the type of TCP/IP protocol that your printer uses for data transfer. Most printers 
support the RAW protocol and print to port 9100. The LPR protocol is normally reserved 
for Unix systems or print servers with multiple interfaces. In most cases, you can leave the 
box blank.

• Print via port

Select a printer that is connected by USB to the computer that is running the Fiery XF 
server software. The printer must be switched on when you start Fiery XF.

• File output (requires the File Output Option or a VUTEk Printer Option)

– Use device link profile

You can apply a device link profile that you have created in Color Profiler Suite or by 
using a third-party software program. A device link profile represents a fixed 
combination of printer and media type. The device link profile must be located in the 
Profiles folder.

– Export path

Define a folder in which to save the print files. Click Choose and browse to the folder.

– Naming

Use character sequences to define a naming convention for print files. Each character 
sequence ensures that specific information is included in the file name. Add a separator, 
such as an underline (_) or a hyphen (-), between two character sequences to make file 
names easier to read. For example, type “%job_%work” to include the job name and 
the name of the workflow in the file name. You can also include custom text, such as 
GS3250LX Pro_%job_%jobid.
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The following character sequences are available:

– Compression

You can compress print files to reduce the overall volume of data. ZIP is the safest form 
of compression and results in no loss of data when the file is extracted. A minimum 
amount of data may be lost when you use JPEG compression. PackBits is very effective 
for reducing the size of TIFF files that contain large areas of solid color.

– Resolution

You can specify a resolution for the print file. For image files, a resolution of 300 dpi is 
normally sufficient. For vector graphics, a resolution of at least 1200 dpi is 
recommended to avoid any loss in quality. The higher the resolution you select, the 
bigger the file. If quality is not so important or if you need to send the file 
electronically, select a lower resolution to keep the volume of data to a minimum.

– Visual correction

You can apply a visual correction file to the current job. A visual correction file is a 
modified base linearization file. The visual correction tool in Color Tools and in 
Color Profiler Suite lets you tweak individual color channels to modify your printer’s 
color reproduction properties.

– Keep input resolution for non-PostScript files

You can keep the input resolution of non-PostScript files. As an example, you could use 
this setting to convert a set of digital files to a single color space without affecting the 
resolution (size) of the original images.

Character sequence Description

%c Counter

%jobid Job ID

%t Tile number

%p Page number

%out Output device

%cm Color mode

%job Job name/nesting name

%res Resolution

%work Workflow

%date Date
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• Print via JDF port (requires a VUTEk Printer Option)

Some VUTEk printers support JDF (Job Definition Format). JDF enables Fiery XF to 
receive information, such as media consumption and ink consumption, from the printer. 
If you select a JDF-compliant printer as the device type, you can print via the JDF port.

See also:

“Printing to a VUTEk printer” on page 223

“Performing visual color corrections” on page 169

“Device link profiles” on page 147

“JDF integration” on page 264

“Creating a system configuration in System Manager” on page 57
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Print Configuration

• Ink type

Select the type of ink that is inserted in the printer.

• Media name

The media name is the name under which base linearization file and media type are 
connected.

• Calibration set

Select a calibration set. The calibration set is a combination of ink type, media, and base 
linearization file.

Click Catalog to display the base linearization files that are available for the media and to 
view the print conditions under which they were created. The base linearization file 
defines a set of print conditions and ensures that the printer’s behavior is adjusted 
optimally to the media. Select one to apply.

The best printing results are achieved if you use a calibration set that has been created for 
your specific combination of printer and media. Click New Linearization and Profile to 
create a new base linearization file for your specific print conditions. Afterwards, you can 
connect the base linearization file to an existing media profile.

• Visual correction

A visual correction file is a modified base linearization file. The visual correction tool in 
Color Tools and in Color Profiler Suite lets you tweak individual color channels to modify 
your printer’s color reproduction properties.

You can save the settings that you make on this pane as a preset. A preset is a template for a 
group of settings that is saved under a unique name. To save a preset, click the menu button 
in the pane header.

See also:

“Performing visual color corrections” on page 169

“Creating or editing a base linearization file” on page 154

“Profile Connector” on page 164
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Media Setting

• Media size correction

You can compensate for any inconsistency in the length of the printed image by adjusting 
the output dimensions. Such inconsistencies can occur as a result of a particular 
combination of printer and media.

The file Lineal_01.ps is provided in the Samples folder to help you to adjust the size of the 
printed image. It consists of a set of ruler markings for a length and width of 
0.5 m x 0.5 m.

• Media size

– Source

Select the type of paper feed: single-sheet or roll media.

– Format

Normally, the media format corresponds to the size of the media that is inserted in the 
printer. However, you can also define a custom size by entering the required 
dimensions and clicking the plus (+) button.

See also:

“Correcting the length of printed jobs” on page 373
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Special Printer Settings

This pane provides printer-specific settings. Most of the settings are self-explanatory. 
However, please refer to your printer documentation if you require further information.

The settings that you make in Fiery XF override the settings of the same name that are made 
at the printer.

In the case of VUTEk printers, you can use the settings on this pane to remotely control the 
VUTEk PrintStation.The print settings are transmitted with the RTL file, so that no further 
settings are necessary at the PrintStation.

EFI also provides articles on how to incorporate some of the more complicated printer 
features into a Fiery XF workflow. Visit our website at: 
http://w3.efi.com/services/fiery-wide-format-services/knowledge-center.
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Device

This pane shows the printer name and the current printer status.

For some printer models with on-board measuring device, the measuring status is also 
displayed.

Some printer models are also able to communicate the current ink level back to Fiery XF.
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Managing spot colors

You can apply the following settings to custom spot colors.

• Plus (+) button

Add a new spot color.

• Minus (-) button

Delete a selected spot color.

• Duplicate button

Create a copy of a selected spot color. You can duplicate custom spot colors or spot colors 
from the internal spot color library.

• Select All button

Select all the custom spot colors in the table. You can duplicate or delete a multiple 
selection.

• Gamut Check button

Check what percentage of L*a*b* spot colors lies within the color gamut of your printer. 
The color gamut describes the full range of colors that the printer can reproduce. During 
job processing, spot colors that are out of gamut are mapped to the nearest possible color 
within the available color gamut. The deviation in color is displayed as a delta E value.

To perform a gamut check, select one or more L*a*b* spot colors, and click Gamut Check. 
The button is not available for spot colors that are not defined in the L*a*b* color space.

By switching between workflows and print configuration sets, you can quickly find out 
which combination will produce the best results.

• Convert button

Convert the selected L*a*b* spot colors to the color space of the printer. It is easier to edit 
spot colors that are defined in the ink colors of the printer.

• Optimize button

You may be able to reduce the delta E values of spot colors by applying a spot color 
optimization file. A spot color optimization file is a correction profile that attempts to 
improve the color accuracy of the selected spot colors and their gradients.

See also:

“Color Editor” on page 287



482

Color Definition tab

• Use as alias for

You can create a fixed link to an existing spot color. An alias spot color has exactly the same 
color properties as the original spot color, but is saved under a different name — for 
example, you could set up the spot color “NewSpotColor” as an alias for a PANTONE 
color. 

You cannot edit the color properties of an alias spot color, but any changes you make to the 
original spot color are automatically applied to the alias also.

By creating an alias, you can ensure that exactly the same color values are used for both 
spot colors, without renaming the spot color in the graphics application.

• Apply as

If your printer supports white ink, clear ink, or metallic inks, you can assign any of these 
additional printer inks in addition to the original spot color definition. The additional 
inks are printed either behind or on top of the original spot color.

You can use these settings to simulate the final production run on a white or colored 
substrate. Interesting special effects can be achieved for use in the packaging industry if 
your printer supports the appropriate ink colors.

• Transparency

The transparency setting affects overlapping colors. A transparency value of 100% means 
that overlapped colors can shimmer through. A transparency value of 0% equals 100% 
opacity and means that overlapped colors are knocked out.

• Spot color definition at 100%

Define a full-tone spot color. Select “Independent” to measure a color patch in the CIE 
L*a*b* or CIE LCH color space. Select “Dependent” to enter color values in the color 
space of the output device or the source profile.

See also:

“Adding spot colors in Color Editor” on page 294

“Creating aliases” on page 296

“Assigning a spot color to a printer ink channel” on page 298
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Characterization tab

Define up to 99 color gradients for each spot color. Color gradients that are defined in the 
L*a*b* or LCH color space are included in the dynamic wedge.

By default, the diagram shows the 0% and 100% color values of one ink. 100% represents the 
full-tone color that you defined on the Color Definition tab. 0% represents the color of the 
media. By default, 0% equals the unmeasured value for pure white.

To add color gradients in the printer’s color space, type appropriate values in the 
characterization table. To add color gradients in the L*a*b* or LCH color space, measure a 
color patch, or type in the color value.

If you have defined a gradient in the printer’s color space, you can finetune it by dragging the 
appropriate point along the curve in the diagram.

See also:

“Adding color gradients” on page 300
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Gradation tab

If you have a spot color with different gradients and find that one gradient is too bright or too 
pale in the printout, you can modify the brightness by adding or subtracting color along the 
gradation curve.

To modify a point along the curve, drag the point upward (to add color), or downward (to 
subtract color). Alternatively, you can type the required coordinates directly in the table.

You can delete a gradient by selecting a row in the table and pressing <Del>. It is not possible 
to delete 0% and 100% values.

Click Save to save your changes. 
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Preferences: Color Definition tab

• Ink overprint characteristics

Normally, when two different colored objects overlap, there is a knock-out effect. They 
will not print on top of each other. Intentionally printing one layer of ink on top of 
another is known as overprinting.

The overprint setting defines how two or more spot colors will behave when printed on 
top of each other.

A higher setting results in a darker printout. For example, an overprint value of 100% 
means that the colors will be completely added to each other — something that is not 
possible on a proper printing press.

A lower setting results in lighter printouts because colors appear more opaque and hide 
parts of other colors.

• Gamma

Modify the dot gain simulation for overprinting spot colors. This setting is applied to areas 
with a mixture of spot colors and process colors, or to areas that consist of more than one 
spot color. It lets you define non-linear behavior for overprinting.

• Method

Overprinting in the CMYK color space is based on a simple CMYK addition.

In the L*a*b* color space, the default setting is based on the Bradford and ROMM 
chromatic adaptation transforms (CATs). CATs are able to predict corresponding colors 
under different illuminantion sources. Fiery XF supports many different chromatic 
adaptation models, including Bradford CAT, XYZ Scaling, vonKries, and Sharp CAT. 
Select a CAT to define the overprint behavior of L*a*b* colors.

You can accentuate the brightness of overprinted colors that are very similar to each 
other — for example, yellow on yellow, or magenta on red.

• White point settings

The color tint of the media is known as the white point. The white point of the print 
media affects the color accuracy of the printout. Particularly in a proofing workflow, it is 
important to be able to simulate accurately the color tint of the final media.

You can use a measuring device to measure the media white point. The white point is 
taken into account in your spot color definitions.
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• Gamut check settings

You can check how accurately an L*a*b* spot color can be reproduced using the selected 
profiles. You can also check if an L*a*b* spot color lies within the color gamut of your 
printer. The color gamut describes the full range of colors that the printer can reproduce.

Define the acceptable tolerance limit as a delta E value. Delta E is used to measure the 
mathematical difference between two colors in the L*a*b* color space.

This setting allows spot colors that lie within the tolerance area around the color gamut to 
be accepted as in gamut.

Click Save to save your changes. Click Defaults to reset the settings on all Preferences tabs to 
their original values. 

See also:

“Checking the color accuracy of L*a*b* spot colors” on page 301
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Preferences: Measurement and Display tab

• Measuring device settings

Use an ES-1000 or ES-2000 measuring device to define a 100% colorant and gradients, or 
to measure the white point of a media. Click Settings to make device-specific settings.

• Light conditions

Define how spectrophotometric values are converted to L*a*b*.

Select a light (illuminant) source: D-50 (horizon light), D-65 (artificial daylight at noon) 
and C (daylight).

Select an observer angle: two degrees is the default setting, but the larger viewing angle of 
ten degrees is sometimes used in the packaging or textile industry.

• Monitor profile

Monitor profiles are used to simulate and verify color accuracy on a computer screen. 
Windows and Macintosh computers provide standard monitor profiles as part of the 
operating system software. You can select a monitor profile that is provided with the 
operating system, or you can select a custom monitor profile.

Click Save to save your changes. Click Defaults to reset the settings on all Preferences tabs to 
their original values.

See also:

“Creating a media profile” on page 156
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Preferences: Gradation tab

If you have a spot color with different gradients and find that one gradient is too bright or too 
pale in the printout, you can modify the brightness by adding or subtracting color along the 
gradation curve.

To modify a point along the curve, drag the point upward (to add color), or downward (to 
subtract color). Alternatively, you can type the required coordinates directly in the table.

You can delete a gradient by selecting a row in the table and pressing <Del>. It is not possible 
to delete 0% and 100% values.

Select “Apply to current table”, if required. If the check box is not selected, the setting is 
applied to future spot color tables that you create.

Click Save to save your changes. Click Defaults to reset the settings on all Preferences tabs to 
their original values. 
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Select alias for new spot color

Create a fixed link to an existing spot color. An alias spot color has exactly the same color 
properties as the original spot color, but is saved under a different name — for example, you 
could set up the spot color “NewSpotColor” as an alias for a PANTONE color. 

You cannot edit the color properties of an alias spot color, but you can edit the gradation and 
transparency values. However, any changes you make to the original spot color are 
automatically applied to the alias also.

By creating an alias, you can ensure that exactly the same color values are used for both spot 
colors, without renaming the spot color in the graphics application.

To search for the spot color, type the name of the spot color in the Search box. The Search box 
has a filter function that ensures that only the spot colors that meet the search criterion are 
displayed.

In the table, select the spot color, and click Use Selection. The color values are transferred 
automatically to the new spot color.

To remove the link to an alias spot color, click Clear Alias. If you remove the alias, the spot 
color receives the default color values of a new spot color.

See also:

“Creating aliases” on page 296
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Select an ink channel for the new spot color

If your printer supports white ink, clear ink, or metallic inks, you can assign any of these 
additional printer inks in addition to the original spot color definition. The additional inks 
are printed either behind or on top of the original spot color.

This setting is useful in the packaging industry, where gold or silver metallic colors are often 
used. Color management is applied to the original spot color during job processing, but is 
by-passed for printer inks.

To search for a printer ink channel, type the name in the Search box. The Search box has a 
filter function that ensures that only the printer ink channels that meet the search criterion are 
displayed.

Some settings have an “inverted” equivalent. They can be recognized by the letters “INV” in 
their name. If you select an inverted setting, the inversely proportional amount of ink is 
applied — for example, 0% color instead of 100% color, or 70% color instead of 30% color.

With the clever use of an inverted setting, you can simulate the final print run on any colored 
substrate.

In the table, select the printer ink channel, and click Use Selection. You can remove the link 
by clicking Clear Alias.

See also:

“Assigning a spot color to a printer ink channel” on page 298
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Find and replace spot colors

Rename custom spot colors by replacing all or part of the name. 

In the “Find what” box, type the search word. In the “Replace with” box, type the word to 
replace the search word. For example, if you search for “2013”, Color Editor will find and 
rename all spot colors with “2013” anywhere in their name.

You can further modify your search by taking upper/lower-case characters into account, or by 
searching for a full name only.

See also:

“Replacing spot color names” on page 309
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Create a new spot color table

• Name

Type a unique name for the spot color table.

• Workflow

Select a Fiery XF workflow. Color Editor retrieves information about the color space, and 
the color gamut of the output device that is connected to the workflow. Color Editor uses 
this information to check whether new spot colors can be correctly reproduced by the 
output device.

• Calibration set

Select a calibration set. The calibration set defines the settings for ink type, media name, 
and base linearization file for the selected printer. The calibration set is important for 
defining printer-dependent spot colors.

• Preferences

In the Preferences dialog box you can make general settings that are applied to all spot 
colors that you define in Color Editor.

See also:

“Creating a new spot color table” on page 307

“Preferences dialog box” on page 290
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Apply spot color table to workflows

Select one or more Fiery XF workflows to which to apply your new spot color table. If a 
workflow already has a spot color table assigned to it, the original spot color table is 
overridden but remains available in the list for reselection.

See also:

“Applying spot color tables to Fiery XF workflows” on page 310
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Check the color accuracy of L*a*b* spot colors

You can check how accurately an L*a*b* spot color can be reproduced using the selected 
profiles. You can also check if an L*a*b* spot color lies within the color gamut of your printer. 
The color gamut describes the full range of colors that the printer can reproduce. During job 
processing, spot colors that are out of gamut are mapped to the nearest possible color within 
the available color gamut. The deviation in color is displayed as a delta E value.

Color Editor applies a default delta E value of 5.0, measured in the delta E 2000 format. It 
allows spot colors that lie within the tolerance area around the color gamut to be accepted as 
in gamut.

After performing a gamut check, the following information is displayed:

• The percentage of in-gamut spot colors

• The average delta E

• The maximum delta E

See also:

“Checking the color accuracy of L*a*b* spot colors” on page 301
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Convert L*a*b* spot colors to the color space of the printer

Convert L*a*b* spot colors to the color space of the printer. It is easier to edit spot colors that 
are defined in the ink colors of the printer.

See also:

“Converting L*a*b* spot colors to the color space of the printer” on page 305



496

Optimize L*a*b* spot colors

You may be able to reduce the delta E values of L*a*b* spot colors by applying a spot color 
optimization file. A spot color optimization file is a correction profile that attempts to 
improve the color accuracy of the selected spot colors and their gradients.

See also:

“Optimizing L*a*b* spot colors” on page 305
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Solve naming conflicts when importing spot color tables

It is not possible to save two spot colors of the same name in one spot color table. A conflict 
occurs if you try and import a spot color that already exists in the loaded spot color table. To 
get round the problem, do one of the following:

• Rename one of the spot colors.

You can rename a spot color in either of the spot color tables. This may be useful if two 
spot colors of the same name have different color values. Use this setting to keep both spot 
colors.

• Replace one of the spot colors

You can replace a spot color in either of the spot color tables. This setting overwrites the 
name and the spot color values, thus providing an easy way to merge two spot colors.

• Exclude conflicting spot colors

You can opt not to import conflicting spot colors. In this case, spot colors remain 
unchanged in both spot color tables. Click Cancel to skip the displayed conflict. Click 
Cancel All to skip all conflicting spot colors.

See also:

“Importing spot colors” on page 309
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Create a base linearization file (printer settings)

A base linearization file forms the basis for a media profile. It contains details of the quantities 
of each ink color that are necessary to achieve the maximum density of color for a specific 
combination of output device, printer resolution, print mode, and media type while, at the 
same time, using as little ink as possible. After you have created a base linearization file, you 
can go on to create a media profile.

If your VUTEk printer supports white ink, you can also linearize the white ink channel. The 
white linearization is applied to the white channel, which is defined by the print mode on the 
Special tab for the output device in System Manager. The following print modes are available:

When linearizing a VUTEk printer with white ink, make sure that you set up the right printer 
in System Manager:

• Select a printer with “White” in its name if you want to limit the white ink and create a 
custom white linearization. Only VUTEk printers with “White” in their name allow you 
to create custom white linearizations.

• Select a printer without “White” in its name if you want to use a printer-specific, 
non-modifiable, default white linearization. This type of white linearization is embedded 
in the base linearization file and applies 100% of white ink in the full tones. No ink 
limiting is possible. The default white linearization achieves perfectly satisfactory results in 
most cases.

This online help contains step-by-step instructions on how to linearize the white ink channel 
in Fiery XF 6.1 and later. Separate documents on the following topics are available for 
download from the EFI website at 
http://w3.efi.com/services/fiery-wide-format-services/knowledge-center:

• How to create a white linearization (Fiery XF versions 5 and 6.0.x)

• How to update the generic white linearization, and how to create a white linearization for 
special applications (Fiery XF 6.1 and later)

Print mode White channel

Spot color WHITE_INK Prints the spot color that is defined as WHITE_INK.

Inked image A white ink dot is created for all pixel information other than 
0,0,0,0.

Inked image inverse A white ink dot is created for all pixel information equal to 
0,0,0,0.

BoundingBox All image pixels are printed white.

http://www.efi.com/bestcolor
http://www.efi.com/bestcolor
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TO CREATE A NEW BASE LINEARIZATION FILE

1 Connect your measuring device.

2 Under “Measuring device settings”, do the following:

• Select your measuring device.

Click Settings to make additional device-specific settings. This button is not available for 
all measuring devices.

Measuring device Description

ES-2000 Select from three types of measuring conditions. They are 
defined by ISO 13655, as follows:

M0: The UV content of the incident illumination is not 
defined. Measuring occurs in one step. This measuring 
condition is recommended for the white linearization.

M1: The UV content of the incident illumination is defined 
as D50. Measuring occurs in two steps.

M2: Requires that the spectral power districution of the 
incident illumination is in the wavelength range of 420 nm 
to 700 nm, with no substantial radiation power in 
wavelengths below 400 nm. Corresponds to UV cut. 
Measuring occurs in two steps.

Barbieri Spectro LFP 
Barbieri Swing RT 
X-Rite SpectroScan T

For dark, opaque substrates: 
Set the measuring device to reflection measurement mode.

For transparent/translucent substrates: 
Set the measuring device to transmission measurement 
mode.

It is recommended that you create a generic white 
linearization for transparent/translucent substrates. If a 
generic white linearization is not adequate for your needs, 
please contact EFI Support for further assistance.

Embedded measuring 
device

If your measuring device is embedded in the printer, you can 
create a base linearization file and media profile 
automatically by selecting the appropriate check boxes.

If your printer has an embedded UV cut measuring device, 
you can cause it to simulate a non-UV cut device by 
selecting the appropriate check box. In Europe, non-UV 
color values are usually used for proofing purposes.
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• Select the linearization intent that is appropriate for your type of workflow (non-VUTEk 
printers only).

– The “Proof” setting lets you select a simulation (reference) profile in a later step. In this 
case, the L*a*b* target values are extracted from the simulation (reference) profile.

– For a photo/production workflow, it is not possible to select a simulation (reference) 
profile. In this case, the best saturation value is calculated for the largest possible color 
gamut, by adding light ink earlier and in greater amounts in the full tone areas.

3 Under “Linearization name”, type a name for the base linearization file.

The default name is generated automatically from the printer model, the resolution, the 

media type and the ink type. If preferred, you can type a custom name by clearing the check 

box “Generate EPL name from settings”.

4 Under “Printer settings”, select the type of ink that is inserted in the printer.

Some printer models support more than one type of ink. Make sure that you select the ink 

type that is inserted in the printer.

5 Under “Media settings”, do the following:

• Select the media type that best matches the media that is inserted in the printer.

• Select a media name or type in a custom name. This is the name that will appear in 
Fiery XF.

• Enter an actual media length and a target media length, if required.

You can correct any inconsistency in the output length of jobs. Inconsistencies can occur as 
a result of a particular combination of printer and media.

The file Lineal_01.ps is provided in the Samples folder to help you to adjust the length of 
the printed image. It consists of a set of ruler markings for a length and width of 
0.5 m x 0.5 m.

6 Under “Output settings”, make the required settings:

• Resolution

Select the targeted resolution. Higher resolutions lead to improved output quality but 
affect processing and printing performance.

If you want to incorporate a screening file into the base linearization file, make sure that 
you select the same resolution that was used to create the screening file.

• Print mode

The print mode defines the quality of the output. The print modes are printer-specific. 
Only print modes are listed that are suitable for use with the selected print resolution. The 
print mode defines the quality of the output — high-quality or draft.
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• Print direction

Bidirectional printing is faster as the print head prints in both directions. However, 
unidirectional printing achieves more accurate results than bi-directional printing. Not all 
printers support bidirectional printing.

• Halftoning

For contone printers, the halftoning method of the printer manufacturer is selected by 
default.

For printers that use one of Fiery XF’s halftoning methods, you can choose between error 
diffusion (SE1) and stochastic halftoning (SE2). It is recommended that you select SE1 for 
maximum quality and SE2 for a faster RIPing speed. SE2 is also recommended for 
VUTEk printers for which “Grayscale” is the selected dot size.

If you want to incorporate a screening file into the base linearization file, select “Screening” 
as the halftoning method. The color mode switches automatically to CMYK, and the 
“Screening” setting becomes available.

• Color mode

Make sure that the number of inks and the ink colors are correct for your printer. 
Depending on the combination of printer and color mode, different procedures for 
creating a base linearization are available.

Printers Description

All non-VUTEk printers, plus 
VUTEk PressVU series and 
VUTEk UltraVU series

Select CMYK if your printer has only four inks, or if 
you want to incorporate a screening file into the base 
linearization file.

CMYK is selected by default if your printer uses the 
original halftoning (contone) method of the printer 
manufacturer. It means that the total ink limit (TIL) 
is already incorporated into the media type and is 
normally 400%. Although all the printer’s available 
inks are taken into account, you can edit only 
CMYK ink curves.

Base linearizations created using this method cannot 
be used in Fiery XF 6.0.x or earlier.
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• Dot size

The available dot sizes and their properties are printer-dependent. For VUTEk Pro series 
printers, there are two settings:

– Fixed: Each dot is one ink droplet in size

– Grayscale: Variable dot size

• Screening

If you have previously created a screening file in Dot Creator, you can incorporate it into 
the base linearization file by selecting it here. For more information on creating screening 
files, see the online help.

Click Next.

See also:

“Correcting the length of printed jobs” on page 373

All VUTEk printers, excluding 
VUTEk PressVU series and 
VUTEk UltraVU series

The new default linearization for VUTEk printers 
can be completed in only a few steps. You can add 
steps for gray balance and quality control by 
selecting the appropriate check boxes.

Add the gray balance step to produce neutral 
grayscales after linearization but before profiling. In 
this step you can adjust the percentage of CMY inks 
along the gradation curve. Unbalanced CMY inks 
typically give an unwanted color cast to grayscales 
images. This step is usually not necessary.

Add the quality control step if you want to compare 
the color gamut of the base linearization with a 
reference.

Base linearizations created using this method cannot 
be used in Fiery XF 6.0.x or earlier.

All VUTEk printers "Advanced" color modes are available for all VUTEk 
printers. This procedure corresponds to the VUTEk 
linearization that was available in Fiery XF versions 5 
and 6.0.x. In this version of Fiery XF it is known as 
“Fiery XF 5 legacy linearization”. 

Base linearizations created in legacy mode can be 
used in all versions of Fiery XF version 5.x and 6.0.x, 
with the exception of linearizations that have the dot 
size “Grayscale”.

Printers Description
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Create a base linearization file (non-VUTEk printers)

TO CREATE A NEW BASE LINEARIZATION FILE (CONT’D)

1 Click Print.

The chart is printed.

2 Wait for the ink to dry. Then, follow the on-screen instructions to measure the chart.

After measuring, you return to the Ink Limit Per Channel window.

3 Do any of the following:

• Click Advanced to check the ink limit for each channel. In the Advanced window:

– Check that the recommended ink limits are within the optimum range. The optimum 
range is represented by the blue area. Move the sliders, as required.

– Select a simulation (reference) profile, if required. Selecting a simulation (reference) 
profile ensures that the ink limits are taken from the profile. You can choose a standard 
simulation (reference) profile or one that was provided by your printing company.

Selecting a simulation (reference) profile limits the available color space and ensures 
that the media profile you create is better matched to the simulation (reference) profile. 
If you do not select a profile, an appropriate industry standard is applied.

Click OK to return to the Ink Limit Per Channel window.

• Click Import Data to import a base linearization file that you started to create during an 
earlier session. You can import data at any stage of the linearization process.

• Click Measure to measure the chart again. You can remeasure charts at any stage of the 
linearization process.

After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.

4 Click Next.

The Linearization window opens.

5 Click Print.

The chart is printed.

6 Wait for the ink to dry. Then, follow the on-screen instructions to measure the chart.

After measuring, you return to the Linearization window.
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7 Click Advanced to check the norm start point, the tonal value increase, and the dot gain.

Normally, the default values achieve good results, as a special algorithm is in place that 

calculates the relationship of light to norm inks, and also takes into account a dynamical dot 

gain. However, if you do need to make changes, observe the following:

The best start point for normal inks depends on the particular combination of media, ink, 

and resolution. For newsprint, it is recommended that you keep the percentage of light ink to 

a minimum in order to prevent too much ink from being applied to the media. However, this 

can lead to a grainy effect in the printout, as the printer prints heavy dots in highlight areas. In 

contrast, when printing on photographic or proofing media, it is usual to apply a higher 

proportion of light ink in order to create a smooth impression.

However, the total ink limit (TIL) is equally important. The maximum value is 100% per ink 

channel. For example, if your printer supports CMYK inks, the maximum possible TIL is 

400%. 

The tonal value increase describes the percentage value to which the dot gain is applied. The 

dot gain represents the difference between the dot size on the plate and the corresponding dot 

size on the printed page. Experience has shown that it is a good idea to consider the dot gain 

in an inkjet print as well. Historically, in Europe the dot gain is defined at the 40% input area 

of the gradation curve, whereas the United States and the Pacific region define the dot gain at 

50%.

Click OK to return to the Linearization window.

8 Click Next.

The Total Ink Limit window opens.

9 Click Print.

The chart is printed with the initial total ink limit (TIL) applied. The initial TIL equals the 

sum of the values that you defined for the ink limits per channel. It is the maximum 

permitted value. Normally, the glossier the media, the higher the TIL.

10 Wait for the ink to dry. Then, follow the on-screen instructions to measure the chart.

After measuring, you return to the Total Ink Limit window.
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11 Visually assess the printed total ink limit chart. Redefine the TIL if the ink is slow to dry or 
if bleeding is visible. You can redefine the TIL as follows:

• Automatically by measurement

When you measured the chart, Fiery XF calculated the best possible TIL, even if too much 
ink was applied to the media. 

• Visually

You can read the TIL from the visual chart. This is useful if you want to take physical 
effects into account, such as bleeding or mottling. Measuring devices cannot "see" such 
effects. From the drop-down list box, select the number of the column with the best TIL.

• Numerically

If you know the exact TIL definition to use, you can enter a custom percentage.

The TIL that you select in this step is saved to the base linearization.

12 Click Next.

The Quality Control window opens.

13 Click Print.

The chart is printed. Check the following:

• Gray balance

Ideally, the black stripe and the CMY stripe should be identical. However, be aware that it 
is not possible to achieve pure black from mixing CMY inks. 

• TIL

– Make sure that the edges of the individual color patches are clearly defined.

– Make sure that the media does not curl up as a result of too much ink.

– Make sure that the ink does not smudge. and is evenly distributed on the media.

• Transition of light to norm inks

Examine the stripes of the primary colors to make sure that there is a smooth transition 
from light to normal inks. Smooth transitions are particularly important when printing 
skin tones. If normal inks are added too soon, there may be a peppering effect.

14 Wait for the ink to dry. Then, follow the on-screen instructions to measure the chart.

After measuring, you return to the Quality Control window.

15 Click Next.

A summary of your base linearization is displayed.

Before saving the base linearization file, you can change the name of the media. You can also 

create a report of the settings that were applied to create the base linearization file.
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16 Click Save & Finish.

If you have modified an existing base linearization file, confirm that you want to overwrite the 

original file.

You can now go on to create a new media profile. Alternatively, you can connect the base 

linearization file to an existing media profile using Profile Connector.
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Create a base linearization file (VUTEk printers)

TO CREATE A NEW BASE LINEARIZATION FILE (CONT’D)

1 Click Print.

The chart is printed to file. Depending on the selected color mode, more than one chart may 

be printed.

If you know that too much ink will be printed on the media, you can reduce the ink limits 

before printing the chart. In this way, you can prevent potential bleeding issues and ensure 

that the chart can be successfully measured. Select “Print with pre-ink limits per channel 

(optional)”. Then, click Pre-Ink Limits and enter an ink limit that is less than 100%. You can 

set individual pre-ink limits per channel or click the chain icon to set identical limits for C, 

M, Y and K. Spot colors (Orange, Violet, White) always use individual limits.

2 For white ink linearization only: Import the RTL files into the VUTEk print station (VUI).

Do the following steps if you want to print white ink on a black or transparent media:

• Right-click each RTL file and create a multilayer job.

• For all charts (except the file with “Ink Limit and Linearization_W” chart in its name):

– Under “Colors”, clear “White” for the top layer in the image.

– For the bottom layer, select “White Flood”.

You can improve the ink coverage, if required, by adding a second white layer. To do so, 
select three layers on the Multilayer panel. Then, select “White Flood” for the middle and 
bottom layers.

• For the white linearization chart (the file with “Ink Limit and Linearization_W” chart in 
its name):

– Under “Colors”, select “White From Image” for the bottom layer.

– Make sure that “White” is cleared for the top layer.

You can improve the ink coverage, if required, by adding a second white layer. To do so, 
select three layers on the Multilayer panel. Then, for the middle layer, click “Select Image”, 
and browse to the RTL file that was used to create the multi-layer job. When the image has 
been loaded, under “Colors”, clear all colors for the middle layer, except white.

3 Print the charts on the VUTEk printer.

Use the print options of each (multi-layer) job to set the smoothing level, and margins, etc. 

Use the interlace mode “Double strike” to increase the ink density, if needed. As this setting 

has a high impact on the output color, it is recommended that you include “double strike” in 

the name of the base linearization file. Multi-layer jobs cannot be grouped together into a 

layout, so you must print them separately. 
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4 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart.

• Click Import Data to import IT8 measurement files from a base linearization that you 
started to create during an earlier session. Note that the measurement file must match the 
color mode that you selected for the base linearization settings. You can import data at any 
stage of the linearization process. If you load more than one file at a time, it will 
automatically be sorted into the proper channels.

After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.

5 Review the light/norm setup.

• Norm ink

Defines the norm ink limit of the ink channel in the full tone.

If the “Auto” check box is selected (default setting), the norm ink limit is calculated 
automatically. Color Tools tries to achieve the best possible chroma (C*) for the CMY 
inks, and the minimum possible L* value (0) for black. The results for each color are 
shown on the appropriate tabs.

If you clear the “Auto” check boxes, you can edit the setting for each color. A value of 
100% forces the linearization to use 100% norm ink in the full tone.

• Norm ink start

Defines the absolute starting point of the norm ink curve, which also adjusts the use of the 
light inks. Change this setting if you want to influence the transition of light ink into 
norm ink.

• Light ink in full tone

Defines the absolute percentage of light ink in the full tone.

If the “Auto” check box is selected (default setting), the percentage of light ink in the full 
tone is calculated automatically. If you clear the “Auto” check boxes, you can edit the 
setting for each color. Color Tools tries to achieve the best possible chroma (C*) for the 
CMY inks, and the minimum possible L* value (0) for black. The results for each color are 
shown on the appropriate tabs.

• Dot gain at 50%

Defines the dot gain relative to 50%. In most cases, you can leave this setting at 0%.

You can experiment with the light/norm settings to find the combination that achieves the 

best balance between chroma and ink consumption, while maintaining smooth gradations. 

When you make changes, the chroma and ink consumption values are automatically updated 

for each ink channel when you press <Enter>.
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The following tips will help you to find the right combination:

• Do not reduce the percentage of norm and light ink too much. A slight reduction often 
has very little effect on the overall chroma, but if you use too little ink the ink coverage is 
not high enough and white spots may appear in the printout. You can check the total ink 
coverage by printing the visual reference chart.

• You can reduce ink consumption by decreasing the starting point for norm ink, which lets 
the norm ink start earlier. However, be careful that you do not set the starting point too 
low, as it can cause graininess.

• The dot gain affects both norm and light inks. A value of -5% transforms 50% input 
values into 45% output values, while gradually changing the other output values 
accordingly.

• Clicking Default resets the settings on the current tab to their original values and also 
reselects the “Auto” check boxes.

6 Print the visual reference chart (optional).

You can check the effect of your changes.

• Make sure that there is a smooth transition at the norm ink starting point. The 
recommended starting point for norm ink is between 20% and 40%.

• Check the total ink coverage in the full tone areas. If there are gaps, try increasing the 
percentage of ink in the full tones.

7 Click Next.

The Advanced Ink Limit window opens. In this step, you can:

• Modify the overprint behavior of the printer’s primary color channels, C, M, Y and K. Do 
this to optimize the tonal range, ink thickness/stack, etc.

• Modify the light ink reduction. Do this to ensure smooth transitions and to control 
graininess.

It is recommended that you start by printing the chart using the default settings (zero light ink 

reduction) and no ink limiting.



510

8 Click Print.

Review the printed chart. Modify the light ink reduction first, if required, as changing this 

setting forces the advanced ink limits to return to their default values which requires you to 

reprint the chart with the new light ink reduction value.

• Search for possible bleeding, mottling or reversing effects. Reversing occurs when color 
transitions that should become increasingly darker actually become lighter.

You can counteract these effects by reducing the amount of light ink. Click Edit, and move 
the slider to the right to reduce the amount of light ink in the mix. This usually solves 
problems very quickly. However, beware of unwanted side effects, such as graininess.

When you have adjusted the light ink reduction value, it is recommended that you print 
the chart again and review the output.

• Check the 200%, 300% and 400% gradients. Each 200% gradient represents a 
combination of two different inks. The 300% gradients represent a combination of three 
different inks, and the 400% gradient is composed of CMYK.

The input ink value increases in increments of 5% for the color patches of each primary 
color. For each color stripe, search for the color patch with a visibly lighter hexagon on the 
darkest background. If you need to apply ink limits (due to mottling, bleeding, loss of 
detail, ink thickness), enter your target values in the appropriate boxes of the Advanced ink 
limits table. Be aware that the ink limits you enter are absolute ink limits and are always 
calculated as a percentage of the full 200% 300% or 400% ink limit.

If you change the ink limits, it is recommended that you print the chart again and review 
the output. Note that scale along the chart does not update to the current advanced ink 
limit — for example, if you set the CM ink limit to 185%, you still have to review the ink 
patch at 200%.

9 Click Next.

The Gray Balance window opens if you selected the appropriate check box in the Settings 

window. In this step, you align the CMY gradation curves to a neutral gray.

10 Click Print.

The chart is printed.

11 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart.

• Click Import Data to import measurements from an existing base linearization file. Click 
Reset Table and do this step from scratch for your specific combination of 
printer/media/ink.
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After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.

Color Tools displays an "average delta C" value. The value stands for the average difference in 

chroma (colorfulness) for the entire gray balance. The higher the value, the stronger the color 

shifts within the gray balance. An arrow indicates whether further optimization is possible. 

Click Print and measure the next chart for additional iterations, as needed. Repeat this process 

until the delta chroma value is reasonably low and the gray balance stable.

You can delete the last iteration by clicking Delete Entry — for example, if you accidentally 

measure a wrong chart, or if the previous iteration achieved a lower delta chroma. To reset all 

iterations, click Reset Table.

12 Select the average delta C value that you want to use.

13 Click Next.

The Quality Control window opens if you selected the appropriate check box in the Settings 

window. This step captures the "color foundation" of your linearization by measuring 

representative color patches.

14 Click Print.

The chart is printed.

15 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart. 

• Click Import Data to import an IT8 measurement file of the quality control chart.

After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.
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16 Click Next.

The Summary window is divided into the following sections:

• Linearization summary

A summary of your base linearization is displayed. Before saving the base linearization file, 
you can change the name of the media. You can also create a report of the settings that 
were applied to create the base linearization file. The report provides an easy way to archive 
your results. It shows general information of the linearization settings, the ink limits, a 
gamut preview or gamut comparison (optional) beneath L*a*b* and chroma values of the 
measurement and the light/norm curves.

The report is created as an HTML file and displayed in the default Internet browser. From 
your browser, you can easily print it out on A4/Letter size media, or create a PDF file.

• Comparison gamut

If you selected the appropriate check box in the Settings window, you can compare the 
color gamut of your base linearization with ISOcoated_v2_eci.icc or 
GRACoL2006_Coated1v2.icc or any custom profile. Select the appropriate check boxes, 
and then click Compare in Profile Inspector.

Profile Inspector displays a 3D view of the color gamuts of your base linearization and the 
profiles you selected for comparison. In Profile Inspector, you can also select additional 
profiles. Drag the 3D model to rotate it. By viewing the 3D model from all sides, you can 
see where the measured color values do not fit into the color gamut of the reference. For 
more information on Profile Inspector, see the tool’s online help.

• Finalize or continue with profiling

If you have a license for the Color Profiler Option, you can go on to create an ICC profile.

If you do not have an appropriate license, you can use the base linearization for the 
following purposes:

– You can select the base linearization as a calibration set in Fiery XF and use it to print 
jobs without color management. You need to print charts without color management if 
you want to create a profile using a third-party software.

– You can connect the base linearization file to an existing media profile using Profile 
Connector.

17 Click Save & Finish.

If you have modified an existing base linearization file, confirm that you want to overwrite the 

original file.
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Create a base linearization file (VUTEk printers legacy procedure)

TO CREATE A NEW BASE LINEARIZATION FILE (CONT’D)

When performing the following steps, it is recommended that you try and achieve the best 
possible results for the black point definition and for the CMY/K transition. These two steps 
have an impact on the whole CMYK gamut, whereas the individual ink limits affect only a 
very specific area of the gamut. By concentrating on finding a good combination of black 
point and CMY/K transition, it is possible that little or no 200%, 300% or 400% ink 
limiting will be necessary.

The VUTEk linearization provides extensive control over light and norm ink curves, ink 
limits, black points, iterative gray optimizations and light ink behavior in areas with higher 
ink coverage. It helps you to achieve the smoothest output and the largest color gamut on 
your VUTEk printer.

Advanced settings are available for color modes with light inks. Click Advanced to define the 
percentage of light ink that is added to the 100% full tone of the equivalent normal ink. It is 
recommended that you do not change the default settings unless it is absolutely necessary.

The relationship between light and normal inks is printer dependent. For some printers, 
adding 5% light ink to the full-tone inks can prevent banding (white stripes) in the printout.

1 Click Print.

The chart is printed.

2 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart.

• Click Import Data to import a base linearization file that you started to create during an 
earlier session. You can import data at any stage of the linearization process. If you load 
more than one file at a time, it will automatically be sorted into the proper channels.

After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.

On the CMYK Channels tab, Color Tools calculates automatically ink limits and linearization 

curves for the largest possible gamut and smoothest gradations. You can adjust the resulting 

ink limits and linearization curves in the next step, if required.

The Limits tab enables you to apply hard ink limits to the printer driver before the 

linearization starts its work. This is very useful on the TX3250r printer when you print on 

textile material and need to control bleeding. Note that default values for 540 dpi and 

1080 dpi have been applied specifically for the TX3250r printer. These values are a very good 

starting point, but you can review and change them as required.
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3 Click Next.

The Physical Ink Limit window opens. In this step, you can modify the norm and norm/light 

ink curves that were automatically determined by Color Tools in the previous step. This is 

important if you want to control ink consumption, thickness, graininess, etc.

4 Click Print.

The chart is printed.

5 Wait for the ink to dry. Then, review the default settings.

• “Norm ink maximum” and “Light ink maximum”

Determines how much norm/light ink Color Tools uses for the linearization. The values 
you enter here are maximum values. Color Tools selects the best possible amount of light 
and/or norm ink but does not exceed the maximum you define. Be aware that sometimes a 
lower value leads to better results.

Click Apply after changing values to update the resulting light/norm ink build curves. You 
can review the result by clicking Print.

The advantage of this algorithm is that it can result in light/norm curves that you would 
never have defined manually. The resulting curves may look "unusual", but do not worry!

• Light ink maximum (full tone)

This setting defines the maximum amount of light ink that Color Tools applies in the full 
tone areas. The easiest and most effective way to use this feature for the VUTEK TX3250r 
printer is to set it to "0" to ensure that no light ink is used in the full tones at all.

You can see that the light ink curves all revert to 0% at the full tone, which heavily reduces 
the amount of ink. 

On UV printers, a certain amount of light ink is necessary in the full tone. By adding light 
ink, you can increase the color gamut and noticeably reduce graininess. When you change 
a value, click Apply. Then click Print to review the effect of the change on the printed 
chart.

Hints:

– By default, the CMYK light inks maxima are set to 50% for the TX3250r. This is a 
good starting value.

– Consider setting the "Light ink maximum (full tone)" to 0% for all channels when 
working with the TX3250r.
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• Manual curve editing

It is recommended that you do not manually modify the light/norm curves. However, if it 
is essential that you do so, you can modify the light/norm curves by dragging any point 
along the curve to a new position. You can also use the arrow keys on your keyboard for 
more precise positioning. Note that for some points horizontal movement is deactivated 
on purpose.

• Notes tab

The Notes tab enables you to add notes to your linearization. For example, you can record 
your VUTEk PrintStation settings (speed, smoothing, curing, shutters). Your notes are 
included in the linearization report.

6 Click Next.

The Gray Balance window opens. In this step, you align the CMY gradation curves to a 

neutral gray.

7 Click Print.

The chart is printed.

8 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart.

• Click Import Data to import a base linearization file. You can open an existing base 
linearization file (EPL), such as one that was shipped with Fiery XF. Click Reset Table and 
do this step from scratch for your specific combination of printer/media/ink. By following 
this procedure you can finetune the gray balance of existing EPLs quickly and efficiently to 
your own media, without having to create a completely new linearization. It is 
recommended that you create a custom media profile afterwards.

After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.

Color Tools displays an "average delta C" value. The value stands for the average difference in 

chroma (colorfulness) for the entire gray balance. The higher the value, the stronger the color 

shifts within the gray balance. An arrow indicates whether further optimization is possible. 

Click Print and measure the next chart for additional iterations, as needed. Repeat this process 

until the delta chroma value is reasonably low and the gray balance stable.

You can delete the last iteration by clicking Delete Entry — for example, if you accidentally 

measure a wrong chart, or if the previous iteration achieved a lower delta chroma. To reset all 

iterations, click Reset Table.
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9 Click Next.

The Black Point Definition window opens. This step helps you to find the darkest possible 

(neutral) color that your specific combination of printer, media and ink can produce. By 

default, the darkest point of a linearization is assumed to be at CMYK 100 100 100 100. 

However, in reality a different combination of C, M, Y and K can lead to darker colors. This 

step allows you to find the best combination to ensure that the linearization uses the gamut of 

the printer to the fullest. 

10 Click Print.

The chart is printed. The chart consists of measurable and visual elements.

11 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart. After measuring, Color Tools automatically suggests a "recommended" 
black point definition. This recommendation is based on a black point that is as dark as 
possible, but still relatively neutral.

• Click Import Data to import a base linearization file. You can open an existing base 
linearization file (EPL), such as one that was shipped with Fiery XF.

• Click Show Patches, and rest the pointer on a color patch to view its L*a*b* value. You can 
view the current patches at any stage of the linearization process.

12 Review the recommendation with the help of the visual elements.

On the printed chart, search for the patch number that Color Tools recommends — for 

example, patch number 13. On the right-hand side of the patch you will find both a smooth 

and a step-based transition from a lighter version of that black point to the full black point. 

This gives you an idea about the neutrality of the patch.

Alternatively, if you prefer the black point of another patch, enter the CMYK combination of 

the preferred patch into the C, M, Y and K boxes for the target black point. You can also type 

in any custom combination of C, M, Y and K values. The target black point if independent of 

the total ink limit.

Make use of the visual elements to check the black point definition with regard to ink 

thickness (UV inks), or bleeding and/or mottling (aqueous, solvent and oil-based inks).

It is recommended that youleave the “List only neutral black points” check box selected, and 

choose the black point that is recommended.
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Hints:

• Start with K = 100% and reduce the amount of CMY inks — for example, 75 75 75 100 
for UV printers.

• Typical examples for the TX3250r are:

– DirectFlag & Transfer Paper: CMYK 50 50 50 100

– Poplin: CMYK 60 60 50 100

If you are an experienced user, you can enter a targeted black point definition without 

printing.

13 Click Next.

The Advanced Limits (Medium Light Inks) window opens. In this step you can apply various 

200%, 300% and 400% ink limits. Light inks are automatically reduced temporarily by 

Color Tools, as this step's focus is on norm inks.

14 Click Print.

The chart is printed.

15 Review the default settings.

Review the default settings on the printed chart before you make any changes. Check the 

200%, 300% and 400% gradients. If you need to apply ink limits (due to mottling, bleeding, 

loss of detail, ink thickness), enter your target values in the appropriate boxes. 

• Show absolute values

Color Tools differentiates between "relative" and "absolute" ink limits.

As an example, you can enter a "relative" ink limit of 160% for a 200% ink limit. 
Afterwards, click Print to check the result. As soon as you click Print, the "relative" ink 
limit is set back to 200%. When you look at the newly printed chart, you can decide that 
190% is the correct value to use. By displaying all ink limits in a "relative" way, this is 
possible.

If, afterwards, you check the "Show absolute values" check box, Color Tools displays 
152%. This is the actual value that is used for the ink limiting. 

It is recommended that you use relative values to define ink limits and only select "Show 
absolute values" if you want to double-check the final value that is used for the ink 
limiting.
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• CMY/K transition

This setting provides extended control over the gamut shape of the "shadow area" and ink 
consumption. It enables you to build a solid shadow area without any reversing effects. 
Reversing occurs when color transitions that should become increasingly darker actually 
become lighter.

As a general rule of thumb, if you see reversing effects on UV printers, increase the 
CMY/K transition to fill out the shadow area and to counter any reversing effects.

On Solvent/Dye-sub (Textile) the best setting for the CMY/K transition depends strongly 
on the acceptance of bleeding from higher ink loads. Although increasing the CMY/K 
transition can help to avoid umbrella effects, the additional bleeding may not be 
acceptable. To avoid umbrella effects, you can also try the following:

– Review the CMY gradient on the printed chart. If you see a color cast towards the end 
point of the transition, cut it off by applying an appropriate ink limit.

– Apply moderate ink limits to the 200% combinations if you see a loss of details and/or 
bleeding.

– In general, it is a good idea to adjust the black point rather than applying lots of ink 
limits for color combinations with K in the Advanced Ink Limit step. It is likely that 
you will find a black point that works well, so that little or no ink limiting is necessary 
in the Advanced Ink Limit step. Apply moderate ink limits in the Advanced Ink Limit 
step.

– Bear in mind that for the TX3250r a certain amount of bleeding in the Advanced Ink 
Limit step is acceptable if you go on to create a profile from measurement and work 
with appropriate black generation settings (black width > 10 and black start = 5-6). 
The bleeding can help to achieve a larger gamut.

During profiling, select one of the following presets for black generation:

– If the end points of the CK, MK, YK, CYK and YMK transitions all tend to be very 
dark, you can go back to the black point generation step and reduce the amount of 
black — for example, to 95%. The end points of the above transitions should show 
some color cast and should not be completely black.

Preset Use for:

Inkjet Default Default preset for all inkjet printers, 
including VUTEk printers

EFI VUTEk TX3250r Direct Print Preset for printing on flag material

EFI VUTEk TX3250r Transfer Print Preset for printing first on paper and then 
transferring to other material
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– If you see strong bleeding in all color combinations with K in the Advanced Ink Limit 
step, you can reduce the amounts of CMY in the black point generation step instead. 
This can be easier and quicker than adjusting various ink limits and the CMY/K 
transition.

– The default value of 2.0 for the CMY/K transition works well for most UV printers.

– The CMY/K transition should be set to ~4.0 for the TX3250r when you are working 
with DirectFlag and Poplin media.

– On transfer paper the CMY/K transition for the TX3250r often has to be adjusted to a 
value below 2.0.

16 Click Next.

The Advanced Limits (Full Light Inks) window opens. In this step you control the amount of 

light ink that is used towards 200%, 300% and 400% ink limits. This setting is independent 

of the light/norm curves that you previously defined in the physical ink limit step.

It is recommended that you print the chart with the slider set at the default position first.

17 Click Print.

The chart is printed.

18 Review the ink thickness.

On the printed chart, search for possible bleeding/mottling and/or reversing effects. Reversing 

occurs when color transitions that should become increasingly darker actually become lighter.

If you find any of these effects, move the slider further to the left to reduce the amount of 

light ink in the mix. This typically solves problems very quickly. 

If you are not satisfied with the smoothness of the transitions, move the slider further to the 

right to add more light ink to the mix. However, beware of unwanted effects (see above) and 

increased ink consumption.

After you have moved the slider, it is recommended that you print the chart again to review 

the effect on the printout.

Review also the black rectangles. The inner circles and stars should be darker than the 

surrounding 100% black. If you see any reversing effects, reduce the 100% black ink limit in 

the "Advanced Limits (Medium Light Inks)" step.

19 Click Next.

This step captures the "color foundation" of your linearization by measuring representative 

color patches.

20 Click Print.

The chart is printed.
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21 Do any of the following:

• Wait for the ink to dry. Then, click Measure, and follow the on-screen instructions to 
measure the chart. 

• Click Import Data to import an IT8 measurement file of the quality control chart.

After measuring or importing data, you can view the current patches at any stage of the 

linearization process. Click Show Patches, and rest the pointer on a color patch to view its 

L*a*b* value.

22 Click Next.

The Summary window is divided into the following sections:

• Linearization summary

A summary of your base linearization is displayed. Before saving the base linearization file, 
you can change the name of the media. You can also create a report of the settings that 
were applied to create the base linearization file. The report provides an easy way to archive 
your results. It shows general information of the linearization settings, the ink limits, a 
gamut preview or gamut comparison (optional) beneath L*a*b* and chroma values of the 
measurement and the light/norm curves.

The report is created as an HTML file and displayed in the default Internet browser. From 
your browser, you can easily print it out on A4/Letter size media, or create a PDF file.

• Comparison gamut

If you selected the appropriate check box in the Settings window, you can compare the 
color gamut of your base linearization with ISOcoated_v2_eci.icc or 
GRACoL2006_Coated1v2.icc or any custom profile. Select the appropriate check boxes, 
and then click Compare in Profile Inspector.

Profile Inspector displays a 3D view of the color gamuts of your base linearization and the 
profiles you selected for comparison. In Profile Inspector, you can also select additional 
profiles. Drag the 3D model to rotate it. By viewing the 3D model from all sides, you can 
see where the measured color values do not fit into the color gamut of the reference. For 
more information on Profile Inspector, see the tool’s online help.

• Finalize or continue with profiling

If you have a license for the Color Profiler Option, you can go on to create an ICC profile.

If you do not have an appropriate license, you can use the base linearization for the 
following purposes:

– You can select the base linearization as a calibration set in Fiery XF and use it to print 
jobs without color management. You need to print charts without color management if 
you want to create a profile using a third-party software.

– You can connect the base linearization file to an existing media profile using Profile 
Connector.
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23 Click Save & Finish.

If you have modified an existing base linearization file, confirm that you want to overwrite the 

original file.
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Optimize a media profile

You can optimize a media profile to a simulation (reference) profile. However, check the print 
quality first to ensure that an optimization is really necessary.

TO OPTIMIZE A MEDIA PROFILE

1 Under “Profiles”, select a workflow.

You can select any workflow that is connected to an output device. When you select a 

workflow, the media profile and the simulation (reference) profile from that workflow are 

automatically retrieved . The simulation (reference) profile represents the target colors that 

you want to achieve when you optimize the media profile.

If you select the workflow “EFI Linearization”, you can select:

• Any base linearization file that is connected to a media profile.

• Any simulation (reference) profile — for example, a CMYK profile from your printing 
company or an RGB profile from a digital camera. You can also use standardized ICC 
profiles, such as ISOcoated v2.

2 Connect your measuring device.

3 Under “Measuring device settings”, select your measuring device.

Click Settings to make additional device-specific settings. This button is not available for all 

measuring devices. If you are using an ES-2000, you can select from three types of measuring 

conditions. They are defined by ISO 13655, as follows:

• M0

The UV content of the speciment illumination is not defined. Measuring occurs in one 
step.

• M1

The UV content of the specimen illumination is defined as D50. Measuring occurs in two 
steps.

• M2

Requires that the spectral power districution of the speciment illumination is in the 
wavelength range of 420 nm to 700 nm, with no substantial radiation power in 
wavelengths below 400 nm. Corresponds to UV cut. Measuring occurs in two steps.

If your printer has an embedded UV cut measuring device, you can cause it to simulate a 

non-UV cut device by selecting the appropriate check box. In Europe, non-UV color values 

are usually used for proofing purposes. 
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4 Under “Optimization chart”, select a chart.

It is recommended that you use the same chart that you used to create the media profile.

• 46

This is a simple control strip with 46 color patches. It is small enough to fit onto every 
printout. The 46 color patches contain additional information which is mathematically 
calculated to ensure that the quality of the resulting simulation (reference) profile is 
comparable to the quality of a profile that has been created using a standard IT8 chart. 
This can lead to smoother results.

• 234

This chart prints 234 color patches.

• 928 (IT8 7/3)

This chart prints 928 color patches. 

• 1485 (ECI 2002)

This ECI 2002 chart has 1485 color-sorted patches. Using this chart creates a better 
quality of media profile, due to the higher number of patches. Select this chart to optimize 
to the ISO standard. 

• 1485 random (ECI 2002)

This ECI 2002 chart has 1485 randomly positioned color patches. Using this chart creates 
a better quality of media profile, due to the higher number of patches. Select this chart to 
optimize to the ISO standard. 

• 1617 (CGATS IT8.7/4)

This IT8.7/4 chart has 1617 color-sorted patches. It forms the basis for the DIN ISO 
norm 12647-7. A chart with 1617 color patches is needed for Fogra certification or G7 
processes. This chart is used at EFI to create media profiles for inkjet printers.

• 1617 random (CGATS IT8.7/4)

This IT8.7/4 chart has 1617 randomly positioned color patches. It forms the basis for the 
DIN ISO norm 12647-7. A chart with 1617 color patches is needed for Fogra certification 
or G7 processes.

• 4028

This chart prints 4028 color patches. It is used at EFI to create media profiles for Fiery 
toner printers.
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5 Select “Use optional additional characterization data”, if required.

This setting lets you load original IT8 characterization data from:

• A simulation (reference) profile

Make sure that the data you select matches the selected profile. A list of which data is 
included in each IT8 reference profile can be found in the readme file that is located in the 
folder "Server\IT8_CharacterizationData". If you want to optimize to the ISO standard 
ISOcoated v2, select FOGRA39L74.IT8. 

• A different media profile

By selecting IT8 characterization data from a different media profile, you can adjust the 
print quality of one printer to another.

If you do not have the original measurement data, leave the check box cleared.

6 Under “Optimization method”, select one of the following optimization methods:

• Optimize media profile 

This setting ensures that the optimized results are applied directly to the media profile.

• Create new L*a*b* correction profile 

This setting creates a file with the extension 3cc. It ensures a more precise printer 
adjustment. By applying an L*a*b* optimization file you can greatly improve color 
accuracy by reducing delta E values.

• Optimize existing L*a*b* corection profile 

This setting lets you select and optimize a previously created L*a*b* optimization file. If 
you have not previously created an L*a*b* optimization file, you can load and optimize the 
default file “neutral.3cc”. By optimizing an existing L*a*b* correction profile, you can 
achieve optimum results in fewer steps.

7 Under “Paper white settings”, select one of the following: 

• Default - Absolute colormetric

This setting applies the rendering intent “Absolute colorimetric” from the simulation 
(reference) profile.

• Suppress paper white 

This setting applies the rendering intent “Absolute colorimetric”, but without paper white 
simulation. Make sure that the rendering intent “Absolute colorimetric” is selected on the 
Color Management pane in Fiery XF.

• Keep current paper white (no change) 

This setting excludes paper white from the optimization. However, the rendering intent 
“Absolute colorimetric” from the media profile is still applied.
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8  Select the criteria for optimization control 

For printers with an embedding measuring device, the optimization procedure can be 

repeated automatically:

• The optimization can be repeated for a defined number of cycles.

• The optimization can be repeated until the required delta E average is reached.

If you select both check boxes, the number of cycles is reduced if an optimal delta E value is 

achieved before the defined number of cycles. If the defined delta E average cannot be 

achieved, the optimization procedure stops when the defined number of cycles has been 

performed. 

9 Click "Next".

The Print and Optimize window opens.

10 Click Print.

The chart is printed.

11 Wait for the ink to dry. Then, follow the on-screen instructions to measure the chart.

After measuring, you return to the Print and Optimize window.

The first measurement forms the basis for the optimization:

• Click Show Patches, and rest the pointer on a color patch to view its L*a*b* value. You can 
view the current patches at any stage of the optimization process.

• Click Import Data to import an optimization file that you started to create during an 
earlier session. You can import data at any stage of the optimization process

• Click Measure to measure the chart again. You can remeasure charts at any stage of the 
optimization process.

12 Click Optimize.

If your printer has an embedded measuring device and you have selected it for the 

optimization, this step is not necessary — the optimization is performed automatically in 

accordance with the defined criteria.

The optimization table displays the average delta E, the maximum delta E, the paper white, 

and the percentage of colors that are within the target gamut.

A green arrow pointing upwards indicates that the profile can be optimized further. A Stop 

sign indicates that no further optimization is possible.

13 Repeat steps 10 to 12 until no further optimization is possible.

When no further optimization is possible, it is useful to perform a visual check on the final 

printout to make sure that the color gradations etc. have not been negatively affected by 

over-optimization.
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14 In the optimization table, click the best set of results, and then click "Finish" to save your 
optimization.

15 Click Yes to confirm that you want to save the selected iteration as the new profile.

The Save selected profile as dialog box opens.

16 Enter a name for the L*a*b* optimization file, and click Save.

The Optimize Profile dialog box opens.

17 Do one of the following:

• Click Yes to select the L*a*b* optimization file for the workflow.

• Click No to save the L*a*b optimization file to the Balance folder, without selecting it for 
the workflow. You can select it at any time in Fiery XF. For more information on selecting 
an L*a*b* optimization file in Fiery XF, see the online help.
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Profile Connector

You can use Profile Connector for the following purposes:

• You can connect a base linearization file to a media profile and/or to a device link profile. 
The source profile determines whether the media profile or the device link profile is 
applied during job processing.

For jobs with an embedded CMYK source profile, the device link profile is applied. For 
jobs with an embedded RGB source profile, the media profile is applied.

• You can connect a new base linearization file that you created to improve the output 
quality of your printer without creating a new media profile.

Furthermore, Profile Connector permits you to make quick changes to an existing base 
linearization file. For example:

• You can incorporate a screening file that was created in Dot Creator for v2 screening.

• You can change the print direction.

• You can change the total ink limit.

• You can correct inconsistencies in the length printed jobs.

TO EDIT AND CONNECT A BASE LINEARIZATION FILE

1 Under “Printer linearization”, click Select and browse to the base linearization file.

This can be a base linearization file you have created for a new media profile or an existing 

base linearization file.

2 Under “Media name”, type the name of the media.

This is the name that will appear in Fiery XF.

It is recommended that you type a new media name. If you type a new media name, the 

media has just one base linearization file connected to it.

If you type the name of an existing media, it means that the media profile will have more than 

one base linearization file connected to it. In Fiery XF, you will have to select which base 

linearization file to apply.
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3 Do any of the following:

• Under “Media length correction”, enter an actual media length and a target media length.

You can correct any inconsistency in the output length of jobs. Inconsistencies can occur as 
a result of a particular combination of printer and media.

The file Lineal_01.ps is provided in the Samples folder to help you to adjust the length of 
the printed image. It consists of a set of ruler markings for a length and width of 
0.5 m x 0.5 m. For more information on adjusting the size of printed jobs, see the online 
help.

• Select “Print unidirectional.

Bidirectional printing is faster as the print head prints in both directions. However, 
unidirectional printing achieves more accurate results than bi-directional printing.

• Change the total ink limit.

The displayed value is the value that is currently saved to the base linearization file. You 
can change the total ink limit without creating a new base linearization file. However, this 
setting should be considered only as a quick fix for experienced users, as there is no 
opportunity to print or measure a chart to check the results.

• Under “Dot Creator Screening”, click Select and browse to a screening file.

Use this setting to implement a screening file that was creating for v2 screening. For more 
information, see the online help.

4 Under “Dot Creator screening”, click Select. Browse to the screening file, and click Open.

5 Under “Connect to profiles”, do one or both of the following:

• Select the “Media profile” check box, and click Select. Browse to the media profile, and 
click Open.

• Select the “Device Link” check box, and click Select. Browse to the device link profile, and 
click Open.

6 Click OK to finish.

You can now select the finished calibration set in Fiery XF. For more information, see the 

online help.
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Make visual corrections

You can use the Visual Correction tool for the following purposes:

• To modify the ink curve of individual ink channels

• To modify the plate characteristics that are often applied to one-bit files

Plate characteristics control the size of screen dots when they are output on the platesetter. 
You can use the Visual Correction tool to compensate for varying dot gain on different 
media. 

As color management normally relies on receiving linear input data to apply color 
management properly, there is a need to compensate non-linear plate characteristics of the 
one-bit files for color-accurate output. There is no fixed formula for modifying plate 
characteristics. However, in the case of contone file formats, a simple formula is applied, so 
that a 5% increase for the 50% patch will yield 55%.

A visual correction is based purely on manual adjustments and should therefore only be 
performed as an emergency measure by experienced users. 

TO PERFORM VISUAL COLOR CORRECTIONS

1 Under “Correction type”, do one of the following:

• Click “Re-linearization” to modify the ink curve of individual ink channels. This type of 
correction is applied after color management in Fiery XF.

• Click “Plate compensation” to modify plate characteristics of one-bit files, or to modify the 
input date for any supported file format. This type of correction is applied before color 
management in Fiery XF.

It is also possible to edit the plate characteristics

2 Under “Color mode”, select your printer’s ink colors.

The radio buttons for the appropriate colors become available.

3 Select the ink colors that you want to modify.

You can apply a global change to all ink colors, or you can modify each ink individually. For 

example, select CMYK to apply a global change, or select C, M, Y, and K to modify each ink 

individually.

4 Add or subtract color anywhere along the ink curve.

For example, you can correct a green tint by reducing the amount of yellow and cyan.

To change output ink percentages, enter input and output values in the table, or drag a point 

along the curve to a new position.
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You can undo your changes by:

• Selecting a table row and pressing Delete 

• Selecting a node along the curve and dragging it outside the diagram 

• Clicking "Reset" to delete all changes 

5 Modify the gamma setting or the linear setting, if required.

• Gamma

This setting affects the lightness of all color values, but mainly the mid-color tones.

• Linear

This setting affects the lightness of all color values equally.

Move the appropriate slider, or type a value in the box.

6 Click OK.

If you performed a visual re-linearization, a visual correction file (*.vcc) is created. For more 
information on selecting a visual correction file in Fiery XF, see the online help.

If you performed a visual plate compensation, a plate compensation file (*.vpc) is created. For 
more information on selecting a visual plate compensation file in Fiery XF, see the online 
help.
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Perform a relinearization

Every printer, even mass-produced printers of the same model, display slightly different color 
properties. Added to this, the color reproduction of a printer can change over a period of time. 

You can compensate for deviances in color by performing a relinearization. A relinearization 
adjusts the ink densities to those of the reference printer on which the media profile was 
created, thus ensuring that the printer’s color reproduction properties remain constant.

It is recommended that you perform a relinearization in the following instances:

• If you are using a media profile that was not created on your exact printer —  for example, 
the media profiles that are provided with Fiery XF

• After changing the print head

• If you notice that your proofs no longer match earlier proof results —  for example, if the 
ink smudges or is not evenly distributed on the media, or if cockling occurs as a result of 
too much ink on the media.

As a general rule of thumb, it is a good idea to perform a relinearization approximately every 
two weeks. 

TO RELINEARIZE THE PRINTER BY MEASUREMENT

When you relinearize the printer by measurement, you optimize the ink densities in the base 
linearization file.

1 Connect your measuring device.

2 Under “Base linearization”, click Select, browse to the base linearization file, and click Open.

3 Under “Measuring device”, select your measuring device.

Click Settings to make additional device-specific settings. This button is not available for all 

measuring devices.If you are using an ES-2000, you can select from three types of measuring 

conditions. They are defined by ISO 13655, as follows:

• M0

The UV content of the speciment illumination is not defined. Measuring occurs in one 
step.

• M1

The UV content of the specimen illumination is defined as D50. Measuring occurs in two 
steps.

• M2

Requires that the spectral power districution of the speciment illumination is in the 
wavelength range of 420 nm to 700 nm, with no substantial radiation power in 
wavelengths below 400 nm. Corresponds to UV cut. Measuring occurs in two steps.
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If your printer has an embedded UV cut measuring device, you can cause it to simulate a 

non-UV cut device by selecting the appropriate check box. In Europe, non-UV color values 

are usually used for proofing purposes.

For printers with an embedding measuring device, the optimization procedure can be 

repeated automatically:

• The optimization can be repeated for a defined number of cycles.

• The optimization can be repeated until the required delta E average is reached.

If you select both check boxes, the number of cycles is reduced if an optimal delta E value is 

achieved before the defined number of cycles. If the defined delta E average cannot be 

achieved, the optimization procedure stops when the defined number of cycles has been 

performed.

4 Click Print.

The chart is printed.

5 Wait for the ink to dry. Then, follow the on-screen instructions to measure the chart.

During this step, the measured ink limits are compared with the ink limits from the base 

linearization file. 

After measuring, you return to the Settings window. The delta E result is displayed, together 

with a recommendation on how to proceed. Before proceeding, you can do any of the 

following:

• Click Advanced to view the L*a*b* and delta E results of the comparison. Click OK to 
return to the Settings window.

• Click Show Patches, and rest the pointer on a color patch to view its L*a*b* value. You can 
view the current patches at any stage of the relinearization process.

• Click Import Data to import previously obtained measurement values — for example, 
measurement data that was obtained with a measuring device that is not supported in 
Fiery XF. The measurement values are used as the basis for creating a new base 
linearization file. You can import data at any stage of the relinearization process.

• Click Measure to measure the chart again. You can remeasure charts at any stage of the 
linearization process.
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6 Do one of the following:

• If the measured delta E is within acceptable tolerances, go on to relinearize the printer:

Click Re-Linearization. Then, print and measure the chart again. During this step, the 
intermediate ink limits (20%, 40%, etc.) are adjusted to those of the base linearization file. 
The 100% ink limits are not affected.

• If the measured delta E is too high and improvements are possible, redefine the 100% ink 
limits before relinearizing the printer:

Click Re-Ink Limiting and Re-Linearization. Then, print and measure the first chart. 
During this step, the 100% ink limits are adjusted to those of the base linearization file.

If necessary, you can reduce the total ink limit for an ink color in the Advanced window. 
Click OK to save your changes.

Click Next. Then, print and measure the second chart. During this step, the intermediate 
ink limits (20%, 40%, etc.) are adjusted to match those of the base linearization file. The 
100% ink limits are not affected.

Further optimization may be possible. Click Optimize & Print to repeat the 
re-linearization process. You can repeat the process as often as you like. If you create 
multiple sets of measurements, the best result is highlighted in green in the Optimize table.

Before saving the re-linearization, you can print out a report with details of the optimization 

results. The report contains details of the print conditions under which the re-linearization 

was created.

7 Click Finish to complete the re-linearization.

You can overwrite the current base linearization file, or create a new base linearization file by 

saving the results under a new name.

You can now select the new base linearization file in Fiery XF. For more information, see the 

online help.
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GLOSSARY

This glossary gives a brief explanation of the terms used in this manual.

Base linearization

Printers do not work in a linear fashion and achieve their maximum color density at 
approximately 50%. As a result, test charts for creating profiles do not have differentiated 
color patches for the upper chromatic values.

A base linearization makes the density curve of the printer linear (input value = output value), 
thus creating an important basis for ICC-compatible color management.

C

Color temperatur of 6,774 Kelvin, which corresponds to daylight.

Calibration set

The calibration set defines a set of print conditions, and ensures that the printer’s behavior is 
adjusted optimally to the media.

Chromaticness difference

See Delta Ch

CIELAB

A color model that is based on the model proposed by the Commission Internationale 
d'Eclairage (CIE) in 1931 as an international standard for color measurement. In 1976, this 
model was refined and named CIELAB. L*a*b* color is designed to be device-independent 
and perceptually uniform. L*a*b* color consists of a luminance or lightness component (L*) 
and two chromatic components: the a* component (from green to red) and the b* component 
(from blue to yellow).

CIELCH

A color space similar to CIELAB, which uses cylindrical coordinates of lightness, chroma, and 
hue angle instead of rectangular coordinates.

Compensation of plate characteristic

A function to linearize a non-linear plate characteristic of one-bit files before they are 
processed in color management. This enables the use of media profiles that are based on linear 
continuous-tone data.

To produce a color-accurate proof from non-linear plate characteristics calculated into the 
one-bit files requires a media profile that is based on the IT8 target using the non-linear 
one-bit files.
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Composite job

A composite job contains all the color information in one file. It can be printed on one page. 

See also Separated jobs

csv

A file format for saving color measurement results in Verifier. A csv file can also be opened 
and edited in any spreadsheet application.

Delta Ch

Describes the distance between two colors in the CIE a*b* color space.

Delta E

The mathematically calculated distance in the CIE L*a*b* color space between two colors. 
Delta E is used to check total color tolerances in a color-management environment.

Delta E 2000

The first major revision of the delta E CIE 94 equation. Unlike dE 94, which assumes that L* 
correctly reflects the perceived differences in lightness, dE 2000 varies the weighting of L*, 
depending on where in the lightness range the color falls.

Delta E 94

A tolerancing system that uses three-dimensional ellipsoids as containers for color acceptance. 
CIE 94 is similar to CMC but lacks some of the hue lightness adjustments. CIE 94 colors 
have 95% agreement with color differences as our eyes see them. CIE 94 is used 
predominantly in the paint and coatings industry.

Delta E CIE 76

A color model that is based on the model proposed by the Commission Internationale 
d'Eclairage (CIE) in 1931 as an international standard for color measurement. In 1976, this 
model was refined and named CIELAB. L*a*b* color is designed to be device-independent 
and perceptually uniform. L*a*b* color consists of a luminance or lightness component (L*) 
and two chromatic components: the a* component (from green to red) and the b* component 
(from blue to yellow).

Delta E CMC

A tolerancing system that is based on CIELCH. It portrays colors as three-dimensional 
ellipsoids and represents colors as they are interpreted by the human eye. CMC colors have 
95% agreement with color differences as our eyes see them. CMC is used predominantly in 
the textile industry.
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Delta H

The difference in hue. In a color wheel, hue is defined by the angle between two colors.

See also Hue

Delta T

The ISO 12647 norm defines delta T purely as a colorimetric value for dot gain — unlike the 
dot gain commonly referred to in printing houses, which is composed of an optical part (light 
trapping) and a mechanical part (dot spread).

Dot gain can only be measured using pure primary colors. For example, if the full-tone color 
Cyan is output on an inkjet printer to simulate offset printing, it will not have the CMYK 
value 100, 0, 0, 0, but will also contain a percentage of magenta, yellow and black.

Device link profile

A Device Link profile represents a fixed combination of printer and media type.

Device Link profiles can be created with Color Profiler Suite. They must be connected to a 
base linearization file and a media profile using Profile Connector. Profile Connector is 
available in Color Tools.

Dot gain

See Tone value

Delta H
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Final Page

Many TIFF/IT files and Scitex CT/LW files are created with a final page. A final page file 
contains information that is extracted from the CT and LW files and ensures that:

• CT and LW files are clearly recognizable as belonging to the same job

• Photos are always correctly positioned at the right coordinates in the final output file

A final page is essential if you are printing a job with a photo that is not positioned in the top 
left corner of the page.

Gamma

The ratio of the contrast range between original and reproduction. A gamma value of 1 means 
that the original and copy proof have the same contrast range.

Halftone screening

A process by which a continuous-tone image is converted into a pattern of regularly spaced 
dots. The individual dots all have the same density, but vary in size. The color tone of a 
printed area is dictated by the size of the printed dots — the larger the dots, the darker the 
reproduced color tone.

Hue

The dominant wavelength of a color. A color system, or model, measures color by hue, 
saturation and luminance. The hue is the predominant color, such as yellow or green, the 
saturation is the color intensity, and the luminance is the brightness.

jdf

Job Definition Format. A file format used in the graphics industry to standardize 
communication between the individual pre-press, print and further processing stages.

The jdf file contains all the settings made in an EFI proofing product that affect color 
reproduction, including print resolution and media. 

L*a*b*

See CIELAB



GLOSSARY 538

Moiré

An interference pattern caused by incorrect selection of halftone screen angles relative to each 
other. Moiré can be minimized by keeping a 30-degree angle between the separate halftone 
screens. However, with a total of four colors and 90 degrees of angle to play with, this is not 
possible. To overcome this issue, yellow — the lightest and least visible color — is often 
positioned only 15 degrees away from cyan and the halftone angles are rotated 7.5 degrees 
from the vertical axis.

Page

Image on a sheet. Pages can be in any supported file format. In a nesting, multiple pages can 
be positioned on one sheet.

pdf

Portable Document Format. A method of formatting documents in such a way that they can 
be viewed and printed on multiple platforms using the freely available Adobe Reader™.

Print configuration set

The print configuration set contains details of the base linearization file that is connected to 
the media profile.

Printer relinearization

A process to re-adjust the color densities and return the printer to the original state that was 
used to create the base linearization.

Quantity of color

A process to define the maximum quantity of ink for each ink channel and so prevent colors 
from becoming oversaturated and “bleeding”.

Remote container

The file format that is used to send the image file and settings from one location to another. It 
is used mainly in conjunction with Verifier. The remote container consists of a pdf file (print 
file) and a jdf file (settings file), which are compressed into a single file with the file extension 
RPF.
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RGB

The additive color system that is used in digital cameras and computer monitors where red, 
green, and blue light is captured separately and then combined to create a full color image.

Separated jobs

On a printing press, each color of ink that is used in a document is printed one at a time. Each 
printing plate that is used on the press is made up only of components of just one color. 

Separations are artwork that is split into four plates of cyan, magenta, yellow, and black for 
process printing (CMYK), or into the required number of plates for spot color 
printing — one plate for each color of ink. Each separation prints a single process or spot 
color.

See also Composite job

Screen angle

The degree of rotation at which a halftone screen is printed. Each element in a four-color 
separation must be photographed through a screen that has been placed at a specific angle in 
order to eliminate moiré patterns when the colors are superimposed. Precise alignment is 
necessary and the order in which the color separations are printed can also affect the finished 
print image.

See also Halftone screening and Moiré

Screen ruling

The number of lines per centimeter or per linear inch in a halftone screen. The higher the 
screen ruling, the smaller the dot size and the smoother the tonal changes will appear to the 
eye. 

See also Halftone screening

Sheet

Sheet refers to the defined output size of a nesting. It can be equal to, or smaller or larger than 
the media size that is defined for the output device. If the defined sheet size exceeds the 
maximum media size that is supported by the selected printer, the nesting can be output as a 
tiling.

System configuration

A system configuration consists of a user, a workflow and an output device. It handles all work 
processes from file input to file output.
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TIFF/IT

When image data is saved to TIFF/IT format, the pixel data of a job is saved to two different 
files:

• The CT (continuous tone) file describes low resolution and half-tone data (e.g. photos). A 
CT file may also be created for each separated spot color.

• The LW (line work) file describes high resolution text or line graphics.

In order for the job to be output, these files have to be combined back together.

See also Final Page

Total ink limit

The total ink limit describes the point at which a printer attains its maximum color density.

Most inkjet printers do not increase color density in a linear fashion. In many cases, the 
maximum color density is achieved at approx. 50%, as illustrated in the graph.

Tone value

The amount that an ink halftone dot expands when applied to the surface of a media, causing 
darker tones or stronger colors. This is usually a factor of the type of press and the absorbency 
of the media.

For example, screen printing increases density by about 15%, so an image with a 50% black 
fill would appear as approximately 65% black after printing.
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White point

In printing, the white point describes the whiteness of the paper. In colorimetric terms, the 
white point is defined as the chromaticity of a white light source or other emissive object. The 
white point may be expressed in terms of correlated color temperature or chromaticity 
coordinates.

XYZ

A device-independent color model developed by CIE (Commission Internationale de 
l'Eclairage), in which RGB values are mathematically transformed into a system that uses x, y 
and z as coordinates. While x and z values have no specific perceptual correlation, the y value 
represents brightness (luminance). 
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A
Adobe print engines 96

increasing number of 367
switching between 96

Advanced Layout 258
Aligning

footer 138
nested pages 117
pages 80

Alignment tools 80
APPE 96

B
Backup and restore 271
Base linearization file

creating 154
editing 154, 164

Bi-directional printing
activating 367
deactivating 373

Black ink, removing color impurities 183

C
Calibration set 140
Canceling jobs

while loading 33
while processing 34

Changes
saving 33
undoing 34

Color
corrections 169
impurities, removing 183
inverting 185

Color accuracy
optimizing 319
tweaking colors 182
verifying 319

at remote site 350
Color adjustments 182
Color consistency, verifying 312

across sites 349
Color Editor

settings 290
starting 288

Color gamut 139
comparing 166

Color gradations, smoothing 376
Color management 139

presets 141
problems with 392

Color space, working 101
Color Tools 153
Composite jobs, overprinting in 102
Connecting system configuration 65
Context-sensitive help 17
Control strips

dynamic wedge 135
selecting 133

Correcting color 169
CPSI 96
Crop marks 229
Cropping jobs 92
Customizing

Job Explorer 28
job list 76
property inspector 31
System Manager 57
Verifier 341
workspaces 71

Cut contours 238
defining as spot color 250
in Advanced Layout 258
in Fiery XF 239
in the graphics program 239
processing 255

Cut Server 247
Cutting options 238

D
Deleting

jobs 34
temporary files 382

Delta E
tolerances, defining 317, 330
warning indicator 342

Device link profiles 147
creating 160

Disconnecting system configuration 68
Dongle ID, finding 20, 43

INDEX
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Dot Creator 356
starting 360

Duplex printing in Advanced Layout 258
Dynamic rendering intent 144
Dynamic smoothing, gradations 376
Dynamic wedge 135

E
Embedded

output intent 142
source profiles 141

Environment, backup and restore 273
EPS job detection 97
Exiting Fiery XF 36

F
Fiery Global University 396
Fiery XF

cleaning up 382
language 32
logging off 36
password 57
program

folders, changing default 381
structure 377
view, saving 71
windows 27

system of measurement 32
uninstalling 397
updating 172

Fiery XF client
exiting 36
starting 20, 23

Fiery XF Control 18
exiting 21
icon, displaying 18, 21
processes 19

Fiery XF files, uploading 175
Fiery XF server

logging on 23
starting 22
stopping 20

File
formats, supported 32
printing to 220

Files, cleaning up 382
Firewall settings 24
Flexo printing, simulating 374

Footer 131
aligning 138
control strips 133
dynamic wedge 135
job ticket 132
layout 136
nestings 117

FOTOBA crop marks 234

G
Gamut check, spot colors 301
Gradations, smoothing 376
Gravure printing, simulating 374
Grayscales, converting to 185
Grommet marks 231

in Advanced Layout 258

H
Halftone screening 356

files, creating 361
Help 17
Hotfolder 190

creating 190
load balancing 368

I
i-cut marks 241

in Advanced Layout 258
Impure color, removing

black 183
process and secondary colors 183

In-RIP separation 98
Installation folders, default 377
Inverting color 185
ISO-compliant proof, achieving 323, 332

J
JDF 264

content files 269
job information 268
print MIS 265
ticket 270
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Job
canceling 34

while loading 33
composite, overprinting in 102
copying 78
cropping 92
deleting 34
editing 88
high-priority 370
JDF 268
loading 32, 186
mirroring 89
moving 78
optimizing color accuracy 319
oversized, printing 92
PostScript and PDF 96
printed length, adjusting 373
printing 33
printing through Fiery XF 188
quality, increasing 371
remote 350
resetting 34
rotating 88
scaling 89
separated 106
speed, increasing 365
verifying color accuracy 319

Job Explorer 27
customizing 28

Job list
customizing 76
display 77
thumbnails 77

Job merge 128
Job ticket 132

K
Keyboard shortcuts 36
KIPCut crop marks 236
Knowledge Center 395

L
Language, user interface 32
Licenses

installation folder 381
installed 20

Licensing 42
problems with 386
regenerating a license file 47

Light conditions, simulating 376
Linearization device, setting up 152
Load balancing 368
Loading jobs 32, 186
Logging off 36
Logging on 23

M
Marks

crop 229
FOTOBA 234
grommet 231
i-cut 241
KIPCut 236

Measurement units, changing 32
Media profiles

creating 156
with third-party software 180

installation folder 381
optimizing 159
problems with 392
selecting 140
third-party 176
updating 174

Media size
at printer 60
virtual 35

Media wedges, selecting 133
Mirroring jobs 89
Monitor profiles 149, 293

creating 163
Multi-threaded halftone processing 368
Multicolor source profiles 141, 283

N
Nestings 108

creating 108
editing 111
footer 117
in Advanced Layout 258
pages

adding 112
aligning 114, 117
cloning 112
locking position 117

renaming 116
sheets, adding 113
updating preview 111



INDEX 545

Non-embedded fonts, PDF jobs 103
Non-printable margins, displaying 87

O
Offline system configuration 66
Offset printing, simulating 374
One-bit files 260
Online help 17
Online system configuration 64
Optimization profile

creating 159
selecting 160

Output device, setting up 60
Output intent, embedded 142
Overprinting

composite jobs 102
spot colors 292

Oversized jobs, printing 92

P
Page alignment 80

frame 85
grid 83
guides 82
marks 84
nested pages 117
on sheet 95
overlapping sheet edge 86
rulers 81
snap to 80

Page size definition, PDF jobs 100
PANTONE Plus spot color library 286
Password 57
PDF jobs 96

loading single pages 104
non-embedded fonts 103
page size definition 100

PDF print engine 96
Plate characteristics

modifying 170
selecting 171

PostScript 3 engine 96
PostScript jobs 96
Presets menu 31

Preview
activating 75
forcing 76
size 79
updating nesting 111
zoom 79

Preview window 79
Print characteristics, simulating 374
Print engines 96
Print MIS

integrating 265
media data base in Fiery XF 266

Print-and-cut devices, setting up 245
Printer

relinearizing 167
setting up 60

Printer inks, using 278, 298
Printing

directly from Fiery XF 188
duplex in Advanced Layout 258
high-priority 370
job 33
job length, adjusting 373
number of copies 189
print-and-cut device 245
problems with 389
through a hotfolder 190
through a virtual printer 209, 210
through Unidriver 197
to a Caddon cabinet 226
to a Fiery output device 221
to a VUTEk printer 223
to Cut Server 247
to file 220
to Zünd Cut Center 243
undefined spot colors 281

Problems with
color management 392
licensing 386
logging on 384
media profiles 392
printing 389
server 384
USB devices 393

Process colors, removing impure color 183
Profile Connector 164
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Profiles
comparing color gamuts 166
creating 151
device link 147

creating 160
inspecting 166
media 140

creating 156, 180
optimizing 159
third-party 176
updating 174

monitor 149, 293
creating 163

multicolor 141
simulation (reference) 141

creating 161
editing 165

source 141
forcing the use of 283

Program
architecture 15
folders, changing default 381
structure 377
view, saving 71
windows 27

Property inspector, customizing 31

Q
Quality, job 371

R
Reference data, random 336
Relinearization 167
Remote container

contents 349
creating 349

Rendering intents 145
selecting 143

Resetting jobs 34
RIP and print on the fly 366, 372
RIP resolution 366, 372
Rotating jobs 88

S
Saving changes 33
Scaling jobs 89
Scitex jobs 105
Scope of delivery 15

Screen angles
changing 364
custom 362
predefined 361

Screening files
creating 361
implementing 363

Screening methods 357
Secondary colors, removing impure color 183
Separated jobs 106
Separations, job detection 97
Setting up

job merge 128
nestings 108
output device/printer 60
step and repeat 125
system configuration 50
tilings 118
user 57
virtual printer 209
workflow 58

Sheet
margins 87
size 35

Simulation (reference) profiles
creating 161
editing 165
selecting 141

Source profiles
embedded 141
forcing the use of 283
multicolor, applying 283
selecting 141

Speed, job 365
Spot color table

applying to workflows 310
deleting 286
editing 280
new 307
opening 308
selecting 279, 310
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Spot colors
adding 276, 294
alias, creating 278, 296
converting to printer color space 305
cut contours 250
defining 275, 294
editing 280
excluding from job 282
gamut check 301
gradients 294, 300
importing 309
ink sequence 282
internal library 277, 286, 294
light conditions 293
manufacturers of, supported 277
mapping to another spot color 278, 296
optimizing 305
overprint settings 292
printer inks, using 278, 298
printing undefined 281
renaming 309
search order 283
undetected 276
white point definition 292

Starting
Fiery XF client 23
Fiery XF server 22

Step and repeats 125
editing 126
renaming 127
setting up 125

Support 395
Supported file formats 32
System configuration

backup and restore 271
linearization workflow 151
online/offline 64
setting up

in Setup Wizard/Assistant 51
in System Manager 57

System Manager 30
customizing 57

System of measurement 32
System requirements 16

T
Thumbnails 77
TIFF/IT jobs 105
Tilings 118

editing 120
exporting settings 123
locked tile sizes 122
setting up 118
tile sizes 120
tiles

hiding 123
merging 122
printing 123
splitting 122
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